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Introduction
Welcome, and thank you for using Origin!
Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists
and engineers. What sets Origin apart from other applications is the ease with which you can customize and
automate your data import, analysis, graphing and reporting tasks.
Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use,
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple
files or datasets.
We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your
findings. And to help you get the most from Origin, we offer first-class customer and technical support,
training and consulting services.
In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing
and Image Handling.
The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or
two about Origin features that you had overlooked previously.
More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main
menu) and numerous other learning resources exist. For a complete listing of available resources, see the
Origin Resources chapter of this guide.
Some things to look for in this guide:

We have added short tutorials to numerous topics throughout this guide. These short
tutorials are intended to give you a quick introduction to a key Origin feature. These
tutorials will be marked with this icon.

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are
marked with this icon.

Features that are new to this version of Origin will be marked with this icon.

Important changes to key features and other critical information will be marked with
this icon.

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter
of this guide.
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Installing and Updating Origin

2.1 Notes for Upgrade Users

•

The Origin upgrade installs into a new program folder - it does not update a previous version. It is
therefore not necessary to install or uninstall a previous version of Origin before upgrading.

•

If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin
2018 and later versions share a common license file and User Files Folder. The first time you run Origin
2022b, it should be licensed and know where your User Files are located.

•

If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see
Selecting a User Files Folder, below). If you have custom Origin files from your previous version, you
can transfer them to your new User Files Folder. From the Preferences menu, select Transfer User
Files. Provided your Maintenance has not expired, you should not have to re-license your software. If
your Maintenance has expired, you will need to re-license your Origin 2022b software (See Registering
Origin, below).

•

If you are upgrading from Origin 2016 or earlier, you will need to complete the license management
process. When your upgrade is launched for the first time, a license dialog will display asking for your
Product Key If you have custom Origin files from your previous version, you can transfer them to your
new User Files Folder. From the Preferences menu, select Transfer User Files.

•

If you have a dongle package, please update your dongle after the Maintenance renewal to make sure
your dongle is available for the latest version. Upgrade your dongle by entering a Product Key in the
License Activation dialog. Once done, you can use this dongle for Origin installed with the same serial
number on any other computers without re-activating the dongle.

Lastly, we want to point out that your Origin software has some great new features. For more information on
key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages
Instructions for getting started with the multi-seat node-locked and concurrent network packages are
available on the OriginLab website (originlab.com/GetStarted).
In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin
installation package for distribution. Information on the MSI installer and alternate deployment techniques can
be found on our website:

•

MSI Installation

•

Silent Install

•

Building an Installation Package

•

Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix.
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2.3 Installing Origin
Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a
virtualization software. For more information, see the Running Origin on Mac using Virtualization
Software, on the OriginLab website.
There are three steps that must be completed to prepare Origin for use:

•

Installation

•

Selecting a User Files Folder

•

License management

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original
version does not have to be installed when running the upgrade.
If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes
an Origin installation button. If the startup program does not automatically run, you can browse the DVD to
launch the setup.exe.

Please note that Origin and OriginPro 2022b are only available as 64-bit versions.

2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed
If you already have the trial version of Origin installed on your computer, you can convert it to the full product
or upgrade.

•

If you have purchased the Origin package with node-locked license management, run Origin and select
Help:Convert Trial to Product; or you can use Help: Activate License, click the “Or if you have
purchased already” radio button and choose Activate for this computer. In either case, you will be
asked to enter the Product Key that was generated when you registered your software purchase on
originlab.com.

•

For all other license management packages, run the Origin Add or Remove Files program located in the
Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator
permissions). When the Origin setup program starts, select the Modify option and then select Install
Product (requires serial number).

2.3.2 How to Correct or Change your Serial Number After you Complete an
Installation
If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or
Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a
log in account with administrator permissions). When the Origin setup program starts, select the Modify
option and then click Yes to change your serial number.

2.4 Selecting a User Files Folder
Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data:
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•

If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is unchanged.

•

If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF.
You must choose a different path from your old UFF.

•

To transfer the contents of your old UFF and your toolbar and workspace configurations to the new UFF,
you can run the Origin software and selecting Preferences: Transfer User Files. For more information,
see Transfer User Files.

Consider these points in selecting your UFF:

•

If you have a mobile computer, it is best to select a location on your computer rather than on your
network.

•

For non-mobile computers, you can select a location on the computer or on the network, as long as you
have stable access to the folder.

•

Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin
users, please see the chapter on Sharing Origin Files, later in this Guide.

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the
UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your
UFF at any time while running Origin. From the Preferences menu, select Options and then click the System
Path tab.

2.5 Licensing Origin
All Origin packages include license management. The type of license management provided with your package
is determined at the time of your Origin purchase.

2.5.1 Node-locked
Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by
entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are
provided for computers with no internet access.

2.5.2 Concurrent Network
Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin
administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains
a license for this server from the OriginLab website, and then sets up a license service. The license service
counts and restricts the number of Origin computers that can run concurrently. For more information, see the
Help Center on the OriginLab website (originlab.com/HelpCenter).

2.5.3 Dongle
A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the
computer's USB port to run Origin. From Origin 2019, dongles are cross-version.

2.6 Registering Origin
Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors.
Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center
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and Template Center dialog, which provide direct access to Apps&Templates and their updates from your
Origin software, requires that your installation be registered.
For Node-locked licenses, registration is completed automatically when you enter a Product Key into the
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin
installation.

For all other license management packages, open Origin, and then select Register on-line... from the Help
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration
ID into the Registration dialog to complete the process. The About Origin dialog should now display your
Registration ID.

2.7 Maintenance
Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting
services, and a home-use license.
Maintenance customers should receive notice of their eligibility for a free upgrade, when
choosing Help: Get Help Files/Check for Updates.

•

To check if your Origin package includes Maintenance, select the Help menu and then select About
Origin. If your package includes Maintenance, the About Origin dialog will show your Maintenance
expiration date.

•

To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor.

•

As your maintenance expiration date approaches, Origin will display a maintenance expiration message
with a link to the OriginLab website to learn how to renew your maintenance. This reminder message
provides a check box to prevent showing in the future.

2.8 Service Releases
When called for, OriginLab publishes free service releases (patches). A service release typically provides bug
fixes and may include some minor improvements. All customers are encouraged to apply service releases to
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab
website (originlab.com/Support).
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2.9 Notification of Upgrade
OriginLab regularly releases new versions of Origin, adding features and feature improvements based on
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance
customers by email. However, to make sure you receive notification of a new version release, please create an
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive
"product updates".

2.10 Setting the Origin Display Language
Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland,
Austria, Liechtenstein, and China, may support running Origin with English display, or with Japanese, German
or Chinese display. To access this language control, select Change Language from the Help menu.

2.11 System Transfers - Deactivating a License

2.11.1Node-locked Licenses (Computer ID-based)
A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

•

If Origin can still be used on your computer:

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your
Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

•

If your licensed Origin computer is no longer available:

1.

Log into your portal at www.originlab.com.

2.

Under Licensing, click the Manage my License(s) link.

3.

Click on the Serial Number associated with the license that you want to deactivate.

4.

Click the go link in the Deactivation column.

2.11.2Concurrent Networks
A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not
required when replacing an Origin computer.
To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available
from the Support area of the OriginLab website.
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2.12 Uninstalling Origin
To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder,
or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays
providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as
prompted.
The Remove program deletes all folders and files that were installed by the Origin setup program. It also
deletes folders and keys created by the installer in the Windows registry.
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Origin Resources
The following tables list key Origin resources available to you. If you purchased Origin from a local distributor,
your Origin distributor may provide additional resources. Please contact your distributor to learn more.

3.1 Direct Support Resources for Origin
For Information On ...

•

Go Here

Contact information for OriginLab
or your Origin Distributor

Technical Support

•

Report a bug

•

Suggest a feature

•

Chat online with an OriginLab

originlab.com/Support

originlab.com

representative

Chat Online

... and click
lower-right corner

•

Share information with and get
help from the Origin user

User Forum

community

•

in the

originlab.com/Forum

Making optimal use of OriginLab
products

Training and
Consulting

•

Help in developing custom tools

originlab.com/Training

for your particular application
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3.2 Resources Installed with your Origin Software

For Information On ...

•

Go Here

Load graph samples and
analysis samples

•

Transfer User Files when
upgrading to the latest version

Learning Center

•

Learning Center for direct

Help: Learning Center (or press F11)

access to Tutorials, Videos,
Origin Blog, User Forum and
social media pages.

•

Online or local (CHM) Help for
Origin (GUI, Programming)

Help Files

•

Help: Check for Updates (to update
CHM files)

Control-by-control explanation
of Origin dialog boxes

Context-sensitive
Help

•

The dialog box must be open

•

Some dialogs have multiple

or

sections/tabs and you may
have to click on that
section/tab to set the focus
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Press F1 when the dialog box is open

Click
in the upper-right corner of the
dialog box

Origin Resources

For Information On ...

•

Recent files

•

Help with problems or

Go Here

Press F1 when no dialog box is
open

questions that arise while
using Origin

•
Start Menu
- Windows-like
Search

or

Direct access to Origin features

•

and dialog boxes

Click the Start menu icon at the

Open or search for Apps

bottom-left of the workspace.

relevant to a particular task

•

Location of Origin menu
commands for searched-for
features

•

For additional information on using
this feature, see
The Origin Interface, Start Menu.

Step-by-step instructions on
performing many Origin
operations, from the simple to

Tutorials

Help: Origin : Tutorials

the complex

3.3 Online Resources for Origin

For Information On ...
Online
Documentation

•

Product documentation

•

Resources list

•

Installation and License
Documentation

Help Center

•

Go Here

originlab.com/Doc

originlab.com/HelpCenter

Contact Info
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For Information On ...

•

Go Here

Help with a range of Origin
features including "tips and
tricks"

•
Video Tutorials

Available in playlists and
categories

•

Search Origin video or YouTube

originlab.com/Videos
youtube.com/user/TheOriginlab

pages by keyword
or type v <key phrase> in the
Origin Start menu.

•

highlighting key features

Webinars

•

•

•

blog.originlab.com

How others are using Origin in
their work

Case Studies

originlab.com/Webinars

Blog posts with plenty of
software tips and tricks

Origin Blog

Graph Gallery

Live and recorded webinars

originlab.com/CaseStudies

Outstanding examples of Origin
graphs, many of them submitted
by the Origin community

originlab.com/GraphGallery

Information on key Origin features often can be found by just doing a quick web
search. Open a browser and search on phrases such as... "Origin shortcut keys",
"LabTalk graph legend", or "OriginC NAG functions".
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OriginPro
OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis
tools and capabilities. If you don't know which product you have -- Origin or OriginPro -- look to the title bar.

Users of standard Origin will note that some menu commands are marked with (Pro),
indicating that the feature is available only in OriginPro. If you own the standard version of
Origin, but find that you need features of OriginPro, you can upgrade by contacting your
Origin representative.
If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):

4.1.1 Curve Fitting
In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the
following:

•

Linear fitting with X error.
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•

Nonlinear fitting with X and Y errors (orthogonal regression).

•

Fitting with implicit functions (orthogonal distance regression).

•

Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two
datasets to one model.

•

Global fitting of multiple curves using different functions, with the option of sharing parameters.

For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.

4.1.2 Surface Fitting
With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

•

Fit worksheet data (XYZ) or matrix data (Z values).

•

Locate and fit multiple peaks using one of several peak identification methods.

•

Automatic peak parameter initialization.

•

Apply constraints and bounds to parameters and fix parameter values.

•

Output parameter and statistical results plus residual curves.

•

Find specific Z values along the fit surface and include them in your output.

•

Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.

For more information, see this web page: Surface Fitting.

4.1.3 Peak Fitting
OriginPro includes the Peak Analyzer tool with support for the following:

•

Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).

•

Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined,
None).

•

Fit Peaks with built-in or user-defined functions.

•

Fit individual peaks with different fitting functions.

•

Fit Baseline as part of the peak fitting process (user-defined or built-in functions).

•

Control fit parameters (fix, share, set bounds).

For more information, see this web page: Peak Fitting.

4.1.4 Statistics
OriginPro includes support for advanced statistical analyses in these areas:

•

Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation
coefficient).
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•

ANOVA (one-/two-way repeated measures, three-way).

•

Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial
least squares).

•

Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival
functions)

•

Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one/two-sample proportion test).

•

Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney,
two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support
for simultaneous tests).

•

Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test,
one-way ANOVA).

•

ROC curve analysis.

For more information, see this web page: Statistics.

4.1.5 Signal Processing
In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

•

Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).

•

Filtering (IIR filter design, 2D FFT filter).

•

Correlation (2D correlation).

•

Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet
transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D
wavelet reconstruction).

•

Rise-time Gadget (linear search, histogram, largest triangle).

•

Decimation (moving average, finite impulse response).

•

Coherence.

•

Envelope curves (upper and/or lower, smooth during envelope detection).

For more information, see this web page: Signal Processing.

4.1.6 Gadgets
Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a regionof-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

•

Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and
deleting points).

•

2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).

•

Rise-time Gadget (analyze rise/fall time of stepped signals).
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For more information, see this web page: Exploratory Analysis.

4.1.7 Image Processing
Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional
tools in the following areas:

•

Image adjustments (function lookup table, leveling).

•

Image conversion (dynamic binary, threshold, RGB merge/split, image scale).

•

Spatial filters (user filter).

•

Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological
filter, pixel logic, replace background, subtract background, subtract interpolated background).

For more information, see this web page: Image Processing.

4.1.8 Apps
Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro
license to run. OriginPro-only Apps will be listed in the Origin File Exchange with a red
them.
Here are some of our more popular OriginPro Apps:

•

Redundancy Analysis

•

Speedy Fit

•

Correlation Plots

•

Neural Network Regression

•

X-Ray Diffraction Analysis

•

Phylogenetic Tree

•

2D Peak Analysis

•

Standard Curve Analysis

•

Linear Mixed Effects Model

•

Rank Models

•

Peak Deconvolution

•

Design of Experiments

•

2D Confidence Ellipse

•

Independent Component Analysis (Requires R software)

•

Logistic Regression

•

Sequential Fit

•

Piecewise Fit

•

Piecewise Smooth

•

Principal Component Analysis

•

Principal Component Analysis for Spectroscopy
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•

Slope Analyzer

•

Global Peak Fit

•

3D Smoother

•

Cyclic Voltammetry

•

Enzyme Kinetics

•

Polynomial Surface Fit

•

Heat Map with Dendrogram

For general information on Apps visit www.originlab.com/apps.
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What's New in Origin 2022b

5.1 Origin 2022b New Feature Highlights

Visit www.originlab.com For Origin 2022b Feature Highlights, including a Highlights
video.

•

Export Graphs and Layouts to SVG Image Format: Graphs and layouts can now be exported in SVG
format, allowing for easy editing of the exported file in applications such as Adobe Illustrator™.

•

Workbook Buttons for New Sheet, Workbook Organizer: Buttons are added to workbook navigation
to add new sheets or to toggle the Workbook Organizer on and off.

•

Arrange Windows with Custom Sorting and Snapping: New dialog to arrange/tile windows by Project
Explorer order, window name, window type, etc. Aligned windows can be "snapped" to a common edge by
dragging.

•

Rich Text Support in Notes Windows: Applies to standalone Notes or Notes added as workbook sheet.
Use Format toolbar, apply document styles. Auto-wrapping.

•

Rich Text Support for Worksheet Cell Notes: Use the Format toolbar and paragraph styles to style
text in both label row and data cells.

•

Insert Images into Graphs and Notes: Insert linked images from data cells, image windows, files or
online, into labels in graphs or into Notes windows.

•

Simplified Symbol Map Dialog: Open a smaller, tabbed dialog for inserting common symbols. Direct
access to "Advanced" dialog.

•

Distance Annotation on Graphs. A new Distance Annotation tool (Tools toolbar) for labeling the
distance between to points on the graph.

•

Expanded Named Range Support for Label Rows and Fitting Dialogs: Use label row values in
calculations or placing reference lines. Use in fitting operations as parameters and bounds.

•

Apps Gallery Improvements: Adjust icon spacing, plus dock the Gallery to top of workspace.

•

New Graph Types: Bar Map, Circular Packing, and Right-Triangle Ternary.

•

New Apps:

5.2 Features by Category
5.2.1 Data Handling
•

New Workbook Buttons to Add Sheet, Show/Hide Organizer

•

Column Label Row Support for Cell Comments
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•

Improved Set Column Value "Column" Handling of Duplicate Long Name

•

Column Label Row Support for Named Range

•

Tolerance Factor Added to Split Worksheet

•

Improve ROI Support for Matrix Image Stack

•

More Interpolation Options for Matrices incl. NetCDF Matrices

•

Convert Project Links and Formulas to Raw Values

5.2.2 Notes
•

Toolbar Support for Rich Text Editing of Notes Windows

•

Paragraph-style Support in Notes Window

•

Font Size Control for Individual Notes Windows

•

Notes Window Support for Inserting Graphs, Images, Cell Values, LaTeX equations, etc.

•

Insert Notes Window Content to Layout or Graph

•

Print Rich Text Content to PDF

•

Notes Window Support for KaTeX

5.2.3 Graphing
•

Point-by-Point Legend improvements

•

Data Highlighter Adds Support for Picking Rows in Multiple Sheets

•

Insert Images into Graph Page Text Objects

•

Simplified Symbol Map when Editing Legend or Text Object

•

Mini Toolbar Button for "Add Label for Layers"

•

Speed Improvement for Sankey Diagram
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•

Text Object Mini Toolbar Toggle for Link to Substitution

•

Longer Minus in Tick Labels, Active Indicator in Legend

•

Object Manager: Select Objects with Same Name

•

Mini Toolbar Support for Modifying Multiple Selected Legend Objects

•

Distance Annotation on Graphs

•

Box Charts: Add Percentile tab > Edge Thickness Control

•

Increment Line Style (dropdown)

•

Box Chart Connect Lines tab Support for Connection Types

•

Case Sensitive Sorting in Dialog Lists (e.g. Layer Contents)

•

Support Wrapping of Tick Labels When No Space Between Characters

•

Colormap Transparency for Image Plots

•

Mini Toolbar Toggle for Speed Mode Banner Display

•

Auto Import of Linked Images

•

Better Batch Plotting Support for Multi-X Plots

•

Column Width Control, Data Point Tooltip

•

Alignment of Multi-line Data Labels

•

New Axis Option for Scientific Notation

•

Fit Page to Objects for Layout

5.2.3.1 New Graph Types

•

New Graph Type: Bar Map

•

New Graph Type: Circular Packing Graph
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•

New Graph Type: Right Angle Ternary

5.2.4 Analysis
5.2.4.1 General

•

Pause Auto Recalculate Hotkey

•

Batch Processing Improvements

•

New Normalization Methods for Worksheet Columns

5.2.4.2 Gadget

•

Customize ROI Label for Quick Fit Gadget

5.2.4.3 Fitting

•

Named Range Support For Fitting Operations

•

Support EMF/SVG for User-Defined Fitting Function Previews

•

Parameter Initial Formula Improvements

•

MT Button to Modify Displayed Digits in Result Table

5.2.5 Import and Export
•

Export Graph or Layout to SVG Image

•

Export Image Window Improvements

•

Import Web Image to Image Window, plus Hotkeys for Import

•

Excel Connector Improvement to Auto Detect Header

•

Support Display of Origin Import Filters (*.oif) on Data Menu

5.2.6 Image Analysis
•

Import GeoTIFF to Matrix Window

•

Import GeoTIFF to Image Window
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•

Import Multi-frame TIFF Control for Display of Thumbnail or Slider

•

NetCDF Import Improvements to Averaging and Handling of Numeric Year

•

Export NetCDF Analysis Results to .nc File

5.2.7 Miscellaneous
•

Disable Mini Toolbar Across Sessions

•

Flexible System for Arranging Windows

•

Resizing and Snapping of Windows in Workspace

•

Undo Delete Workbook

•

Control App Icon Spacing and Gallery Docking

•

Update LabVIEW VI Files to add "Close References"

•

Project Explorer Shortcut Key Control of Preview

•

Adjust Window Size and Position For Display Resolution

•

Improved Notification of Upgrades via Check for Updates

•

Install Apps from the Origin Start Menu

•

Install Cloud Template from Origin Start Menu

•

Customize Behavior of Insert Object to Graph Button

•

Subpanel of Project Explorer Displays Size When Show Folders is Checked

5.2.8 Programming
5.2.8.1 LabTalk

•

Cell Notes LabTalk Access via Text Label/Legend Option @WN

•

LabTalk System Variable for Disabling Sparklines

•

Improve Notes Window Raw Text Editor
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For more information, see Programming in Origin > LabTalk.
5.2.8.2 Origin C

•

Add Function to matrixbase Class for Importing ASCII string

•

Add Function to Get DataRange from Named Range.

•

Add Function to Get List of Cells with Notes to Worksheet Class.

For more information, see Programming in Origin > Origin C.
5.2.8.3 Python

•

Support Calling Fitting Functions in Python.

•

Specify Package Version When Running pip Command.

For more information, see Programming in Origin > Python.

5.2.9 New Apps for Origin 2022b
•

Zoom FFT

•

Radiometric Geochronology Analysis

•

Matrix Analysis

•

NetCDF Data Analysis

•

Tangential Baseline

•

Mann-Kendall Test

•

GeoTIFF Export

•

Color Spectrum Plot

•

Hansen Solubility Parameter Plot

To find out more about Origin Apps, including where you can get the free add-on Apps listed above, see the
Apps for Origin chapter of this User Guide.
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6.1 The Origin Workspace
This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim
this chapter.

For Origin 2022b, window size and position in the workspace, are automatically
adjusted to accommodate different displays. This should make it easier for you to
switch between your laptop and a higher-resolution monitor, without having to
resize/reposition every window and dialog box. A system variable is added to control
rescaling behavior: @SRWS (0 = previous behavior; 1 = fit width, scale y; 2 = fit
height, scale x; 3 (default) = fit width and height).
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6.1.1 Windows File Explorer Previews
While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to
preview graphs in a project file.

•

Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View:
Large Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the
last active graph before the project file was saved.

•

Open the Preview Pane (ALT + P) and scroll through all graphs in the project file.

•

If you do NOT wish to save graph previews into the file (either in icon view or in the Explorer Preview
Pane), you can set LabTalk system variable @PESS=0 or =-1. For information on changing the value of a
system variable, see FAQ-708 How do I permanently change the value of a system variable?

6.1.2 Origin Menus and Menu Commands
•

Context-sensitivity of menu bar and menus: The menu bar and menu commands are contextsensitive; they change as you change window type (from worksheet to graph to matrix, for instance).
Only menus pertinent to the active window will display.

•

Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that
display to the left of the command. Additionally, you may see a shortcut key combination listed to the
right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the
same functionality.
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•

Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut
menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent
menu commands will show.

•

Collapsible menus: By default, main and shortcut menus in Origin are "collapsed", meaning they display
an abbreviated set of commands. When you use a menu item which isn't included, it is added to the menu.
If you prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear the
Enable Collapsible Menus box.

•

Most frequently used analysis menu commands: Most-recently used menu commands will appear at
the bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick
access to tools when performing repeat operations.

•

Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu
Organizer to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this
Guide.

6.1.3 Origin Toolbars
Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize
toolbars.

•

Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars
dialog box to modify button and toolbar appearance.

•

Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar,
hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar
off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title
bar.

•

Hide/Show a toolbar: Clicking the Close button on a toolbar removes the toolbar from view. To restore
a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar.

•

Hide/Show a button: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a
toolbar.

•

Move button location: Alt+drag a button to move it to a new location within or among toolbars.
Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window til X shows to
remove a button.

6.1.4 Mini Toolbars
OriginLab continues to add Mini Toolbar support for common objects and tasks. These toolbars appear when
the user selects an object or when the user clicks in certain key areas inside the page. Available controls
depend on context (selected object, window type, etc).
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•

Before using Mini Toolbars, make sure there is a checkmark beside View: Mini Toolbars (default).

•

To display the toolbar, select an object such as a data plot, a text label, or a worksheet cell.

•

In addition, there are toolbars for more-general page- and layer-level customizations and these toolbars
are displayed by hovering near the margins of the window. When you see your mouse cursor change to
something like this

, this is your cue that clicking in this spot will display a Mini Toolbar of relevant

tools.

•

Most Mini Toolbars have a Properties button

that gives access to more complex settings (e.g. a

graph window's Plot Details dialog box).

•

If you move away or you do not act quickly enough, a Mini Toolbar will fade away. To restore a Mini
Toolbar after it has faded, press the SHIFT key.

•

To add or remove buttons from a Mini Toolbar, click on the three dots at the bottom center of the toolbar.
This opens the Customize Mini Toolbar dialog box where you can enable or disable buttons as needed.
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Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
sessions (i.e. if turned off in the current session, they would be restored on Origin
restart). Now, this setting is remembered across sessions (alternately, you can control
Mini Toolbar display by setting system variable @DMT (ON=0; OFF=1)).

6.1.5 Start Menu
Enter keywords and phrases into the Find box to return relevant Menu entries, Apps, FAQs, Videos and XFunctions. Open recently-opened Files, Menus and Apps.
Open the Start Menu by (1) pressing F1 (when no other dialogs are open), (2) by clicking the magnifyingglass icon at the bottom left corner of the Origin workspace, or (3) by clicking Help: Activate Start Menu
(main menu).
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To narrow your search, type the following letters in front of the search term(s):
m = search only Menu entries
a = search only Apps
h = search only Help + FAQ
v = search only Videos
x = search only X-Functions
p = search your recent projects
s = search sample projects
e = search Menus + Apps + X-Functions (only executable)
Alternately ...
Click the "gear" icon beside the search field to open the Settings box. Here you can restrict search results and
tweak other search settings.

Search for Apps and install them directly from the Start
menu.
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6.1.6 Learning Center
Learning Center is a "startup" dialog that gives quick access to graphing and analysis examples, plus
learning resources (tutorials, videos, the OriginLab blog, etc.).
1.

To open the dialog, choose Help: Learning Center or press F11.

2.

Check or clear the Show on Startup box to show or hide this dialog each time Origin starts.

•

View and load sample graphs, including sample data and notes on re-creating the graph.

•

Load analysis samples with data.

•

Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and
Origin social media pages.

•

Move files from your previous User Files Folder to your new User Files Folder.
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To see new graphs in Origin 2022b, open the Learning Center, click the Graph
Samples tab, set the plot filter drop-down to All Plot Types and search on 2022b.

6.1.7 Project Explorer
Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).

Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel
shows windows contained in the folder that is highlighted in the primary panel.
Using Project Explorer to manage your projects:

•

Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical
Alignment) or side-by-side (Horizontal Alignment).

•

Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on
what is selected or where you have right-clicked.

•

Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your
mouse).

•

The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons,
Extra Large Icons.

•

In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or
layout window. Notes window content is shown in a tooltip.
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Project Explorer Improvements, Origin 2022b:

•

Control display of popup previews by right-clicking in the subpanel and placing a check
mark beside Hold Ctrl Key for Preview Popup. Henceforth, popups will only appear
as you press CTRL.

•

•

When subpanel's Show Folders is checked, folders now show folder Size.

When displaying windows as Extra Large Icons, the PE sub-panel displays a thumbnail of graphs, layout
windows, workbooks and matrixbooks. Notes window content is shown in a tooltip.
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Prior to 2018, the PE sub-panel listed sub-folders in the folder selected in the top panel.
To restore this display mode, set the value of system variable @PEF = 1.

You can right-click on PE folder (upper panel) and choose Copy -- or select the folder
and do a CTRL + C and CTRL + V -- to copy and paste the folder structure and content
to (a) another folder in the current project or (b) another project running in a second
Origin session. To copy a single workbook window, right-click on the window (lower
panel) and copy and then paste the window to (a) another folder in the same project,
or (b) to a new project running in a second Origin session.
Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag

1.

the file Tutorial Data.opj to your Origin workspace.

2.

By default, Project Explorer is docked to the left side of the Origin workspace in
auto-hide mode. Mouse over the Project Explorer tab to show the PE window.

3.

Click on the "push pin" icon on the PE title bar to pin the window in the docked
position.

4.
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Name, Size and Comments show below these column headings. Try dragging
column headers to reorder them.

5.

Right-click on the column headings and show or hide any of the headings by
checking or unchecking the box beside each.

6.

To add a comment in the Comments field, click once, pause briefly and click a
second time. This puts you into edit mode. Enter a comment.

7.

To change the Name of a window, right-click in the row and choose Rename. By
default, the Name field displays the window Short Name; or if a window Long
Name exists, the window Long Name (all windows must have a Short Name but
Long Names are optional). Click the SN or LN button to the right-side of the
editable Name field to edit the Short Name or Long Name. If the Long Name does
not exist, you can enter one.

8.

In the top panel of Project Explorer, scroll to the folder 3D Surface with Point
Label and click on it. The sub-panel shows that there are three windows in the
folder. Note that the worksheet window eastcali3053 is bold indicating that it is
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the "active" window - the window that is being acted upon as well as the window
that determines what operations are available. There is also a Notes window, and
a matrix window named MBook4.

9.

In the sub-panel, double-click on MBook4 and note that it is now bold and has a
magenta "halo", indicating that it is the active window. You will also see that the
whole window(in the workspace) displays with a halo which can be customized in
color with the system variable @AWC-- another indicator that this is the "active"
window. Double-click on this MBook4 icon again and note that the icon is now
dimmed. Note also that the actual window disappears from the workspace. This is
because MBook4 is now hidden. Double-click the MBook4 icon again and the
window is restored and made active.

10. With MBook4 active, click Plot > 3D: Surface: 3D Colormap. This creates a 3D
colormap surface graph (close the attention message). Note also that a new window -Graph1 -- has been added to the sub-panel of Project Explorer.

11. Right-click in an empty portion of the sub-panel and choose View: Extra Large
Icons. Note that Graph1 now displays a graph thumbnail.

12. Right-click again and choose View: Large Icons. Note that windows are now
represented by icons but if you hover on them, you can see the window contents
as a pop-up.
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To disable PE previews, open the Script Window (Window: Script Window) and type
one or both of the following, then highlight the text and press Enter:

@PESS=-1; //turn off window preview in PE, show window comments
as tooltip

@PESH=0; //turn off window comments tooltip
When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.8 Apps Center and App Gallery
Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number
of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin software.
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Use the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you
direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and
navigate there.

To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at
the right-side of your Origin workspace. If you do not see the Apps Gallery, click View: Apps (or ALT + 9) and
verify that there is a check mark beside Apps.

•

Installed and Up-to-date Apps will appear in the App Center with a green check mark beside them

•

Installed Apps for which there is a newer version will appear with an Update icon beside them

•

Those not installed will appear with a clickable Download and Install icon beside them

Origin's Statistics, Analysis: Fitting and Analysis: Peaks and Baseline menus include a Find Apps entry.
Clicking Find Apps opens the App Center to show only Apps that relate to the current menu (e.g. Statistics).
You can download or update Apps directly from the App Center.
Use the Apps Gallery to organize and access your installed Apps.
New For Origin 2022b:

•

Adjust App Gallery icon spacing using a slider control.

•

Dock the Gallery in a horizontal configuration, at the top of the workspace.

New Apps and App updates are are continually made available to Origin and OriginPro
users. Be sure to open your App Center occasionally (press F10) and if it displays the
red Download Now button, click to get the latest list of available Apps.

For more information on Apps, please visit www.originlab.com/apps.
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6.1.9 Object Manager
The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the
Object Manager for quick manipulation of the active graph or workbook window.
Graph Windows

•

Select an element (layer, plot group, data plot or special point) in the Object Manager to select the
corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the
graph layer and (b) selects the source data in the worksheet.

•

Object Manager can show a "Graph Objects" view and a "Plots" view of graph windows. To toggle
between the two views right-click in an empty portion of the Object Manager and choose Show
Plots/Show Graph Objects; or press Ctrl + Shift + S.
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•

Hide or show plots or graph objects by clearing or checking the corresponding box in the Object Manager.

•

At the graph level, change Object Manager list order (Drawing Order or its reverse -- Order of
Appearance ).

•

At the layer level, change layer order.

•

At the plot level, show labels, show or hide plots, reorder plots or create plot groups.

•

Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu
command, change plot type.

•

Remove a plot (permanently) from the graph window.

•

Access the Plot Details, Layer Contents and Plot Setup dialog boxes.

•

Right-click on the layer icon and Reverse Plot Order.

Workbook or Matrix Windows
The Object Manager also supports certain actions for workbooks and matrices:

•

List all sheets in the active workbook or matrix.

•

Quickly select multiple sheets by pressing CTRL + Up/Down arrow.

•

Click a sheet in Object Manager to activate the corresponding sheet in the workbook or matrix.

•

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,
Move, Copy, and Duplicate.

•
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Layout Windows
When a Layout Page is active, the Object Manager lists and allows arrangement of objects via shortcut
menu commands.

•

All objects, including added graphs, tables and text objects, list in the Object Manager.

•

Hide or show objects by clearing or checking the adjacent box.

•

Select multiple objects in Object Manager, then right-click and align or distribute them using shortcut
menu commands.

6.1.10Origin Child Windows
Active windows -- the window that will be acted upon by graphing and analysis
operations -- display a colored frame to make the active window more obvious. You can
customize the active window indicator properties (frame color, where the frame shows,
frame line style) with "@ System Variables" @AWC (color) and @AWI (style).
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•

Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing,
transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each
sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data,
workbook windows may also store graphs, annotations, column-based functions, scripts and
programmable button objects, LabTalk variables and import filters.

•

Matrixbooks: Like the worksheet, a matrixsheet is a grid of cells, arranged in rows and columns. The
primary difference is that in the worksheet, each column is a dataset and each dataset can be configured
to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast,
the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X)
index numbers. The matrixbook contains between 1 and 1,024 sheets. Each sheet can contain multiple
matrix objects (up to 65,504).

•

Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart
types, chosen specifically for their applications in various technical fields. Each chart is created using a
built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data
plots, the graph may also contain annotations (text and drawing objects) or button objects that, when
triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet
cells or "floated" on worksheets (outside the grid) in a workbook window.

•

Images: The image window is a window for importing, viewing and editing raster images and videos
(.avi, .mov, .mp4).

•

Function Graphs: The function graph is a specialized graph window that displays a curve described by a
function. The function graph differs from other Origin graphs in that it is not produced from a dataset of
discreet values (though you can generate data after plotting).

•

Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and
various annotations onto a single "display panel." It is used primarily for creating presentations.

•

Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved
separately or as part of your Origin project file.

•

Notes: The Notes window supports plain text, Rich Text, HTML and Markdown. Use it for simple tasks
such as recording analysis procedures, making notes to students and colleagues, and cutting and pasting
text from other applications; or use it for rendering highly formatted text, including HTML reports and
mathematical expressions (see next).

The Notes window now supports both LaTeX and KaTeX, allowing you to render
highly-formatted mathematical expressions.
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Note: For more information on Origin's child windows, see
Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a
Child Window
Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child
Window Operations

To save an Origin child window independently of the Origin project file:

•

Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for
Origin Workbook, Graph and Matrix windows, respectively.

•

Right-click any window title bar and choose Save as... context menu.

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose
Save Workbook as... context menu.
Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and
templates. When you save a window file, you will have the option of saving a file with
or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file
only in the latest version of Origin, you should choose the Unicode-compliant
(appended "u") option as it offers some performance advantages.

To open a worksheet, graph, matrix, or notes window that was saved to a file:

•

Select File: Open or click the Open button

•

Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window

on the Standard toolbar to open window files.

files.
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Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be
unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the
project. If you open window file in the current project, then save the project, the window will be included in
the project.
To open an Excel workbook file:

If you are intending to work with Excel files in Origin, please see this section of the
Origin Help file before proceeding.

•

Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the
Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu
to import the Excel file.

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs
inside Origin. In this mode, you have only limited access to Origin features. If you choose Data: Connect to
File: Excel or Data: Import From File: Excel, the Excel file is imported into an Origin workbook and all
Origin features are available.
6.1.10.1 Arranging Child Windows

Origin 2022b adds some new window arranging tools that go beyond the basic Tile
and Cascade functionality. Users in industry and research who work with high
resolution monitors and many windows should find the tools helpful.

6.1.10.1.1

Arrange Windows Dialog

Central to using these tools is the Arrange Windows (winarrange) dialog (Window: Arrange Windows).
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Use the dialog to sort and arrange windows in the Origin workspace.

•

Divide windows into how many columns?

•

Sort by order of activation, Project Explorer order, or window name (ascending, descending).

•

Sort within window type.

•

Horizontal (left to right) or vertical direction (top to bottom).

•

Overlap each column (cascade) by user-defined Offset.

•

Save settings as a Dialog Theme.

6.1.10.1.2

Snapping Windows

Windows that are arranged in rows and columns can be "snapped"; that is, dragged and resized along a
common edge. The visual cue for engaging the snap is a green bar.
1.

Toggle this feature off or on using Window: Snap Windows (Ctrl+F12).

•

To resize a single window without snapping, press SHIFT while dragging window border.

•

Swap two window positions by pressing ALT while dragging the window title bar.

•

To snap a window into an empty space, press SHIFT while dragging.

6.1.11The Command Window and Script Window
The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped
command history that can be carried over from session to session, and intellisense which provides autocompletion features when writing X-function commands.
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The Command Window is dockable and has two panels. The left-hand panel displays the command history,
while the right-hand panel provides the command line.
The Script Window provides some of the same functionality as the Command Window. It lacks some of the
Command Window's features (no intellisense, no command prompt, no command history) but it is handy for
running simple LabTalk commands (e.g. changing the value of a LabTalk system variable). The window's Tools
menu also opens the LabTalk Variables and Functions dialog box where you can view a list of Origin
variables, functions, macros, loose datasets, etc.
To open the Command Window:

•

Click the Command Window button

on the Standard toolbar. Alternately, select Window:

Command Window menu or press ALT+3.

To open the Script Window:

•

Select Window: Script Window menu or press SHIFT+ALT+3.

6.1.12The Formula Bar
The Formula Bar is similar to formula bars in OpenOffice and Excel. While it is not necessary to use the
Formula Bar to enter cell expressions, it does offer the advantages of function search, interactive range
selection and improved visibility of expressions, particularly of long expressions that exceed cell width.

1.

With a workbook active, toggle the Formula Bar on or off by clicking View: Formula Bar on the main
menu.

2.

To change font size, change the value of LabTalk system variable @FBFS (default is "130").

For more information, see the Workbooks, Worksheets and Columns chapter.

•

The Search Functions dialog that is opened from the Function menu in certain
dialogs (e.g. Set Column Values) can be opened by clicking Tools: Search
Functions.
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6.1.13The Status Bar

The Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:

•

Help messages and tool descriptions.

•

Statistics on the current workbook, matrix or graph selection.

•

Whether the AutoUpdate analysis feature is turned on.

•

The name of the System Theme, if any.

•

Information pertinent to the active window.

•

Angular unit (radians, degrees, or gradians).

•

Tool tips for functions listed in the Set Values F(x) menu.

•

Notifications from OriginLab, represented by a small red flag to the right side of the Status Bar.

Customize and Copy Status Bar Data

•

You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items
from the context menu.

•

Copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are
TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.

6.1.14Smart Hints and the Smart Hint Log
Smart Hints are triggered by user actions and are intended to give the user help with current task. These
hints may appear briefly inside a dialog box, as in this example.
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Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.

Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking
the "Do not show this message in the future" box at the bottom of a Smart Hint.
Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab,
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

To open (and close) the Smart Hint Log window:
1.

From the Origin menu, select View: Smart Hint Log or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you
to confirm that you do not want to show or log this message.
To turn off all Smart Hint display in the session, open the Script Window and type the following:

@SHS = 0;
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To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help:
Reactivate All Hints.

When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.15Code Builder
Origin integrated development environment (IDE) is called Code Builder. Code Builder provides tools for
writing, compiling, and debugging your Origin C functions. Additionally, it can be used for running and
debugging Python code.
To open Code Builder:

1.

From the Origin menu, select View: Code Builder or click the Code Builder button

on the Standard

toolbar or press ALT+4.
2.

Code Builder can also be opened by clicking Connectivity: Open untitled.py. In this mode, you can
paste and run Python code by pressing CTRL + F5.

6.1.16Messages Log
The Messages Log window shows messages about operations including Output Information, Results and
Errors. It displays messages that are not sent to the Script Window or the Command Window.
To open (and close) the Messages Log window:
1.

From the Origin menu, select View: Messages Log or press ALT+6.

6.1.17Results Log
Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log
includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the
type of analysis performed, and the results.
In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close)
the Results Log by doing one of the following:

1.

Click the Results Log button

on the Standard toolbar. Alternately, from the Origin menu, select

View: Results Log or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View
Results.

6.1.18Float, Dock and Auto-Hide Windows
There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows
include Project Explorer, Results Log, Command Window and Messages Log. This allows you to
customize your Origin workspace so as to maximize utility and save screen space.
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6.2 Numbers in Origin
•

Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrixbook,
Origin uses a combination of user-specified settings to determine how to display the data in each cell.
What displays is a visual representation of the data value. The actual data values are stored with the full
precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the
actual data values that are used and not the displayed values.

•

When Contents Exceed Cell Width: Prior to Origin 2020b, if the sequence of characters in a sheet cell
exceeded what could be displayed at the current cell (column) width, Origin represented cell contents as a
series of pound signs (######). This has changed to mimic MS Excel's worksheet behavior:

•

Text strings will not trigger display of pound signs ###### regardless of column width. To
view the full string, you must increase column width.

•

Numeric values that exceed column width will first be rounded to the nearest decimal and
only if that is not sufficient to display the full integer value, will pound signs ######
display in place of the numeric value.

•

This rounding of numeric values affects the displayed value only. The internally-stored value
does not change.

•

To restore the old behavior of displaying pound signs ###### whenever cell contents were
not fully displayed, set system variable @WPE = 1. For information on changing the value of
a system variable, see this FAQ.

•

Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that
there was a need for a special number that was "not a number" which would - when used in a calculation generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin
recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix
and it can be used in calculations or scripts (for instance, to return a missing value unless some condition
is met). Origin displays missing values in a worksheet or matrixsheet as "--". However, you shouldn't
confuse this display (output) with what you enter as a missing value (input).

•

Decimal, Scientific and Engineering Notation: You can display workbook or matrixbook data in
Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually
choose from these data display options but you can also pre-define thresholds for automatic display of
scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).

•

Dates and Times in Origin: Origin's long-time mathematical system for dates and time is based on
Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1,
4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1)
a true Julian Date value (0 is at noon instead of the following midnight) and (2) a "2018" system in which
0 is defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance,
importing data with the Import Wizard (e.g. Custom Date Format supports "MM'/'dd'/'yyyy
HH':'mm':'ss'.'######"). Previously, precision was limited to 0.0001 seconds. For more information, see
Dates and Times in Origin.
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Note: For more information on numbers, see
Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in
Origin

Origin workbooks and matrixbooks support the following Data Types:

Workbook

Matrixbook

Bytes

Range of Values

double

double

8

±1.7E±308 (15 digits)

real

float

4

±3.4E±38 (7 digits)

short

short

2

-32,768 to 32,767

long

int

4

-2,147,483,648 to 2,147,483,647

char

char

1

-128 to 127

byte

char, unsigned

1

0 to 255

ushort

short, unsigned

2

0 to 65,535

ulong

int, unsigned

4

0 to 4,294,967,295

complex

complex

16

±1.7E±308 (15 digits), each 8 bytes

6.3 Topics for Further Reading
•

Project Explorer

•

Customizing Toolbars

•

Mini Toolbars

•

The Object Manager

•

Finding Data in your Origin Project

•

Basic Child Window Operations

•

Numbers in Origin

•

Dates and Times in Origin

•

FAQ: How do I turn off the collapsible menus and show full menus?

•

Customizing Toolbars

•

Setting Your Preferences
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•

52

The Numeric Format Tab of Preferences: Options

7

Origin File Types

7.1 Roundup of Origin File Types

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Upgrade
users may recognize that some of the old familiar file types now have a Unicode
counterpart, denoted by an appended 'u' (e.g. *.opj => *.opju). Origin versions 2018
and later will read and write the older, non-Unicode file types. As the default is to save
to the newer Unicode-type files, be sure to set the Save as type drop-down if you
need to save to an older file type.

File Type

File Extension

Used As

Origin Project
Files

*.opj(u)

A container for all data.

Child Window
Files

*.ogw(u);*.ogg(u);*.ogm(u);*.txt

The child windows for workbooks (.ogw(u)), graph
(.ogg(u)), matrix(.ogm(u)), notes (.txt).

Template Files

*.otp(u);*.otw(u);*.otm(u)

A stored customizable suite of data-handling and
format options: graphs(.otp(u)), worksheets
(.otw(u)), matrix(.otm(u)).

Import Filter
Files

*.oif

An external file which handles basic import file
parsing and data extraction.

Fitting Function
Files

*.fdf

A fitting function definition file.

Region of
Interest Files

*.roi

One or more sets of XY coordinates that define the
position of one or more regions-of-interest (ROI)
within a given matrixsheet or Image Window.

LabTalk Script
Files

*.ogs

A text file organized in sections of LabTalk script.

Origin C Files

*.c;*.cpp;*.h;.etc

A file used for developing Origin C programs.

X-Function
Files

*.oxf;*.xfc;

An Origin tool with a flexible mechanism for
performing a wide variety of data manipulation
tasks.
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*.opx

A package file created for distributing custom
applications.

Origin Menu
Files

*.xml;*omc;

A file that contains Origin menu information. An
*.xml can be edited outside of Origin for menu
customization purposes. An *.omc file contains the
configuration of customized menus.

Initialization
Files

*.ini

A file that controls the configuration of some Origin
features on startup.

Configuration
Files

*.cnf

A text file that contains LabTalk script commands.

Custom Plot
Symbols

origin.uds

A binary file that holds the bitmap images of custom
symbols.

Origin Package
Files

7.2 Topics for Further Reading
•

Opening, Closing and Backing Up the Origin Project File

•

Protecting Origin Projects

•

Origin Template Files

•

The Theme Organizer

•

System Themes

•

Import Wizard, Save Filters Page

•

Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder

•

OGS Files and Getting Started with LabTalk

•

Running LabTalk Script from OGS Files

•

Using X-Functions in LabTalk

•

Packaging Multiple Files as an OPX File
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A new generalized data import mechanism we call Data Connectors was added in Origin 2019b. As the name
implies, Data Connectors create a link between your project and an external source file. The source file may be
local, it can be on a company network; it can even be on a web-server. Data Connectors support options for
excluding imported data when saving the project (smaller files, plus, maintain a live link to source data) and
for protection of data against accidental alteration or deletion. Data Connectors also make possible import of
previously-unavailable data sources, including HTML Tables and JavaScript Object Notation (JSON). Data
Connectors support drag-and-drop and Auto Import on Project Open. In addition, OriginLab continues to
expand Connector support to new data formats. In Origin 2021b, for instance, we have improved Connectors
for National Instruments TDMS and NetCDF files; plus we've added a new Thermo Fisher Scientific
MSRawFile Connector.
Other supported import mechanisms:

•

OriginLab continues support for Origin's long-standing X-Function + filter-based routines for ASCII,
CSV, Excel, binary files, and many third-party formats, including MATLAB, pClamp, NI TDM and NetCDF. If
you are a long-time user and you have import filters and Themes that you have long relied on, they
should still work as they always have.

•

Copy-paste for quick import of simply-structured data (mostly useful for quickly adding data to
worksheets).

•

For complex ASCII, binary or User-defined file types, you can use the graphical interface of the Import
Wizard to parse your file and save settings to an import filter file. The Import Wizard supports power
features such as saving file metadata to variables and use of custom Origin C functions for data
processing and import.

•

If you work with SQL databases, you can use Origin's Database Connector and SQL Editor interface to
create connection strings and SQL queries.
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8.1 A Note to Upgrade Users
Longtime Origin users who are upgrading from older versions should note that import routines have moved
from the File menu to a new Data menu. Here, you will also find Origin's newest data-import tool: Data
Connectors.

8.2 Data Connectors
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Data Connectors are a general mechanism for importing data to your Origin projects from local or from webbased files and pages. Data Connectors differ from older Origin import methods primarily in two default (but
modifiable) behaviors:

•

Data imported via Connector is locked to editing. This helps ensure data integrity.

•

Data imported via Connector is not saved with the project. This helps to keep your project files smaller.

Data Connectors support a number of common data formats, including:

•

Text/CSV

•

Excel

•

MATLAB

•

Origin File (project, workbook, matrix)

•

HTML Table

•

JavaScript Object Notation (JSON)

•

HDF

•

TDMS

•

NetCDF

•

N42

•

Import Filter (use a custom import filter with the Data Connector mechanism)

To connect to SQL database, see Database.

To import data with a Data Connector:
1.

With your workbook active, click the Data menu.

•

If you are connecting to a local or network file, click Connect to File and pick a file type.

•

To connect to multiple files, click Connect Multiple Files.

•

If you are connecting to web data, click Connect to Web and enter a URL.

8.2.1 Things to Know about Data Connectors
•

By default, when import data file size exceeds 500kB, the imported data and graphs made from that data
are NOT saved with the Origin file (see LabTalk system variable @FSE). All analysis output resulting from
imported data ARE saved with the Origin file. Not saving raw data with your project file can significantly
reduce file size and improve performance when working with large projects.

•

IMPORTANT: Since, by default, connector-imported data (> 500kB) is not saved with the project file,
users should always ask themselves whether they need to preserve imported data. This could be an issue
when the data source is web-based and stored in a place beyond your control. If you prefer to save all
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data imported via a Data Connector, with your Origin file, click the Data Connector icon and clear the
check mark beside Exclude Imported When Saving prior to saving your file†. Note that each Data
Connector-containing book will have its own Exclude... check mark. Alternately, if you decide the Data
Connectors are not needed, you can click the Data Connector icon and choose Remove Data Connector
(from this book) or Remove Data Connectors from All Books (in the project).

•

Data can be re-imported at any time by clicking the Data Connector icon (

or

) in the upper left

corner of the worksheet and choosing Import (Ctrl+4) or Import All.

•

By default, imported via a Data Connector is locked from editing. You can graph it and analyze it but you
cannot modify it. While this ensures against accidental modification, some users may find this too
restrictive. Unlock sheet data by clicking the Connector icon and choosing Unlock Imported Data. See
this FAQ for more information on removing editing restrictions from Connector-imported data.

•

A workbook can have only one type of Connector (e.g. Text/CSV). For files with a simple structure such as
Text/CSV, you can have multiple sheets with each connecting to a separate file, as long as they share the
same Connector. For files with more complex structures such as Excel or MATALAB, you will initially
connect to one sheet/variable, then use the Data Navigator's Add and Connect Sheet(s) shortcut menu
command to add other sheets/variables in the book, as needed. You can only connect a single Excel or
MATLAB file to a single Origin workbook or matrixbook.

•

In books containing files with a simple structure (e.g. CSV), when you right-clicking on a sheet tab and
add a new sheet, the sheet is added with an empty Connector. The unconnected state is denoted by a
pale-yellow Connector icon

(see Connector states, below). Click on the Connector icon to open a

shortcut menu where you can connect the sheet to a data source.
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•

Data Connectors that you do not use can be hidden by choosing Data: Connect to File: Customize...
and clearing the checkbox next to unused Connectors.

•

Data Connectors for file formats not shipped with Origin, are available by clicking Data: Connect to File:
Add New.... New Data Connectors are added to the Data menu.

†

Origin caches data imported by Data: Connect to Web, for a period of time
determined by LabTalk system variable @CFDT, plus file size. By default, a 10MB file
will use cached data for ~24 hrs. In other words, if you re-import (i.e. reconnect to the
web file) within 24 hrs, you will be using data that was cached on first import. If you
re-import to this 10MB file after 24 hrs passes, the cache is cleared and the data are
freshly imported. To learn how to control this caching behavior see, these topics:

•

LabTalk system variable @CFDT.

•

The LabTalk delete -web command.

8.2.2 Data Source File Path
A Data Connector icon appears in one of five states:

•

When the data source is connected, the icon looks like this:

•

When data in the sheet are unlocked to editing (either by the Connector menu or @IPDC=0), the icon
looks like this:

•

When a data source import is pending, the icon looks like this:

•

When a new sheet is added to a connected book, an empty Connector is added to the sheet and the icon
looks like this:
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•

When the data source is no longer viable (e.g. the data source has been moved), the icon looks like this:

Regardless of the state of the connection, you can click the Connector icon, then use the Data Source File
Path and Common Data Path to help you maintain the connection between your Origin files and your source
data.

•

Relative to Project Path: If your data are stored in folders under the project file, you could set Data
Source File Path to Relative to Project path. You can then move the project and data sources together,
and their relative paths are preserved. No path corrections are then needed when re-opening the project
file from a different location on your network.

•

Relative to Common Data Path: If data sources are under some common path, you could set Data
Source File Path to Relative to Common Data Path. If the files are subsequently moved, you can reestablish the Common Data Path and then Import All Books.

8.2.3 Data Navigator
The Data Navigator is a collapsible panel that is automatically added to the workbook when you connect to
multi-page/multi-variable files such as Excel, MATLAB or Origin Projects.
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•

Origin will import data from the first sheet and list other sheets in dimmed type.

•

Right-click on a dimmed sheet -- or press CTRL or SHIFT and select multiple sheets -- then choose Add
and Connect Sheets.

•

The file name is assigned to the book Long Name and sheets are the original sheet name is assigned to
sheet Name.

•

Connected sheets can be deleted from the current Origin workbook.

8.2.4 Data Connectors and Drag-and-Drop
There is drag-and-drop support for the file types listed under Data: Connect to File:

•

For files with a simple header information (e.g. only column name and units), a Data Connector is added
and the file is properly parsed with no need for an import filter.

•

For files that are not properly parsed (i.e. header information ends up in the data portion of the
worksheet), consider making an Origin Import Filter (*.oif) file using the Import Wizard.

•

Import filters can be saved to the data file folder, the User Files\Filters folder or in the current window. If
you intend to use a template for your data import, you can save the filter to the window; otherwise the
filter file (*.oif) should be placed either in the data file folder or in \User Files\Filters.

8.3 Connecting to Text/CSV
You can use a Data Connector to import local or web-stored text files (TXT, DAT, CSV). Data Connector
methods work well for these file types, simplifying and in some cases eliminating, some of the problems
associated with Origin's older X-Function-based import routines. For instance, import of date-time data always
required manual configuration of date-time columns. With Connectors, if your date-time data are of a standard,
easily-recognized format, that configuration is done for you automatically.
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To connect to a file on a local or LAN drive:
1.

With the workbook active, choose Data: Connect to File: Text/CSV.

2.

Browse to and select your file.

3.

Set your CSV Import Options. In many cases, you can simply accept defaults and your file will be
cleanly imported, so as a test, try importing data without modifying defaults. If the results are
unsatisfactory, rerun the import and modify the default settings.

In this mini-tutorial, we use the Text/CSV Connector to import a text file with a datetime component. While older Origin import methods treated the date-time data as text,
requiring the user to manually set the date-time column to Date after import, the Text/CSV
Connector is able to automatically configure the worksheet column on import.

1.

Click the New Workbook button

and choose Data: Connect to File: Text/CSV.

2.

Browse to the <Origin Program>\Samples\Import and Export\ folder and open Date
with higher precision.dat.

3.

In the CSV Import Options dialog, accept default settings and click OK. Data are
imported to the workbook.

4.

Click on the column A header to select the column, then right-click and choose
Properties. Note that Format has been automatically set to Date, Display has been
set to Custom Display and a custom format shows in Custom Display.

In this mini-tutorial, we use a Data Connector to import multiple files. These identicallystructured files have multiple rows of metadata that we want to preserve. So, you will
make use of an import filter file that has been developed using the Import Wizard, to
import the files and write file metadata out to multiple column label rows in each
worksheet. In so doing, you will see (a) how to import multiple files using a Data
Connector and (b) how you can use an import filter file (*.oif) developed with an earlier
version of Origin, to import files using Origin's newer Data Connector technology.
1.
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Start a new project and with the workbook active, choose Data: Connect Multiple
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Files.
2.

In the files2dc dialog box, set the following:

o
o
o

Data Connector = Import Filter
Source = Specified Files
File Names = <Origin Program>\Samples\Import and Export\S15-12503.dat, S21-235-07.dat and S32-014-04.dat

o
3.

Same Book = enabled (checking the box will bring all files into one book)

Click OK and in the dialog that opens, set Import Filter = Data Folder:
VarsFromFileNameAndHeader.oif

4.

Click OK and the three files are imported as separate sheets in the workbook.

To connect to a file on the Web:
1.

Choose Data: Connect to Web.

2.

If you have a file URL, enter it in the URL box. Otherwise, set File Type to Text/CSV (optional but helps
to filter Recent URLs), then click directly on Recent URLs and pick from the list.

You can use the CSV Import Options dialog to specify a partial import of web-stored
files just as you can for locally-stored files. Check the Partial Import box for guidance
on the syntax used to define Column and Row import.

Note: To learn more about working with the Text/CSV Connector, see the Origin Help:
Help: Origin: Origin Help > Text/CSV Connector

8.4 Connecting to MATLAB Files
While Origin continues to support older X-Function based MAT file import, Data Connectors offer some distinct
advantages for import of both locally-stored and web-stored MATLAB files:

•

Connecting to a MATLAB file at the root level will add all variables as Origin matrix objects in the
matrixsheet.

•

A slider is added so that you can flip through Origin matrix objects in the sheet. You can toggle between
slider and thumbnails using the Slider or Thumbnails Mini Toolbar button.
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•

The Connector also adds a collapsible Data Navigator panel to the window. If you wish to add variables
as individual sheets, you can right-click on the Data Navigator list and add them.

To connect to a MATLAB file:
1.

With a workbook or matrixbook active, click Data: Connect to File: MATLAB or Data: Connect to Web
and enter a URL to your .mat file.

2.

Select the variables that you want to import (add them to the Browser's bottom panel) and click OK.

Note: To learn more about working with the JSON/MATLAB Connector, see the Origin Help:
Help: Origin: Origin Help > JSON/MATLAB
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8.5 Connecting to NetCDF and Shapefiles
The NetCDF file format is used for sharing multi-dimensional scientific data. The format is widely used in
climate science. Shapefiles are commonly used to store geographic boundaries and other geo-spatial data.

To connect to a NetCDF file:
1.

With a workbook or matrixbook active, click Data: Connect to File: NetCDF; or Data: Connect to Web
and enter a URL to your .nc file.

2.

Select the variables that you want to import by adding them to the Browser's bottom panel.

3.

Adjust Import Options ("pencil" button) as needed and and click OK twice.

4.

If a workbook is active but the variable requires a matrixbook, you will be prompted to add a new
matrixbook or an embedded matrixbook in the active workook.

Origin 2022b improves .nc file import:

•

Support for executing Time Axis Skipping first, then applying Averaging

•

Support Across Years for non-Julian numeric year (e.g. 1900).

To connect to a Shapefile:
1.

With a workbook or matrixbook active, click Data: Connect to File: Shapefile and browse to and choose
your .shp file.

2.

Specify whether to Load Attributes and (optionally) encoding, and click OK.

Origin 2022b improves export of NetCDF data. Now, you can export matrix analysis
results (e.g. Linear Fit of Matrix Stack) to .nc files that can be used in Origin or in
other software. For more information on importing and analyzing NetCDF data and on
using shapefiles, see the Origin Help File. In addition, check out these OriginLab blog
posts:
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•

An Introduction to NetCDF Matrix-Based Features in Origin 2021b

•

Adding Maps to Graphs with Built-In and Imported Shapefiles

Note: To learn more about working with the NetCDF Connector, see the Origin Help:
Help: Origin: Origin Help > NetCDF Connector

8.6 Connecting to a Cloud Drive
You can connect to Origin, MS Excel and ASCII files stored on MS OneDrive or Google Drive. Once you've
established your account credentials, connecting to cloud files is similar to connecting to local files:
With a workbook active, click Data: Connect to Cloud. This opens the browser for picking files.

1.

2.

3.

Use the browser's drop-down controls to switch cloud services or accounts, if needed.

Pick a file and click Open.

Note that the first time you connect to a cloud account, you'll be asked to verify that account. OriginLab will
only access and transfer data between your cloud account and your local computer using a temporary file. No
other communication of information occurs.

8.7 Working with Excel Data
There are several ways to work with MS Excel data in Origin:

•

66

You can copy Excel data to the Clipboard and paste or paste link that data into Origin.
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•

You can use a Data Connector to import a local Excel file by (1) clicking Data: Connect to File: Excel,
(2) clicking the

button on the Standard toolbar, or (3) dropping your Excel file onto the Origin

workspace.

•

You can use a Data Connector to import Excel data from the web by clicking Data: Connect to Web:
Excel (see below).

•

You can use Origin's older X-Function-based routines to import a local Excel file by clicking Data: Import
From File. This option was recently hidden to accommodate the Excel Connector but if you prefer to use
this method, see this section of the Origin Help file.

Things to know:

•

Origin imports files of type .xls, .xlsx or .xlsm.

•

If you are importing data using the Excel Connector, you can refresh your Origin-side data at any time by
clicking the Connector icon

and choosing Import; or re-import your Excel data at the time that you

open the Excel-connected Origin project.

•

If you are using the older (X-Function based) impMSExcel import routine: Certain file import information is
saved to the workbook on import. Having once imported an Excel file to an Origin workbook, you can use
the Re-import button on the Standard toolbar to re-import an updated Excel file -- including those that
contains multiple sheets -- to your Origin workbook.

•

Origin does not support dynamically linking one Excel workbook with another Excel workbook, nor does it
recognize or translate Excel formulas.

Note: To learn more about working with Excel data, see the Origin Help:
Help: Origin: Origin Help > Working with Microsoft Excel and Connecting to File > Excel

Both the Excel Connector and impMSExcel routines support partial import of Excel
data. For more information, see the Origin Help file topic Partial Importing and Reimporting.

8.7.1 Connecting to Excel Files

Origin 2022b auto detection of import file header info (i.e. column names, units and
other file header information) is improved for Data: Connect to File: Excel.

Origin's Data Connectors create a live link between your external data files and your Origin project.
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•

To connect to a local file, click Data: Connect to File or click the

button located on the Standard

toolbar.

•

To connect to a web-stored file, click Data: Connect to Web.

•

You can connect one Excel file per Origin workbook.

•

If the file is a multi-sheet file, you must first connect to a single sheet. This opens the the Data
Navigator panel (described above) where you can connect to additional pages, as needed.

•

When all sheets are identically structured, ensuring that the first sheet is properly parsed (e.g. the header
information is correctly handled) will allow you to connect additional sheets without making adjustments.

1.

Click the New Workbook

button to create a new workbook, then choose

Data: Connect to File: Excel.
2.

Browse to and open <Origin Program>\Samples\Import and Export\United States
Energy (1980-2013).xls.

3.

In the Excel Import Options dialog that opens, accept default settings and click
OK.

4.

In the Data Navigator panel that opens to the left side of the workbook, hold the
CTRL key and select the other three (dimmed) sheets, right-click and choose Add
and Connect Sheet(s). The remaining sheets -- Natural Gas, Coal and Total
Primary Energy -- are imported into the workbook. Note that if the unconnected
sheets are large in size, you can opt to connect to them one-at-a-time, as needed.

8.8 Import from File
The import routines listed under Data: Import From File pre-date Data Connectors. While the Import From
File routines are no longer being developed, they are still supported.
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Note, also, that Connectors may not exist for some of the file types listed in this table. If no Data Connector
exists, you should use the Data: Import From File methods.

The Standard toolbar Import Single ASCII
button now calls the Data: Connect
to Files: Text/CSV routine. For the impASC routine, see the next section.

8.8.1 Importing ASCII Files with impASC
•

The Data: Import From File: Multiple ASCII... (

) method is generally satisfactory for importing

text files having a simple structure (works for single or multi-file import). This routine will typically handle
files with commonly-used delimiters and a simple header structure, without adjustments.

•

If the file import needs adjustments, select the Show Options Dialog checkbox when selecting your
file(s) in the ASCII dialog. This will open the impASC dialog box prior to file import, allowing you to
tweak the way that the files are handled.

Note: To learn more about working with the ASCII Import using the impASC dialog, see the Origin
Help:
Help: Origin: Origin Help > Customizing the ASCII Import Options

8.8.2 Saving Import Settings
Once you've adjusted impASC dialog import settings, you can save them in one of two ways:

•

With the worksheet template.

•

As a Theme file from within the impASC dialog box (including saving for drag-and-drop).
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Saving import settings with the worksheet template offers portability (e.g. templates are easily shared with
colleagues). Saving import settings as a Theme offers the advantage of being able to recall any number of
import options combinations (Themes) when importing via the impASC dialog box.
For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide.
Additionally, see topics listed under "Topics for Further Reading", below.
You can quickly load your custom import theme from the list at the bottom of the Data
menu. You can also use the Data: Import from File: Add/Remove File Types ...
menu to open the Import Menu Customization dialog box where you can select and
add User Themes to the Data: Import From File menu.

8.8.3 Third Party Formats
If a Data Connector does not exist for a certain third-party format, you can still use Origin's older XFunction-based import routines. These include many widely-used formats, including pClamp, NI TDM, and
NetCDF. As with all X-Function-based routines, you can customize third-party file import options and save your
settings with the worksheet template or as a dialog Theme for later use. As with other supported file types,
you can import third party files by drag-and-drop.

To Learn More, see
File Type

Thermo (SPC, CGM)
pCLAMP (ABF, DAT, AB?)
Princeton Instruments (SPE)
Sound (WAV)
NetCDF (NC)
CDF (CDF)
HDF5 (H5, HE, HDF5)
NI DIAdem (DAT)
Famos (DAT, RAW)
ETAS INCA MDF (DAT, MDF)
IgorPro (PXP, IBW)
Prism (PZFX, XML)
MATLAB (Mat)
Minitab (MTW, MPJ)
KaleidaGraph (QDA)
SigmaPlot (JNB)
MZXML(mzData, mzXML,
mzML, imzML)
EarthProbe (EPA)
EDF (EDF, BDF, REC, HYP)
Somat SIE (SIE)
JCAMP-DX (DX, DX1, JDX,
JCM)
HEKA (DAT)
SPSS (SAV)
BRUKER OPUS
SAS (sas7bdat)
Tektronix (ISF)
Data Translation (DCF, HPF)
Binary 2D Array (IMG, B2D)
Image
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Note: Some of these 3rd party file formats are hidden by default. To add, choose Data: Import From
File: Add/Remove File Types.... This opens the Import Menu Customization dialog box where you
can choose which file types to show in the Import From File menu. To insert a separator after a menu
command, right-click on the command in the right-hand panel and choose Add Separator. To remove a
separator, double-click on it in the right-hand panel.

If no Data Connector exists for a given file type (i.e. those listed in the table above),
then drag-and-drop support is managed by file extension, using the Filter Manager
dialog. From the main menu, click Preferences: Import Filters Manager....

Note: To learn more about working with the Third-party Formats, see the Origin Help:
Help: Origin: Origin Help > Importing Third Party Files

8.9 The Import Wizard
For import of complex ASCII files -- those not satisfactorily handled by the methods previously discussed -you can use the interactive Import Wizard. Files with an optional header section followed by a sequential
binary structure, can also be imported using the Import Wizard:
Another advantage to using the Import Wizard to your ASCII data is that you can create import filters that are
targeted to a group of similarly-named data files. This is especially helpful when those files contain metadata
that that needs to be handled in a certain way. The filter can then be used for drag-and-drop import
operations and it can be added to the Data: Import From File menu.
A couple of improvements to Origin Import Filters (*.oif) for Origin 2022b:

•

You can add your import filter file to the Data: Import From File menu.
Subsequently, when you pick your filter from the menu, the Open dialog will only
show files that match your filter.
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•

In prior versions, the default was to apply a filter to all files with .dat, .txt or .asc
extensions. Henceforth, the default will be to name the filter as the current Wizard file
and to only apply the filter to files of the same name. As was the case in earlier
versions, the user can still modify the Applicable File name, and using wildcards,
expand the list of files to which the import filter (.oif) applies.

To run the Import Wizard:

1.

Choose Data: Import From File: Import Wizard... or click the

button located on the Standard

toolbar.

•

Develop Origin import filter files (*.oif) for import of ASCII files not handled satisfactorily by the Text/CSV
Connector.

•

Import data from the web pages using the Clipboard (see below).

•

Extract variables from the import file name and header.

•

Specify custom delimiters and date formats to parse your data.

•

The ability to post-process your imported data using a custom LabTalk script.

Note: For more information, view the help topic:
Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard

8.10 Copy/Paste the Clipboard Data
One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook.
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your
data into Origin. Here are some things you should know:

•

Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the
number of displayed decimal digits in Excel.

•

When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin
(not into the column label rows), then select a row and use the (right-click) shortcut key commands Set
as Long Name, Set as Units, Set as Comment, etc. to tag your header information.

•

Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a
method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import
Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added
benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted
data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data.
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8.11 Selectively Import Data by Querying an Origin File
You can selectively import columns of data from an external Origin file by specifying an SQL-like Query in the
Data Connector Browser prior to import.
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To selectively query Origin files using the Origin Connector:
1.

With the worksheet active, choose Data: Connect to File or Connect to Web.

2.

Browse to your Origin file and click Open. This opens the Data Connector Browser.

3.

Click the Select Query button

4.

Enter your Query in the Select Query dialog, then click OK.

.

Data will be selectively imported into the active workbook as specified by your query.
Common Keywords:

Keyword

Description

_SName

short name, e.g. _SName, Sheet_SName

_LName

long name, e.g. _LName, Book_LName

_Comments

comments, e.g. _Comments,
Sheet_Comments

Column_D1

column user-defined parameter, where 1
is the parameter index

Column_[Name]

column user-defined parameter, where
[Name] is a parameter name containing
spaces

Examples:

Select Column from Project where _SName == "A";

Select Column from Project where _Comments like "S*3";

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3);

Select Column from Project where Sheet_SName like "Trial*";

Select Column from Project where (Book_SName like "Book*" or Book_LName like
"*fit*")

For more information, see Examples of using SQL query condition in Origin Connector.
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8.12 Database
Origin supports connecting to databases by ODBC and OLE DB. Additionally, Origin includes a simple SQL
Editor to add connection strings and generate SQL queries within Origin.
To import SQL data, start with the Data: Connect to Database menu command:

•

Open lets you browse for and open a saved connection (ODS) or query (ODQ) file.

•

New opens the Database Connector dialog.

•

Connection string: Select this if you already have a text-based connection string for a
given data source (ODBC or OLE DB).

•

ODBC data source: Select this if you have defined an ODBC data source via the Windows
ODBC Data Source Administrator applet.

•

ODBC driver: Select this if you have an ODBC driver and want to create a data source
applicable to this data connector instance.

•

Windows Data Link Properties dialog: Select this if you are using an OLE DB-based data
source such as some SQL Server or Access client libraries.

Other things to note:

•

Use the LabTalk system variable @IPDB to control protection of imported range (0 = no protection, 1 =
protected but allow reorder, 2 = protected).

•

Similar to other Connectors, you can opt to Exclude Imported (data) When Saving as OPJU/OGWU.
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Note: For more information, see the Origin Help
Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database

8.13 Digitizer
At times, you may only have a graphic representation of some data that you would like to explore further. Use
the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you
can study and re-plot using Origin's analysis and graphing tools.
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•

Import most common image formats.

•

Rotate the imported image, remove noise and calibrate scales by picking start and end values.

•

Pick points on curves manually or automatically.

•

Manually add curve inflection points, as needed.

•

Interactively remove points that you do not want digitized.

•

Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:

1.

Click the Digitize Image

button on the Standard toolbar or choose Tools: Digitizer... from the

main menu.

8.14 Saving Origin Files without Imported Data
Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As
Analysis Template and Save Project without Data, were three options for saving Origin files without data
while preserving settings and operations with the file.
Users now have the option to save Origin files without imported data. This is a particularly attractive option for
those who work with large data files, where saving of that data with the file would hinder performance or
waste disk space.

•

By default, data imported using a Data Connector, will not be saved with the book when the import file
size exceeds 500kB. Each book has its own Exclude Imported When Saving check mark and clearing
the check mark on any page in the book will cause all imported data to be saved with the book.

•

Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported
data by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported
data when saving project box at the bottom of the dialog.
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The act of excluding data when saving differs from saving a template file in a couple of important
ways:

•

When you exclude imported data, you are still saving all output resulting from analysis operations on
imported data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don't save
imported data or graphs of that imported data.

•

Books which you have saved without imported data retain a "live" link to the original data source. For
Data Connector-containing books, click the Data Connector icon and click Import (active sheet) or
Import All (all sheets in book). For books used for standard file import, activate the empty book and click
Data: Re-import Directly; or click the Re-Import no dialog button on the Import toolbar (see next).

8.15 Re-Importing Data Files
There are two import commands in the Data menu that are specifically intended for repeat import of the
same file (i.e. the file path and name must be the same):

•

Re-Import Directly. When you import a file into an Origin worksheet or matrixsheet, by default a
number of parameters, including file path and name, are saved in the sheet. If you have an external data
file that is periodically updated or you want to reload a standard file into the worksheet, you can re-import
directly without opening an import dialog.

•

Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file
type so that you can adjust your import options before re-importing.

Notes:

•

Only one file can be re-imported at a time. When you use either of these two menu commands,
only the file associated with the active worksheet or matrixsheet, will be imported. If the selected
data are imported from multiple files, re-importing will fail.

•

If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the impASC
dialog will open instead of the Import Wizard.

•

Re-import does not work for Binary or User Defined data types brought in using the Import
Wizard.
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8.16 Clone Import
Clone import works by "modeling" an import -- and optionally, an associated analysis operation -- and then
applying what was done to the initial file, to a series of similar files. As long as the active book contains
imported data and associated operations, it can be cloned. In this sense, cloning is similar to creation of an
Analysis Template but is somewhat more limited in power (e.g cannot be used with the Batch Process tool).
Clone import is supported by both Data Connector and X-Function-based import methods. A brief tutorial
will show you the basics of cloning import and analysis operations.

1.

Click the New Workbook

2.

Using Window's File Explorer, browse to your <Origin Program>\Samples\Curve

button to open a new workbook.

Fitting folder and find a file called Sensor01.dat. Drag-and-drop the file onto the new
workbook. The .dat file is imported using the Text/CSV Connector.
Click the column B header to select the column, then click the Scatter

3.

button to

create a scatter plot.
Click on the X or Y graph axis scale and in the Axis dialog box that opens, click the

4.

Scale tab, then press Ctrl and select both Horizontal and Vertical axis icons in the
left panel. Set Rescale to Auto and click OK.
With the graph active, click Analysis: Fitting: Linear Fit and open the dialog box.

5.

Set Recalculate = Auto, accept other default settings and click OK. Answer No to the
Reminder Message and click OK.

6.

Right-click on one of your workbook tabs and click Add Graph as Sheet. This will
add your scatter plot with the linear fit results, as a page in your workbook.

7.

Make sure the sheet with data imported from Sensor01.dat is active and click the
Clone Import

8.

button on the Import toolbar.

Browse, once again, to your <Origin Program>\Samples\Curve Fitting folder,
press Ctrl or Shift and select files Sensor02.dat - Sensor07.dat. Click Add Files
and then click OK. What you should see is that using the original book as a model
for import and analysis operations, the Sensor files are imported using the
Text/CSV Connector and, one-by-one, they are processed (it may take a few
seconds for all operations to go to completion).
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8.17 Topics for Further Reading
•

Data Connectors

•

Importing Simple ASCII Data Files

•

Customizing the ASCII Import Options

•

Updating Excel Data in Origin.

•

Video: Use Clone Import to Batch Process More Data Files

•

Tutorial: Importing Multiple Files into Workbooks Cloned from Active Workbook

•

Importing Third Party Files

•

Importing Data by Drag-and-Drop

•

Tutorial: Updating Graphs by Re-importing Data from a Database

•

Tutorial: Connect to Web Data by Copy Link Address

•

Importing Data from a Database

•

Drawing or Deleting Data Points

•

Tutorial: The Digitizer
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Workbooks Worksheets Columns

9.1 Workbook, Worksheet and Column Basics
The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing,
organizing, analyzing, transforming, plotting and presenting your data.

•

Each workbook is a collection of one or more worksheets (up to 1024).

•

Each worksheet contains a collection of columns (up to 65,500) and each column contains rows of cells
(up to 90,000,000).

•

Each column has a Short Name (e.g. "A") that uniquely identifies it within the worksheet and a Column
Designation (e.g. "(X)" which determines how it is handled, by default, in plotting and analysis
operations.

•

Each worksheet, and each worksheet column, has data-containing cells identified by row (index) number;
and a preceding metadata containing area ("header") comprised of optional label rows, including Long
Name, Units, Comments, etc.
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For Origin 2022b, two convenient buttons are added to the workbook window: Add
Sheet and Show/Hide Organizer.

9.1.1 Some Workbook, Worksheet and Column Limits

Object
Worksheets in a workbook
Rows in a worksheet, 1 column
Rows in a worksheet, 5 columns
Rows in a worksheet, 32 columns
Columns in a worksheet, 1 row
Columns in a worksheet, 100 rows
Columns in a worksheet, 1000 rows

Maximum Number
1024†
90,000,000
90,000,000
90,000,000
65,500
65,500
65,500

† > 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not
compatible with Origin versions prior to Origin 2018.
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9.1.2 Naming Workbooks, Worksheets and Columns

•

A Workbook has a Short Name and an optional Long Name and Comments.
Origin uses the Short Name for internal operations.

•

Short Name must be unique within the project file, can contain only alphanumeric characters (letters and numbers), must begin with a letter and are
limited to 13 characters.

•

A Workbook Long Name is optional, need not be unique within the project
file, can use any characters in any order and has a limit of 5,506 characters

Workbooks

(including spaces).

•

To name a workbook, right-click on the window title bar and choose
Properties. Here you can edit Long name, Short name and Comments. Use
the Window Title drop-down to control which name(s) show on the window
title bar.
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•

A Worksheet has a Name and optional Label and Comments.

•

The Name must be unique within a workbook.

•

A Worksheet Name has a 64 character limit, including spaces. These special
characters are not allowed: {}|"<>()![].

•
Worksheets

Worksheet Label and Comment are optional. They need not be unique within
the project file, can use any characters in any order, and can be of any
practical length.

•

To name a worksheet, double-click on the sheet tab, or right-click on the tab
and choose Name and Comments. More details are listed under
Worksheets, below.

•

A Column has a Short Name and an optional Long Name.

•

The Short Name must be unique within the worksheet. When spreadsheet
cell notation is enabled (default setting), you cannot edit the column Short
Name (see Column Short Name Restriction). When cell notation is disabled,
you can edit the column Short Name. When editing Short Names note that
they must use only alphanumeric characters (no special characters), must
begin with a letter or number, and cannot exceed 18 characters.

•

A Column Long Name is optional, need not be unique within the project file,
can use any characters in any order and has a limit of 30,000 characters. The

Columns

Long Name can be edited directly by clicking in the Long Name cell or by
right-clicking on the column header and choosing Properties from the
shortcut menu.

•

Dialog box and Status Bar references to data range will use Long Names,
provided that (1) Long Name exists and (2) you have selected Use Long
Names when available (Preferences: Options: Miscellaneous).
Otherwise, Short Names are used.

9.1.3 Workbooks
Origin workbooks are highly customizable and can be saved with data (e.g. Workbook File) or without data
(e.g. Workbook Template). Since they can be configured for many different applications, there is a good
chance that you will collect a number of custom files over time. The New Book dialog is useful for organizing
and choosing these files for use.

Origin 2022b supports Edit: Undo Delete Workbook (CTRL+Z). Set system variable
@WU to disable Undo.
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9.1.3.1 New Book and Book Templates

To open the New Book dialog:
1.

Click File: New: Workbook: Browse or press Ctrl + N.

For Origin 2022, an Open Template Center button
was added to the New Book
dialog. Click the button to browse for additional workbook templates that you can
download and add to your template list.

•

The dialog lists both add-on (Extended) and User-defined (User) files.

•

Files can be sorted by Name, Book Type, Category or Location.

•

A file preview shows when you hover on the

•

icon.

Right-click on a template name and Edit metadata or Set as Default (e.g. New Workbook

button).

Also, right-click to Clear Default.

•

Enable Show in Menu to list a window in the New: Workbook or New: Matrix menus.

•

Filter windows by category using the "All Categories" menu.

•

Filter windows by type using the Book Type drop-down menu. Reset to show all.

•

Right-click on a template to Set as Default or Edit metadata.
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•

Enable/disable Show on startup and new project.

Each window's Properties dialog has a Comments box for entering text. These
comments are included in the New Book dialog previews and the Project Explorer
previews. In addition, comments are searchable from the Edit: Find in Project tool.

9.1.3.2 Spreadsheet Cell Notation (SCN)
Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of
cell-level calculations that are familiar to users of spreadsheets (more details below).

•

By default, SCN is ON for all new workbooks.

•

In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon

in the upper-left

corner of the worksheet.

•

Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by
default) to make room on the workbook window for the Data Connector icon.

•

Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short
Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose
Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page.

•

When SCN is turned off, users of all versions will see this icon

in the upper-left corner of the

workbook.

•

If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the
SCN OFF button

will display in the upper-left corner. This includes projects or workbooks that were

created prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and
check the Spreadsheet Cell Notation check box.
9.1.3.3 What Types of Data Can I Store in the Workbook?
The workbook serves as a flexible container for all of your work-related data -- not just text and numeric data.
You can add graphs, matrices, images, notes; and store calculations, scripts and variables, text objects and
programmable buttons, and create live links to other project data. Beyond its role as a flexible data container,
the workbook can also serve as a medium for batch analysis and reporting.
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This table summarizes the kinds of objects that can be saved in the workbook window at the workbook,
worksheet and worksheet cell levels, and how to access them.

Element

Workbook

Worksheet

Worksheet Cell

Graphs

Right-click on the sheet
tab > Add Graph as
Sheet

Right-click in the gray
area beyond the last
column > Add Graph

Right-click on the cell >
Insert Graph

Matrices

Right-click on the sheet
tab > Add Matrix as
Sheet

--

--

Images

--

--

Right-click on the cell >
Insert Images from
Files

Notes

Right-click on workbook
title bar > Properties >
Comments

Click the workbook's
Show/Hide Organizer
button > Data Sheets >
enter notes in box

Click on the cell and
Insert Note with the
Mini Toolbar (see
below).
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Element

Workbook

Worksheet

Worksheet Cell

Added text objects
linked to data/variables

Right-click on the
worksheet cell and
Insert Variables; or
select a cell and Define
Name using Mini
Toolbar.

Select a column, rightclick and Set Column
Values. Alternately,
enter formula in F(x)=
cell.

Click on a cell and use
the Formula Bar or
direct cell entry, to
create cell formula.

Click the workbook's
Show/Hide Organizer
button > page.info,
Imported Files, User
Tree, etc.

•

The Insert
Variable Dialog

Variables

Box (Used with
Worksheets)

•

The Insert
Variable Dialog
Box (Used with
Text Labels)

Functions and
Formulas

Right-click in the gray
area to the right of last
column > Show Script
Panel

•

Right-click the
selected
column > Set
Column

Scripts

Values

Right-click in the gray
area to the right of last
column > Show Script
Panel

•

Added

--

text/drawing
objects and
associated
scripts

File Metadata

Links
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Click the Show/Hide
Organizer button on the
workbook toolbar

--

--

--

--

Enter cell-level links to
URLs, other worksheet
ranges/cells, project
graphs, matrices and
image files.
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Element

Workbook

Worksheet

Text and Drawing
Objects

--

Add Programmable
Buttons and Text
Labels and Drawing
Objects to the
worksheet.

Arrows

--

--

Worksheet Cell

--

Right-click and Insert
Arrow

9.1.4 Worksheets
Prior to Origin 2018, an Origin workbook could contain a maximum of 255 worksheets. That number is now
increased to 1024. When you have more than 255 sheets in a book, you will need to save your file to one of
the Unicode-compliant formats (opju, oggu, otwu).
To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:

•

Insert. Inserts a single worksheet ahead of the active sheet.

•

Add. Appends a single worksheet.

•

Duplicate Without Data. Duplicates the active worksheet without duplicating the data.

•

Duplicate. Duplicates the active sheet, including the data.

Each sheet in a workbook can have its own set of customizations. When you Insert or
Add a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the
version of ORIGIN.otwu that is saved to your User Files Folder (found in UFF if you
have customized this file). To add a sheet that is based on another sheet in the
workbook (including number of columns and special formatting), you would use the
Duplicate or Duplicate Without Data shortcut command.
A sheet has a single Name which can contain spaces and special characters. Optionally, you can add a Label
and/or a Comment.
To edit the sheet Name
1.

Double-click on the sheet tab and enter a Name. Alternately, right-click on the sheet tab, choose Name
and Comments and edit the Name field.

System variable @SSL can be used to modify sheet naming behavior. Look for @SSL in the LabTalk System
Variable List.

When mousing over the worksheet tab, Name, Label and Comments appear as a
tooltip.
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9.1.4.1 Worksheet Properties
To open the Worksheet Properties dialog
1.

Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and
choose Properties.

You can use the Worksheet Properties dialog box to customize properties of the sheet, including...

•

Display of row labels, header labels and grid lines (View tab).

•

The number or rows and columns and other sheet dimensions such as column or row header height (Size
tab).

•

Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab).

•

Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab).

•

Printing/exporting of grid lines, headers and footers, background color (Print/Export tab).

•

Script to run after import or upon data change (Script tab).

•

Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User
Tree tab).

Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell
and choosing Format Cells.
For more information, see The Worksheet Properties dialog box.
9.1.4.2 Manipulating Sheets with Object Manager
Use the Object Manager's shortcut menu commands to manipulate display of workbook content:

•

List all sheets in the active workbook.

•

Click a sheet in Object Manager to activate the corresponding sheet in the workbook.

•

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,
Move, Copy, and Rename.
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9.1.5 Worksheet Columns
•

To add a new column to the right end of an existing worksheet, right-click in the gray area to the right
of the worksheet columns and choose Add New Column or Click the Add New Column

button on

the Standard toolbar.

•

To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New
Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog
box and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the
Worksheet Properties dialog, then set the desired value for Column Number in the Size tab.

•

To insert a column into the worksheet, highlight a column, then right-click and choose Insert. A column
is inserted ahead of the selected column and column Short Names are adjusted accordingly.

Worksheet columns can be renamed by:

•

Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name
and/or Long Name.

•

Type a Long Name directly into the worksheet header cell by double-clicking in the cell.

•

Import a data file and specify that the workbooks, worksheets, and columns be named upon import.

•

Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column
names and labels.

•

Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottomright corner of the selection to auto fill and enumerate the names for other columns. This also works for
other column label rows such as Comments. See the above table for rules on worksheet column naming.
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9.1.5.1 Column Designations
As mentioned, worksheet Column Designations (aka "Plot Designations") generally determine how data are
handled during analysis and plotting operations. For instance, you might select an X column + three Y columns
to perform a simultaneous linear fitting of each Y dataset against a common set of X values. Or you might
select the same columns to graph 3 line plots against a common set of X values. In addition, there are
designations for Z values, for error data, for labels, etc. (for more information, see Column Designation in the
Origin Help file).

While there are a number of places in the user-interface where you can designate columns during some
analysis or plotting operation, at a basic level, they are set in the worksheet by (1) clicking on the column
header to select a column, then (2) doing one of the following:

•

Choose an option from the column-level Mini Toolbar.

•

Click a button on the Column toolbar.

•

Right-click on the column and choose Set As and choose an option from the shortcut menu.

•

Right-click on the column, choose Properties and set Plot Designation.

9.1.5.2 The Column Properties Dialog Box
The Column Properties dialog box is used to customize properties of the column including...

•

Long Name, Short Name, Units, Comments, etc.

•

Format (Numeric, Text, Time, Date, etc.).

•

Plot Designation.

To open the '''Column Properties''' dialog box:
1.

Double-click on the column header.

2.

Right-click the selected column(s) and choose Properties....

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units
and Comments -- can be edited here or entered directly into the column label row cells.
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9.1.5.3 Formatting Column Data
Data in the Origin worksheet is treated as either text or numeric data. While the display of text data in the
worksheet is fairly straightforward, the display of numeric data is more complicated.
Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double
precision (Double(8)) numbers. This includes date and time, data which is formatted to display in degreesminutes-seconds or numbers that are formatted to display a fixed number of decimal digits.
When dealing with numeric data, understand that what you see in the worksheet is a representation of a
number that is stored internally. This is important for two reasons:

•

Calculations involving worksheet values are always done on the double-precision number that is stored
internally, not the value that is displayed in the worksheet.

•

You can apply various Format and Display options to change the way that this stored number displays in
the worksheet.

While the central place for formatting worksheet data is the Properties dialog, as
described above, keep in mind that there are quick-access Mini Toolbar buttons for
changing the Display of numeric and date-time data. Note that the Format of selected
columns must first be set as Date or Numeric/Text & Numeric for these buttons to be
visible.

9.1.5.3.1

Numeric Display Formats

1.

Double-click on a column heading to open the Column Properties dialog.

2.

Click the Properties tab, then set Format = Numeric.

3.

Set Display to Decimal: 1000, Scientific: 1E3, Engineering: 1K, Decimal: 1,000 or Custom (see
below).

9.1.5.3.2

Date and Time Formats

By default, Origin stores date-time data as a modified Julian Day value and it uses this number for date-time
calculations. Typically, however, you will prefer to display this Julian Day value in a more meaningful date-time
format:
1.

Double-click on a column heading to open the Column Properties dialog.
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2.

Click the Properties tab, then set Format = Time, Date, Month or Day of Week.

3.

Set the Display list to one of the listed options.

4.

If none of the listed options are appropriate you can choose Custom Display and construct your own
custom date-time string using these date-time format specifiers.

When importing date-time data into the worksheet, Origin will sometimes treat this data
as text (Origin's CSV Connector generally does a better job of recognizing date-time
data). If your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text.
You will need to open the Column Properties dialog box and choose your Format and
Display options. When you see that your date-time data are right-aligned in the cell, you
know that Origin "sees" the data as numeric data, displaying in a date-time format.

9.1.5.3.3

Color Format

Origin 2021 introduced a new column and cell Format -- Color.

•

Supports direct entry of HTML color codes into the worksheet cell to set cell background color, with the
option to display or hide the HTML codes in the Color cell.

•

Use the color() function to calculate hex values and set colors from RGB values in other data columns
using Set Column Values or cell formula (e.g. color(A,B,C) sets color using RGB values in columns A, B
and C).

94

Workbooks Worksheets Columns

•

Select a column in which Format = Color and use a Mini Toolbar button to Save as Increment List
(color list) for use in your graphs.

•

Alternately, from the Custom colors menu in the Color Chooser, choose Create Color List from
Column and pick a Color worksheet column from the flyout.

9.1.5.3.4

Other Custom Display Formats

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows
various formats applied to the same set of numeric values (column A(X)).

The following is a sample listing of some supported custom format options (this just happens to be the prepopulated list that ships with Origin 2019). Note that you can enter custom formats directly into the Custom
Display list and they will be saved to this list.
There are many other format options. For more information, see Custom Numeric Formats.

Format

*n

Description

Display n significant digits.

Example
if cell value = 123.456
*3 displays 123
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Format

.n
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Description

Example
if cell value = 123.456

Display n decimal places.

.4 displays 123.4560

S.n

Display n decimal places, in scientific notation of the
form 1E3.

S.4 displays
1.23456E+02

E.n

Display n decimal places, in engineering format.

E.2 displays 123.46

* "pi"

Display a number as a decimal, followed by the
symbol π.

* "pi" displays
39.29727π

#/4 "pi"

Display a number as a fraction of π, with a
denominator of "4".

#/4 "pi" displays 157π/4

#/# "pi"

Display a number as a fraction of π.

#/# "pi" displays 275π/7

##+##

Display a number as two digits, a "+" separator, then
two digits (e.g. surveying stations).

##+## displays 01+23

#+##M

Display a number as one digit, a "+" separator, then
two digits, plus a suffix of "M".

#+##M displays 1+23M

#n

Display a number as an integer of n digits, pad with
leading zeros as needed.

#5 displays 00123

#%

Display a number as a percentage.

#% displays 12346%

# ##/##

Display a number as proper fraction.

# ##/## displays 123
26/57

# #/n

Display a number as proper fraction, in nths.

# #/8 displays 123 4/8

DMS

Display a number in Degree° Minute' Second", where
1 degree = 60 minutes, and 1 minute = 60 seconds.

DMS displays
123°27'22"
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Format

Description

Example
if cell value = 123.456

Display a number in Degrees and Decimal Minutes.
Parameter n specifies decimal places. Positive values
will have "E" or "N" appended, Negative values will
have "W" or "S" appended. If you wish to preserve
negative values do not append "EW" or "NS".

D MD3 EW displays
123° 27.360 E

Display a number in Degrees and Decimal Minutes.
Parameter n specifies decimal places. Letter "B"
("before") specifies that positive values should have
"E" or "N" prefixed, negative values will have "W" or
"S" prefixed. If you wish to preserve negative values
do not append "EWB" or "NSB".

D MD3 EWB displays E
123° 27.360

Display a number as a 32-bit hexadecimal (max 8
hexdigits). The "#" symbol specifies "Ox" prefix.

%#x displays 0x7b

%#0nx

Display a number as a 32-bit hexadecimal (max 8
hexdigits) notation, as an n-character string, pad with
leading 0 as needed.

%#06x returns 0x007b

%#0nI64X

Display a number as a 64-bit hexadecimal notation
(max 13 hexdigits, 15 total including #="0x"), as an ncharacter string, pad with leading 0 as needed.

%#014I64X returns
0X00000000007B

D MDn EW
(longitude)
D MDn NS
(latitude)

D MDn EWB
(longitude)
D MDn NSB
(latitude)

%#x

9.1.6 Column Label Rows

Origin 2022b adds cell Notes support to column label rows, including the F(x)= column
formula row. Select a cell and on the Mini Toolbar, click the Insert Note button.

Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be
brought in as header information in imported files, or it may be manually entered. Display of column label rows
is optional and the user can selectively show them or hide them, as needed.
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Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph
legend text or Axis titles). The F(x)= row is used in performing math operations on columns of data (see
below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in
plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below).

You can copy a selected subrange of worksheet cells and include associated column
label row information with the copy-paste operation. To copy label rows with data cells,
right click on your subrange selection and choose Copy (including label rows).

9.1.6.1 Managing Display of Column Label Rows
Display (showing or hiding) of column label rows is controlled by shortcut menu commands:
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1.

Right-click here and choose View from the shortcut menu.

2.

Right-click here and choose Edit Column Label Rows or other label row command.

3.

Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in
this area, then right-click to Set Comments Style.

There is also a worksheet column label row Mini Toolbar for managing label rows. Use it to do such things as
hide selected label rows, enable Rich Text or change label row order.

9.1.6.2 Column List View
Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed
view of the column label row metadata. This view is potentially useful if your worksheets have many rows of
metadata and you want to focus on some particular aspect of that metadata. With the worksheet active,
choose View: Column List View or press Ctrl + W.

Further, you can apply a data filter to metadata in Column List View. When you return to the standard
worksheet view (clear the mark beside View: Column List View), only data associated with the filtered
metadata will show in the worksheet.
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Column List View displays column index number ahead of column short name (+ column
designation). In addition, you can hover on the left edge of column long name and a
tooltip reports dataset size. To disable the display of column index, set @DSI=1.

9.1.6.3 Sparklines
Numeric data stored in a column will graphically display in the column header in a special label row called
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent
variable (Y) against the row number or the associated X column as independent variable (X). When importing
data, Origin displays sparklines by default when the number of columns is less than 50.

To Show or Hide Sparklines:

•

Show Sparklines by clicking Column: Add or Update Sparklines. This opens the sparklines dialog.

•

Show Sparklines for selected columns by clicking the Add Sparklines button

•

Right-click on the worksheet's Sparklines column label row and choose Add or Update Sparklines.

•

Delete sparklines by right-clicking the Sparklines column label row and pressing the Delete key.
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•

In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or
more columns by clicking on the column header, then choose Column: Add or Update Sparklines. In
the dialog box that opens, set the Plot Type to Histogram or Box.

•

Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window.
Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot.
When you close the pop-up window, your customizations are applied to sparkline.

9.1.7 The Workbook Organizer
As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows.
Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file
path and name, date and time of data import, file header information not written to the column label rows,
variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer panel.
To show (or hide) a workbook's Organizer panel:

•

Click the Show/Hide Organizer button on the workbook button bar.

•

Right-click on the workbook title bar and select Show Organizer.
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Starting with Origin 2022b, you can add separate plain-text Notes to each sheet by
highlighting a sheet under Data Sheets in the Organizer panel.

9.1.8 Managing Workbooks with Mini Toolbars
A number of common book-, sheet-, column and cell-level properties can be set or toggled ON/OFF with a
Mini Toolbar button.
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•

To see which tools are available, make a worksheet selection and then hover on your selection.

•

Page-level formatting options are shown by hovering in the upper-left corner of the sheet or near the
window margins in the gray area to the right of the worksheet columns.

•

Go here for a full list of worksheet Mini Toolbars.

Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
sessions (i.e. if turned off in the current session, they would be restored on Origin
restart). Now, this setting is remembered across sessions (alternately, you can control
Mini Toolbar display by setting system variable @DMT (ON=0; OFF=1)).

9.1.9 Find and Replace in Worksheets

•

Clicking Find opens a small dialog for searching the current worksheet selection.

•

Small dialog supports string or numeric, forward and backwards search.

•

While the dialog is minimized, you can edit within the selection or press CTRL + Page Up/Page Down to
search backwards or forwards; or change the worksheet selection and restore the dialog to perform a new
search.

•

Click the ellipsis button (...) to open Origin's larger Find and Replace dialog.
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Origin has another "Replace" tool that can be scripted: wreplace. To open a UI dialog,
open the Script Window (Window: Script Window) and type wreplace -d. To learn
about scripting options, see X-Function documentation for wreplace.

9.2 Simple Utilities for Filling Columns with Data
Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a
menu command to fill a worksheet column with either row index numbers, uniform random numbers or
normal random numbers. This is useful for generating quick datasets to test and try out other Origin
features.
These simple procedures create a dataset in a pre-selected worksheet range or column(s):
Action

Toolbar Button

Menu Command

•

Column:Fill Column With:Row
Numbers

Fill a range or column with row
numbers

or

•

Right-click and select Fill
Range/Column(s) With Row
Numbers
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Action

Toolbar Button

Menu Command

•

Column:Fill Column
With:Uniform Random
Numbers

Fill a column with uniformly
distributed random numbers between
0 and 1

or

•

Right-click and select Fill
Range/Column(s) With
Uniform Random Numbers

•

Column:Fill Column
With:Normal Random Numbers

or

Fill a column with normally distributed
random numbers

•

Right-click and select Fill
Range/Column(s) With Normal
Random Numbers

•
Fill a column with a patterned or
random set of numbers

Range/Column(s) With A set

--

of Numbers...

•
Fill a column with a patterned or
random set of Date/Time Values

Right-click and select Fill
Range/Column(s) With A set

--

of Date/Time Values...

•
Fill a column with arbitrary set of
Text&Numeric values

Right-click and select Fill

Right-click and select Fill
Range/Column(s) With

--

Arbitrary set of Text&Numeric
values...

The auto fill feature can be used in filling column label rows and the worksheet data cells:
To use auto fill to extend a pattern in the data across a range of cells (numeric data only):
1.

Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.

2.

When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.
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To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):
1.

Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.

2.

When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the
right.

Datasets can also be generated quickly using LabTalk script. As an example:
1.

With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the
following lines of script code into that window:

col(1)={0:0.01:4*pi};

col(2)=sin(col(1));

2.

Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be
filled with data.

9.3 Setting Column Values

Access to Origin's built-in functions has been improved in recent versions:

•

The Set Values dialog and the F(x)= cell get Auto Complete support. Begin
typing to see a list of possible functions.

•

The Search Functions dialog that is opened from the Function menu in the Set
Values dialog can now be opened directly from the Tools menu (Tools: Search
Functions).

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a
one-line mathematical expressions, a Before Formula Scripts panel (usage optional) intended for data preprocessing and defining of variables used in your one-line expression and for Python users, a Python
Function tab for defining and using Python functions which can also be used in your expressions.

106

Workbooks Worksheets Columns

Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified
spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column
Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is
now simply "A1").
In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used
in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can
it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode,
so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have.
For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see
Column Formula Examples.
To open the Set Values dialog box for a single column:
1.

Select a worksheet column or a range of cells in a worksheet column.

2.

From the menu, choose Column: Set Column Values... or right-click on the worksheet column and
choose Set Column Values... from the shortcut menu.

To open the Set Values dialog box for multiple columns:
1.

Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.

2.

From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column
and choose Set Multiple Column Values... from the shortcut menu.
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9.3.1 Set Values Menu Commands
Because Long Names need not be unique within the worksheet, Origin 2022b now
displays both Long Name and Short Name in the formula box.
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•

Formula: Load a saved formula into the column formula box. Formulas are
saved using Formula: Save or Formula: Save As....

•

wcol(1): Use the menu to include worksheet columns in either your column
formula or your Before Formula Scripts (column reference is inserted at the
cursor). A Column Browser is available to help in selecting the correct
columns. Columns are listed by column index.

•

Col(A): Similar to wcol(1) menu functionality but columns are listed by
column name (including Long Name, if it exists).

•

Menu
Commands

Function: Add LabTalk functions to your expressions (function name is
inserted at the cursor). Note that when you hover over a function in the menu
list, the function description will be shown in the Status Bar. When a function
is selected, its description will be displayed in a pop-up Smart Hint.

•

Variables: Add a variable or a constant to Column Formula or Before
Formula Scripts; Add range variables (including by selection) or file
metadata, to Before Formula Scripts.

•

Options: Allow direct editing of column formula in worksheet Formula row;
add a comment about the column formula; or preserve text in Set Values
columns (do not treat as text as missing values).

•

Add a single line expression for generating data. Functions, conditional
operators and variables can be used.

Column Formula

•
Before Formula
Scripts

LabTalk scripts to be executed before the expression in the column formula
box is executed.

Python Function

•

Define and use Python functions in your expression.

When you mouse over one of the functions listed in the Function menu in Set Values
dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a
Smart Hint appears with a more detailed explanation and a link to the full function
description, syntax, examples, etc.
Additionally, you can click the Search and Insert Functions
button to search for
available functions by keyword and, once found, insert the function into your
expression.

To learn more, see Set Column Values - Quick Start

9.3.2 The "F(x)=" Worksheet Column Label Row
For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is
directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation
that works in the formula box in Set Values also works in F(x)=:
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1.

Double-click in a cell in the F(x)= column label row.

2.

Enter an expression to enter output in the data column below.

Note that there is "Auto Complete" support for Functions and Named Ranges in the
Formula Bar, cell formulas (begin typing with "="), the F(x)= cell and the Set Values
dialog. Hints are linked to function documentation (Functions) or data ranges (Named
Ranges).

If you prefer not to use Auto Complete, you can disable it by setting system variable
@FAC=0.

9.3.3 Set Column Values Tutorials
Tutorial 1: A Quick Units Conversion using F(x)=
1.

Start with a new workbook and import the file \Samples\Graphing\WIND.DAT.

2.

We will assume that column B contains Speed values in miles per hour (MPH). Click
on the column heading for column C, then right-click and choose Insert. Origin
inserts a new column C and moves Power values to column D.

3.
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Double-click in the F(x)= cell of column C and enter

B*1.6

and press Enter. Column C is filled with values in units of KPH.

Tutorial 2 : Computing Moving Average and Moving Standard Deviation
1.

Import the file Samples\Signal Processing\fftfilter1.DAT.

2.

Add two more columns to the worksheet by clicking the

3.

Click on the header of the 3rd column to select it, then right-click and select Set

twice.

Column Values... from the context menu.
4.

In the Set Values dialog, enter the following in the upper panel:

movavg(B,5,5)

and press Apply. Column 3 is filled with an 11-point moving average of the data
from column B (note that you can insert functions such as movavg from the
Function menu of the Set Values dialog box).
5.

Click the >> button above the edit box to switch to the 4th column.

6.

In the edit box for the 4th column, enter the formula:

movrms(B,5,5)

and press OK. This 4th column will be filled with root-mean-square (RMS) values,
using a window size of 11 at each point.

Tutorial 3: Set Values for Multiple Columns

1.

Create a new project by clicking the New Project

button on the Standard
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toolbar.
2.

Click the Import Multiple ASCII

button to import the files F1.dat and F2.dat

in the <Origin Folder>\Samples\Import and Export\ path. In the impASC dialog,
set Multi_File (except 1st) Import Mode to Start New Books and click OK.
3.

Two workbooks are created, named as F1 and F2. Click the New Workbook
button on the Standard toolbar to create another workbook.

4.

With the 3rd workbook active, click the Add New Columns

button to add a

column. Highlight all columns and select Column: Set Multiple Columns Values
from the main menu or right-click the columns and select Set Multiple Columns
Values from the shortcut menu to open the Set Values dialog box.
5.

Expand the bottom panel by clicking the Show Scripts

button. Enter this

script in the Before Formula Scripts edit box,

range r1=[F1]F1!wcol(j); //"j" is the column index.

range r2=[F2]F2!wcol(j);
6.

Enter (r1+r2)/2 in the Column Formula edit box

7.

Select Options: Direct Edit Formula Cell to clear this option.

8.

Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text
dialog, then click OK.

9.

Click the OK button in the Set Values dialog box. You will see the results in the
worksheet, and (F1+F2)/2 will display in the F(x)= column label row instead of the
formula.

9.4 Setting Cell Values
Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions
which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into
cells in a User-Defined Parameter row of the column label row area. When Edit Mode (Edit: Edit Mode) is
toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content
can be edited regardless of Edit Mode state.
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•

To use cell formulas, Spreadsheet Cell Notation must be enabled (it is by default).

•

Cell formulas begin with an equal sign (e.g. =B1 - C1).

•

Cell formulas can return a numeric, a string or a date-time value.

•

Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and
constants.

•

Cell formulas can reference values in other sheets or books.

•

Cell formulas can be extended to other cells by dragging with your mouse.

To learn more, see Using a Formula to Set Cell Values.

9.4.1 The Formula Bar
When creating cell formulas, or column formulas using F(x)=, the Formula Bar makes it easier to find and
insert functions, select cell ranges and view and edit expressions, particularly long expressions that exceed cell
width.

To enter an expression into a cell (data cell or F(x)=), click on the cell, then:

1.

Enter an "=" and type your expression; or click the

button to open the Search and Insert

Functions dialog.
2.

Search for the desired function then double-click on it to insert it into your Formula Bar expression.
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3.

Interactively select your data range going to the worksheet and (a) clicking on a column heading or (b)
dragging to select a range of cells.

4.

When your expression is complete, click the

button or press Enter.

Note that you can drag the edge of the Formula Bar to resize it. You can also change
the default font size by changing the value of LabTalk system variable @FBFS (default
is "130").

9.4.2 Set Cell Values Tutorials
Tutorial 1: Extending a cell formula to other cells

1.

Click the New Workbook button

2.

Click on the column A heading to select, then right-click and choose Fill Column

to open a new book.

with Row Numbers.

3.

Click on cell B1 and enter:

=A1+A$1

4.

Press ENTER. This adds the value in A1 to the value in A1.

5.

With the cell still selected, hover on the selection handle in the lower-right corner
of the cell and when it looks like a "+", double-click to extend the cell formula to
the bottom of the column.
Click the Add New Columns button

6.

7.

to add column C.

Click on the Cell in C1 but this time enter (omitting the "$"):

=A1+A1

8.

Press ENTER. This adds the value in A1 to the value in A1.

9.

With the cell still selected, hover on the selection handle in the lower-right corner
of the cell and when it looks like a "+", double-click to extend the cell formula to
the bottom of the column. Note that this time, the resulting values are different.

10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in
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column B "locked" the second cell A1 reference so that it didn't change but that the
A1 reference in column C changed with the row index number as we extended the
cell calculation to other cells.

Tutorial 2: Quickly finding maximum values in multiple columns of data using
special keyword "This"
The only place where you can use cell formulas in the worksheet column label rows
(worksheet header rows), is in a User Parameter row.

1.

Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2.

With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3.

In the dialog box that opens, enter "MaxValue" and click OK.

4.

In column A(X), in the MaxValue cell, enter:

=Max(This)

5.

Click outside the cell and cell should now display "10".

6.

Click back on this cell, then grab the selection handle in the lower right corner of
the cell and drag to the right to extend the cell formula to MaxValue cells in
columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the
maximum values in their respective columns.

Tutorial 3: Use a column label row value in a cell calculation
All data in the worksheet column label rows, including User Parameter rows, is stored
as string data. To use a "number" stored in a column label row in a cell calculation, you
must convert the string to a numeric value. In the following example, we use the
LabTalk value() function to convert column label row data to a numeric so that it can
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be used in a cell calculation:

1.

Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2.

With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3.

In the dialog box that opens, enter "Correction" and click OK.

4.

In column D, enter the value "0.2" into the Correction cell.

5.

Click the Add New Columns button

6.

In cell E1, enter:

to add column E.

=D1+value(D[Correction]$)

7.

Press ENTER. This converts the Correction value to a numeric and adds the
numeric to the value in cell D1. The cell should display 101.9.

NOTE: The "$" in the above expression does not function to create an absolute cell
reference as in the first example above. In this context, the "$" syntax is used to
express a string variable stored in a user-parameter cell, before converting that string
to a numeric value.

9.4.2.1 Naming Data Ranges

Origin 2022b adds support for named ranges to column label rows. Use, for example,
to incorporate a label row parameter value in your Set Column Values calculations.

You can assign a name to a worksheet data range and use the name in cell formulas or column formulas and
to define Reference Lines in graphs.
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To create a named range:

1.

Highlight a cell or a range of cells and choose Data: Define Name.

2.

In the New Name dialog box, enter a Name for the selected (Refers to) range.

3.

Assign a Scope to your named range.

4.

Optionally: if you wish to use the named range to return interpolated values, enable Define as Function
and/or add a Comment.

To manage named ranges:
1.

With the worksheet active, choose Data: Name Manager.

2.

Use the dialog to modify name, scope, range and comments.

117

UserGuide_2022b

9.5 Remove Formula/Links
Beginning with Origin 2022b, you can use a small dialog to remove formulas and links
from the current selection, the active sheet, the active book or the entire project. This
converts formulas and links to raw numbers.

Removing formulas and links can make it easier to share project data with colleagues without having to share
such things as externally-linked (DDE) Excel files; or to significantly reduce project size before archiving data.

Things you can convert to raw numbers:

•

Cell formulas

•

Column formulas

•

Linked cell values (e.g. values copied a report sheet and paste-linked to other worksheet cells in the
project).

•

DDE links (e.g. paste-linked values from an external Excel sheet).

9.6 Cell Notes
Any worksheet cell -- data row or column label row -- can contain a cell note; even those that contain data or
other objects such as images or embedded graphs.
For Origin 2022b, worksheet cell Notes get Rich Text support, meaning you can now
style text using Origin. In addition, you can add images and graphs, and link to
worksheet cell values, report table values, etc. See Notes Windows for Reporting.

1.
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To add a Note, select the worksheet cell and click the Mini Toolbar Add Note button .
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2.

Enter your text. If adding more than brief, simple text, click the Mini Toolbar Open in Notes
Window button. Rich Text is enabled by default.

3.

While editing cell notes, use Format toolbar buttons (a) to format your text. To see your note in
"Render" mode (b), press CTRL + M (Notes: Render Mode). To insert the finished Note into the
worksheet cell, click the Close button (c).

4.

The reinserted Note can be seen by hovering on the worksheet cell.
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For text that is not assigned a paragraph style (see next section), you can use the Font
Size control on the Format toolbar, to control text size. Font Size can be set for each
window but all Notes windows must share a common Font (e.g. Segoe UI).

Origin 2022b supports "substituting" cell Notes in graph legend and text objects using
@WN (e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source
worksheet).

9.6.1 Text Styles Manager

In addition to styling text with the Format toolbar, you can apply a simple set of styles
to each line/paragraph. Manage styles with the Text Styles Manager dialog box.

1.

With a worksheet active, choose Tools: Text Styles Manager.

2.

Select a Style to Modify and Apply or Close.
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Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style
and Delete.
To apply a paragraph style to Notes window text:
1.

Open the cell note in a Notes window.

2.

With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph
Styles and choose a style from the popup menu.

3.

To check results, press CTRL + M (Render Mode).

9.7 Processing Worksheet Data
Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the
Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be
active). Some utilities are available from a shortcut menu: select your data and right-click.

Utility

•

Sorting Data

Menu Access
Worksheet:
Worksheet:
Worksheet:
Worksheet:

Sort
Sort
Sort
Sort

Range
Columns
Worksheet
Columns by Label
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Utility

•

Find

•

Replace

•

Go To (sheet row/column)

Menu Access
Edit: Find in Project Edit: Find in
Sheets
Edit: Replace
Edit: Go To

•

Hide Column

•

Hide Rows

•

Move Columns

•

Swap Columns

Column: Hide/Unhide Columns
Hide/Unhide Rows (shortcut menu only)

Column: Move Columns or Column
toolbar.
Column: Swap Columns

•

Query Worksheet Data

•

Copy Columns to (new locations)

•

Append Worksheet

•

Join Worksheets

•

Split Columns

•

Split Worksheet

•

Split Workbooks

Worksheet: Worksheet Query

Worksheet: Copy Columns to

Worksheet: Append Worksheet

Worksheet: Join Worksheets by
Column
Worksheet: Join Worksheets by Label

Worksheet: Split Columns
Worksheet: Split Worksheet

Split Worksheets by
numeric column(s) adds
user-specified
Tolerance
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Utility

Menu Access
No menu access. To open the dialog box:

•

Split Cell Strings to Multiple Columns

1.

Click Window: Script Window.

2.

At the cursor, type text2cols -d
and press Enter.

For more information, see this link

•

Stack Multiple Columns into One with
Grouping

•

Unstack Grouped Data into Multiple Columns

•

Stack Columns Common to Multiple Sheets
by Label

•

Summarize Data with Pivot Table

•

Filter data by defining conditions on one or
more columns

Worksheet: Stack Columns
Worksheet: Unstack Columns
Worksheet: Stack Worksheets

Worksheet: Pivot Table

Column: Filter menu, or Worksheet
Data toolbar
See Also: Data Masking

•

Data Reduction

•

Worksheet Transpose

•

Convert Worksheet Data

Worksheet: Remove/Combine
Duplicated Rows
Worksheet: Reduce Columns
Worksheet: Reduce Rows
Analysis: Data Manipulation: Reduce
Duplicate X Data
Analysis: Data Manipulation: Reduce
by Group
Analysis: Data Manipulation: Reduce to
Evenly Spaced X

Worksheet: Transpose

Convert to XYZ Convert to Matrix
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Utility

•

Apply Conditional Formatting to Worksheet
Cells

•

Reverse Order

Menu Access
Worksheet: Conditional Formatting:
Highlight
Worksheet: Conditional Formatting:
Heatmap
Worksheet: Conditional Formatting:
Duplicates

Column: Reverse Order

9.8 Conditional Formatting of Worksheet Data
In addition to the above worksheet data utilities, the Origin worksheet supports Conditional Formatting.
Conditional Formatting has three modes:

•

Highlight mode opens a dialog box with controls to apply color to worksheet cells based on one or more
conditions (e.g. "equal to", "not equal to", "text that contains", etc).

•

Duplicates mode opens a dialog box with controls to apply to worksheet cells that contain duplicate
values.

•

Heat Map mode opens a dialog box with controls to apply a color map to cells based on worksheet values.
The worksheet Heat Map is zoomable and scrollable, making it easy to get a "big picture" overview of data
variation in three dimensions.

Manage conditional formatting in the active sheet using the Conditional Format Manager.

When using 3-Color Limited Mixing to apply color to worksheet heatmaps, you can now
precisely control where the middle color falls. Specify by Percentile, by Percent or by
Value.
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9.9 Workbooks for Analysis and Reporting
Apart from text and numeric data, the workbook can contain various other types of information -- images,
graphs, notes and matrices; links to cell values in other books, project variables, documents or web pages;
plus, import file metadata, variables and scripts -- making the workbook a flexible medium for collecting
research data or for creating custom reports.
Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- for instance,
the application of a data filter, plus a fitting operation on the filtered data, combined with a customized plot of
the results -- into something that we call an Analysis Template. The Analysis Template makes it possible to
automatically generate a custom report of results, simply by supplying new input data.

One attractive option for generating reports (there are others -- see the tip at the bottom of this section) is to
export data to a custom MS Word template, and optionally, a PDF file. This is done by running an outputgenerating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally,
saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool,
point to both your Analysis Template and your Word template, run the batch process and generate your
reports.

•

For information on generating custom reports using an MS Word Template, see the tutorial
Batch Processing with Word Template for Reporting.

•

For information on batch analysis and generating custom reports, see the Batch Analysis
section of the "How to Handle Repetitive Tasks" chapter of this Guide.
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Another option for generating reports is to create HTML reports using Origin's Notes
window. A Notes window can link to graphs, worksheet cells, etc., either directly or
using a placeholder sheet. For more information, see HTML Reports from Notes
Windows.

9.10 Topics for Further Reading
•

The User Files Folder

•

Origin Template Files

•

What is Saved with the Workbook Template?

•

The New Workbook Dialog

•

Arranging the Worksheet
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•

Displaying Supporting Data in the Worksheet Header Rows

•

Controlling How Numeric Data Display

•

Dates and Times in the Worksheet

•

Generating Simple Worksheet Datasets

•

Column Short Name Restriction

•

Using Formulae to Set or Transform Worksheet Column Values

•

Using a Formula to Set Cell Values

•

Simple Manipulation of Worksheet Datasets

•

Inserting Graphs, Images and other Objects into Worksheet Cells

•

Inserting Links into Worksheet Cells

•

Inserting Variables into Worksheets

•

Conditional Formatting of Worksheet Cells

•

Analysis Report Sheets and Columns
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10.1 Matrixbooks, Matrixsheets and Matrix Objects
A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X
and Y values. The following table summarizes some important matrixbook limits:

Maximum Number of...
Matrixsheets in a matrixbook
Matrix objects in a matrixsheet
Cells in a matrix (Note)

32Bit OS
1024†
65,527
90,000,000

64Bit OS
1024†
65,527
90,000,000

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with
Origin versions prior to Origin 2018 SR0.
Note: The product of any combination of rows and columns must not be greater than 90,000,000.
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10.1.1Naming Matrixbooks, Matrixsheets and Matrix Objects

•

The matrixbook has a Short Name whether you display it or not. Origin uses
the Short Name for internal operations.

•

Short Names must be unique within the project file, cannot contain spaces,
must begin with a letter, consist only of alphanumeric characters (A to Z and 0
to 9), and limited to 13 characters. You can use lowercase characters and the
text will appear as such, but upper and lower case are not unique characters.

Matrixbook

(You cannot name one matrix MBOOK1 and another mbook1.)

•

Long Names are optional, need not be unique within the project file, can
contain spaces, can begin with a letter, a number or a special character, and
the length cannot exceed 520 characters, including spaces.
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•

The sheet Name must be unique within the matrixbook and is limited to 32
characters.

Matrixsheets

•

Can contain spaces and numbers.

•

Can contain special characters except `!%"|()[]{}<>.

•

Can begin with a letter, number or allowed special character.

•

Optionally, sheet can have Label and Comments.

•

By default, Origin assigns a matrix object index number to each object, as it is
created. This index number cannot be changed.

•
Matrix Objects

You can add a name to the object by clicking on the yellow object icon a data matrix or

for

for an image matrix - in the upper right corner of the

matrixsheet and choosing Rename from the menu. Alternately, you can
double-click on the matrix object number/name below the thumbnail and enter
a name.

10.1.2Different Views of the Matrix
In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The
matrix contains a single dataset of Z values.

•

Matrix columns are mapped to linearly-spaced X values.

•

Matrix rows are mapped to linearly-spaced Y values.

Note that the matrix window has two column and row heading view modes:

•

By default, matrix row and column headings display as row and column index numbers (View: Show
Column/Row from the menu or press Ctrl+Shift+C).

•

You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the
Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values,
calculated by linear interpolation of the axes From and To values by the number of columns and rows.
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In addition to the two row and column heading view modes, there are two matrix display modes:

•

In Data Mode (View: Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as
raw numbers.

•

In Image Mode (View: Image Mode from the menu or press Ctrl+Shift+I), the matrix object displays
as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of
real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color
image.
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Note: If the matrix object is an image, the object icon will display as

whether you are viewing the

matrix object in Image Mode (View: Image Mode) or Data Mode (View: Data Mode). Similarly, when
you import numeric data into the matrix, the object icon will display as

regardless of View mode.

10.1.3Matrixbooks
Like the workbook window, the matrixbook window is created from a customizable template (.otmu file). The
matrix template stores such things as number of sheets in the book, the names of the matrixsheets, matrix
dimensions, data type, math functions, data import handling instructions as well as various style and format
options.
When you create a new matrixbook, the book is named MBookN, with N reflecting the order of window creation.
Appended to the book name, you will see something like ":1/3" where the first integer denotes the active
matrix object and the second denotes the number of matrix objects in the active matrixsheet. Following the
above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix
objects with the first being the active one - the one with a check mark placed beside it (note that in our
illustration, the objects are empty).

You can right-click on a worksheet tab and Add Matrix as Sheet and insert a
matrixbook into a workbook. This is useful when building Analysis Templates that
involve matrix-based operations such as 3D surface fitting or 3D plotting operations.
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10.1.4Matrixsheets
Prior to Origin 2018, an Origin matrixbook could have a maximum of 255 sheets. That
number is now increased to 1024. When you have more than 255 sheets in a book, you
will need to save the file using one of the new Unicode-compliant formats (opju, ogmu,
etc).
A matrixbook can have up to 1024 matrixsheets. The default matrixbook template - ORIGIN.otmu - has a
single matrixsheet containing 32 rows and 32 columns. Each matrixsheet can differ in dimensions(number of
rows and columns and X & Y range).
To specify the dimensions of the matrixsheet:
1.

Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix
Dimensions and Labels dialog box.

2.

Specify a number of columns (X dimension) and rows (Y dimension).

3.

Specify a From and To value for X (columns) and Y (rows).

Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix
column and the last X is mapped to the last matrix column. The X coordinates of other columns are
interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or
analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y
coordinate values (not column or row index) and the Z value contained in the cell intersected by the row
and column.

10.1.5Matrix Objects
A matrixsheet can contain up to 65,504 matrix objects, though the actual limit is likely to be far less
(determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row
(Y) headers, but every object can have its own Z header. Other matrix object properties include internal data
type and numeric display options.
Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog
box:
1.
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Make sure that the matrix object is active (check mark shows beside it in the object menu).
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2.

Choose Matrix:Set Properties... from the main menu.

You can set properties for multiple matrix objects without closing the Matrix Properties
dialog box by clicking the << Previous or Next >> buttons at the top of the dialog
box.

10.1.6Import Image to Matrix
Origin has two structures for importing multi-frame images -- the matrix window and the Image window. The
matrix window is better-suited to performing data analysis tasks (e.g. surface fitting, statistics, mathematic
transformations of data, etc.) and some graphing operations, but take note of the following:

•

When you import an image to the matrix, you can -- as with other matrix data -- switch between "Data
Mode" (View Data Mode) and "Image Mode" (View: Image Mode).

•

However, until converted to data, matrices contain RGB values (regardless of View mode), as seen in the
second window in the sequence below.

•

Performing certain analysis or graphing tasks requires that the matrix first be converted to Z values (e.g.
Nonlinear Matrix Fit or creating an Image Plot) by choosing Image: Conversion: Convert to Data.
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For more information, see Image Conversion in the Origin Help File.
To import an image or image stack to the matrix window:
1.

With the matrix active, choose Data: Import From File: Image to Matrix.

2.

This opens the Image to Matrix (impImage) dialog. Note that there are are controls for Import
Grayscale GeoTIFF as Data, Show Image Thumbnails and multi-file import-handling.
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10.1.6.1 Image Thumbnails and Image Slider

When importing multi-frame TIF files, thumbnail/slider display is controlled by system
variable @MSS (default value =10):

•

If the sheet contains a single frame, don't show thumbnail/slider.

•

For 1 < frames < 10, show thumbnail

•

For frames > 10, show slider

When the sheet contains multiple objects, you can display those objects as a series of thumbnails in a spacer
at the top of the matrix window.
1.

Right-click on the matrix window title bar and place a check mark beside Show Image Thumbnails.
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Alternately, you can use a slider control to view these objects in the active matrixsheet.

If you are seeing thumbnail images in the spacer at the top of the window, you can switch to the slider by
doing the following:
1.

Hover in the space between the thumbnails and when the cursor changes to a grid icon

, click to show

the page Mini Toolbar (you can also click in the gray area to the right of your matrix image).

2.

3.

Toggle the Slider or Thumbnails button to show slider or thumbnails.

Likewise, you can turn off both thumbnails and slider by clicking the Image Selector button. Click the
View Image button to toggle between Data Mode and Image Mode.
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10.1.6.2 Naming Matrix Objects
You can assign a name to a matrix object:
1.

With the matrix object active, choose Data: Define Name.

2.

Give the matrix a Name, set Scope and, optionally, add a Comment.

Named ranges can be used in Matrix: Set Values (e.g. to perform math operations on other matrix objects of
the same dimensions).
10.1.6.3 Import GeoTIFF to Matrix

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file
and which has applications in mapping. Starting with Origin 2022b, Origin supports
import of GeoTIFF files to both matrices and Image windows.

To import a GeoTIFF file to the active matrix:
1.

Click Data: Import From File: Image to Matrix.

2.

In the Image to Matrix dialog (impImage), check the Import Grayscale GeoTIFF as Data box and click
OK.

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.

10.2 Extracting Information from the Matrixsheet or Object
When viewing matrixsheets or matrix objects in Image Mode (View: Image Mode), you can extract
information from the matrix using the Region-of-Interest (ROI) tools:
1.

Go to Tools: Region of Interest Tools and verify that there is a check mark beside the menu item. If
not, click on this item or press CTRL + SHIFT + T to enable the ROI tools.
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2.

Click on the displayed ROI tool (e.g. Rectangle Tool

) on the Tools toolbar and choose an ROI shape

from the flyout menu (rectangle, circle, polygon, region).
3.

Using your mouse, drag out an area on the image and double-click to set your selection. Once the
selection is set, additional clicks allow rotating, stretching, or skewing the ROI.

4.

To add multiple ROI to a matrix, you must give each ROI a name that is unique within the matrixsheet.
Double-click on the ROI to open a small dialog with access to the object name.

5.

Right-click on your ROI and choose an option from the shortcut menu. To discard the ROI, press Delete:

o

Crop: Crop the image to the minimum rectangular area that will contain the ROI. By default,
values outside the ROI will show black (zero values in Data Mode).

o
o
o
o
o

Copy: Rectangle only. Creates an image from the ROI.
Copy Positions: Copy the position of the selected ROI.
Paste Positions: Paste the position of the selected ROI to another ROI (width, height...all).
Export ROI: Save the ROI object(s).
Import ROI: Replace the object(s) with those in a saved .ROI file (hint: create a "dummy" ROI
to import).

o
o
o
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Create New: Use the mroi2mat tool to generate a new matrix from the ROI.
Extract as XYZ: Use the mroi2xyz tool to generate a new worksheet of XYZ values.
Intensity Profile: Use the mroiprofile tool to generate a statistics for the ROI.
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ROI stats are automatically reported to the Status Bar. Right-click on the Status Bar to
hide or show statistics.

10.3 Image Plot
Data in a matrix can be plotted as an Image Plot. Axis scales are determined by the matrix XY coordinates
(when the matrix is active, choose View: Show X/Y).
Note that if you import an image to the matrix (Data: Import From File: Image to Matrix) you must first
convert the image to data (Image: Conversion: Convert to Data) before creating your Image Plot (Plot:
Contour: Image Plot).
1.

Activate a matrix window and choose Plot: Contour: Image Plot.
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By default, the image plot will use the same colormap, Z scale range and missing value color, as matrix image
mode (View: Image Mode). See Matrix: Apply Palette to Color Map, below.

For Origin 2022b, a Transparency control is added to the Plot Details Colormap tab
of Image Plots created from matrix data.

10.4 Image Window
The Image Plot described above is used to plot values in a single matrix object. The Image Window can be
used to:

•

Open an image file for basic manipulation (flip, rotate, convert to gray-scale) using the Image Window's
Mini Toolbar.

•

Edit an image inserted into a worksheet cell or graph window (double-click on the inserted image).

•

Import an image set such as the common "TIFF stack".

•

Import multiple discrete image files as an image stack.

•

Open and play a movie (.avi, .mov, .mp4) file.

•

Define one or more regions-of-interest (ROI) for which you can Copy Positions, Paste Positions (from
another ROI), and Export or Import position information saved to an Origin *.ROI file (a text file with
position information on each ROI on the image).

•

Open and operate on images inserted to worksheets or graphs: crop, copy, export ROI, etc.

Image window import improvements:

•

Content can be exported to one of several raster formats: BMP, GIF, JPG, PNG,
TIF. For Origin 2022b, you can adjust DPI in the exported file.

•

Import GeoTIFF files, with negative numbers treated as missing values.

•

Import multiple GeoTIFF files of same dimensions into an Image window and
enable a slider.

10.4.1Image and Video Import
1.

Choose File: New Image, then choose an option from the flyout menu.

•

Empty Window: You can later add a file by right-clicking and choosing Import or Import
from Web. Alternately, click the New Image button
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•

Image/Video (CTRL + ALT + I): Use the file type drop-down to specify an image or video
file format.
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•

Multiple Image Files (CTRL + ALT + T): Specify which files to import as a stack, including
GeoTIFF. Note that the resulting stack will show an image slider, by default.

•

Web Image (CTRL + ALT + L): Enter a URL in the dialog to link to a web-stored image. Hint:
to grab an image URL, right-click on the web image and choose Copy image link or Copy
image address.
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10.4.1.1 Import GeoTIFF as Image

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file
and which has applications in mapping. Starting with Origin 2022b, Origin supports
import of GeoTIFF files to both matrices and Image windows.

To import a GeoTIFF file as an image:
1.

Click File: New: Image: Image/Video and choose the GeoTIFF image.

To import multiple GeoTIFF files as image:
1.

Click File: New: Image: Multiple Image Files and choose your images. Images are imported to the
active Image window and a slider is added to scroll images.

•

All Images must be the same size.

•

Negative numbers (e.g. -999) are treated as missing values.

•

The Image window Mini Toolbar has a button for setting Missing Value Color

•

Convert an Image window containing multiple GeoTIFF files to matrix using Image: Convert
to Matrix. Each image in the stack becomes an object in the output matrix.

Click inside the window, somewhere near the top, to show the Mini Toolbar.

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.
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10.4.1.2 Image Import Notes

•

To help control Origin project file size, right-click on an Image Window image and enable Linked File.
This saves a link to the image file into the window but excludes the image from the saved project. When
you reopen the saved project, the window will appear empty; at this point, you can decide whether you
need to re-import the image (CTRL + 4 or Import from the window shortcut menu).

•

Actual Size Mode is turned on by default for images of max width or height of less than 800 pixels. The
size threshold can be adjusted using system variable @IWP (see this FAQ for info on changing the value
of a system variable).

10.4.2Image Window Navigation
Display of image information and navigation controls is enabled or disabled via the the View menu and/or the
Image Window Mini Toolbar (None, Thumbnails, Video or Slider).

The same Mini Toolbar button is shown for GeoTIFF images:
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Additional Keyboard control for Video navigation

•

Pressing the left/right arrow keys will move the frame by 1.

•

Shift + arrow key will move the frame by 5.

•

Shift + Ctrl + arrow key will move the frame by 20.

10.4.3Image Resize
To resize the image by one of several interpolative methods:
1.

With the Image Window active, choose Image: Resize.

2.

Choose options including your Interpolation Method (Nearest Neighbor, Bilinear, Bicubic, Pixel Area
Relation, Lanczos) and click OK.

10.4.4Define ROIs

For Origin 2022b, you can add multiple ROI without stopping to rename each (see 2.,
below). To speed operations, Add ROI is added to the matrix image shortcut menu.

You can define a region-of-interest using one of the ROI tools (e.g. Rectangle Tool
1.

) on the Tools toolbar.

Select the tool and drag out an ROI. Once added, fine adjustments can be made by dragging the blue
handles.

2.

To add multiple ROIs to an image, (a) click an ROI tool (Rectangle/Circle/Polygon/Region) and drag out
your ROI or (b) right-click on the matrix image and choose Add ROI. Repeat as needed. Objects will be
named as "ROIxx" as they are added.
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When the ROI is selected, use the Style toolbar Line/Border Color button
change the outline color of the ROI.

to

10.4.5Mini Toolbars for Image Window
Mini Toolbar buttons are available for performing simple image manipulation, including rotating, flipping or
converting to grayscale.

You can apply a color palette to a grayscale image using the Palette button
on the
Style toolbar. Click More Palettes to open the Color Manager dialog box and add
more palettes.
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10.5 Profiling Matrix Data
Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.
1.

Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu.

This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X
and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a
button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the
Image/Contour Profiles dialog.

10.6 Setting Matrix Values
The Set Values dialog box is used to generate or transform data in a matrix object.
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You can assign a name to a matrix object and use the name Set Values (e.g. to
perform math operations on other matrix objects of the same dimensions).

To open the Set Values dialog box, make sure that the matrix object is active, then:
1.

From the menu, choose Matrix: Set Values.

1.

Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix

or

icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu.
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•

Formula: Load a saved formula into the matrix formula box. Formula are
saved using Formula: Save or Formula: Save As....

•

Mat(1): Use the menu to include matrix objects in either your matrix formula
or your Before Formula Scripts (matrix object reference is inserted at the
cursor). A Matrix Browser is available to help in selecting the correct objects.
Objects are listed by object index.

•

Menu
Commands

Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by
object Long Name, if one exists.

•

Function: Add LabTalk functions to your expressions (function name is
inserted at the cursor).

•

Variables: Add a variable or a constant to Matrix Formula or Before
Formula Scripts; Add range variables (including by selection) or file
metadata, to Before Formula Scripts.

•

Add a single line expression for generating data. Functions, conditional
operators and variables can be used.

Matrix Formula

•
Before Formula
Scripts

Enter one or more lines of LabTalk script to be executed before the expression
in the Matrix formula box is executed.

Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to
define variables or LabTalk functions that you wish to use in your matrix formula.
Click the Search and Insert Functions button
functions.

to search for built-in LabTalk

10.7 Manipulation of Matrix Data

Utility

•

Menu Access

For an XY coordinate pair picked
with the Screen Reader, output Z
values for for the matrix stack
(multiple matrix objects) to a

Matrix: Pixel Extraction

worksheet.
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Utility

•

Flip or Rotate a matrix.

Menu Access
Matrix: Rotate90
Matrix: Flip: Vertical
Matrix: Flip: Horizontal

Matrix: Resize

•

Resize a matrix using one of four

The msresize dialog adds
more control and flexibility for
Origin 2022b. Those working
with NetCDF data will find new
interpolation options: Random
Kriging and Inverse Distance
Weighted.

methods (Expand, Shrink,
Interpolate and Pad).

•

Transpose a matrix.

•

Generate a 3-dimensional
dataset by transforming XYZ
values by formula.

•

Matrix: Expand

Shrink the matrix by some
row/column factor, using one of
several shrink methods.

•

Matrix: Generate Grid

Expand the matrix by scaling in
the X and Y directions.

•

Matrix: Transpose

Matrix: Shrink

Use a palette file to transform a
matrix in Image Mode. Set a
system variable to apply a color
palette (Style toolbar, Palettes
button) to all matrix objects
(@MAP=0, default) or only the
active matrix object (@MAP=1).
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Utility

•

Menu Access

Convert a matrix of values to
worksheet columns (see next
section).

Matrix: Convert to Worksheet

10.8 Changing the Color Scheme of a Matrix
You can use the Palette
button and the Missing Value Color
the color of the matrix window.

button in the Mini Toolbar to customize

The selected palettes and missing value color will apply to all matrix objects in the
active matrix sheet, but will not change the palettes and missing value colors of objects
in other matrix sheets in the same matrix window.

10.9 Converting Matrixes to Worksheets

To convert a matrix to worksheet:
1.

With a matrix active, choose Matrix: Convert to Worksheet: Open Dialog.

There are two methods for converting matrix data to worksheet data -- Direct and XYZ Columns. Starting,
for instance, with the following arrangement:

10.9.1Direct
This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N
columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X
and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to
the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.
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10.9.2XYZ Columns
When there is a single matrix object, this method produces a worksheet with three columns: X,Y, and Z, with
X and Y columns containing the X and Y coordinate values and the Z column containing the matrix Z value at
each XY coordinate.

In addition, this method:

•

Saves matrix object Long Name, Units and Comments to the Z column label rows.

•

If the converted matrix contains a color image, the resulting Z column will display a Color column of HTML
colors for each matrix cell.
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When converting multiple matrix objects:
When there are N matrix objects, you can set Convert On = All Objects and output columns as X, Y and Z x
N (i.e. XYZZZ...).

10.10 Converting Worksheets to Matrixes
1.

With the worksheet active, choose Worksheet: Convert to Matrix and choose one of the following
methods:
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Method

Conversion Type

Notes
Ideal for spreadsheet data that
conforms to the following:

•

X data values in the 1st
column, Y data values in the
1st row and Z values in

Direct

•

X across columns

columns 2 to N and rows 2 to

•

Y across columns

M.

•

No X and Y

•

Y data values in the 1st
column, X data values in the
1st row and Z values in
columns 2 to N and rows 2 to
M.

Note: See Virtual Matrix,
below.

Some ASCII files have an upper limit
for characters allowed on a single line.
Use this method when your file breaks
a single line of data across multiple
lines.

•
Expand

Expand by Row: specifies

•

Row

the number of ASCII file

•

Column

rows comprising one matrix
row.

•

Expand by Column:
specifies the number of
ASCII file columns
comprising one matrix
column.
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Method

Conversion Type

Notes
Conversion Type depends upon XY
spacing:

XYZ
Gridding

•

Choose Regular applied for

•

Regular

data that are regularly

•

Sparse

spaced in XY.

•

Random (Renka Cline)

•

Random (Shepard)

•

Random (Thin Plate Spline)

•

Random (Kriging Correlation)

•

Random (Weighted Average)

•

Choose Sparse when you
have missing values.

•

Choose Renka-Cline,
Shepard, TPS, Kriging or
Weighted Average
methods for data that are
irregularly spaced in XY.
Option for No Extrapolation
outside Boundary.

XYZ Log
Gridding

methods same as XYZ Gridding

Calculates logarithmic values for X
and Y, then performs XYZ Gridding.

10.11 Virtual Matrix
Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots.
The data can include a column or label row with the X or Y values. Unlike a regular matrix which only supports
a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate
values (provided those values are in ascending or descending order).
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Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in
the X and Y dimensions. This is not considered a "virtual matrix."

10.12 Topics for Further Reading
•

Matrixbooks, Matrixsheets and Matrix Objects

•

Matrixbook and Matrixsheet Operations

•

What is Saved with the Matrix Template?

•

Matrix Dimensions and XY Coordinates

•

Matrix Object Data Properties

•

Setting Matrix Values

•

Matrix Conversion and Gridding

•

Creating 3D and Contour Graphs from a Virtual Matrix

•

Viewing and Profiling Matrix Data
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11.1 Creating a Graph
Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for
its applications in various technical fields.
All graph types are accessible from the Plot menu. Note that while most graph types also have a
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating
graphs.
Creating most graphs involves just two steps.
1.

Select your data.

2.

Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple
data arrangements. See the Origin Graph Types section for specific requirements.

11.1.1Creating Graphs from Worksheet Data
Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and
creating a simple graph.
Tutorial: One click to create graph with selected data
1.

Open a new workbook and select Data: Import from File: Single ASCII... from
the main menu.

2.

Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.

3.

Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across
the four column headings.

4.

Click Plot > Basic 2D: Line & Symbol: Line & Symbol. A graph window is
created with four line and symbol plots. Note that the plots differ by line color and
by symbol type.

5.

Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).

6.

This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a
very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs
discusses customizing graphs and saving templates in more depth.
We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a
3D surface plot, then overlaying it with a 3D scatter plot.
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Tutorial: 3D Surface Plot from XYZ Data
1.

Create a new, empty workbook window and import the file \Samples\Matrix
Conversion and Gridding\XYZ Random Gaussian.dat.

2.

Highlight column C and right click. Select Set As: Z from the fly-out menu.

3.

Select Plot > 3D: 3D Colormap Surface to create a 3D Colormap Surface plot.

4.

Select the Graph: Layer Contents... menu item or right click the layer icon on the
left-top of the graph to open the Layer Contents dialog. In this dialog, click on
drop-down next to the

button and select 3D Scatter/Trajectory/Vector

from the fly-out menu.
5.

Select column C from the left panel and click on the Add Plot

button to add

the 3D scatter plot to the graph. Click OK to close the dialog.
6.

Double-click on the plot to open the Plot Details dialog. In the left panel, expand
the Layer1 node and then expand the 2nd node which represents the scatter plot.
Click and select the branch named Original. Be sure to leave the node-level check
box selected, otherwise this plot will be hidden.

7.

In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to
Color Mapping: Col(C).

8.

In the Drop Lines tab, clear the Parallel to Z Axis check box.

9.

Select Layer1 from the left panel of the Plot Details dialog. In the Lighting tab,
under Mode, select Directional. Click OK to close the dialog.

10. Click on the scatter plot in the graph to select this plot, then in the Style toolbar,
click on the

button and select the Rainbow palette.

Your graph should look like this:
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You can hold down the R key on your keyboard and use the mouse to freely rotate the
3D surface. With the pointer tool active, click on the layer for additional controls to
move, stretch and rotate the surface.

11.1.1.1 Worksheet Column Plot Designations
The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data
requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in
concert with settings saved in the graph template, to allow you to quickly create a graph.
To set the Column Plot Designation, select a column or multiple columns, then from the menu choose Column:
Set as:<option>; or right-click and choose an option from the Set As: context menu.
In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns.
The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D
graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.
Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot
Designation, in documentation for the Column Properties Dialog Box.

11.1.1.2 Selecting Worksheet Data
Various ways to select data for plotting:

•

Single column: Click on the column heading, e.g. B(Y)

•

Multiple columns: To select a small number of contiguous columns, click on the first column heading and
drag the pointer to the last column heading. To select a large number of contiguous columns, click on the
first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then
press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the
CTRL key while clicking on the desired column heading.

•

A range in a column: Click on the first cell of the range and drag to the last cell of the range.

•

Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range.
When plotting, each range will be treated as a separate data plot in a plot group.

•

Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell.
If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be
treated as a separate data plot in a plot group.

•

Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select
multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row
headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot
group.

•

Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner
of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downwardpointing arrow, click to select the entire worksheet.

•

Specific columns: To select columns by data in column label rows (header rows); or to select columns
using a pattern, choose Edit: Select.
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As noted in the Worksheet Column Plot Designations section just above, if you select Y
or Z columns, Origin defaults to plotting the Y column against the nearest X column to the
left; or to plot the Z column against the nearest Y and X columns to the left. But if you In
the case of simple XY 2D plots (line, line+symbol, etc.), you can ignore this rule and plot
with selected XY columns not matter the selected X is on the left or right side of Y.

11.1.2Creating a Graph from Matrix Data
As discussed in the Matrixbook, Matrixsheets and Matrix Objects chapter, a matrix is a dataset of Z values
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars
still require matrix data.
There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a
worksheet and for one reason or another, you need to convert it into a matrix form, see Converting
Worksheets to Matrixes.
Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since
you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset
of the data plot to display once the graph is created. See Editing Plot Range, below.
11.1.2.1 The Virtual Matrix
The Virtual Matrix concept was covered in the Matrixbook, Matrixsheet and Matrix Object chapter of this Guide.
To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the
first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can
even contain text or date/time data.
When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's
Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y
coordinates. The intersecting data points are then treated as Z values.
Tutorial: Contour Plot from Virtual Matrix
1.

With a new workbook active, use the Data: Import from File: Import Wizard...
menu to open the Import Wizard dialog.

2.

Press the browse button in the dialog and select the file Waterfall.dat from the
Samples\Graphing subfolder.

3.
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import the file.
4.

With the workbook active, press CTRL+A to select the entire sheet.

5.

Now select the Plot > Contour: Contour - Color Fill menu item. The plotvm
dialog will open.

6.

In the dialog, set the Y Values in drop-down to Column Label, and then set the
Column Label drop-down to Excitation Wavelength(nm).

7.

Set the X Values in drop-down to 1st column in selection, then press OK to
close this dialog.

8.

The contour plot will be created.

9.

Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the
Speed Mode drop-down to Off and press OK. This will turn off speed mode so that
all data points are plotted (see the discussion of Speed Mode, below).

10. Click on the contour plot to select this data plot, then from the Style toolbar, click
the Palette button

and then select the Pumpkin Patch palette. Your graph

should look similar to the image below:

Once you customize your contour levels and colors, you can save your settings as a
Theme, or simply copy-paste your customizations from one graph to another. To save a
Theme, right-click on the graph and choose Save Format as Theme; or use the
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog
box.
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11.1.32D and 3D Function Plots

Unlike plots from worksheet data or plots from matrix data, parametric plots are not plots of actual data.
Instead, they are plots of mathematical functions.
To create function plots and parametric function plots, select File: New: Function Plot menu. There are four
options to choose from:

Type

Function Form

2D Function Plot

y = f(x)

2D Parametric Function
Plot

x = f1(t)
y = f2(t)

3D Function Plot

z = f(x, y)

3D Parametric Function
Plot

x = f1(u, v)
y = f2(u, v)
z = f3(u, v)

These plot types are also accessible from the function plot buttons on the Standard toolbar.

Tutorial: 3D Function and 3D Parametric Function in Same Layer
1.

From the menu, choose File: New: Function Plot: 3D Parametric Function
Plot...

2.

In the dialog that opens, click on the arrow button at the top right side of the
dialog, and from the fly-out menu select the built-in example Partial Torus
(System) and press OK to close the dialog. The function plot will be created.

3.

With the function plot window active, invoke the menu File: New: Function Plot:
3D Function Plot....

4.
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y scale.
5.

In the Z(x,y) edit box, enter 0.

6.

Set the drop-down at the bottom left corner of the dialog to Add to Active Graph
and press OK to close dialog.

7.

The Z=0 plane will be added to the graph, and the plane will properly intersect the
parametric surface plot. You can hold down the R key and use the mouse to freely
rotate the plot.

•

Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of
the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

•

For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is
created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of
Function or if on the Function tab in Plot Details, click the Workbook button.

•

Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting
or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate
Surface.... You can even add noise to the plot. Corresponding data is created as well.

11.1.3.1 Adding Function Plots to Existing Graphs
You can add function plots to existing graph windows containing other plot types. See FAQ-171, specifically
the section entitled Add Function Plot to an Existing Graph.

11.2 Plotting without Using Column Plot Designations
While worksheet Column Plot Designations are always used when creating graphs from the Plot menu or one
of the graph toolbars, the Plot Setup dialog box does not make use of them. With Plot Setup, you assign
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column designations on an ad hoc basis, allowing you to overcome some of the restrictions of template-based
plotting.
However, to make use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of
objects contained in the Origin graph window.

11.2.1Pages, Layers, Plots and the Active Plot
Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default,
the dimensions of the graph page are defined by the printable area of your default printer driver; without
adjusting settings, a printed graph should fill the printed page.

•

The graph page must contain at least one, and may contain as many as 1024, graph layers.

•

Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that
the graph in the image above contains three graph layers, represented by the three non-printing layer
icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted,
indicating that this is the active layer.

•

Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is
the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is
active. The active plot will have a check mark beside it.
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The hierarchical structure of the graph page can be seen in these places:

•

The Plot Details Dialog Box (Format: Page ...)

•

The Object Manager (View: Object Manager)

•

The Plot Setup Dialog Box (Graph: Plot Setup...)

11.2.2The Plot Setup Dialog Box
The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data
plots in an existing graph.

•

Creating graphs without regard to Column Plot Designations

•

Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrixbooks, loose
datasets, etc.

•

Creating graphs combining multiple plot types.

•

Adding, removing, replacing data plots.

•

Grouping or ungrouping data plots.

•

Reordering data plots in a layer or moving data plots to another layer.
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To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and
choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button).
To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box
1.

Click the New Workbook button on the Standard toolbar.

2.

Click Data: Import From File: Single ASCII, browse to the Origin installation folder
and import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns
are actually paired - X data and Y data -- but by default all columns are assigned a "Y"
Column Plot Designation on import.

3.

Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup
dialog box.

4.

Click the two "double-arrow" buttons to show all three dialog box panels.

5.

In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for
Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the
bottom panel.

6.

Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By),
then click Add.

7.

Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy),
then click Add. Three plots are added to Layer 1.
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8.

Press CTRL and click on each plot in the bottom panel to select all three, then right-click
and choose Group.

9.

Click OK to create a grouped line plot.

Tutorial: Creating a Graph with Data from Multiple Worksheets
1.

Click the New Workbook button on the Standard toolbar.

2.

Click Data: Import From File: Multiple ASCII, browse to the Origin installation
folder and select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve
Fitting\ to import. After Import, 3 workbooks are created.

3.

Without selecting any data, click Plot > Basic 2D: Line+Symbol. This opens the Plot
Setup dialog box.

4.

Expand the top panel if it is hidden. From the Available Data list, choose
Worksheets in Folder.

5.

Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.

6.

In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box
for Column B (Sensor Output), then click the Add button.

7.

Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3
worksheets.
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•

The Plot Setup middle panel only allows choosing one X column at a time.

•

If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want
columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only
plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns
and select all columns with same Long Name and plot them together. The Y columns will be plotted
against corresponding X columns.

•

To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y
columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.

•

All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a
group, right-click the Group node in bottom panel and Ungroup first.

•

Drag and drop data plots in the bottom panel to move them to different layers.

•

If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click
the OK button to create your graph.

11.3 Manipulating Data Plots
The following sections discuss higher level modifications to existing graphs such as changing plot type, adding
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed
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plot customizations, including those involving such things as changing plot symbols, colors, and legend
customizations, see the Customizing Graphs chapter.

11.3.1Changing Plot Type
Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing
plot with a few other select plot types. Some examples:

•

Scatter, line, line+symbol, column/bar are interchangeable.

•

3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

•
•

Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.
Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type dropdown list.

•

Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are
switched.
A word of caution: This is an old Origin feature, and for a quick change of common plot
types in a single-layer graph it works well. Changing plot types in a multi-panel, multilayer graph can lead to unwanted outcomes. When working with more complex graphs,
it is better to create a graph directly using the specified Plot menu command or toolbar
button .

11.3.2Exchanging Data Plots

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands.
Right-click on a data plot, then select one of these options:

•

Change X/Y/Z. These menu items allow you to swap the current X,Y or Z data with data from any column
in the project.

•

Select Columns. This opens the Column Browser where you can select another column in the Current
Folder, in the Current Folder (recursive) (includes subfolders) or in Current Project.

•

Change Worksheet. This menu item allows you to replace both X and Y with data from another
worksheet. The selected worksheet must have the same Short Names, the same Column Plot Designations
and the same row index range as the current worksheet.

Tutorial: Changing X and Y assignment of a data plot
1.

Start with a new workbook and import the file automobile.dat from the
Samples\Statistics sub-folder of the Origin installation folder.
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2.

Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu
item. The Gas Mileage column is plotted against the default X column Year.

3.

Right-click on the data plot and select Change X: Engine Displacement. The
Gas Mileage column is now plotted against Engine Displacement.

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the
graph should be rescaled. If data are not significantly different, you may want to manually rescale the
graph (Hot key: CTRL+R).

If you have performed some analysis on the data plot (e.g. linear regression with
Recalculate set to Auto), the fit results will automatically update when you change
X/Y or the worksheet.

11.3.3Adding, Removing and Hiding Data Plots
Use the following methods to add or remove data plots from a graph.
11.3.3.1 Adding Data by Drag and Drop
You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column
Plot Designations to create the plot.
1.

Select the worksheet data (one or more columns or a range of one or more columns).

2.

Move the mouse over the left or right edge of the selected range.

3.

When the pointer looks like this

, hold down the left mouse button and drag the data to the graph

window. Release the mouse.
4.

If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.

Usually the current plot type is used when plotting by drag-and-drop. To change the
global plot type to use when drag and drop, choose Preferences: Options... from the
main menu. Go to the Graph tab and change the Drag and drop plot type.

11.3.3.2 Adding Data with Insert: Plot to Layer
Use the Insert menu to insert some types of plots to the active graph layer. Choice of plot type depends on
the active graph window and the last-activated data source (worksheet or matrix). For instance, if you create a
2D graph, select data in a workbook window, then return to graph window and click Insert: Plot to Layer,
your insert choices will be Line, Scatter, Line + Symbol, Column..., Area and Contour....
To use the Insert menu command, you should have an existing graph window:
1.
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2.

Return to the graph window, make sure that the target layer is active layer, then choose Insert: Plot to
Layer: Plot Type.

11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box
Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right
panel lists datasets that are plotted in the active layer.

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the
layer.

In Origin 2022b, a new LabTalk system variable @SCCS modifies Layer Contents
sort behavior: @SCCS = 0 (default) sorts as Book1 > Book2 > Book10; @SCCS = 1
sorts as Book1 > Book10 > Book2.

11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box
Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.
1.

To add plots to the graph, use the top panel of Plot Setup to identify your source data.

2.

Use the controls in the middle panel to specify the plot type and how the data selection should be treated
(as X, Y, yError or Label).

3.

In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.
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4.

To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.

5.

To hide a plot, uncheck the Show check box for the plot.

6.

To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in
middle panel and click the Replace button.

11.3.3.5 Adding Data by Direct ASCII Import
You can import ASCII files directly into the active graph window using the the Import ASCII toolbar button.
Note that this method works only with files having a simple structure and it supports only the simplest of
graph types - Line, Scatter, Line + Symbol, Column and Bar charts.

1.

Click the Import ASCII

2.

Choose a file.

3.

Click Open.

button. This opens the Import ASCII dialog box.

The file is imported and plotted in the active graph window.
11.3.3.6 Adding Data by Copying and Pasting a Plot
With many Basic 2D graphs (e.g. Scatter, Line, Line + Symbol, Bubble, etc.), you can copy a plot from an
existing graph layer and paste it to another layer in the same window or into a separate graph window. Prior to
Origin 2020, this would only produce a black line plot. Origin 2020 expanded copy-paste of plots to other plot
types, while preserving plot properties (symbol size, color, etc.).
1.

Click on the plot to select it and press CTRL+C.

2.

Click on the target graph and press CTRL+V.

You can also copy a plot by selecting the plot in the graph and clicking on the Copy Plot button on the Mini
Toolbar.
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Previous versions also allowed you to select and copy a simple plot (Line, Scatter, Line
+ Symbol, 2D Column/Bar) and paste underlying data into a worksheet. The default
settings no longer support this but you can reverse this by setting LabTalk system
variable @CPNP=1.

11.3.3.7 Removing or Hiding Plots with the Object Manager
The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots.
See the section on The Object Manager in this Guide.
To hide or remove plots, right-click on a plot and choose from the shortcut menu:

•

Show or hide plots of the same Long Name.

•

Show all plots.

•

Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be
added back using one of the above methods).

•

If the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can
right-click on the group icon and remove the entire plot group.
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•

When you right-click on a plot, you can use Hide Plots with Same Name and Hide All Plots shortcut
menu items to quickly hide selected plots in the window without removing them entirely (restore plots by
enabling their display in the Object Manager or in Plot Details).

11.3.3.8 Removing or Hiding Data with Plot Details
In the left panel of the Plot Details dialog box (Format: Plot...), right-click on a plot and choose Remove or
Hide from the context menu. Remove will delete the data plot from the graph so if you just want to
temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.

11.3.3.9 Deleting Plots using the Delete Key
Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected
plot is part of a group, the entire group is deleted.
Note that this is more sweeping than the Remove shortcut menu command in that it will remove an entire
plot group from the graph window. This action does not delete worksheet or matrix data.
To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.
11.3.3.10 Editing Plot Range
Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:

•

Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To
values.

•

In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column
by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click
the ... button that appears to the right side of that column.

•

In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and
click the ... button that appears to the right side of that column.

Choose Graph: Rescale to Show All to rescale the graph after editing the plot range.
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11.3.4Grouping Data Plots
When you make multiple range or column selections, then create a graph, Origin groups the resulting data
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.
Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...;
etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles.
For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be
denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the
color list), and so on.
Tutorial: Creating a simple grouped data plot

1.

Open a fresh worksheet and click the Import Single ASCII button

on the

Standard toolbar.
2.

Browse to the Samples\Graphing subfolder in the Origin software folder and Open
GROUP.DAT.

3.

Select B(Y), C(Y), and D(Y) columns

4.

Click the Line & Symbol button

on the 2D Graphs toolbar. Note that line and

symbol color and symbol type are automatically differentiated for each plot.

Tutorial: Grouping (or ungrouping) plots manually

•

Via the Layer Contents dialog box

1.

To open the Layer Contents dialog box, double-click on the layer n icon in
upper-left corner of the graph window.

2.

To create a group, select the desired data sets from the Layer Contents list (use
CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data
sets).

3.

Click Group. Note that each plot in Layer Contents is now preceded by a gn (for
"group1", "group2", etc.).

4.

To ungroup, click on one of the grouped data plots in the Layer Contents list and
click Ungroup.

•

Via the Plot Setup dialog box

1.

To open the Plot Setup dialog box, ALT + double-click on the layer n icon in
upper-left corner of the graph window.

2.

To create a group, select the desired plots from the Plot List (use the CTRL or
SHIFT keys to select multiple data sets).

3.

Right-click and select Group. Note that a Group icon now precedes the selected
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plots in the Plot List.
4.

To ungroup, right-click on the Group icon and choose Ungroup from the shortcut
menu.

11.3.5Speed Mode
With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most
used when working with large data sets, though note that there have been improvements in this area and
Origin now has Density Dots and Color Dots graph templates specifically for creating scatter plots of large
datasets.
Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in
red and a Speed Mode is On banner appears in the layer. The banner is not included when printing, copying,
or exporting the graph.

To adjust Speed Mode settings:
1.

With your graph active, select Format: Layer... from the Origin menu.

2.

Select the Display/Speed tab.

3.

For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check
box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type
the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n,
Origin displays a subset of the data plot containing n points, drawn by extracting values at regular
intervals from the data set.

4.

For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data,
Maximum Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the
X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of
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the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at
regular intervals from the matrix columns (X) and rows (Y).
For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-Function
dialog. The dialog lets you specify which windows the settings should apply to ( Target ) and also, offers
several levels of data plot thinning from Off to High, plus Custom.

Click the Enable/Disable Speed Mode
button on the Graph toolbar, to toggle
Speed Mode on/off for all layers in the graph window.

To turn off the Speed Mode is On banner for all graphs:
1.
2.

Select Preferences: Options to open the Options dialog box.
Select the Graph tab and clear the Speed Mode Show Watermark check box and refresh the graph, if
needed. Note that this only disables the banner across the graph; it does not disable Speed Mode.

Origin 2022b adds a page-level Mini Toolbar button to toggle the Speed Mode Banner
at the individual graph level.

11.3.5.1 Notes on Speed Mode

•

Skip Points and Speed Mode plot the last data point, by default, but this is controlled by system
variable @SMEP.

•

The Speed Mode controls on the Display/Speed tab of the layer's Plot Details only apply to what you see
on screen. They do not apply to graphs that are printed or exported, by default.
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•

If you wish to skip points in printouts, use controls in the Print dialog. See the discussion of the Skip
Points feature as it applies to some graph windows in the Origin Help file.

•

If you wish to apply Speed Mode settings to graphic export, please see this discussion of Performance
Group controls on the Miscellaneous tab of the Plot Details dialog box or use controls under the Export
Settings node in the Graph Export dialog.

•

Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for
a particular graph type, you will have to resave the graph template to make those changes permanent.

•

Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a
portion of your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately
represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and
compare Speed Mode settings to ensure that trends in your data are accurately depicted.

11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and
Printing
There are a number of ways to present your finished graph.

•

Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.

•

Export the graph page as an image file (raster or vector).

•

Send Graphs to PowerPoint.

•

Printout.

•

Slideshow within Origin.

•

Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading"
there.

11.5 Origin Graph Types
Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graph
are plotted from Worksheet data (XYY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or
from Matrix data.

Origin Graph Samples of most 2D and 3D graph types are included with your Origin
software. To view graphs, supporting data and guidelines for making the graphs,
choose Help: Learning Center(F11).

The tables below list all Origin graph types, grouped by Plot menu category:
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•

The Plot menu icon for each graph type precedes the graph name.

•

The Notes column provides basic information on data requirements. For more specific data
requirements, click on the graph name beside the Plot menu icon.

11.5.1Plot Menu Graphs by Category
Plot menu templates display basic data requirements on hover.

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.
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11.5.1.1 Basic 2D

Graph Types

Notes

Scatter
Scatter Central
Column Scatter
Y Error

•

Start with a Worksheet.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

XY Error
Error Band

or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.

Scatter + Rug
Bubble
Color Mapped
Bubble + Color Mapped

•

Start with a Worksheet.

•

Select one or more Y columns or at least a portion
of one Y column.

Line
Horizontal Step

•

Multiple Y columns are grouped in layer.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

Vertical Step
Spline
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or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.
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Graph Types

Line + Symbol
Line Series

Notes

•

Start with a Worksheet.

•

Select one or more Y columns or at least a portion
of one Y column.

•

Multiple Y columns are grouped in the graph layer
(except Line Series).

Before and After Graph

•

For Line Series graph, select 2 or 3 Y columns.

•

If there is an associated X column, X column

2 Point Segment

supplies X values; otherwise, Y sampling interval
or row number is used.

3 Point Segment

•

For specific data requirements, follow links in the
Graph Types column.

Spline Connected

•

Start with a Worksheet.

•

For Bar, Column or Column + Label, select one or
more Y columns (multiple Y columns are grouped
in layer).

Lollipop Plot
Vertical Drop Line

•

For Floating Bar/Column, select two Y columns.

•

For Stack graphs and Lollipop plots, select two or
more Y columns.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.

•

Start with a Worksheet.

•

Select one Y (Density Dots) or two Y (Color Dots)
columns.

Density Dots

•
Color Dots

For more information, follow links in the Graph
Types column.
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Graph Types

Colormapped Line Series

Offsets

Notes

•

Start with a Worksheet.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

Stacked Lines by Y

•

For specific data requirements, follow links in the
Graph Types column.

Row-wise

11.5.1.2 Bar, Pie, Area

Graph Types

Notes

Column
Column + Label

•

Start with a Worksheet.

•

For Bar, Column or Column + Label, select one or

Bar

more Y columns (multiple Y columns are grouped
in layer).

Stacked Column
Stacked Bar
100% Stacked Column

•

For Floating Bar/Column, select two Y columns.

•

For Stack graphs and Lollipop plots, select two or
more Y columns.

•

supplies X values; otherwise, Y sampling interval
or row number is used.

100% Stacked Bar

•
Floating Column
Floating Bar
Kite Diagram
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If there is an associated X column, X column

For specific data requirements, follow links in the
Graph Types column.

Graphing

Graph Types

Notes

3D Color Pie Chart
2D Color Pie Chart
Doughnut Plot

•

Start with a Worksheet.

•

Select exactly one Y column or a range from one Y
column.

Pie of Pie

•

used in the graph legend; otherwise row number is

Bar of Pie
Doughnut of Pie

If there is an associated X column, the X data are
used.

•

For specific data requirements, follow links in the
Graph Types column.

Doughnut with Total
Pie with Different Radius

Radius

Origin 2022b New Graph
Type: Bar Map

Doughnut with Different

Pie Map
Bar Map

Area
Stacked Area
100% Stacked Area
Fill Area

•

Start with a Worksheet.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.

Fill 2 Colors
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11.5.1.3 Multi-Panel/Axis

Graph Types

Double-Y Column Graph

Notes

•

Start with a Worksheet.

•

Select two Y columns.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

Double-Y
2Ys, ColumnLine&Symbol

3Ys Y-YY
3Ys Y-Y-Y

or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.

•

Start with a Worksheet.

•

Select one Y column for each Y axis.

•

Multiple Y Axes opens interactive dialog. Choose
plot type, number of axes, plots per layer, axis

4Ys Y-YYY

color to match plot, etc.

•
4Ys YY-YY

For specific data requirements, follow links in the
Graph Types column.

Multiple Y Axes...

Vertical 2 Panel
Horizontal 2 Panel
4 Panel
9 Panel
Stack...

Label...
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Multiple Panels by

•

Start with a Worksheet.

•

Select one Y column (or range) per panel.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.
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Graph Types

Notes

•

Start with a Worksheet.

•

Select at least one Y column or a range from at
least one Y column.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

Zoom

or row number is used.

•

For specific data requirements, follow the link in
the Graph Types column.
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11.5.1.4 Statistical

Graph Types

Box Chart

Plot

Interval

Notes

•

Start with a Worksheet.

•

Select at least one Y column or a range from at least one Y column.

•

For specific data requirements, follow the link in the Graph Types
column.

Bar Chart

Overlap

Normal

Box

•
•

Normal

Bar

Bar

Scatter
Interval
Marginal
Box Charts

m Plot
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Beeswar

An Edge Thickness control is added to the Plot Details
Percentile tab of box plots.

Box

Half Box

Overlap

Box chart enhancements for Origin 2022b

The Connect Lines tab now supports a choice of
connection types (e.g. Akima Spline) in addition to
straight.
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Graph Types

m

Notes

Histogra

Histogra
m + Rug
Histogra
m + Probabilities
MultiPanel Histograms

on

Distributi

Distributi
on + Rug

•

Start with a Worksheet.

•

Select at least one Y column or a range from at least one Y column.

•

For specific data requirements, follow links in the Graph Types column.

•

Start with a Worksheet.

•

Select two Y columns or a range from two Y columns.

•

For specific data requirements, follow the link in the Graph Types

Histogra
m with Labels
Stacked
Histograms
Populatio
n Pyramid
Marginal
Histograms
Marginal
Plots (Grouped
Marginal
Histogram)

Matrix

Scatter

column.
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Graph Types

Plot

Notes

Violin

Violin
with Box
Violin
with Point
Violin
with Quartile
Violin
with Stick
Split Plot

Violin

Chart

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at least one Y column).

•

Split violin requires exactly 2 data columns, plus a third grouping
column.

•

Violin Plot.
For data requirements and other information on Ridgeline Charts, follow the
link in the Graph Types column.

Half

Ridgeline

Pareto
Chart - Binned
Data

•

Start with a Worksheet.

•

Select one Y columns or a range from one Y column (Raw), or a Y
column of Binned results.

•

QC (X-bar
R) Chart

For specific data requirements, follow the link in the Graph Types
column.

Pareto
Chart - Raw Data

190

For data requirements and other information on plot variations, see

•

Start with a Worksheet.

•

Select at least one Y column or a range from at least one Y column.

•

For specific data requirements, follow the link in the Graph Types
column.

Graphing

Graph Types

Chart

Notes

Bridge

Stacked
Bridge Chart
Stacked
Total Bridge
Chart

•

Start with a Worksheet.

•

Select one or more Y columns (or a range of one or more Y columns). If
there is an X column to the left of the Y column(s), this X column is
treated as categorical data; otherwise, the worksheet's row indices will
be used.

•

information, see Bridge Charts.

HorizBridge Chart

Box

y Plot

Origin Bridge Charts are variants of one basic chart type. For more

Double Y

Probabilit

•

Start with a Worksheet.

•

Select one Y column or a range from one Y column.

•

For specific data requirements, follow the link in the Graph Types
column.

Q-Q Plot

BlandAltman Plot

•

Start with a Worksheet.

•

Select two Method columns and one Subject column (optional).

11.5.1.5 Contour

Graph Types

Contour - Color Fill

Labels

Contour B/W Lines +

Gray Scale Map

Notes

•

Contour Color Fill, B/W Lines + Labels, Gray Scale
Map, Contour Profiles: XYZ, Virtual Matrix,
Matrix.

•

Contour - Categorical Z: XYZ, Virtual Matrix.

•

For specific data requirements, follow links in the
Graph Types column.

Contour - Categorical Z
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Graph Types

Notes

•

Worksheet (XY, XYZ), Virtual Matrix or Matrix.

Heatmap
Heatmap with Labels

Heatmap and Heatmap with Labels start with a

•

Split Heatmap starts from a Worksheet.

•

For specific data requirements, follow links in the
Graph Types column.

Split Heatmap

•
Contour Profiles

Matrix (Image Profiles, Matrix only).

•

•

Start with a Worksheet or Matrix.

•

For data requirements and other information on
polar contour graphs from worksheet data, see

Polar Contour theta(X),

Polar Contour from XYZ Data.

•
Polar Contour r(X),
theta(Y)

Ternary Contour

For specific data requirements, follow links in the
Graph Types column.

Image Profiles

r(Y)

Start with a Worksheet, Virtual Matrix or

For data requirements and other information on
polar contour graphs from matrix data, see Polar
Contour from Matrix Data.

•

Start with a Worksheet.

•

Columns should be designated as XYZZ.

•

For specific data requirements, follow the link in
the Graph Types column.

•

Start with a Worksheet.

•

Select at least one Y column or a range from at
least one Y column.

2D Kernel Density

•

For specific data requirements, follow the link in
the Graph Types column.
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Graph Types

Notes

•

Start with a Matrix.

•

Z values are from an imported raster image.

For Origin 2022b, a
Transparency control is
added to the Plot Details
Colormap tab of Image Plots.

Image Plot

11.5.1.6 Specialized

Graph Types

Notes

•

Start with a Worksheet.

•

For XYAM Vector, select three Y columns (or a
range of the three Y columns).

Vector XYAM

•

For XYXY Vector, select two X columns and 2 Y
columns (or a range of two X and two Y columns).

Vector XYXY

•

For specific data requirements, follow links in the
Graph Types column.

Streamline Vector Plot

•

Start with a Matrixsheet with two matrix objects.

•

The two matrix objects are the derivatives of the
plotted curve in the (x,y) directions, respectively.
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Graph Types

Notes

Ternary
Ternary, Line+Symbol
Ternary, Line

•

Start with a Worksheet.

•

For specific data requirements, follow links in the
Graph Types column.

Right-Triangle Ternary
Piper

Origin 2022b New Graph
Type: Right-Triangle
Ternary

Stiff
Stiff Map
Schoeller
Durov

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at
least one Y column). The X column displays as the

Radar

title of the radial axis around the chart. If there is
an associated X column, X column supplies X

Line Fill
Line
Symbol
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values; otherwise, Y sampling interval or row
number is used.

•

Radar Charts are also known as "Spider Plots".

•

For more information, see Radar Chart (Spider
Plot).

Graphing

Graph Types

Notes

Polar theta(X) r(Y)
Polar r(X) theta(Y)
Bar theta, r
Bar r, theta

•

Start with a Worksheet.

•

Select one or more Y columns or a range from one
or more Y columns. If there is an associated X
column, X column supplies X values; otherwise, Y

Line + Symbol theta, r

sampling interval or row number is used.
Line + Symbol r, theta

•

For data requirements and other information on
polar graphs, see Polar Graph.

Symbol theta, r
Symbol r, theta
Wind Rose - Binned Data
Wind Rose - Raw Data

•

Start with a Worksheet.

•

Select at least one Y column of values (or a range
from at least one column). If there is an

Stacked Radial

associated X column, X column supplies X values;
otherwise, Y sampling interval or row number is

Radial Bar Plot
Radial Stacked Bar

used.

•

For more information, see Radial Bar and Radial
Stacked Bar Plot

•

Start with a Worksheet.

•

For Compass, Select at least one Y column of
values (or a range from at least one column). If
there is an associated X column, X column supplies

Polar Vector θr θr]
Compass Plot

X values; otherwise, Y sampling interval or row
number is used.

•

For Polar Vector θr θr, select two pairs of XY
columns in the order θr θr.
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Graph Types

Notes

•

Start with a Worksheet.

•

Select at least one Y column of values (or a range
from at least one column). If there is an
associated X column, X column supplies X values;
otherwise, Y sampling interval or row number is

Smith Chart

used.

•

For more information, follow the link in the Graph
Types column.

High-Low-Close
Japanese Candlestick

•

Start with a Worksheet.

•

For specific data requirements, follow links in the

OHLC Bar Chart

Graph Types column.

OHLC-Volume
Line

Bullet Chart
Vertical Bullet Chart
Normalized Bullet Chart
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•

Start with a Worksheet.

•

Select one X column and at least two Y columns.

•

For more information, see Bullet Chart.

Graphing

11.5.1.7 Categorical

Graph Types

Grouped Scatter Indexed Data

Notes

•

Start with a Worksheet.

•

Select at least one Y column as input data.

•

One or more column(s) of categorical data provide
grouping information.

•

For more information, see the link in the Graph
Types column.

•

Start with a Worksheet.

•

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval

Color Mapped
Bubble + Color Mapped

or row number is used.

•

For specific data requirements, follow links in the
Graph Types column.

•

Start with a Worksheet.

•

Select at least one Y column (Grouped Columns)
or two Y columns (Grouped Floating Bar).

•

supplies X values; otherwise, Y sampling interval

Grouped Columns Indexed Data
Grouped Floating Bar

If there is an associated X column, X column
or row number is used.

•

For Grouped Columns - Indexed Data, an
additional column supplies the Group information.

•

For Grouped Floating Bar Graphs, subgroup by
size (i.e. number of columns) or by column label.
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Graph Types

Notes

Grouped Box Charts Indexed Data
Grouped Box Charts Raw Data
Grouped Column Scatter Indexed Data

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at
least one Y column), plus a second column with
grouping information. If there is an associated X

Grouped Interval Plot Indexed Data
Grouped Mean Bar Indexed Data

column, X column supplies X values; otherwise, Y
sampling interval or row number is used.

•

the Grouped Box.

•
Data

Plots of Indexed Data are all style variations of

Grouped Violin - Indexed

For more information, follow the links in the
Graph Types column.

Grouped Half Violin Indexed Data
Grouped Half Box Indexed Data

•

Start with a Worksheet.

•

Select at least one Y column as input data.
Optionally, you can have an additional associated
Y error column for each Y column. Other column(s)
generally contain grouping information.

Trellis Plot

•

For more information, see the link in the Graph
Types column.

•

Start with a Worksheet.

•

Select two Y columns as input data. Optionally,
you can have an additional associated Y error
column for each Y column. Other column(s)
generally contain grouping information.

Double Y Trellis Plot

•

For more information, see the link in the Graph
Types column.
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Graph Types

Notes

•

Start with a Worksheet.

•

You need at least two Y columns, one of which
should contain grouping information.

•
Cluster Plot

Grouping columns can be used to create separate
panels in the horizontal and/or vertical directions
and/or to modify plotted points (color, scatter
point size, scatter point shape, etc.).

•

Start with a Worksheet.

•

Select at least one (ideally, two or more)
column(s) or a range from one or more columns.
Column designation does not matter. Each column

Parallel Plot
Parallel Sets

will be treated as data on a single variable.

•

Variables may be numeric (Parallel Plot or Parallel
Index) or they may be categorical (Parallel Sets).

•

Parallel Sets plots have a "curvature" option that is
sometimes seen in plots termed "Alluvial

Parallel Index

Diagrams" (see next).

•

For more information, follow links in the Graph
Types column.

•

Start with a Worksheet.

•

For Sankey Diagrams, select exactly two columns
of categorical data + 1 column of numeric data.
Column designation is ignored

•

For Alluvial Diagrams, select two or more columns
of categorical data. Column designation is ignored.

Sankey Diagrams

•

For more information, follow links in the Graph
Types column.

Alluvial Diagrams
For Origin 2022b, an effort
was made to improve
responsiveness when
highlighting or dragging
(moving) nodes in Sankey
Diagrams.
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Graph Types

Notes

•

Start with a Worksheet or Virtual Matrix.

•

Select at least three columns of values
(worksheet) or a block of values (virtual matrix)

Chord Diagram

Layout

from at least three columns.

•

The first column will be treated as X and should be
monotonic.

Chord Diagram with Ratio

•

For more information, see Chord Diagram and
Chord Diagram with Ratio Layout.

Ribbon

•

Start with a Worksheet.

•

Select at least two Y columns of values (or a range
from at least two columns).

•

If there is an associated X column, X column
supplies X values; otherwise, sampling interval of

100% Ribbon

the Y column or row number is used.

•

Start with a Worksheet.

•

The plot requires one of three data arrangements:
Adjacency matrix, Incidence Matrix or Edge List.

•
Network

A dialog box is used to specify input and analysis
parameters.

•

Regardless of data arrangement, an intermediary
worksheet will be created to tabulate node and link
information.

•

Start with a Worksheet.

•

Select multiple categorical X columns and one Y
column.

Sunburst Plot
Circular Packing Graph
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Origin 2022b New Graph
Type: Circular Packing
Graph

Graphing

11.5.1.8 3D

Graph Types

Notes

3D Scatter
3D Scatter + Error Bar

•

Data requirements vary by plot type. See links in
the Graph Types column.

3D Line
3D Trajectory

•

Start with a Worksheet.

•

Select 6 worksheet columns, designated as XYZ
XYZ.

3D Vector XYZ XYZ

•
3D Vector XYZ dXdYdZ

3D Bar Graph
3D Stacked Bars Graph

For more information, see links in the Graph
Types column.

•

Start with a Worksheet (XYZ) or a Virtual
Matrix or Matrix of Z values.

•

For specific data requirements, follow links in the
Graph Types column.

Graph

3D 100% Stacked Bar
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Graph Types

Notes

Color Fill Surface

Surface

Surface

X Constant with Base

Y Constant with Base

•

Start with a Worksheet or Matrix.

•

For specific data requirements, follow links in the
Graph Types column.

Color Map Surface
Color Map Surface with
Projection
Wire Frame
Wire Surface

Surface

•

Start with a Worksheet.

•

Select two Z columns (XYZZ) or a range of data
from two Z columns (Z columns may be multiples

3D Ternary Colormap

of 2).
3D Ternary Symbol

•

For more information, follow links in the Graph
Types column.

•

Start with a Worksheet.

•

Select two Z columns (XYZZ) or a range of data
from two Z columns (Z columns may be multiples

3D Tetrahedral

of 2).

•

For more information, follow links in the Graph
Types column.
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Graph Types

Waterfall

Notes

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at
least one Y column). Ideally, select at least two Y
columns (or a range of at least two Y columns). If

Waterfall: Y Color
Mapping

there is an associated X column, X column supplies
X values; otherwise, Y sampling interval or row

Waterfall: Z Color
Mapping

number is used.

•

For more information, see the links in the Graph
Types column.

3D Waterfall
3D Waterfall: Y Color
Mapping

Waterfall, Waterfall: Y
Color Mapping and
Waterfall: Z Color Mapping,
are only available from the 2D
Graphs toolbar.

3D Waterfall: Z Color
Mapping

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at

XYY 3D Bars

least one Y column). Ideally, select at least two Y
columns (or a range of at least two Y columns). If

XYY 3D Side by Side Bars

there is an associated X column, X column supplies
X values; otherwise, Y sampling interval or row

XYY 3D Stacked Bars

Bars

XYY 3D 100% Stacked

number is used.

•

For more information, see the links in the Graph
Types column.

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at
least one Y column). Ideally, select at least two Y
columns (or a range of at least two Y columns). If
there is an associated X column, X column supplies
X values; otherwise, Y sampling interval or row

3D Ribbons

number is used.

•

For more information, see the link in the Graph
Types column.
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Graph Types

Notes

•

Start with a Worksheet.

•

Select at least one Y column (or a range from at
least one Y column). Ideally, select at least two Y

3D Wall Graph

columns (or a range of at least two Y columns). If
there is an associated X column, X column supplies

3D Stacked Wall Graph

Graph

3D 100% Stacked Wall

X values; otherwise, Y sampling interval or row
number is used.

•

For more information, see the link in the Graph
Types column.

For an overview of Origin's 3D graph types and their source data requirements, see these topics:

•

Creating 3D Graphs

•

3D and Contour Graphing

•

Creating Contour Graphs

•

Creating 3D and Contour Graphs from Virtual Matrix

11.5.1.9 Browser Graph

Browser graphs are useful for selectively plotting data from worksheets containing many columns (and rows),
into a single graph layer:

•

Select a single plot or every Nth column for plotting.

•

Easily change column selection.

•

Stretch the window in either dimension to obtain the best view.

•

Specify automatic rescale and/or common display range for all plots.

•

Works with other Origin tools including Gadgets.

•

Plots can be further customized via Plot Details dialog box.
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The page-level Mini Toolbar includes an Add Browser button so that you can add a
Browser panel to a regular 2D line plot.

Graph Types

Black Lines

Notes

•

Starts with a Worksheet.

•

Plot selected Y columns, plot every nth column or
plot all columns.

Color Lines

•
Histogram

For more information on use and configuration of
Browser Graphs, see Graph with Browser Panel

Stack

11.5.1.10 Function Plot

Graph Types

Notes

•

Function plots are not created from physical data.

•

Once a function plot is created, you can obtain the
derived dataset.

New 2D Plot

•
New 2D Parametric Plot

in the Graph Types column.

•

Function plots are not created from physical data.

•

When a 3D Function is plotted, a matrix of Z
values is simultaneously generated.

New 3D Plot

•
New 3D Parametric Plot

For more information on function plots, follow links

For more information on function plots, follow links
in the Graph Types column.
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11.5.1.11 My Templates

Dialog Box

Notes

•

This Category lists and gives direct access to the
custom templates in your User Files Folder.

My Templates

11.5.1.12 Other Graphing Tools

App

Notes

•

The Graph Maker app is pre-installed in your
Origin software.

•

Launch the App from the Plot menu or from the
Graph Maker app icon in the Apps Gallery to the
right side of your Origin workspace.

•

Use the Graph Maker app with Preview pane, to
interactively plot grouped data.

Graph Maker App

•

Choose from line, scatter, line+symbol, column,
box and histogram chart types.

•

Supports fitting for scatter plots.

•

Drag-and-drop worksheet columns to set up the
graph.

Template Library

11.6 Topics for Further Reading
•

The Page-Layer-Plot Hierarchy

•

Page Viewing Modes

•

Graph Template Basics

•

Creating Graphs from Graph Templates

•

The Graph Template Library

•

Graph Axes
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•

Graph settings are saved and can be re-loaded.

•

Use this dialog to organize your custom graphing
templates.

Graphing

•

Zooming In or Out on the Graph Page

•

Creating Multi Layered Graphs

•

Adding Data Plots to the Graph Layer

•

The Layer Contents Dialog Box

•

The Object Manager

•

Graph Layers

•

Linking Layers

•

3D and Contour Graphing

•

Graph with Data Slicer

•

Plotting Mathematical Functions

•

Batch Plotting

•

Appendix 2 - Complete Listing of Origin Graph Types
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12 Customizing Graphs

12.1 Introduction
This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph
template. If the graph you are making is fairly standard for its type, the options that were stored in the graph
template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation
was covered in the last chapter, Graphing.
Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors.
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and
techniques, as well as to point you toward resources that will help you manage more complex graph
customization tasks.
We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are
commonly used for quick modifications of graph elements.
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12.2 Dockable Toolbars
Toolbar buttons useful for graph customization tasks, include the following:

Description

Format toolbar buttons:

•

Creating and
customizing text
objects.

Style toolbar buttons:

•

Editing colors, line
thickness, fill patterns.

Tools toolbar buttons:

•

Add text objects,
lines, curves, arrows,
rectangles/circles/poly
gons.

Graph toolbar buttons:

•

Add graph layers incl.
inset graphs, merging
or extracting graphs;
exchanging axes;
anti-aliasing and
Speed Mode.
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Toolbar
(default configuration)

Customizing Graphs

Toolbar
(default configuration)

Description

Add Object to Graph toolbar
buttons:

•

Add legends/color
scales/bubble scales;
date & time and
project path stamps;
XY scale; table
objects.

Object Edit toolbar buttons:

•

Arranging and aligning
objects and layers on
the page.

12.3 Menus, Dialogs and Buttons Used in Graph Customization
Many quick graph customizations can be done using Origin's graphing Mini Toolbars. More complex
customization options can be accessed from commands on the Format or Graph menus. The following table
lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs.

Task

Dialog Name

Method

•

Double-click on Page, Layer or Data
Plot

Customize the graph
Page, Layer, or Data
Plot

Plot Details dialog

•

Format: Page... menu

•

Format: Layer... menu

•

Format: Plot... menu

See, Customizing Page, Layer and Data
Plots
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Task

Customize Axes

Dialog Name

Axis Dialog

Method

•

Double-click on axes or tick labels

•

Format: Axes... menu

•

Format: Axis Tick Labels... menu

•

Format: Axis Titles... menu

See, Customizing Graph Axes

•

Click the Reconstruct Legend
(CTRL+L)

button on the Add

Object to Graph toolbar
Add a Default
Legend
(most 2D
graphs)

•

Right-click on the legend object and
choose Legend: Reconstruct

N/A

Legend

•

Choose Graph: Legend:
Reconstruct Legend from the main
menu

See, Graph Legends

•

Ctrl + double-click on the legend
object text

(Text Object -)
Legend dialog

See, The (Text Object Properties) Text tab

•

Right-click legend and choose
Legend: Update Legend or choose

Update Legend
dialog

Graph: Legend: Update Legend...
See, The legendupdate Dialog Box

Customize the
Legend

•

Double-click in the white area just
inside graph window frame (but
outside of the data plot), then click on

Legends/Titles tab
at Page level of Plot
Details dialog

the Legends/Titles tab

•

Choose Format: Page and click on
the Legends/Titles tab

See, The (Plot Details) Legends/Titles tab
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Task

Dialog Name

Method

•
Add a Color Scale
(color-mapped plots)

Click the Add Color Scale

button

on the Add Object to Graph toolbar

N/A

See, Color Scales

•
Add a Bubble Scale
(symbol-size mapped
plots)

Click the Add Bubble Scale
button on the Add Object to Graph

N/A

toolbar
See Bubble Scale

•
Merge multiple graph
windows into one
graph window

menu
Merge Graphs dialog
See, Merge and Arrange Graphs (tutorial)
and The Merge Graph Dialog Box.

Adjust multi-layer
graphs:
resize, move, swap,
align, or add layers

Layer Management
dialog

Simple adjustment of
multi-layer graphs:
arrange and/or resize
layers

Arrange Layers
dialog

Save settings as
graph template

Graph: Merge Graph Windows...

•

Graph: Layer Management... menu

•

Right-click on the layer icon.

See, Layer Management-Quick Start

Save Template As
dialog

•

Graph: Arrange Layers... menu

•

Right-click on the layer icon.

•

File: Save Template As... menu

•

Right-click graph window title and
choose Save Template As...

See, Graph Template Basics

•
Manage graph
templates,
plot to a template

Template Library

Plot > Template Library menu
(worksheet or matrixsheet is active)

See, The Graph Template Library
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Task

Dialog Name

Method

•
Save settings as
graph Theme

Right-click and choose Save Format
as Theme... context menu (graph is

Save Format as
Theme dialog

active)
See, Saving Formats to a Theme

•
Manage Graph
Themes: edit,
combine, apply
Theme, set as
System Theme

Theme Organizer
dialog

Preferences: Theme Organizer.. >
Graph tab.

•

F7 hotkey.

See, Theme Organizer

12.4 Quick Editing: Mini Toolbars and Object Manager
While the dialog boxes listed in the previous section will provide full access to plot properties, settings are
sometimes buried and hard to find. Often, the most convenient way to carry out common graph editing tasks
is to use Mini Toolbar buttons or Object Manager short-cut menu commands -- or a combination of the two.

12.4.1Mini Toolbars for Graph Editing
Most Origin graphs support a set of "quick editing" tools for interactively modifying common graph object
properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, (2)
what the selected object is and (3) whether you have selected an individual plot or a plot group -- you will
have a different set of tools available to edit your selection.

•
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Workspace display of Mini Toolbars is controlled via View: Mini Toolbars.

Customizing Graphs

•

There are five levels -- i.e. five groupings of graph properties -- that can be edited with Mini Toolbars:
page, layer, plot, text or drawn objects and graph axes.

•

When editing grouped plots, a single click will select a single plot. The Mini Toolbar displays two tabs -one for the customizing the group, the other for customizing the single plot.

•

Most Mini Toolbars have a "properties"

button that opens a related Origin dialog box where you will

find the full range of available controls.

Unless you have changed your selection, you can do a one-time restore of a Mini
Toolbar after it has faded by pressing the SHIFT key.

Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
sessions (i.e. if turned off in the current session, they would be restored on Origin
restart). Now, this setting is remembered across sessions (alternately, you can control
Mini Toolbar display by setting system variable @DMT (ON=0; OFF=1)).

12.4.1.1 Controlling Buttons that Increment
Some Mini Toolbar buttons will increase or decrease some property by some increment, each time you click
the button (e.g. font size, rotation angle, layer grid spacing). In such cases, you can modify that increment by
manipulating the value of a LabTalk system variable.

For information on these LabTalk system variables, see this Appendix in Origin Help.

12.4.2Manipulating Graphs with the Object Manager
The Object Manager is general tool for managing Origin windows but it is especially useful for manipulating
graph windows. When a graph window is active, the Object Manager offers alternate views -- toggled by right-
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clicking in an empty portion of the Object Manager and choosing Show Plots or Show Graph
Objects(Ctrl+Shift+S):

•

Show Plots: a collapsible, hierarchical list of plots by layer, plot group, etc.

•

Show Graph Objects: a collapsible, hierarchical list of window objects (legends, text objects, images,
etc.) by layer.

Object Manager Tips:

•

Whether in Show Plots or Show Graph Objects view, right-clicking on an element will open a shortcut
menu of relevant actions (ungrouping a set of plots or designating a plot as the first plot in a plot group,
for instance).

•

Common to both views is a check box beside each element; when checked, the element displays in the
graph window, when cleared, the element is hidden.

•

Additional shortcuts give quick access to source data, to Plot Details, allow you to rearrange plot or object
order and to other relevant tasks such as opening an inserted image in an Image window for further
editing.

12.4.3Editing Graphs Using Object Manager and Mini Toolbars
When a graph is active and you select graph elements in the Object Manager, a Mini Toolbar will show (make
sure the Mini Toolbars option is checked in the Show Plots/Show Graph Objects shortcut menu as shown
in the image above).
With the available buttons, you can make quick customizations to common plot properties such as line color,
line thickness, display of labels, etc.

New in Origin 2022b: In Object Manager Show Graph Objects view, a new Select
All with Same Name shortcut menu entry. Use in combination with Mini Toolbar
buttons (e.g. Font Size) to make quick graph changes.

12.5 Customizing Page, Layer and Data Plots
A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are
editable properties at the Page, Layer, Data Plot and Data Point levels.
Quick formatting of many plot properties can be done using Mini Toolbar or dockable toolbar buttons, as
mentioned above. However, more comprehensive access to plot properties is available from each graph's Plot
Details dialog box.
To open Plot Details:

•
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Double-click on your plot.
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•

Click the Format menu, then choose Page..., Layer... or Plot..., to open Plot Details at the
corresponding level.

The figure below shows an example of the Plot Details dialog box:

•

The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree.

•

The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in
the left panel.

•

To customize an object, select it in left panel and modify the corresponding properties that appear on
the various tabs in the right panel.

Selected Left Panel
Object

Page

Right Panel, Controls for...

Settings that pertain to the whole page -- Print/Dimensions, layer drawing orders,
page display color, legends/titles, etc.
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Selected Left Panel
Object

Right Panel, Controls for...

Layer

Settings that are specific to the graph layer -- Layer background colors, layer size
and speed mode settings, layer display settings, stack settings for applicable plot
types. Some plot types will include extra tabs/controls specific to the plot type.

Plot

Plot-specific properties. The tabs and controls vary by plot type (e.g. Scatter plots
have a Symbol tab with controls pertaining to scatter symbols, Line plots a Line tab
with controls pertaining to line plots). Anything to do with a particular data plot -color, fill patterns, colormapping, labeling -- will be found at this level in Plot Details.

Data Point

Properties that apply to user-specified "special points". Available for any plot for
which plots discrete points (scatter, line + symbol, column/bar, etc.). The tabs and
controls are generally similar to those available at the Plot level but any property that
you set at the level of a special point, will apply only to that point.
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Prevent text and label objects from scaling when resizing layer, by going to the Size
tab of Plot Details (Layer level) and setting Fixed Factor to 1.

12.5.1Customizing Grouped Plots

Beginning with Origin 2020, there was a change in selection behavior that affects
grouped plots. Now, a single-click on a plot selects the plot. A second click (or
CTRL+click) selects a single point. SHIFT+click selects the entire group. Note that when
using the new mini toolbars, a single click on a plot group displays tools for editing the
plot group or the single, selected plot. To revert to the old plot selection behavior, set
@GSM=0.

When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer.
Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or
more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.).
By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the
"Candy" color list and each successive plot is assigned the next color in the list) and some will be configured
not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any
case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so
that you can easily use them later to create graphs with the same look.
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The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this
Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol
Interior. Properties of Line Color, Symbol Type and Symbol Edge Color are set to increment By One and
Between Subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol
Interior are set to increment by None (they do not vary).
As previously mentioned, this arrangement is completely customizable and you can save customizations with
the graph template:

•

To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab
Controls.

•

To find out more about saving graphs as templates, see Graph Template Basics.

12.5.1.1 Using Object Manager with Grouped Plots

•

To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in
Object Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph
window, while dimming others.

•

To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object
Manager) and choose Move Up or Move Down.

•

To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To
group plots in the layer, right-click on a plot and choose Set as Group Begin.
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•

To move a plot from one group to another, drag the plot to the other group.

•

To move a series of plots out of the group, right-click the last plot that you want to keep in the group and
choose Set as Group End.

•

To remove a plot from the layer (and the graph), right-click on the plot and choose Remove.

•

To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object
Manager and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer ....

12.5.2Customizing Multi-layer Graphs
The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin
graphs (e.g. a graph with both left and right Y axes is constructed by overlaying one layer on another, and
sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-contained
unit it is, at times, desirable to create dependencies between layers:

•

One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships
or relationships between axis scale values. You can read more about linking graph layers, below.

•

Another type of dependency is based on what we call "common display" and this is most useful in a
situation where we have multiple similar panels in a graph and we want to do something like change the
background color of each graph, or perhaps the change plot colors used in each layer.

For Origin 2022b, a new Add Label for Layers button is added to the page-level Mini
Toolbar (hint: click outside of graph layers to show).

At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within
a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot
and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis
plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely
different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously
add a background color to both layers. We could have accomplished the same thing without using the Common
Display controls but this would have required twice the work -- set the background color of layer 1, then set
the background color of layer 2.
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This was a simple illustration but we can use the Common Display controls for application of more complex mix
of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display
elements turned on by default. When working with multi-panel graphs, you may want to choose Format:
Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display
for more information.
The Common Display Apply to control supports including or excluding certain layers
from common display customizations. For instance, you might have a 4 panel graph,
each with an inset layer and using this control, you could apply a common background
color to the inset layers without applying the same background color to the 4 primary
layers (panels). See Common Display for more information.

12.5.3Special Points: Customizing a Single Data Point

You can customize line style within a single data plot (e.g. between data points in a line
+ symbol plot). For Origin 2022b, you can assign line style according to a custom
increment list.
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1.

Double-click on the plot to open Plot Details, then click the Line tab.

2.

Set Style = Increment, adding a Line Style List tab.

3.

Enable custom increment list and customize the list as needed.
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For some plot types such as scatter, column or pie, you can modify the display properties of a single data point.
To edit a single point:
1.

Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit
properties of the data point; or click available buttons on the Style or Format toolbars.

2.

For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL +
double-click on an unselected data point. This opens the Plot Details dialog box with the focus set to edit
the data point (identified in the left-panel of Plot Details by its row index number). Then use controls on
the tabs in the right panel to modify the appearance of the data point, add drop lines, data label, etc.
Changes you make to the special point will not affect the appearance of other points in the same plot.
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Note:: When the Custom Construction box is checked, you can use these controls to customize the
plot symbol of the selected point. Custom Construction can be applied to any plot symbol -- not
simply those that are designated as special points.

Origin supports adding your own plot symbols. For more information, see User
Defined Symbols Grid.

To remove customizations made to a single data point:

•

Right-click the single point in the left panel of the Plot Details dialog and choose Delete.

•

In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point itself is not deleted; only the custom style is removed, with the point reverting to the style of the
containing data plot.
Adding a special point at the beginning or end of a plot is not always easy, but there is a
simple, foolproof technique:
1.

Select a special point anywhere on the plot, then double-click on the point to open Plot
Details.

2.

In the left-hand panel of Plot Details, click once on on the point index number and
wait until the index number becomes editable.
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3.

To add the special point to the first point in the plot, type Begin; to add to the last
point type End. If you know the index number of the first or last point, you can type
that instead.

4.

Click outside the edit box. Make other special point customizations as needed, the click
Apply or click OK to close Plot Details. The special point will be added to the beginning
or end of your plot.

12.6 Customizing Graph Axes
Many common edits to axis properties can be done quickly from Mini Toolbar buttons. Click on an element
to edit.

For more complex edits of axis properties, open the Axis Dialog:

•

from the Axis Mini Toolbar > Open Properties Dialog.

•

from the Origin menu > Format: Axes.

12.6.1Customizing Axes with Mini Toolbars
For quick adjustments to axis properties, you can use Origin's axis Mini Toolbars. As with all Mini Toolbars,
available tools will vary by plot type and selected object. For instance, note that clicking on a graph axis line
brings up a different set of buttons than clicking on the axis tick labels.
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Note that clicking the "gear" button on the axis line Mini Toolbar produces a popup menu with simplified "Mini
Dialogs" for axis line elements. For access to all axis settings, click Axes Dialog on either toolbar.

12.6.2Customizing Axes with the Axes Dialog Box
All graph axis customizations can be made in the Axes Dialog box. Click on the Mini Toolbar "gear" button
and choose Axes Dialog; or double-click on the graph axis or tick labels. This will open the Axis Dialog Layer N dialog box.
This image shows the tab-based axis dialog used by most 2D and 3D graphs.

In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the
axis or axes to be customized, then select the desired tab and choose your options.
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Tab

Scale

Controls for
Scale range of values, scale type, rescale mode and margin, reverse scale, major and
minor ticks.

Display and Format options for major and minor tick labels, including custom labeling using
LabTalk substitution or mathematical expression. For information on custom formatting of
numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon)
formats, see Origin Custom Formats.
Tick Label additions to Origin 2022b:

•

Previously, users had to set page.longminus=1 to use a
Unicode (long) minus sign in tick labels. Now, all graphs

Tick Labels

created from system templates will automatically use the
"long minus" (to roll back this change, set @TNA=2 or
=3).

•

Axis dialog Display tab controls for displaying scientific
notation (base + exponent) at a single location along the
axis, rather than appending it to each significand.

Title

Axis title (often set using variable notation) and font options. Note that you can directly edit
by double-clicking the text object in the graph.

Grids

Control display and properties of grid lines at major and minor ticks.

Line and
Ticks

Global axis line and tick display options for all axes.

Special
Ticks

Placement of special tick labels.

Reference lines are optional lines that you add to your graph, either for emphasis or to
mark some key statistic. Additionally, they can be paired to add fill color to some portion of
your graph (e.g. "recession bars" in plots of financial data).
Reference
Lines

Breaks

You can use named ranges to place Reference Lines on a
graph.

Enable line breaks and configure each break.
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Click the Apply To... button to apply the axis format settings of the currently selected
axis to another axis.

Origin 2022b supports wrapping of tick labels for languages which typically do not use
space between characters (e.g. Japanese or Chinese). Controls are found at Format:
Axes > Tick Labels > Format > Wrap Text.

Note: For more information on axis customization and for axis controls for specialized graph types (e.g.
polar, ternary, radar chart.etc), refer to:
Help: Origin: Origin Help > Graphing > Graph Axes

12.7 Customizing Data Plot Colors
Origin ships with a number of installed color lists or palettes. If you prefer to create your own color lists or you
have a standard set of palettes and want to port them over to Origin, there are a number of tools available in
the software for doing that. See the next section, Color Manager, for more information.

12.7.1Color Manager
Use the Color Manager for importing, creating and organizing the color lists and palettes that you use in
Origin:
To open the Color Manager:
1.
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Choose Tools: Color Manager.
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The following list numbers correspond to controls shown in the image above:
1.

Click these radio buttons to display installed Color Lists or Palettes.

2.

Click Import from Web to open a dialog where you can specify a URL to install palettes. Support for
Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch
Exchange (.ase) and JASC PaintShopPro (.pal).

3.

Click to install locally-stored palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color
(.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).

4.

Click to open the Build Colors dialog where you can build a color using a number of tools: using standard
color controls, direct entry of HTML codes or use an eye-dropper tool to pick onscreen colors. You can read
more about the Build Colors dialog in the Origin Help file.

5.

Right-click on the Available list to Delete or Rename lists (you can also rename by clicking directly on
the name). Lists that are dimmed have already been Selected for GUI. Those that are Selected for GUI
appear from drop-down lists throughout the user-interface -- in Plot Details, from the Fill Color button
on the Style toolbar and from the Mini Toolbar Fill Color button

when a plot or special point is

selected.
6.

Use the list control to set Category = Undefined, Sequential, Diverging or Qualitative.

7.

Use these controls to add or remove color lists and palettes from the user-interface (GUI).

8.

Use these controls to move a selected list or palette up or down in the various GUI color lists.

9.

Click Set Default Plot Colors to open the Theme Organizer's System Increment Lists tab, where you
can set default colors for use in your plots.

10. Drag list-number icons to rearrange GUI color list order.

12.7.2Applying Color to Your Graphs
There are many options for applying color to your graphs. We will try and cover the basics here, pointing you
to other resources for more in-depth discussion.
List of key topics on the subject of plot color:

•

The Color Manager

•

Customizing Data Plot Colors

•

Using a Dataset to Control Plot Color

•

The Plot Details Color Map/Contours Tab Controls for 3D and Contour Plots

12.7.2.1 Applying Colors Singly

Picking and applying a single custom color has been made easier with the addition of
the "eyedropper" tool to the Single tab of the Color Chooser. Previously, the
eyedropper tool was buried in the Build Colors dialog.
Applying colors singly simply means applying a single color to a plot as opposed to applying color from a color
list to a series of plots. It is the most basic way to apply color to a single plot or special point. Simply select a
color well from anywhere on the Single tab -- from the LabTalk colors at the top, from a selected color list, or
from a custom or recently used color.
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•

Select a plot (e.g. scatter plot) and click the Fill Color button on the Mini Toolbar that appears.

•

Select a plot and click the Fill Color button on the Style toolbar.

•

Double-click on a plot to open the Plot Details dialog box where you can click on a tab to the right side
(e.g. Symbol tab for a scatter plot) and set color for the element.

•

To create a special point -- i.e. to assign special characteristics to one data point in your plot -- press
Ctrl+click to select the point, then use the Mini Toolbar, Style toolbar or Plot Details controls to
customize color for that point.

12.7.2.2 Applying Colors By Points
Applying colors By Points generally means applying a color to each point in a plot by one of several schemes.
The simplest involves picking an Increment From color from a predefined color list and assigning colors, in
sequence, to each point in the plot.
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As in the case of applying a single color, you can apply these settings using controls in Plot Details; or by
selecting the plot and using the Fill Color buttons on the floating Mini Toolbar or Style toolbar docked to the
top of your workspace.
Other schemes typically make use of a column of values to assign color to points:

•

Indexing assigns point color by associating an integer or text string (categorical value) to different colors
in a list.

•

Direct RGB assigns color using a value derived from columns of RGB values.

•

Color Mapping -- used for 2D, Contour and 3D plots -- assigns colors in a list or palette, to values across
the range of the plot's Y or Z values.

There are several other schemes which are specific to a certain plot type (or family of plots), but the list above
covers most of what you will use. For more information see Using a Dataset to Control Plot Color.
12.7.2.3 Applying Colors By Plots
You apply color By Plots when you want to assign differentiating colors to a series of plots. Typically, this
series of plots comprises a "plot group." In a plot group, plot attributes including color, are assigned to each
plot by incrementing through a style list -- color, line-style, symbol shape, etc.
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12.7.2.4 Applying Colormaps to 2D, 3D and Contour Plots
While you can use a color list with a contour or 3D plot, it is probably more common that you will use a color
palette. This allows a wider range of color variation and can add realism to to 3D surfaces and 3D function
plots.

You can add new color palettes to Origin by drag-and-drop. Support for Scribus (.xml),
Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch
Exchange (.ase) and JASC PaintShopPro (.pal).

Colormapping can also be applied to 2D plots. This allows you apply a greater range of color variation to data
points than would be possible with incrementing or indexing. A good example of applying a color map to a
scatter plot would be Origin's Density Dots plot in which, typically, thousands of scatter points are plotted
and an algorithm is used to calculate point density and assign color to ranges of point densities.
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Applying a colormap to a 3D or contour plot is much the same as applying color singly, by points or by plots.
You select a plot -- then using the Palette button on the floating Mini Toolbar or the Style toolbar. You pick
a palette.

You can also use the controls on the Colormap/Contours tab of Plot Details. This tab gives many more
options beyond simply picking and applying a colormap.
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For more information on applying color to colormapped plots, including contour and 3D surfaces,
see these topics:

•

The Plot Details Colormap/Contours Tab

•

Tutorial: Contour Plots and Color Mapping

•

Surface Graph

•

Symbol Plot with Size and Colormap from Other Columns

•

Parametric Surface with Colormap from Data

12.8 Graph Legends
12.8.1How the Default Legend is Created
A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the
default legend combines (A) plot style information stored with the graph template, with (B) dataset
information stored in the worksheet column label rows, and places the resulting legend object on the
graph page.

Note that the default legend object is not created with literal text and plot symbols but instead is created from
LabTalk script.

•

This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that
the legend can be updated when data or plot metadata change.

•

Because construction of the legend object relies on scripting rather than literal information, you can save
customizations to a graph template and recreate the graph with its accompanying legend object using new
data, as often as is needed.

The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You
can see this notation when you double-click inside of the legend object (as if to edit it).
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•

You control which dataset metadata are used in constructing the default legend text by setting the the
Translation mode of %(1), %(2) list in the Legends/Titles tab of the Plot Details dialog box
(Format: Page...).

•

Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the graph
template for repeat use.

Origin has a Fit Layers to Page tool that is useful for arranging a graph and a large,
text-wrapped legend on the page.

12.8.2Adding and Updating the Default Legend
The table below lists tasks associated with adding or updating the graph legend, and where to find editing
controls for each legend type. Before proceeding, we should point out that there are two legend refresh modes:

•

Updating a legend will preserve any customizations that you might have made to the existing legend,
including size and position adjustments and legend symbol and text customizations.

•

Reconstructing a legend will overwrite any customizations. When you add or reconstruct the legend, you
are creating a copy of the legend that is stored in the graph template.

In addition, the graph template stores a Legend Update Mode setting that determines how the legend is
refreshed when adding or removing data plots from the graph. See Controlling Legend Update, below.

Task

Method (graph is active)

•

Graph: Legend: Reconstruct Legend menu.

•

Reconstruct Legend button

•

CTRL+L.

(Add Object to Graph toolbar).

Add or reconstruct
legend
Legend customizations not saved with the template,
will be lost when you reconstruct.
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Task

Method (graph is active)
Open the legendupdate dialog box:

Update legend

•

Graph: Legend: Update Legend menu.

•

Right-click on legend and select Legend: Update Legend.

Note: "Updating" a legend does not overwrite legend customizations.

Right-clicking on these special legends opens a dialog box with customization
options specific to each legend type:
Customizing
special legends

•

Categorical legends.

•

Box chart legends.

•

Point-by-point legends.

Only available for color-mapped plots (e.g Contour Plots).

Add color scale

•

Click the Add Color Scale button

•

Right-click in the layer and select New Color Scale.

•

Insert: Color Scale menu.

•

When you have multiple color-mapped plots in a single graph window, you

(Add Object to Graph toolbar).

can click on each plot to select it, then add a corresponding color scale.

Available when a color scale object has been added to a graph. To open the Color
Scale Control dialog:
Control color scale
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•

Double-click on the color scale object.

•

Right-click on the color scale object and choose Properties.
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Task

Method (graph is active)
Available for bubble plot, or when symbol size is controlled by a dataset.

Add bubble scale

•

Select Insert: Bubble Scale.

•

Right-click in the layer and select New Bubble Scale.

•

Click the Add Bubble Scale button

in the Add Object to Graph

toolbar.

•

Right-click the legend to select Add Bubble Scale from the context
menu.

Available when bubble scale object has been added to a graph. To open the
Bubble Scale Control dialog:

Control bubble
scale

•

Double-click on the bubble scale object.

•

Right-click on the bubble scale object and choose Properties.

The legendupdate dialog box and the Legend/Titles tab at page level of Plot
Details both have an Auto Legend Translation Mode drop-down that determines
which worksheet metadata (e.g. column Long Name, Comments, etc.) is used to
generate the legend text. For a list of Custom options, see Legend Substitution
Notation.

Note: For more information on creating and customizing graph legends, see:
Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales

12.8.3Controlling Legend Update
When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The
Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down
to control this behavior.
The default setting Update when Adding only affects the legend display of data plots that are added or
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be
maintained.
Tutorial: Customize legend and add data plots
1.

Start with a new project in Origin.

2.

Open Windows Explorer and navigate to the subfolder <Origin EXE
folder>\Samples\Import and Export\

3.

Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and
then drag-and-drop the files onto an empty Origin workbook. The three files will be
imported into three separate workbooks.
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4.

Click on one of the workbooks, select the column B, and create a line plot.

5.

Right-click on the legend and select Legend: Update Legend... to open the
legendupdate dialog.

6.

Change the Auto Legend Translation Mode drop-down to Custom, and in the
edit box that appears below, enter the string:
@WS, @LD3
and then press OK to close the dialog box. The legend updates, displaying the
sheet name and the third user parameter.

7.

Click on the second workbook, select column B, move the mouse over the rightedge of the column until it changes to

, and then drag-and-drop this data

onto the graph to create a 2nd data plot.
8.

Repeat the procedure with column B from the third workbook. The graph will now
display three data plots, and the legend will automatically update to display the
identifier for all three plots.

9.

Click on each individual curve and use the Style toolbar to set a different line color
for each. The legend will automatically update and display the new line color.

12.8.4Special Legend Types
As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can
be customized and updated similarly to the Data Plot legend used by most 2D graph types.
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Legend Type

Menu to Create

Legend for
Categorical
Values

Graph:Legend:Categorical
Values

Used in situations where ...
At least one plot attribute (e.g. color, symbol
shape.etc) is controlled by data indexing.
See the Legend for Categorical Values help
page.

The plot symbol style is controlled by data
indexing, an increment list, or color mapping.
See the Point by Point Legend help page.
Point by Point
Legend

Graph:Legend:Point by
Point

Legend for Box
Chart
Components

Graph:Legend:Box Chart
Components

Origin 2022b
adds a Show
Unique Entries
Only option.

The graph is a box chart, or a grouped box
chart.
See the Legend for Box Chart Components help
page.

12.8.5Tips for Quick Legend Edits
Origin 2022b adds support for quick editing of multiple legend objects on the same
page using Mini Toolbars:

•

In the graph window, press Ctrl and select multiple objects. Release Ctrl to display
the Mini Toolbar.

•

Additionally, when the graph window is active, go to Object Manager and right-click
on a legend object and choose Select All with Same Name to display the Mini
Toolbar.

Many edits to the graph legend can be made from the legend's Mini Toolbars. The default legend for 2D graphs
has two Mini Toolbars:

•

The Legend toolbar -- available when you select the legend object -- has general controls for font, legend
reconstruction, reversing order, etc. Click on the legend object to produce the blue selection handles.

You also gain quick access to more complex controls such as Data Plot Legend Translation Mode -identifying the column label row metadata that you wish to use to create your graph legend.
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•

The Legend Symbol toolbar becomes available when you click on a legend symbol. Use it to change
symbol or pattern block height and width, line thickness, etc.

In addition to the Mini Toolbar for the default legend, there are toolbars specifically for Color Scales and
Bubble Scales.
To format your legend or scale using a Mini Toolbar:

1.

Select a legend or legend component (e.g. legend symbol). A Mini Toolbar with context-specific buttons
will show.

2.

If the toolbar fades too quickly, restore it by pressing the Shift key.

Other legend editing tips:

•

Apart from the Mini Toolbar buttons, you can also right-click on the legend object, choose Legend and
open a shortcut menu with some useful commands such as Text Color Follows Plot, Reverse Order,
and Show Legend for Visible Plots Only. The same menu commands are available from Graph:
Legend.

•

Both the Mini Toolbar and the shortcut menu have an Arrange in Vertical/Horizontal button/command
for changing the legend aspect; or you can modify it interactively by selecting the legend object, then
pressing CTRL while dragging a selection handle (e.g. drag horizontally to create a legend that is all on
one line).
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•

You can modify the white space around legend entries in the default 2D legend, by clicking precisely on
the legend frame and dragging the selection handles.

•

While plot metadata stored in column label rows is an ideal source for legend text, you can simply
overwrite the existing legend text with literal text. Either double-click on the legend text to enter in-place
edit mode or if that proves to cumbersome, right-click on the legend and choose Properties (taking care
not to overwrite the "\l( )" notation that creates the plot symbol). CTRL + double-clicking on the legend
will also open the this dialog.

•

Double-click a legend symbol to open the Plot Details dialog box.

•

Any changes that you make to the legend can be saved with the graph template (File: Save Template
As) If you do not want a legend object added to your graph each time you create the graph, delete the
legend object and re-save the graph template.

If you are adding symbols to the legend manually, there is a new simplified Symbol
Map dialog for Origin 2022b. Most-used symbols are arranged on tabs for easy
access. To access the full Symbol Map dialog, click the Advanced button.

12.9 Annotating Your Graph
When we speak of "annotating" a graph, we are talking about adding text or drawing objects to the graph.
Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to
draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph
creation, etc.
Annotating a graph can be as simple as adding a static text object and formatting it with Mini Toolbar buttons.
Or you might add a more complex object that is dynamically linked to a variable value or to some LabTalk
script that is executed whenever some user-specified event occurs.

Origin 2022b supports "substituting" cell Notes in graph legend and text objects using
@WN (e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source
worksheet).

The following table lists some common graph annotation tasks and available tools for accomplishing those
tasks:
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Task

Method

•

Choose Format: Plot ..., then click the Label tab and select Enable (not
available for all plot types).

•

Select a plot and use the Mini Toolbar Show Data Labels button

to turn

on labels. Some label buttons may support formatting options for the data
labels (hint will be a downward pointing arrow as on the button shown here).

•

To label a single data point, click twice on the point (hint: not a double-click but
a click, pause, click). When the single-point is selected, click the Show Data
Labels button on the Mini Toolbar.

Label Data
Points and Plots

•

For format options not supported by Mini Toolbars, you will generally use
controls on the Label tab of Plot Details. Note that labeling options will depend
on the plot type.

For Origin 2022b, the Label tab of Plot Details (Format:
Plot) adds a Font group Alignment control that applies to
multi-line data labels.

•

Click the Text Tool

•

Right-click on the graph and choose Add Text from the shortcut menu.

•

Double-click on text to do rich text editing; or click on the object and use the

button, then click on the graph to place the object.

text object Mini Toolbar to change font color, bold, align, wrap text, etc.

Add Text
Objects

For Origin 2022b, you can add images from a worksheet
cell or an Image window, to a text object on the graph
page.

•

Worksheet cell: Select a worksheet cell and Copy
(Ctrl + C); then while editing a text object on the
graph, right-click and Paste Link.

•

Image window: While creating the text object, rightclick and choose Insert Graph/Image.
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Task

Method

•

Right-click on graph and choose Add/Modify Layer Title from the shortcut
menu to add/modify layer title in active layer.

In Origin 2022b, add a label to multi-layer graphs with the
page-level Mini Toolbar Add Label for Layers button
(hint: click outside of graph layers to show).

Add Layer Title

•

With a 2D graph active, use the Insert: Straight Line... menu item. Note that
this tool allows use of a simple LabTalk expression in the At Value field (e.g.

Add
Vertical/Horizont
al Line

"mean(plotdata(1,Y))" which translates to "mean of 1st plot's Y dataset") for
positioning the line object. For information, see At Axis Value.

•
Annotate a Data
Point

This is another another option for labeling individual data points. Click the
Annotation

tool on the Tools toolbar. See The Annotation Tool.

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:

•

Arrow, Curved Arrow.

•

Line, Polyline, Curve, Freehand Draw.

•

Rectangle, Circle, Polygon, Region.

Add Drawing
Objects
New for Origin 2022b: On the Tools toolbar "split-button"
with the Arrow and Curved Arrow tools, you'll now find a
Distance Annotation button for drawing a scale-labeled,
double-headed arrow between two points on a 2D graph.
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Task

Method

•

Insert Equation button group on the Tools toolbar. For equations, note that you
can download a free App from the OriginLab File Exchange, for adding LaTeX
objects to worksheets and graphs.

New in Origin 2022b:

Insert Equation,
Word Object,
Excel Object,
Other OLE
Object

•

Insert Object dialog now has a "Use
Current Selection as Default...." checkbox to allow inserting a user-specified
object, without opening the dialog.

•

You can override (i.e. open the dialog) by
pressing Shift while clicking the Insert
Object button.

•

Right-click on the graph and choose Insert Images From Files. You will be
asked whether you want to insert your image as a background for the active
graph layer. Answering yes will cause the image to be imported and placed

Insert Image

behind plots, graph legends, text objects, etc.

•

Click the New Link Table

button on the Add Object to Graph toolbar and

then click on the graph.

Add Table
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•

From the main menu, choose Insert: Table.

•

To edit table content, double-click the table object.

•

To format the table, select it and use the available Mini Toolbar.
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Task

Method

Insert Date &
Time Stamp

•

Date & Time

button on the Add Object to Graph toolbar.

Insert Project
Path

•

Project Path

button on the Add Object to Graph toolbar.

•

To indicate statistical groupings, click the Add Asterisk Bracket

button on

the Add Object to Graph toolbar.

Add Bracket with
Asterisk

•

Manually adjust the size and placement of brackets by dragging handles on the
object.

•

To format the bracket, click the bracket and use the Mini Toolbar buttons.

This is useful when using a nonlinear xy scale.

Add XY Scale

•

New XY Scale button

•

Select Insert: XY Scaler.

and click on a graph layer.

12.9.1Tips for Editing Your Graph Annotations

Beginning with Origin 2021, use Alt+Enter when creating multi-line text objects. To
revert to using Ctrl+Enter to insert a line break, set @FCA=1.

•

Pressing CTRL when drawing with the Rectangle

or Circle

tools, will draw a square or circle (as

opposed to a rectangle or ellipse).

•

Use Mini Toolbar buttons for quick edits to selected objects. For more complex edits, right-click an object
and choose Properties to edit object properties and set defaults.

•

For text objects, including the axis titles and graph legends, you can edit text objects directly in "In-place
Edit" mode. Double-click on a text object to edit. Use the Format toolbar buttons to add superscript,
subscript, and Greek characters.

•

Note that manual editing of axis titles and legends may be the best "quick solution", in most cases, you
are better off using worksheet column metadata to automatically create axis title and legend text.

•

Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes within a single text
object. The correct way to change font size is to click the text object once so that the green selection
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handles appear, then select font size from the Format toolbar. If you set while in In-place Edit mode,
Origin will not indicate the proper font size when you hover on the text object.

•

When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special
characters into your text object.

For Origin 2022b, this opens a simplified, tabbed Symbol Map with quick access to
most-used symbols. To access the full dialog, click the Advanced button.

•

You can insert data from of a worksheet cell into a text object by copying and pasting the cell contents.
While in In-place Edit mode in the text object, right-click and choose Paste or Paste Link. Data added by
Paste is static; Paste Link is dynamic and thus, the text object will update if the data in the linked cell
changes.

•

Also, when in In-place Edit mode, you can right-click and choose Insert Info. Variable... to insert
project variables into the text object. Since the pasted information is linked to a LabTalk variable value,
the inserted data updates if the variable value changes.

•

You can insert variable values into a text object using the LabTalk %, and $ substitution notation by
setting the Link to (%,$), Substitution Level to 1 in the text object's Properties dialog box,
Programming tab. Right-click on the text object and choose Properties from the shortcut menu.

Alternately, you can use the Link to Substitution Mini Toolbar button, saving you
from having to open the Properties dialog.

•

You can use controls on the Programming tab of Properties to associate your LabTalk script with a text
or drawing object (for instance, see Linking Text Labels to Data and Variables). Enter your script in the
text box and specify a Script, Run After condition for running the script. Use the Apply to drop-down to
set the scope for the script.

•

You can copy a range (of cells) from a workbook and paste it into a graph as a table object. Table content
is (a) edited by double-clicking on the object and (b) can be formatted using Mini Toolbar buttons.
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You can add text formatting (e.g. super-/subscripting) to non-consecutive characters
via the text object's Properties dialog:
1.
2.

Right-click on the text object and choose Properties.
On the Text tab, press CTRL and in the text box, highlight multiple characters by
dragging with your mouse.

3.

Click the desired text formatting button above the text box and click OK to close.

12.9.2Grouping, Aligning and Arranging with the Object Edit Toolbar

You can group text labels and drawn objects so that they move or resize as a unit:

1.

To select objects, press SHIFT + click; or drag out a box around objects using the Pointer

2.

To group the selected objects, click the Group button

3.

To ungroup objects, click the Ungroup button

tool.

on the Object Edit toolbar.

on the Object Edit toolbar.

You can align multiple text labels and/or drawn objects with one another using the tools on the same Object
Edit toolbar:
1.

Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using
the Pointer

tool), then click one of the align objects buttons on the toolbar. Note that objects will be

aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:
1.

Select the objects that you want to move to the front or the back.

2.

Click the Front button

or the Back button

on the Object Edit toolbar.

Note: For more information on graph annotations, see your Origin User Guide:
Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects

You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to
align and set a uniform size for multiple graph layers or to swap layer order.
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12.9.3Using Page or Layer Grids to Place Objects
For manually placing objects -- graph layers, text objects, legends, etc. -- you can turn on a non-printing, nonexporting page or layer grid:

•

With the graph active, choose View: Show: Page Grid/Layer Grid (displays only one at a time).

•

Alternately, you can turn on grids by clicking near the page margin and clicking the Mini Toolbar Show
Grids button. In addition, you'll find buttons for increasing or decreasing grid size by increments.

12.9.3.1 Control of the Grid
Grid display and related grid settings are found by clicking on the Show Grids button.
1.

Click Show Grids, then click Page Grid Settings.

12.9.4Object Attachment and Scaling in Graphs
There are two settings that you should know something about, particularly if you subsequently modify axis
scales or resize the graph layer after adding annotations: One is the object's Attach to method, the other is
the layer's Scale Elements behavior.
12.9.4.1 Object Attachment
When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph
layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object.
In addition to being part of the graph layer that was active at the time of object creation, note also that
objects are attached to the graph in one of three ways, depending upon the type of object and where it is
created on the page.
To view the "Attach to" setting for any object:

1. Right-click on a text or drawing object and choose Properties....
2. Click on the Programming tab and note the object's Attach to setting.
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Though objects remain a part of the layer that was active at the time of their creation, you can manage some
object behaviors by changing the object attachment method. An object is attached in one of three ways:

•

Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are
they affected by a change in axis scales. These objects are still associated with a particular graph layer
and they will be hidden or deleted if the layer is hidden or deleted.

•

Layer Frame. Objects that are attached to the layer frame, are resized and moved with respect to the
layer frame. However, they are not tied to axis scales and are not affected by changes in the layer's axis
scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.

•

Layer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer,
the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale
and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or
deleted if the associated layer is hidden or deleted.

To briefly illustrate why object attachment is important, let's look at the following graph. After the graph was
created, arrows and text objects that point to their respective data plots, were added to the graph. Both
arrows and text objects are attached to the graph Layer Frame.

Now, consider what happens to these objects when we modify the graph's X axis scale (recall that objects
attached to the Layer Frame "are unaffected by changes in the layer's axis scale values"). Note that by
changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not
move with them.
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The remedy for this is to change the text and drawing objects' Attach to method to be Layer and Scales
because "if you rescale the axes, the object moves in relation to the visible scale." Sometimes we may want an
object to move with scale changes; at other times we may not. You can force either behavior if you keep in
mind the Attach to setting.
12.9.4.2 Object Scaling
Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a
single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with
Layer Frame -- that is, when the graph layer is resized, associated objects such as text objects, axis lines and
ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into
a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer
frame.

However, this is another default behavior that you may want to change (e.g. you have set your font size to 10
pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab
(Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for
instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size
tab, choose the Fixed Factor radio button and set the scaling factor to 1.
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If you have resized the graph layer, either by merging multiple graphs into a single
graph or by manually resizing the layer, you will find that the font sizes do not display
at their "correct" size (i.e. if you select a text object, the Font Size list on the Format
toolbar shows the original font size). Further, if select a text object, the Status bar will
report two font size numbers -- "size" and "actual". You can reset font size so that they
are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For
more information, see FAQ-441 How do I export graphs with exact size and resolution
as specified by publishers?

12.10 Inserting Images to Graphs
There are two general approaches to adding images to graph windows:

•

Insert the images as floating or background images.

•

Insert images within a text object.

12.10.1

Floating or Background Images

•

Images can be inserted to graphs from file or from Image Windows.

•

Images can be inserted as floating images or as a layer background.

•

Double-click on a graph image to open the image in an Image Window.

•

Once opened in the Image Window, define a region-of-interest (ROI) and Clip the image (graph image
clipped to ROI) or Crop the image (image is cropped in Image Window and graph).

•

Use the Image Window to Set (image) Scale or Set (image) Coordinates of the inserted image.

•

Images may be saved with the project or linked to an external file (Link File) to control project size.

Previously, images linked to an external file had to be manually reimported on project
open. Now, linked images are automatically reimported, including modified source
images. Disable or modify auto import with system variables @LFAU and @LFC.

12.10.1.1 Inserting Image from File
You can insert an insert an image into graph page, with the option of inserting it as a background image that is
linked to layer and scales.
1.

With the graph layer active, choose Insert: Image from File. The image is inserted as a floating image.

2.

To convert the image to a background image, double-click to open it in an Image Window.

3.

Right-click on the Image Window image and choose Set as Layer Background.

4.

Click the Close button on the Image Window.
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12.10.1.2 Inserting Image from Image Window

You can also insert images to graphs from an Image Window:
1.

With the graph window active, choose Insert: Image from Image Window. The Insert from Image
Window dialog opens.

2.

Set the Image Window drop-down to the desired image.

3.

Optionally, choose to insert the image as Layer Background and to Rescale Layer using Image
Coordinates (Layer Background only).

12.10.1.3 Manipulating Images with the Image Window
12.10.1.3.1 Mini Toolbar
Clicking on an Image Window image produces a Mini Toolbar with buttons for simple image manipulations
(flip, rotate, convert to gray scale, etc.).

12.10.1.3.2 Region-of-Interest (ROI)
Placing an ROI object on the Image Window image allows you to perform certain image editing operations.
Add an ROI to the image by one of the following:

•

Click the Add ROI button on the Mini Toolbar.

•

Right-click on the image and choose Add ROI.

•

Click the Rectangle Tool on the Tools toolbar.

Once added, the ROI can be resized (by dragging handles) or moved. Additionally, various operations can be
performed on the ROI, including:

•

Clip graph image to ROI, Crop image to ROI or Copy ROI as image to graph.

•

Copy Positions/Paste Positions for copying ROI dimensions to a second ROI on another Image Window.

•

Export ROI or Import ROI to save or apply previously-saved ROI dimensions.

For more information on the Image Window, see the Origin Help File.
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12.10.2

Inserting Images into a Text Object
Starting with Origin 2022b, images can also be inserted as part (or the entirety) of a
text object. Source images can be from:

•

Local image file or Web image URL

•

Worksheet cell

12.10.2.1 Local Image or Web URL

When you insert an Image from File or Image from Web using the following
methods, the image is linked and not stored in the Origin project file. This helps control
project file size.

1.

On the Tools toolbar, click the Text tool

2.

Enter text if needed and when ready to insert image, right-click and choose Insert: Image from File or

and click once on the graph to enter "in-place" edit mode.

Image from Web:

o
o

When inserting an image from file, browse to your local image file and click Open.
When inserting an image from Web, you'll need a URL (hint: locate your Web image, then rightclick and copy the address (Copy Image Address, Copy Image Link, etc, depending upon
browser).

To examine (or modify) the syntax used for inserting an image, you can select the inserted object and choose
Properties. In the Text Object dialog, you should see something like these examples:
Examples:

\img(file://"C:/Program Files/OriginLab/Origin2022b/Samples/Image Processing and
Analysis/white camellia.jpg",w=200)

\img(https://www.originlab.com/images/header_logo.png, w=200)
... where option "w=" is the default width in pixels, of the inserted image. Width is user-modifiable by editing
the "w=" value in Properties or -- if no width is specified -- by simply dragging the object's selection handles.
12.10.2.2 Worksheet Cell
You can also insert an image from a worksheet cell into a text object, but you'll need to make use of a special
syntax. The syntax is not complicated and combines a \cell( ) escape sequence with a cell reference -either a range reference (e.g. [Book1]Sheet1!col(C)[1] ) or a named range reference.
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1.

On the Tools toolbar, click the Text tool

and click once on the graph to enter "in-place" edit mode; or

right-click and choose Add Text from the shortcut menu.
2.

Enter your string into the text object using the examples below as a guide:

o

If you are copying and pasting a string (e.g. \cell([Book1]Sheet1!B[1])), click outside the
text object to leave edit mode. Your cell image should display in the text object.

o

If you are typing directly into the text object in "in-place" mode, enter your syntax (e.g.

\cell([Book1]Sheet1!B[1])) and when finished, right-click on the object, choose
Properties and on the Text tab, remove one of the leading "\" characters from your cell
reference (Origin automatically "protects" "\" characters entered into text objects which is why
you'll need to remove one "\". See Escape Sequences).

o

If you are typing directly into the Text Object (Properties) dialog, enter your syntax (e.g.

\cell([Book1]Sheet1!B[1])) directly to display the cell image.
Examples:

\cell([Book1]1!col(C)[2]) // Book1, Sheet1, col C, row2, size = current font height

\cell(alpha,200) // named range "alpha", width=200 logical pixels

\cell(alpha,h=300) // named range "alpha", height=300 logical pixels

12.11 Working with Map Data

You can overlay geopolitical boundaries on graphs or Image Plots of NetCDF data from the Insert menu.

•

Insert: World Map will apply boundaries within the graphs current Lat and Lon ranges.

•

Depending upon the graph's Lat and Lon ranges, other options may be available (e.g. Continental USA
Map, Map of China, etc.).

12.11.1

Importing Shapefiles

You can also import locally-stored shapefiles using Origin's Shapefile Connector:
1.

With a workbook active, choose Data: Connect to File: Shapefile.

12.11.2

Map-related Apps

There are at least two add-on Apps for inserting geographic data:

•

OriginLab's free Google Map Import App lets you place a Google Map as background on the graph page
using specified coordinates.
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•

Maps Online is another free OriginLab App that lets you connect to one of several map databases.

You can find and install these Apps by pressing F10 and searching on maps. For information on App
installation, see Where Do I Find Apps?

12.12 Arranging Graphs and Layers

Task

Method

•

Graph: Merge Graph Windows... menu command

•

Merge Graph Windows button

or

Merge
multiple
graph
windows
into a single
graph
window.

on the Graph toolbar.

A Unit control is added for Origin 2022

Origin has two dialog boxes -- Fitting Layers to Page and Fit
Page to Layers -- that are useful for arranging multiple graph
panels on the page and for adjusting graph margins.

Extract data
plots in one
layer to
multiple
layers.

•

Extract to Layers button

on the Graph toolbar.

Hint: to preserve your original graph, click the Duplicate button
to layers.

before extracting
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Task

Method

•

Graph: Extract to Graphs

•

Click the Extract to Graphs button

or

Extract
multiple
layers in a
single
graph to
multiple
graph
windows

on the Graph toolbar.

All layers are extracted to individual graph windows, even if a layer is linked to another
layer.
By default, the layextract dialog box has Extracted Layers set to 1:0, which specifies
that all layers be extracted. To extract only certain layers, clear Auto and use the
layextract X-Function's comma/colon notation to control which layers are extracted. The
notation 1:0 means starting with layer 1, extract all layers to graphs (0 denotes all).
Specifying 1,3:4, for example, tells Origin to extract only the first, third and the fourth
layer. Note that you can enable Keep Source Graph to preserve the original graph.

•

Graph: Layer Management... menu.

•

Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to
select multiple layers and Align Left, Right, Top, Bottom, etc.

Add,
arrange,
resize,
position,
swap, align,
or link
layers

A Unit control is added for Origin 2022

You can use the Layer Management tool's Swap control (Graph:
Layer Management,Size/Position tab) to physically swap
layer positions without reassigning layer numbers. Before doing
so, set each linked layer's Units to % of Page (Size/Speed
tab of Plot Details).

•

Graph: Arrange Layers... menu.

•

Row by column layer arrangement with control of page size and spacing between
layers.

Simple
arrangeme
nt of layers

New easy-to-use tool for Origin 2022
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Task

Link graph
layers

Method

•

Linked Axes Scales tab, layer level of Plot Details dialog box.

•

Link tab of the Layer Management dialog box.

When linking layers, the child layer must have a higher layer number than the parent
layer.
Linked layers can be moved and resized together.
You can link layers' axis scale values to be Straight (1:1) or you can specify a Custom
mathematical relationship.

Reorder
layers

There are several ways to reorder graph layers (reassign Layer number for each Layer).
Learn more about reassigning layer numbers in the mini tutorial below this table.
Method 1: Open the Layer Management dialog and click the row header (shown in image
below) and drag it up or down to change the Layer order.

For more information, see the Layer Management tool.
Method 2: Enter the following LabTalk script in the Command Window
(Window:Command Window), then press Enter to execute.

page.reorder(n,m)
The command changes the nth Layer to the mth Layer.
Method 3: Use the Front and Back buttons on the Object Edit toolbar (these buttons work
on the active layer as indicated by the graph layer icon

). Alternately, right-click on

the graph layer icon and change layer order using shortcut menu commands (e.g. Bring to
Front).

When two layers are linked by a common X axis (e.g. Double-Y
graph), you can swap layer drawing order by right-clicking on the
"front" layer in Object Manager and choosing Push to Back. This will
not break layer linking.
Note: Reordering layers may break layer linking relationships.
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Task

Method

Reorder
layers

A Note on Inset Graphs: In certain situations (see Tutorial, below),
the order in which the layers are drawn on the screen becomes an
issue. In this image, we have added an inset graph using the Add
Inset Graph with Data button (Graph toolbar). The problem is that
the data plot of the parent layer (red symbols) shows through the inset
layer (small, black symbols). To fix this, we do two things:

(cont’d)

•

Set the inset layer background Color = White -- by default, it is None
(Format: Layer, then Background tab).

•

Set the layer Drawing order to Draw layer by layer (Format: Page

then Layers tab).

By default, an inset layer is added "on top of" the parent layer but if
needed, you can click on the inset layer to select it, right-click and
choose Bring to Front.

Exchange
X-Y Axes
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•

Graph: Exchange X-Y Axes menu command

•

Exchange Axes

button on the Graph toolbar.

Customizing Graphs

Task

Method

•

Method 1: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the
bottom panel, select a plot and drag it from a layer to another layer.

•

Method 2: Run laymplot -d; (e.g. open the Script Window, type the command
and press <Enter>) to open the Move Plot dialog to specify plot(s) to move and a
target layer.

Move a
plot(s) to
another
layer

You can move a plot by Copying (CTRL+C or Copy Range
context menu) and Pasting (CTRL+V or Paste context menu)
operations, between different layers or different graphs. Please
note, the pasted plot won't be associated with the source data of
the copied plot, but exists as a loose dataset.

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and
then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on
top of the layer with lower number. This is important when plots in one layer overlay plots
in another layer. When necessary, you can change layer order to change plot drawing
order.
This mini tutorial shows you how layer reassignment works. Use the preview window to
see how layer number reassignment affects your graph.

1. Click Help: Origin Central or press F11.
2. Click on the Graph Sample tab, set the Samples in drop-down list to Area Plots
and double-click on this graph:

3.

Activate the graph Area Plot With Horizontal Color Gradient, then click the
Extract to Layers button

on the Graph toolbar. Set both number of rows

and columns to 1, click OK, then, click OK again for the page spacing. The green
layer is on the top of the yellow layer in the figure. The purpose of this last step
was simply to create a two layer graph in which the data in one layer partially
hides the data in the other layer. What we will do now is to reorder the layers and
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set the yellow layer on the top, giving you a better view of the two plots.

4.

Choose Graph: Layer Management... menu, then drag the row header "1" of the
Layer1 in the Layer Selection downward under the Layer2 (indicated by a blue
line), and click OK.

5.
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Alternate Method: You can use the Front
or Back
toolbar buttons (located in
the Object Edit toolbar, or at the top of Layer Selection box in the Layer Management
dialog) to bring a layer forward or push it backwards. As happens when you rearrange
layer order with the Layer Management dialog, this method swaps layer numbers.

You can easily add an inset layer with data by clicking the Add Inset Graph With
Data button
on the Graph toolbar or Insert: New Layer(Axes): Inset With
Data (Linked Dimension) .

You can copy a layer from one graph window to another graph window. Click to select
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and
choose Copy. Click on the target graph window, then right-click to Paste.

Note: For more information on merging graphs, see your Origin User Guide:
Help: Origin: Tutorials > Graphing > Layers > Merging and Arranging Graph Layers
Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box

261

UserGuide_2022b

12.13 Templates and Themes
Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a
couple of ways -- either with templates or with Themes. These concepts are introduced below.
Note: For detailed information please refer to Origin Help file, see:
Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates
Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

12.13.1

Templates

A new Origin installation lists close to 240 plot types, each one backed by an Origin graph template file (*.otp
or *.otpu). For most users, a Plot menu graph is the starting point for customizing and saving your own
custom graph templates. The basic process goes like this:
1.

Plot your worksheet or matrixsheet data using the Plot menu (or equivalent graphing toolbar button).

2.

Customize the graph's default settings.

3.

Save the graph as a graph template file (*otp or *.otpu) by choosing File: Save Template As and filling
in the requisite information. By default, custom templates are saved to your User Files Folder (hint:
easily find this folder by clicking Help: Open Folder: User Files Folder).

A few things to note:

•

The Plot menu is the definitive list of built-in plot types. At one time, a graphing toolbar button was
created for each new plot type but in recent versions, few toolbar buttons have been added as toolbar
space has become limited.

•

In a fresh Origin installation, each one of Origin's 240 built-in graph types uses a specific "system"
template when creating a particular graph type. When you click on a Plot menu graph or graphing toolbar
button (e.g. Area

•

), one of these system templates is used to plot the selected data.

System templates are installed to the Origin Program Folder. They are completely customizable but as the
Program folder is write-protected, you cannot overwrite the original system template file (see next).

•

Instead, when you customize and save a system template, it is saved by default to your User Files Folder
(UFF). If you save the customized template to the same system template name, the customized template
replaces the system template as the template associated with the Plot menu command or corresponding
toolbar button used to create that plot type. Additionally, the customized template is added to the user's
Template Library.

•

To view your custom graph templates, click Plot (workbook or matrix should be active) and click Category
= MyTemplates.

•

You can save a graph template anywhere (and with any name) that you like -- it does not need to be
saved to your UFF. However, by saving customized templates to your UFF, they will be collected in one,
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easily-remembered place and they will be readily available when you upgrade your Origin software (since
Origin 2018, all Origin versions have shared a common User Files Folder).

•

For an overview of graph templates, see Graph Template Basics.

•

For information on the Template Library, see The Graph Template Library.

•

For information on "cloneable" templates, see Cloneable Templates.

12.13.1.1 The Template Library

Summary of Features:

•

Toggle between list and thumbnail view modes. Thumbnails images are automatically generated when you
save a template.

•

In either mode, you can hover on the template to preview, read template location, comments, etc.

•

In list mode you can sort; or opt to list a User or Extended template under Plot: My Templates.

•

Templates are listed as System, Extended or User. System templates are Origin's default templates for
creating Plot menu graphs. They can be plotted to and customized but cannot be overwritten. Extended
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templates are add-on templates that are installed with Origin. User templates are those that you
specifically customize then save using File: Save Template As; or which you add using the Library's Add
or Scan functions. Note that User templates can include customized System templates that you have
saved to \User Files.

•

To scan your User Files folder (UFF) for custom templates, click the Scan User Template icon. To browse
and add a template file to the Library, click the Add Template icon.

•

Click the List Cloneable Templates icon to show only cloneable templates.

•

Click the Manage Mode icon to delete, show or hide a given template. Hiding a template removes it from
My Templates but does not remove it from the Template Library (note that you can also remove a
template from My Templates simply by clearing Show in Menu). Deleting a template removes it from the
Library and moves the template to User Files\DeletedTemplates.

•

Click the Template Center icon to open a dialog and search the OriginLab site for additional graph
templates.

Beginning with Origin 2022b, you can search for Template Center templates and
install them directly from the Start menu.

12.13.2

Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin:
graph Themes, worksheet Themes, dialog Themes and function plot Themes.
Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be
very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex
(e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or
complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an
existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to
recreate a suite of settings, or to apply those settings one-by-one to individual graph windows.
All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows
that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy
a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from
one object as a named Theme and apply that named Theme to other like objects at a later time.
1.

Right-click on an object in a graph window (e.g. a plot) and choose Copy Format. Depending on what
you click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the
option as to what exact format to copy.

o

To apply the copied formats to a single object, right-click on your target graph and choose Paste
Format To. Again, this shortcut menu might has some sub-items that limit what to paste. In this
way, the formatting option(s) from your source object should be applied to your target object.

o

To apply the copied formats to multiple windows in the project, keep the source graph window
active and select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply
Formats dialog box. Here you have the option of editing or selectively applying formats to one or
more graph windows in the Origin Project.
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2.

If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose
the Save Format As a Theme... shortcut menu item, then use Preferences: Theme Organizer to
apply the Theme when needed.

12.13.2.1 Theme Organizer
Use the Theme Organizer (Preferences: Theme Organizer) to organize and apply Themes to graphs.
With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.
To combine multiple Themes in the Theme Organizer dialog box:
1.

Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the
shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to
add/delete properties from an existing Theme.

•

The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and
plotted mathematical function Themes.

•

If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new
graph, this System Theme will be applied regardless of the settings that were saved with the graph
template†.

•

Use the System Increment Lists tab to manage increment lists and selectively apply them to project
graphs.

•

You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported
image file.
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† If you don't want a System Theme to be applied automatically to the graph, save the
graph as a template (File: Save Template As) and clear the Apply System Theme
to Override check box.

12.14 Topics for Further Reading
•

Plot Details: Customizing Graph Page Elements

•

Plot Details: Customizing Graph Layer Elements

•

Plot Details: Customizing Plot Elements

•

The Preferences: Options: Axis tab Settings

•

The Preferences: Options: Graph tab Settings

•

Graph Axes

•

Controlling the Graph Axis Display Range

•

Graph Legends

•

Color Scales

•

Customizing Data Plot Colors

•

Using a Dataset to Control Plot Color

•

Using a Dataset to Control Plot Attributes

•

Labeling Data Points

•

Adding Text and Drawing Objects

•

Adding Unicode and ANSI Characters in Text Labels

•

Linking Text Labels to Data and Variables

•

Associating Script with an Object

•

Hiding Labels, Data and Layers

•

Working with Maps

•

Graph Template Basics

•

Graph Template Library

•

System Templates

•

System Themes
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13 Graphical Exploration of Data

Origin includes a number of tools for graphically exploring your data including those for zooming and panning
data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected
data points.
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With Origin 2016, OriginLab began releasing add-on tools called Apps. Many
exploratory and analysis-related tools have been added to OriginLab's File Exchange
since that time. If you find you need some exploratory or analysis tool that is not a
standard part of Origin, you might check to see if the tool exists as an App. If it does
not, request it!.

13.1 Plot Highlighting
While plot highlighting can be used to select a subset of data for more in-depth analysis, at a basic level it is
useful for quick visual comparisons.

To engage plot highlighting:

•

Click on one plot in the graph layer. Other plots in the layer and in linked layers sharing the same X axis,
will be dimmed.

•

Click on the plot in the Object Manager.

•

To highlight/dim plots on hover (without clicking), click the Highlight Plot when Mouse Over Mini
Toolbar button (page-level).

Other Origin features useful for quick visual inspection of data plots:

•

If you have many columns of Y data, plotting a Browser Graph, or adding a Browser panel to an existing
2D line plot, can be useful for quick visual inspection. Clicking the menu on the Browser panel, you can
plot every Nth column or Flip Through plots using a specified Move By factor.

•

For scatter data, use the customizable Data Point Tooltip to read coordinate values and column
metadata on mouseover.

•

You can also use Tools toolbar buttons to zoom or pan your graph, as you will see in the next section.

•

Origin has various other tools available for visually inspecting and recording information on your data plots
and those are covered in the remaining subsections of this chapter.
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13.2 Data Slicer
If you are plotting worksheet data where a data filter has been applied, you can enable a Data Slicer panel,
make quick changes to filter conditions and see the effect on your plot. The tool is intended for plotting and
comparing single categories.

1.

Apply one or more filters to your worksheet data and create your plot.

2.

Hover just inside the graph window but outside the layer and when you see the Mini Toolbar cursor, click
and look for the Data Slicer button.

3.

Once the Data Slicer panel is enabled, you will want to right-click on the title bar of both the worksheet
and the graph and Duplicate the two windows. Duplicating the two will allow you to make side-by-side
comparisons.

4.

In the left panel of the duplicated graph, click on the listed filter(s) and choose another category from the
drop-down list.

13.3 Zooming, Panning and Rescaling
This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of
your 2D graph. We have split these tools and commands into two groups:

•

Page-level zoom and pan operations that do not change axis scales.

•

Axis rescale operations which zoom and pan the graph by changing axis From and To values.
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Page level zoom and pan do not alter the graph; they only determine which portion of
the graph page is visible within the graph window. You can read the current zoom level
in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not
affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g.
and
graph.

) do alter the graph and, thus, will affect the printout and export of the

13.3.1Page-level Zoom and Pan
Action

Button

Shortcut Key

Menu

Notes
Click the toolbar button; or
with the Pointer tool

Zoom-Panning: Zoom
and pan the graph page.

active, place the cursor on
the graph page and press "A",
then ...

A+
+/- keys
(zoom)
or
arrow keys
(pan)

•

Use +/- keys or
mouse wheel to
zoom in or out.

•

Use the arrow keys
to pan horizontally or
vertically.

•

Stepped zoom.

•

CTRL+I activates
zoom in; click on the

†

Stepped Zoom-Pan :
Zoom graph in or out, by
increment.

CTRL + I
CTRL + M

View:Zoom
In and
View:Zoom
Out

graph to establish
the focal point.

•

CTRL+M zooms out;
clicking on graph not
needed.
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Action

Button

Shortcut Key

Menu

Notes

•
Whole Page: Show the
whole graph page.

CTRL + W

Reset the view of the
page after using the

View:
Whole
Page

Zoom-Panning tools,
above.

•

Can be used to
locate "lost" objects

Zoom All: All objects in
the window are shown.

--

--

View: Zoom
All

lying outside the
graph page.

†

Notes: These are older tools and methods that have been deprecated. Toolbar buttons are not shown by
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph
button group).

13.3.2Axis Rescaling
New Hotkey support for Rescaling of 3D Graphs:

•

D + mouse wheel: rescale in Z direction

•

Z + mouse wheel: rescale in X direction

•

SHIFT + Z + mouse wheel: rescale in Y direction

•

Enable clipping on Miscellaneous tab of Plot Details (layer level) hides plots
outside of frame.

Action

Button

Shortcut Key

Menu

Notes

•

Scroll mouse wheel
to rescale X.

•

SHIFT + scroll to
rescale Y.

•
Rescale: Rescale and
pan the graph in both X
and Y dimensions.

--

Drag with the left
mouse button to pan

--

(will rescale both X
and Y).

•

Select the Pointer
tool to exit Rescale
mode.
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Action

Button

Shortcut Key

Menu

Z + scroll
wheel
Rescale the graph in the
X dimension.

--

or
Z+
+/keys

•

--

Rescale X: Rescale the
graph in the X
dimension.

or
X+
+/keys

--

--

Rescale the graph in the
Y dimension.

--

or
SHIFT
+Z+
+/keys

Rescale Y: Rescale the
graph in the Y
dimension.

--

or
SHIFT
+X+
+/keys

--

•

Rescales X.

•

Does not rescale Y.

•

Rescales (Resets) X
to full X range +
some padding factor.

•

--

without limits.

•

Rescales Y.

•

Does not rescale X.

•

Rescales (Resets) Y
to full Y range +

--

some padding factor.

•
Rescale XY: Rescale
the graph in both X and
Y dimensions.
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--

--

Rescale the graph in
the Y dimension

--

SHIFT + X
+ scroll
wheel
Pan the graph in the Y
dimension.

without limits.

--

SHIFT + Z +
scroll wheel

Rescale the graph in
the X dimension

--

X + scroll
wheel
Pan the graph in the X
dimension.

Notes

Rescales (Resets) X
and Y to full range +
some padding factor.
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Action

Button

Shortcut Key

Menu

Notes

•
Rescale Z: Rescale the
graph in the Z
dimension.

--

Rescales (Resets) Z
to full range + some

--

padding factor.

•

Select Scale In
button, then drag
out rectangle(s) to
define axis scale
range desired.

•
Scale In/Scale Out:
Rescale the graph in X
and Y dimensions.

Reset by clicking on
the Scale Out

and

--

button (no need to

--

drag) several times.

•

Rescales both X and
Y.

•

Press ESC (or select
another tool) to quit
magnifying mode.

•

Rescales (Resets) all
axes to display all

Rescale: Rescale the
graph in the all
dimensions.

CTRL + R

Graph:
Rescale to
Show All

data in the layer (+
some padding
factor).

You can use the Scale In button
to copy an enlarged portion of your 2D graph to a
new window. This will also work on any graph that has multiple linked layers as long as
the layers are overlapped and share a common axis (% of Linked Layer has
Left/Top set to 0 and Width/Height set to 100, plus Straight (1 to 1) linking to the
parent layer). With a graph active, press Ctrl then click the Scale In button
(Tools
toolbar) and drag out a rectangle on your 2D graph. Note that this Enlarged graph is
dynamic. Move or resize the rectangle on your original graph and the Enlarged graph
is updated.

If you do not see a toolbar button, it may be turned off. To add or remove buttons from
a toolbar, see The Customize Toolbar Dialog Box.
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To prevent an axis from rescaling when using one of the axis rescaling tools, set
Rescale = Fixed. If both X and Y axes are set to Fixed and you pick one of these axis
rescaling tools, you are reminded that X and Y axes are in "Manual Rescale mode" and
are prompted to proceed. Answering Yes will allow you to override and manually
rescale in one or both dimensions. If you need to block such manual overrides of Fixed
axis scales, set @nrm = 1.

13.4 Rotation of 3D openGL Graphs
This openGL toolbar that previously displayed when a 3D layer was selected, has been
replaced by layer-level Mini Toolbar buttons.

When you click inside the layer of a 3D graph, the layer is selected and a Mini Toolbar appears. Click the
Rotate Mode button to enter rotation mode; then use one of the hotkey/mouse combinations listed below; or
drag the radial rotation handles in the graph with your mouse.

Hot Key

Menu/Action

Context

Rotate 3D graphs with the 3D floating buttons

X + Arrow key

Rotate the 3D graph around
the X axis.

Y + Arrow key

Rotate the 3D graph around
the Y axis.

With graph layer active and with Rotate Mode
button selected in the 3D floating button group.

Z + Arrow key

Rotate the 3D graph around
the Z axis.

Q + Arrow key

Rotate the 3D graph in
screen.

W + Arrow key

Rotate the 3D graph around
any axes.

Rotate 3D graphs using R key

R + Mouse
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Drag to rotate the 3D graph
in an arbitrary direction.

Press "R" before pressing other keys.
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Hot Key

Menu/Action

R + Ctrl +
Mouse/Arrow key

Rotate the 3D graph around
the X axis.

R + Shift +
Mouse/Arrow key

Rotate the 3D graph around
the Y axis.

R + Ctrl + Shift +
Mouse/Arrow key

Rotate the 3D graph around
the Z axis.

Context
Hovering on a 3D graph while pressing "R"
changes the Pointer tool
to a
. Press Ctrl
and/or Shift as needed, and rotate by (a) dragging
with your mouse or (b) pressing the arrow keys on
your keyboard.

13.5 Reading Coordinate Values and Distances
Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available
from the Gadgets menu.

13.5.1Data Point Tooltip
Most 2D plot types, 3D Scatter, XYY Bar and XYZ Bar plots support a floating, customizable tooltip that reads
data point values when you hover on a data point.
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Tooltip Shortcut Menu
For tooltip customization and other options, right-click directly on the data point tooltip.

•

Go to Sheet pops up the worksheet with source data highlighted.

•

Show Data Plot Tooltip toggles display of a non-customizable data plot tooltip in place of the
customizable data point tooltip (see, below).

•

Pick Data Points puts the cursor into data reading mode and opens a Pick Points dialog. Double-click
on points in the graph and when finished, click Done. This generates summary data (source, X-Y
coordinates, etc.) for your picked points.

•

Copy copies data point tooltip information, including labels, to the Clipboard.

•

Copy Coordinates copies only coordinate values. Right-click on a cell and Paste each value to a separate
cell within the row; or Paste (keep spaces) to paste values to the selected cell as a space-separated
string.

•

Preferences opens the Data Point Tooltip dialog allowing you to customize tooltip content and
formatting. Use documentation of the Data Info window, below, as a guide to configuring your tooltips.

The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data
Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip.

For Origin 2022b, the Data Point Tooltip dialog adds a Column Width control, giving
you better control over the width of tooltip column display. This is especially handy when
tooltips include images.
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By default, the Data Point Tooltip displays with a moderate degree of transparency. You
can affect tooltip transparency by changing the value of LabTalk System Variable
@TDT. For information on changing the value of a LabTalk System Variable, see this
FAQ.

13.5.2Data Plot Tooltip
There is a second tooltip that can be displayed in place of the Data Point Tooltip and this we refer to as the
Data Plot Tooltip. This non-customizable tooltip displays the source book, worksheet and coordinate datasets,
on hover.

The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data
Point Tooltip and choose to Show Data Plot Tooltip. Conversely, right-click on the Data Plot Tooltip and
choose Show Data Point Tooltip.
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13.5.3Managing Tooltip Display
You can turn off display of data tooltips by activating the graph window, clicking on the View menu and
clearing the check mark beside Data Tooltips.
There is a second way to control tooltip display that is more complicated but allows a greater degree of control.
This entails changing the value of LabTalk system variables @PT and @PTI.

@PT=0; //Disable both data plot and data point tooltips

@PT=1; //Enable data plot tooltips for 2D graph

@PT=2; //Enable data plot tooltips for 3D OpenGL graph (default)

@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph

@PTI=0; //Disable only data point tooltips

@PTI=1; //Enable data point tooltips (default)

13.5.4The Annotation Tool
Use the Annotation tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar plots.
Choose from several standard data point labels or create your own custom label using LabTalk script.
To annotate a data point:

1.

Click the Annotation button

on the Tools toolbar and move the cursor to the desired data point. The

cursor and the Status Bar will display the current label form.

2.

Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate
value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value;
index number (row number); or Custom (see Tutorial, next).

3.

When you've selected your label form, double-click to add a label to the data point; or single-click on the
point and press Enter.

Tutorial: Customizing the Annotation String
The annotation string can be customized by combining literal characters with the X and
Y coordinate values:
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1.

Start with a graph of your data.

2.

Open the Script Window (Window:Script Window) and type the following
command, then press Enter:

system.annotation.customlabel$="X value: $(x,.2), Y value: $(y,*5)”

3.

Click the Annotation button

, hover on your graph, then press the Tab key

several times to cycle through the annotation choices until the custom string
format specified above is displayed in the Status Bar. The cursor will display the
word "Custom".
4.

Start double-clicking on data points (or single-click and press Enter) to add the
custom annotation string. The X values will be displayed with two decimal places
and the Y values will be displayed with 5 significant digits, as specified by your
script.

Adjustments using the Pointer Tool:

•

To move a label to another data point, click the Pointer tool

•

To re-position overlapping labels, drag the label. A leader line is automatically added.

•

To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point.

, press the ALT key and drag the label.

Note: Please view more information on string formatting in the Programming help file:
Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical
Listing of Objects > String

13.5.5The Screen Reader Tool
The Screen Reader
uses the Data Display window to report the XY(Z) coordinates of the cursor on the
graph page. Note that the Screen Reader is not reading data point coordinates; rather it is reading page
coordinates relative to the graph axes.
The Data Display window opens automatically when you select the Screen Reader tool from the Tools toolbar
(by default, the Data Display window is docked at the bottom of your Origin workspace).
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You can alter basic properties of the Data Display window by right-clicking on the window title bar or by rightclicking inside the window.
To use the Screen Reader:

1.

Click the Screen Reader button

on the Tools toolbar. This opens the Data Display tool.

2.

Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only).

3.

To increase cross-hair size, press the space bar.

4.

Click the Pointer button

Coordinate values show in the Data Display window.

on the Tools toolbar to exit screen reading mode.

13.5.6The Data Reader Tool
The Data Reader
is used to read information associated with a data point in your plot. This could be
coordinate values or it could be more complex information including metadata or even images that relate to
the data point. The Data Reader works in concert with the customizable Data Info window.

The Data Reader tool is grouped with two related tools -- the Data Cursor

and

the Data Highlighter
. Only one of these toolbar buttons will show at any given
time. To select a hidden tool, click on the small arrow to the right of the button and
select a tool from the pop-up menu.

To use the Data Reader tool:

1.
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Click the Data Reader

button on the Tools toolbar. This opens the Data Info window.
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2.

Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the
Data Info window (and Data Display window).

3.

To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or
click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN
arrow keys to move to a data point on another plot or use your mouse to click on the point.

4.

To change the vertical and horizontal cross-hair size, click on a point and press the spacebar.

5.

Click the Pointer button

on the Tools toolbar or Esc key to exit the Data Reader tool.

You can zoom into the graph while using the Data Reader. While the tool is active,
press CTRL and use your mouse wheel to zoom in or out on the page.

13.5.7The Data Cursor Tool
The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data
Reader.
Tutorial: Using the Cursor Tool to Measure Relative Distance
1.

Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot.

2.

Click and select the Data Cursor button from the Tools toolbar.

3.

Double-click on one of the peaks or click once on a data point and press
ENTER, to add a cursor object.
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4.

Repeat to place a second cursor object on another peak.

5.

Double click in the Data Info. window to open the Data Info. Report Settings
dialog. If this window is not visible, select the View: Show Data Info menu item
to open the Data Info. window.

6.

Switch to the Columns tab and then right-click in the gray area to the right of the
columns and choose Add Column.

7.

In the new column that is added, click on the source row of new column, and select
Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close
the dialog.

8.

Now you can drag and move the cursor objects and the third column in the Data
Info window will display the X and Y distances between the two cursors.
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13.5.8Distance Annotation Tool
New for Origin 2022b: On the Tools toolbar "split-button" with the Arrow and
Curved Arrow tools, you'll now find a Distance Annotation button

for drawing a

scale-labeled, double-headed arrow between two points on a 2D graph.

1.

Click the Distance Annotation button

2.

On a graph, place the crosshair on the starting point and drag with your mouse. Press Shift to force the

on the Tools toolbars.

double-headed arrow to the horizontal or vertical
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To fine-tune arrow placement, right-click on the drawn arrow and choose Properties.
Use Dimensions tab settings to control exact placement of object.

13.5.9The Data Highlighter Tool
The Data Highlighter is grouped on the Tools toolbar with the Data Reader and Data Cursor tools. Use the
Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding
data row in the worksheet. Unselected points are dimmed in the graph and the worksheet.

While in Data Highlighter mode ...

•

CTRL+click to select multiple points in the graph.

•

Drag out a rectangle/freehand object on the graph to select multiple points.

•

Use SPACE to toggle between rectangle and freehand selection modes.

•

Use left/right arrow keys to highlight individual points in sequence by row index.

•

In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and
highlight corresponding points in the graph.

•

Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet.

13.5.9.1 Collect Data from Multiple Sheets
When the Data Highlighter is active, a Mini Toolbar displays at the upper-right corner of the graph or
worksheet window. The toolbar has buttons to Create Subset Sheet, Delete Points, Mask/Unmask
Highlighted Points or Dimmed Points; plus a Highlighter Properties for configuring how to pick and
collate data from multiple worksheets.
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How to Pick Points Plotted from Multiple Sheets
A new method is added for picking a subset of points from a graph of plots from
multiple worksheets and adding them to a single sheet:

1.

Pick the Data Highlighter tool

, then CTRL+click to select multiple points

from a SINGLE plot; or drag out a rectangle/freehand object on the graph to select
multiple points (hint: press spacebar for ROI shape).
2.

When finished, click the Create Subset Sheet button

on the Highlighter Mini

Toolbar.
3.

Click the Open Properties Dialog button

on the Mini Toolbar and set Add

Data Mode = Append or Append with Gap.
4.

Continue to pick points from other plots (worksheets) as in step 1, clicking the
Create Subset Sheet button each time you finish picking points from one of the
plots.

5.

13.5.10

When you have finished, pick the Pointer tool

.

The Data Info Window

The Data Info window opens when you choose either the Data Reader

, the Annotation

or the

Data Cursor tools
. When you click on a plotted data point with one of these tools, the Data Info window
displays information about this particular data point.
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In its default configuration, the Data Info window reports only a column short name, plot designation (e.g.
"X") and the XY coordinate values of a data point. However, the window is capable of displaying any of the
worksheet-contained information that is associated with a data point including metadata and images.

To customize the Data Info window:
1.

Double-click on the Data Info window; or right-click and choose Preferences....

2.

Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info
window:

•

The Data Info window can report any information in the source data worksheet. You are not limited to
displaying plotted data.

•

The window can display anything that can be inserted into the worksheet cell, including inserted graphs
and images.

•

The window can be customized with a Window Title and Report Title.

•

Window configurations can be saved as Themes, including Save to <Graph>, Save to <Layer> and
Save to <DataPlot>. This allows, for instance, all graph windows in your project or all graph layers in
your multi-panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the
current Data Info window.
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If you save your Data Info Theme settings in the graph, then save the graph window
as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels
only with the data that are plotted in the graph. Therefore, if your Data Info Theme
uses data in other columns in your worksheet, the Data Info display will be incomplete
if, for instance, you reopen the window file in a new project.

For more information on customizing the Data Info window, see:

•

The Data Info Window.

•

Tutorial: The Data Reader Tool (discussion on customizing the Data Info window).

13.5.11

Gadgets

Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

•

Vertical Cursor

•

Statistics

•

Cluster (OriginPro)

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked
panel plots or multi-plot graphs, where plots share a common X scale.
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To open the Vertical Cursor:
1.

With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the
Vertical Cursor dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label
font size, hide labels, etc.

When labeling plots with the Vertical Cursor, you can opt to combine separate data labels
into a single label by clicking the gadget's Show All Info in One Label button.

The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI)
on the graph.

•
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Display basic statistics for data inside the ROI.
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•

Display mean and nth Standard Deviation lines inside the ROI.

•

Update results dynamically as ROI is moved or resized.

The Cluster gadget (available in OriginPro) provides the following features:

•

Display basic statistics for data inside a region of interest (ROI).

•

Switch between rectangular or elliptical ROI.

•

View statistics for points inside and outside of the ROI.

•

Edit, copy, mask, delete or group data points.

•

Update results dynamically as ROI is moved/re-sized.

•

Output results to a worksheet.
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When you use the Cluster gadget to define a category (points within a ROI on a plot), you
can apply a differentiating color to points within the ROI.

Note: To learn more about these gadgets, see:
Help: Origin: Origin Help > Gadgets
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13.6 Drawing Data Points on the Graph
This section discusses methods of graphically creating and modifying data plots.
This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D
scatter plots.

13.6.1Drawing a Data Point
1.

Activate the graph window.

2.

Click on the Draw Data Tool

3.

.

A small dialog opens and displays the graph window short name.

Click the Start button, then hover on the graph and double-click to set a data point. Continue clicking to

4.

set as many data points as you need.

5.

Points drawn on a new graph window will be added to a new sheet in the GAData book. Click the
Worksheet button to pop-up this new Workbook.

6.

Click Finish to end the point series.

o

Each time you click Finish, a "--" separator is added to the worksheet columns to delineate a
group of XY coordinates (drawn points).
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o

Points drawn on a new graph window will be added to a new sheet in the GAData book. Each
graph window will have its own sheet in the workbook.

7.

To label data points, go to the new Worksheet and enter label information in the Label column. Note that
Label column info can also be used to create plot groups by opening Plot Details and editing controls on
the Symbol tab (e.g. Symbol Color is indexed, by points, using the Label column data).

13.6.2Moving or Deleting Data Points in the Graph
13.6.2.1 Moving a Data Point
You can move individual data points in the graph. Understand that when you do this, you are changing the plot
and the underlying data:
1.

Select Data: Move Data Points (you'll be warned that you are about to change your data).

2.

Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag;
or use the arrow keys.

3.

Click the Pointer button

on the Tools toolbar or press ESC to exit the Move Data Points mode.

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.
13.6.2.2 Deleting a Data Point
You can delete individual data points from your graph:
1.

Select Data: Remove Bad Data Points.

2.

Double-click on the data point, or click to select the data point and press ENTER key.

3.

Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode.
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The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell
for the Y value will be cleared and shown as missing value.

13.7 Topics for Further Reading
•

Gadgets

•

The Data Analysis chapter of this User Guide

•

The Cluster Gadget (OriginPro)

•

The Vertical Cursor Gadget

•

The Digitizer

•

The Statistics Gadget

•

Masking Data

•

Data Filtering

•

Drawing or Deleting Data Points in the Graph

•

List of Origin Built-in Toolbars and Buttons
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14 Gadgets
Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple:
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.
You can drag to modify the ROI at any time, then change your analysis options and recalculate results by
clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.
Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new
exploratory and analysis-related tools have been added to OriginLab's File Exchange
and more tools are being released all the time. Please visit the File Exchange to review
available tools.

14.1 Origin Gadgets
The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin.
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Cluster Gadget

Differentiate Gadget

FFT Gadget

Integration Gadget

2D Integration
Gadget

Interpolate Gadget

Intersect Gadget

View statistics on points inside or outside of a graphically-defined region-of-interest
(rectangular, circular/elliptical or arbitrarily-shaped).

Calculate and plot the nth-order derivative of selected data.

View FFT spectrum of selected data.

Calculate the area under a curve, or between two curves.

Calculate the 2D integration for a contour or image graph created from matrix or
XYZ worksheet data.

Perform linear, spline, b-spline or Akima spline interpolation of selected data.

Calculate the intersection points of two or more data plots.

Perform linear, polynomial, or nonlinear fitting of selected data.

Quick Fit Gadget

With Origin 2022b the Quick Fit Gadget supports
custom labeling of the ROI Box .

Quick Peaks Gadget

Locate peaks, and compute area and other peak properties.

Quick Sigmoidal Fit
Gadget

Perform Sigmoidal fit of selected data.

Rise Time Gadget

Analyzes rise/fall time for the step-like signal.

Statistics Gadget

Compute and display simple descriptive statistics of selected data on the graph.

Vertical Cursor
Gadget

Read coordinate values and label data plots across multiple graph layers that share
the same X axis.

Image/Contour
Profile

Analyze the image or contour from matrix data and generate profiles.
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Curve Translate
Gadget

Drag a curve in the vertical or horizontal direction, adjusting source data in the
process.

Note: To learn more about these gadgets, see:
Help: Origin: Origin Help > Gadgets
Help: Origin: Origin Help >Matrixbooks Matrixsheets and Matrix Objects > Viewing and
Profiling Matrix Data

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet
1.

With a new workbook active, import the file Peaks on Exponential Baseline.dat
located in the Samples\Spectroscopy subfolder under the Origin installation folder.

2.

Create a line plot of the data in column B.

3.

With the graph active, go to the main menu and click Gadgets: Integrate....

4.

In the dialog box that opens, click the Baseline tab and select Straight Line from

5.

Click the Output tab, and under the Output Quantities to node, select Append to

the Mode drop-down list.
Worksheet and clear the other check boxes.
6.

Expand the Quantities node, select None from the Dataset Identifier drop-down
list and enable Beginning X and Ending X.

7.

Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is
added to the graph.

8.

Resize and move the ROI object to cover just the first peak in the data plot, then
press the arrow button

located at the top-right of the ROI and select New

Output; or press "O" on your keyboard. This will write the parameters for the first
peak to a worksheet.
9.

Drag and move the ROI to cover the second peak, and repeat the steps above to
generate output for the second peak.

10. Press the arrow button

again and this time select Go to Report Worksheet. A

worksheet with the integration results will open.
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Click the flyout menu button
(top right of the ROI) and output results for all curves
in the current layer (New Output for all Curves (N)) or for all layers of the graph
page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This
allows for batch analysis of multiple curves in a graph.
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14.1.1Custom Label for ROI Box

Origin 2022b supports custom labeling of the ROI Box for the Quick Fit and
Statistics gadgets.

14.1.1.1 Quick Fit Gadget
1.

Choose a gadget from the Gadgets: Quick Fit menu.

2.

Open the gadget dialog (hint: if the ROI is already added, click the menu button

and choose

Preferences).
3.

Click the ROI Box tab and enable Custom Label.

4.

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or
superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label

Custom Variable

Example

Reduced Chi-Sqr

chisqr

Chi-Square \g(c)\+(2) = $(chisqr, .2)

R-Square

cod

R-Squared r\+(2) = $(cod, .2)

Pearson's r

r

r = $(r, .2)

Y Intercept

intercept

Y Intercept = $(intercept, .2)

Slope

slope

Slope = $(slope, .2)

X Intercept

xintercept

X Intercept = $(xintercept, .2)
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14.1.1.2 Statistics Gadget
1.

Choose Gadgets: Statistics: Open Dialog (hint: if the ROI is already added, click the menu button
and choose Preferences).

2.
3.

Click the Show on Center-Top of ROI Box tab and enable Custom Label.
Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or
superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label

Custom Variable

Example

N

n

Count = $(n)

Mean

mean

\g(m) = $(mean, *4)

Minimum

min

Min = $(min, .2)

X at Minimum

xminy

X Min = $(xminy, .2)

Maximum

max

Max = $(max, .2)

X at Maximum

xmaxy

X max = $(xmaxy), .2)

Sum

sum

Sum = $(sum, .2)

14.2 Topics for Further Reading
•

Gadgets

•

The Image/Contour Profile tool

•

Tutorial: Using Multiple Gadgets

•

Tutorials for Individual Gadgets

•

Peak Analyzer

•

Digitizer
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15 Data Analysis
15.1 Introduction
Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak
analysis and signal processing. Most of Origin's analysis tools can make use of a stored collection of settings -something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from
one operation can become the input for another operation, thus allowing you to set up a chain of operations,
with results that update whenever there are changes to source data, as would happen when importing a series
of data files.
The following sections cover (1) selecting the data that you wish to analyze and (2) the Origin and OriginPro
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

Apps are add-on tools that extend Origin's graphing and analysis capabilities. Many
analysis-related tools are available free-of-charge from OriginLab's File Exchange. To
find out more about Apps in Origin, see the Apps for Origin chapter of this User Guide.

15.2 Data Input
Origin's analysis tools will work with workbook, matrix and/or graph data, depending upon the tool. By default,
analyses will be on done on selected data (note that in the case of matrix data, "selected data" will the the
matrix sheet or matrix object, depending on the analysis). When working with worksheet or graph data, you
may want to restrict your analysis to a subset of the data -- say, a certain range of rows or columns in a
worksheet or a certain X range in a graph.
Data selections can be made before or after opening an analysis dialog. Most of Origin's X-Function based
analysis tools have a Input branch with a range selection control that you can use to interactively select your
data (as explained below).

15.2.1Selecting Data in the Worksheet
When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range
selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior
to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
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If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do
upon opening the dialog is to select data in Input branch:

1.
2.

Click the range selection control next to Input (or Input Data). The dialog box will roll up.
Go to worksheet and highlight your worksheet data, then click the

button at the right end of the

rolled up dialog box. The Input branch will now show the selected range.
Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only
supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will
be picked in the analysis.
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Notes

•

The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can
add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its
corresponding X, Y, Error and Row controls.

•

Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet
and column).

•

A Rows control under each range node lets you set range by row index or X value. If you want to apply
the same row range to all ranges under Input Data, click the arrow button to the right of the range node
and choose Apply Row Range to All.

•

Depending on where you are in the Input Data hierarchy, the range selection button may have some
limitations ( e.g. if you click range selection control next to Y, though you could select multiple columns in
a worksheet, only the 1st column is accepted).

•

Clicking the arrow button to the right of the range selection control will show more selection options,
including individual worksheet columns that can be quickly added to your data selection.

•

Depending on which level you are in, the selection options when clicking the arrow button may vary. For
instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item,
will open the Column Browser allowing you to select multiple columns from different worksheets.
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1.

Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can
be sorted by clicking any of the column headings, making it easy to select, for example, all columns that
share the same LName or Comments.

2.

Then click the Add button to add the column to your selection list in bottom panel.

3.

To modify the data input range of any dataset, click the range button to the right of any dataset added to
the bottom panel and edit the From and To values.

15.2.2Selecting Data in the Graph
When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the
interactive range selector button, changing a data range, etc.).
15.2.2.1 The Data List and the Active Data Plot
The active data plot is the one that shows in the data list (bottom of the Data menu) with a check mark next
to it. If the active graph layer contains a plot group, the default behavior is to make the first plot in the group
the active data plot (note the "g1" beside each range in the following image, indicating that all are members of
plot group 1). You can activate a different plot by clicking on another of the data plots listed at the bottom of
the Data menu. Subsequently, when you open an analysis dialog box, this newly-selected plot will be listed as
your input data.
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However, for most purposes, you can ignore the data list and select your plot data directly in the graph
window or using the Object Manager:

•

If your data plots are part of a plot group, select the entire group by pressing SHIFT + clicking on a plot.
Alternately, click on the group icon in the Object Manager. Either will set Input Range to all plots in the
group.

•

To select just a single plot -- whether it be an independent plot or part of a group -- click once on the plot.
Alternately, click on the plot icon in the Object Manager. Either will set Input Range to only the selected
plot.
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You can also indicate the active dataset by placing a red box around the plot's legend
entry. In the case of grouped plots, the red box shows on the first plot in the group.
To turn this feature on or off:

•

Click on your graph window, select Format: Page..., click on the Legends/Titles
tab and enable or clear the Indicate Active Dataset box.

•

Select the graph legend, then right-click on it and choose Legend, then
select/deselect the Indicate Active Dataset menu entry.

•

Select the graph legend, then right-click on it and choose Legend: Update
Legend and enable or clear the Indicate Active Dataset box.

15.2.2.2 Customizing X scale range using Analysis Dialog "Rows" controls
You can adjust data range using the Rows controls under the Input Data branch of most analysis dialogs. If
you have an analysis dialog box open:
1.

Click on Input Data branch to expand.

2.

Change the Rows drop-down list to By Row or By X and enter your From and To values. Note that each
Range N will have its own Rows controls.

15.2.2.3 Customizing X scale range using Axis Scale Mini Dialog
Before opening an analysis dialog...
1.
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Click on an axis then click the Mini Toolbar Axis Scale button to open the Axis Scale dialog box.
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2.

Adjust the X axis scale to your desired range.

3.

Now open your analysis dialog (e.g. Linear Fit) and click the arrow button beside the Input Data box and
select Use X Scale Range from the context menu:

As you can see, the customized scale range of X axis on the graph has been used to specify the input data
range for your analysis (Rows = By X).
15.2.2.4 Selecting data graphically using The Regional Data Selector
You can graphically select a range of data using the Regional Data Selector tool:
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1.

With a graph window active, click and hold on the Regional Data Selector button

on the Tools

2.

Drag out a rectangle or freehand object to select an area of the plot(s). Note that you can press Space to

toolbar, and then choose either the Selection on Active Plot or Selection on All Plots button.

toggle between rectangle

and freehand modes

.

When you make your selection, Data Markers are placed on the graph to mark the selected range(s). You can
now use Origin's analysis tools (e.g., Linear Fit) to perform an analysis on the selection, but note that some
analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis:
Signal Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.
There is a new Mini Toolbar for controlling X scale range when using Data Markers.
Click on a Data Marker and use the buttons to Set Display Range or Reset to Full
Range.

Tutorial: Linear Regression on Partial X Range
1.

Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new
workbook.

2.

Select all Y columns and create a line plot.

3.

Click and hold the Regional Data Selector button on the Tools toolbar, and then
choose the Selection on All Plots button

4.

.

Drag out a rectangle to select the tail-end of the three curves between values of
approximately 0.6 and 1.0 along the X axis.

5.

Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.

6.

Input Data branch is filled with three ranges. Mouse over Input Data branch will
show tooltip which shows 1X,1Y, ...3X and 3Y.

7.
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If you want to change the data selection, click the arrow button in Input Data
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and choose Reselect All Data from Graph. The dialog will roll up. Drag out a
rectangle in graph again to make your selection and then click the

button at

the right end of the rolled up dialog box. The new data selection will show in Input
Data branch.
8.

Accept default Linear Fit settings and press OK to close the dialog. Linear fitting
will be performed on all three curves over the selected range.

In addition to the data selection and data masking methods discussed in this
section, Origin offers data filtering and data reduction tools. Please visit the linked
pages for details.

15.2.2.5 Editing a Data Marker
To edit a Data Marker:

•

To modify a data range, right-click a data marker and choose Edit; or double-click on the data marker.
The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair.
Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below
and modify the data range. To escape edit mode, double-click on the marker or press the Enter key.

•

There are other options when right-clicking the data marker such as Delete Marker, Delete Data, etc..
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Note: If you use the Regional Data Selector to place markers on multiple plots (Selection on All
Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of other
selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:
1.

Select data markers using these keys ...

Hot Key

2.

s

Select the first pair of data markers on the graph (those marked with "1").

Tab

Select the next pair of data markers (not in edit mode) or the other data
marker of the pair (in marker edit mode).

Home

Return to the first data marker.

End

Go to the last data marker.

... then activate and edit the data marker using these key combinations:

Hot Key
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Action

Action

Enter

Activate the selected data marker for editing. (Press Enter again to exit
data selection mode.)

Arrow

Move the active data marker exactly one data point.

Ctrl/Shift + Arrow

Move the active data marker multiple data points.

Delete

Delete the the active data marker.

Data Analysis

15.2.2.6 Difference between Data Markers and Analysis Markers

•

Data Markers define a sub-range that you select using the Data Selector tool.
If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from
the main menu, or click the Clear Data Markers

•

button on the Markers and Locks toolbar.

When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default,
Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange,
Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun
your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the
Input Data range and rerun the analysis.
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Note:
1.

If you set Recalculate to None in the analysis dialog box, then no analysis markers are
generated.

2.

Data markers and analysis markers are not exported when you choose File: Export Graphs.

3.

To select the exact same range again for another analysis, click the green lock and choose Plot

4.

There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker

Input Data with Data Markers to create a new graph and do analysis on it.

Hide Show

to toggle analysis markers on or off, etc. There is also an Analysis Markers

submenu, available from the Data menu; or when you right-click on an analysis marker or green
lock and choose Analysis Markers.

15.2.2.7 The Pick Points Tool
You can also pick the data points in the graph using the Pick Data Points tool. This works best for scatter or
line + symbol plots of smaller datasets.
1.

Select Data: Pick Data Points. The Pick Points dialog will pop up.

2.

With the square cross-hair, you can read the coordinate of current data points in the Pick Points dialog
(also the Data Source). Double-click on the point you want to pick until the cross-hair cursor became
round, the actual X&Y values will be recorded and the total number of picked points will be counted up.
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3.

Once you finished the picking, click the Done button to output the results to a new workbook.

15.2.2.8 The Data Highlighter
In some cases, the Data Highlighter on the Tools toolbar, can be useful for selecting some portion of your
data for further analysis. For instance, you have a 2D scatter plot and you are interested in data points in a
particular region of the graph.

1.

Click the the Data Highlighter button

2.

Highlight the desired group of data points. Note that you can toggle between rectangular and freehand

on the Tools toolbar.

selection modes by pressing the spacebar while the Highlighter is active. Selection points in the graph
simultaneously highlights selected rows in the source worksheet.
3.

Go the source worksheet, right-click on it and choose Create Subset Sheet.

You now have a secondary worksheet named as wcopyN, that contains only the data points that you selected
in the graph.
For more information, see The Data Highlighter Tool.

15.3 Data Output
Origin's analysis tools typically have an Output branch (the exact name varies by tool), in which you can
specify the output that you wish to generate and where you would like that output to go. This happens to be
the output branch of the Integration tool.

Output can be directed to various places -- a range of worksheet cells or columns, or possibly to a worksheet,
a workbook, a matrixsheet, or a graph layer. Output options depend upon the target object as well as the type
of window that was active when the tool was opened. You can determine your output target by:
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•

Typing directly in the associated text box, using a standard range notation

•

Selecting data with the interactive range control.

•

Type or select your target using a set of predefined range strings.

This being an introductory manual, we will stick with the simplest to use -- using predefined range strings.
For information on other options, follow the links above.

15.3.1Specifying Output Using Range Strings
Referring to the image above, note that range strings are enclosed by < > characters. Valid strings will differ
from dialog to dialog (e.g. <source> is available from the Book list under the Output Fitted Values To
branch of the Fit Linear dialog, but it is not used to specify Output in the Smooth dialog).
The most common strings:

•

<none>: Generate no output.

•

<new>: Create a new Origin object -- a column, a worksheet, a graph, etc.

•

<input>: Use the input object for output.

You can type these strings directly into the edit box but the easiest thing to do is to just select them from the
flyout menu (options will vary by tool). Alternately, you can click the Custom button and open the Range
String Builder. Despite the intimidating name, it is just a way to step through the process of specifying your
output target. For more information on range strings and Range String Builder, see Output Results in the
Origin Help file.

15.4 Data Masking
Masking is another technique that you can use when you want to analyze only a subset of your data, or
when you have spurious data points that you do not want included in your analysis. Masking or unmasking
data will trigger recalculation of linked operations.

•

You can mask data points in both worksheets and graphs.

•

When data exist in both the worksheet and the graph, masking data in one will mask (and mark) the
corresponding data in the other.

•

Mask toolbar buttons work on both graphs and worksheets.

•

Tools toolbar buttons work on graphs.

•

When data are selected in the worksheet, a Mini Toolbar Mask Data button becomes available.

•

Additionally, you can mask worksheet data by mathematical condition.

The active worksheet's Masked and/or Unmasked Data Count can be reported to the
Status Bar.
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15.4.1Masking with the Mask Toolbar (worksheet, graph)
These toolbar buttons are used to mask and manipulate masking of selected data. Note that this includes
graphs, once data have been selected (see the next section on Tools toolbar buttons for graph selection).

Action

Toolbar
Button

Shortcut Command

Notes

Mask: Range

Mask the selected data range.
Masked data will display in the mask
color.

Unmask data

Mask: Clear Range

Unmask the selected data range.
Unmasked points are included in
analysis operations and plot
"normally".

Swap mask

Mask: Swap

Swap masked and unmasked points
in the active dataset.

Change mask
color

Mask: Change Color

Change the mask color of the
masked data range.

Hide/Show
masked points

Mask: Hide

Toggle display of masked points ON
and OFF on-screen, and in printed
and exported graphs.

Mask: Disable Masking

Toggle the mask ON or OFF for all
masked data in the worksheet.
When toggled OFF, all data points
are analyzed and included in printed
and exported graphs.

Mask data

Disable masking

15.4.2Masking with the Tools Toolbar (graph)
There was a change made to the default masking mode, starting with Origin 2021:

•

Default is changed from mask by row index number to mask by
rectangular region.

•

Otherwise, behavior remains as before: toggle between masking modes
(see next) by pressing Spacebar.

•

Use system variable @MTI=1 (persistent) to revert to mask by row
index as default.
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To mask points, click on the graph window to activate it:
1.

Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or
Mask Points on All Plots button on the Tools toolbar, then hover on the graph.

2.

To mask a single point, double click on the point. To mask a region of points, press the Space bar to
toggle among masking by row index number, by rectangular region or by freehand region (differences
explained below), then drag out a region.

3.

Once data are masked in the graph, you can use the Mask toolbar buttons, described above.

Mask Points
on Active Plot

Mask Points on All
Plots of Active
Layer

Purpose

Mask data points by rectangular region. Only the data points inside
the rectangle that you drag out, will be masked.

Mask data points by freehand region. Only the data points inside
the region that you drag out, will be masked.

Mask data points by row index number. All data points between the
lowest and highest selected index numbers are masked regardless
of whether they lie inside your rectangle.

To remove the mask from data points in the graph window:

1.

Choose either the Unmask Points on the Active Plot
Active Layer

2.

tool or the Unmask Points on All Plots of

tool on the Tools toolbar.

Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then
drag to unmask your data points. The tool will be active until press ESC or click the Pointer

tool.

15.4.3Mask Mini Toolbar Button (worksheet)
When worksheet data are selected -- cells or entire columns -- A Mini Toolbar Mask Data button
becomes available. The button works as a toggle to mask or unmask data within the selection.

15.4.4Mask Cells by Condition (worksheet)
There is a tool for masking worksheet data values by condition (e.g. <= 0).
1.

With the data selected (cells or one or more columns), choose Column: Mask Cells by Condition. This
opens the colmask dialog.

2.
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Choose your Condition and Value, plus other options as needed and click OK.
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15.5 Mathematics
Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume
calculations.

15.5.1Basic Math
New Analysis: Mathematics: Normalize Columns options:

•

Normalize Methods = Normalize to [x,y] to normalize columns to a userspecified range of values.

•

For Normalize Methods = Use Reference Column, a new Normalize to =
Range option.

Tool Name

•

Description

Menu Entry

Simple Column
Math/Simple Curve
Math

•

Normalize

•

on worksheet columns or

Columns/Curves

•

Perform basic calculations
XY data plots

Average Multiple

Analysis:Mathematics
(workbook, graph)

Curves

•

Differentiate

•

Simple Math

•

Subtract Reference

•

arithmetic on two matrices.

•

Data

•

Subtract Straight

•

Subtract

Analysis:Data Manipulation
(workbook, graph)

Subtract a straight line
defined graphically by
clicking in the graph.

•

Analysis:Mathematics
(matrix)

Subtract one dataset from
another

Line

•

Perform element-wise

Analysis:Data Manipulation
(graph)

Subtract matrices in sheet
by another matrix.

Analysis:Mathematics
(matrix)
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Tool Name

Description

•

Use a Gadget to

•

Vertical Translate

graphically translate

•

Horizontal Translate

curve(s) in vertical or
horizontal.

•
•

Differentiate Gadget

a graph

•

Intersect Gadget

Gadgets:Differentiate...
(graph)

Calculate the intersection
points of two or more data
plots.

•

Analysis:Data Manipulation
(graph)

Perform differentiation
over a region of interest in

•

Menu Entry

Gadgets:Intersect... (graph)

Read and tag X, Y
coordinate values for data

•

Vertical Cursor

plots across multiple
graphs that share the

Gadgets:Vertical Cursor...
(graph)

same X axis.

•
•

Set Column Values

Use formulae to
set/transform worksheet
column values

Generate pseudo inverse of

•

Inverse

•

Median Filter

•

Special Filter

median/special/custom

Custom Filter

filter to a matrix

•
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•

a matrix

•

Analysis:Mathematics
(workbook)

Analysis:Mathematics
(matrix)

Apply

Analysis:Mathematics
(matrix)

Data Analysis

15.5.2Interpolation

Tool Name

Description

•
•

Interpolate Gadget

Perform interpolation
over a region of
interest

•

Menu Entry

Gadgets:Interpolate...
(graph)

Perform
interpolation/extrapola

•

Interpolate/Extrapolate

•

XYZ Trace Interpolation(3D
Graph)

•

tion on a group of XY
data.

•

interpolation on XYZ

Trace Interpolation(2D
Graph)

Perform periodic
worksheet data

•

Analysis:Mathematics
(workbook, graph)

Perform interpolation
on cycle or periodic
curves

•

Perform
interpolation/extrapola
tion on a group of XY
data to find Y at given
X values.

•

Interpolate/Extrapolate Y

•

interpolation on a

from X

•

Perform 2D
group of XYZ data to

3D Interpolation

find Z at given XY

Analysis:Mathematics
(workbook)

values w/ choice of 8
methods.

•

Perform interpolation
with a 3D function on
XYZ dataset.

•
•

2D Interpolate/Extrapolate

Perform 2D
interpolation/extrapola
tion for a matrix

Analysis:Mathematics
(matrix, graph from
matrix)

319

UserGuide_2022b

15.5.3Area/Volume Calculation

Tool Name

Description

•
•

Integrate Gadget

Perform integration over a
region of interest in a 2D
Graph

•

Menu Entry

Gadgets:Integrate... (graph)

Calculate max height,
volume, FWHM (X,Y) for a

•

2D Integrate Gadget

contour or image graph
created from matrix or XYZ
worksheet data (OriginPro

Gadgets:2D Integrate...
(graph)

Only).

•

Integrate(2D Graph)

•

Polygon Area(2D
Graph)

•

XYZ Surface Area
(3D Graph)

•

2D Volume Integrate

•

Matrix Surface Area

•

Perform integration on
input data

•

Calculate the area of
enclosed plot regions

•

Analysis:Mathematics
(workbook, graph)

Calculate the area of the
XYZ surface

•

Calculate the volume
beneath the matrix surface
from zero plane

•

Calculate the area of the
matrix surface

Analysis:Mathematics: 2D
Volume Integrate (matrix, 3D
graph from matrix)
or
Analysis:Mathematics:
Matrix Surface Area (matrix,
3D graph from matrix)

15.6 Curve Fitting
A number of free Apps designed for various curve-fitting operations are available from
the OriginLab File Exchange. To find and install these Apps click Analysis: Fitting:
Find Apps. The App Center will open, displaying only fitting-related Apps. Browse
available Apps and click the Download and Install button
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Curve fitting improvements in Origin 2022b:

•

Use named range values as fitting function parameters, X "From" and "To" values,
lower and upper bounds and initial parameter values in the nonlinear curve fitter
(NLFit).

•

Better auto initialization of parameters that are not assigned a specific value.

•

For User Defined functions, support EMF or SVG image of Formula (Equation) to
display in lower panel of NLFit or Fitting Function Organizer.

To add an EMF or SVG image to your user-defined function:
1.

Create the EMF/SVG using an equation editor (hint: Origin's LaTeX App can convert a
user-defined fitting function into a LaTeX equation object).

2.

Name the EMG/SVG image just as you named the user-defined fitting function (e.g.
MyFunction.SVG) and place in \User Files\fitfunc.
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15.6.1Linear and Polynomial Fit

Most curve fitting and peak finding analyses add an optional Result Table with equation,
weighting, slope, intercept, etc., to the active graph. Origin 2022b adds a Mini Toolbar
button for adjusting displayed digits in the Result Table.

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. Linear Fit on
Matrix Stack is performed on a series of matrix objects.

Tool Name

•

Linear Fit

•

Fit Linear with X Error

•

Multiple Linear Regression

•

Polynomial Regression

•

Perform a linear fit on a series of
matrix objects for each pair of XY
coordinates.

Menu Entry
Analysis:Fitting:Linear Fit
or
Gadgets:Quick Fit (graph)

Analysis:Fitting:Fit Linear with X Error

Analysis:Fitting:Multiple Linear Regression

Analysis:Fitting:Polynomial Fit
or
Gadgets:Quick Fit (graph)

Analysis: Linear Fit on Matrix Stack (matrix)

15.6.2Nonlinear Curve Fit
You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a userdefined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some
tools are available only in OriginPro.
The table below summarizes available nonlinear curve fitting tools:
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Tool Name

Features

•

Menu Entry

Fit a region of interest in a
graph interactively

•

Fit with built-in or userdefined fitting functions

•

Quick Fit Gadget

•

Fit one or multiple datasets

•

Choose from a number of
pre-defined analyses (incl.

Gadgets:Quick Fit (graph)
or
Gadgets:Quick Sigmoidal
Fit (graph)

Linear, Cubic, Peak and
Sigmoidal).

•

Fit with built-in or userdefined fitting functions

•

Fit one or multiple datasets

•

Compare fit, multiple
parameter sets

•
•

sharing

Nonlinear Curve
Fitting

Global fit with parameter

•

Global fit, parameter
sharing with multiple

Analysis:Fitting:Nonlinear
Curve Fit (workbook, graph)

functions

•

Fit with replicas

•

Advanced options including
bounds, constraints, fit
control

•

Implicit Curve Fitting

•

Fit with implicit functions

•

Orthogonal Distance
Regression (ODR)
algorithm

•

Surface Fit

•

Fit data from a matrix or
worksheet XYZ columns

Analysis:Fitting:Nonlinear
Implicit Curve Fit (workbook,
graph)

Analysis:Fitting:Nonlinear
Surface Fit (workbook, graph)
or
Analysis:Nonlinear Matrix
Fit (matrix)
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Tool Name

•

Fitting Function

Features

•

Builder

•

Manage fitting functions by

•

Move or share functions
between categories

•
•

•

Request or Share a
Function with OriginLab

•
•

Simulate

Simulate a surface from a
given function

•

Click the Fitting Function
Library icon in the Apps
Gallery

Simulate a curve from a
given function

•

Tools:Fitting Function
Organizer

Download fitting functions
from originlab.com

Fitting Function
Library App

Tools:Fitting Function
Builder

categories

Fitting Function
Organizer

Create or edit user-defined
fitting functions

•

Menu Entry

Analysis:Fitting:Simulate
Curve
or
Analysis:Fitting:Simulate
Surface

Compare fit results from
two datasets using one

•

Fit Comparison

function function

•

Compare fitting results for
one dataset using two
fitting functions

•

Fit and Rank
Functions

•

Analysis:Fitting:Compare
Datasets
or
Analysis:Fitting:Compare
Models (workbook, graph)

Compare fit results of two
or more functions for a
single dataset

Analysis:Fitting:Rank
Models (workbook, graph)

15.7 Peak Analysis
Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.
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Note that a number of free Apps designed for peak analysis are available from the OriginLab File Exchange. To
find and install these Apps click Analysis: Peaks and Baseline: Find Apps. The App Center will open,
displaying only peak-fitting related Apps. Browse available Apps and click the Download and Install button
to install an App.
The table below summarizes various built-in tools available for peak analysis:

Tool Name

Features

•

Menu Entry

Perform peak analysis over
a region of interest

•

•

•

Quick Peaks Gadget

Multiple Peak Fit

•

Create baseline

•

Subtract baseline

•

Find peaks

•

Integrate peaks

•

Fit peaks

•

Pick multiple peaks

•

Fit peaks

•

Create baseline

•

Subtract baseline

•

Find peaks

•

Integrate peaks

•

Fit multi-peak datasets

•

Fit baseline

•

Find hidden peaks

•

Compute many peak

Peak Analyzer

Gadget:Quick Peaks (graph)

Analysis:Peaks and
Baseline:Multiple Peak Fit
(graph, workbook)

Analysis:Peaks and
Baseline:Peak Analyzer
(graph, workbook)

characteristics

•

Use a theme file created
using Peak Analyzer tool

•

Batch Peak Analysis

•

Perform batch peak
analysis on multiple
datasets

Analysis:Peaks and
Baseline:Batch Peak
Analysis Using Theme
(graph, workbook)
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15.8 Signal Processing
Origin provides signal processing tools for many tasks, including producing signal transforms,
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.
You may refer to the tables below for the signal processing tools and their menu entry.

15.8.1Signal Transforms
Tools

•

FFT Gadget

•

Fast Fourier Transform (FFT)

•

Inverse Fast Fourier Transform
(IFFT)

•

2D FFT

•

2D IFFT

•

Short-time Fourier Transform

Menu Entry

Gadgets:FFT... (graph)

Analysis:Signal Processing:FFT
(workbook, graph)

Analysis:Signal Processing:FFT (matrix)

Analysis:Signal Processing:STFT
(workbook)

(STFT)

•

Hilbert Transform

•

Image Profiling

Analysis:Signal Processing:Hilbert
Transform (workbook, graph)

Plot>2D:Profile:Image Profile (matrix,
worksheet, XYZ data)

15.8.2Filtering

Tools

•
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FFT Filter

Menu Entry
Analysis:Signal Processing:FFT Filters
(workbook, graph)

Data Analysis

Tools

Menu Entry

•

2D FFT Filter

Analysis:Signal Processing:2D FFT
Filters (matrix)

•

IIR Filter Design

Analysis:Signal Processing:IIR Filter
(workbook, graph)

15.8.3Smoothing

Tools

•

Smooth

Menu Entry
Analysis:Signal Processing:Smooth
(workbook, graph, matrix)

15.8.4Correlation

Tools

•

Correlation

•

2D Correlation

Menu Entry
Analysis:Signal Processing:Correlation
(workbook, graph)

Analysis:Signal Processing:2D
Correlation (matrix)

15.8.5Convolution

Tools

•

Convolution

Menu Entry
Analysis:Signal
Processing:Convolution (workbook,
graph)
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15.8.6Wavelet Analysis (Pro Only)

Tools

•

Continuous Wavelet Transform

•

Discrete Wavelet Transform

Menu Entry

(Decomposition)

•

Inverse Discrete Wavelet
Transform (Reconstruction)

•

Multi-Scale Wavelet

Analysis:Signal Processing:Wavelet
Analysis (workbook, graph)

Decomposition

•

Smoothing

•

Noise Removal

•

2D Wavelet Decomposition

•

2D Wavelet Reconstruction

Analysis:Signal Processing:Wavelet
Analysis (matrix)

15.8.7Other Advanced Tools (Pro Only)

Tools

•

Rise Time Gadget

•

Decimation

•

Coherence

•

Envelope Curves

Menu Entry

Gadget:Rise Time (graph)

Analysis:Signal Processing:Decimation
(workbook, graph)

Analysis:Signal Processing:Coherence
(workbook, graph)

Analysis:Signal Processing:Envelope
(workbook, graph)

15.9 Image Processing
Origin provides a collection of tools for basic image processing. These tools are accessible from the Image
menu when a matrixbook is active. Some tools are
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The tools are organized in the following sub-menus:

•

Image:Adjustments

•

Image:Arithmetic Transforms

•

Image:Conversion

•

Image:Geometric Transforms

•

Image:Spatial Filters

15.10 Topics for Further Reading
•

Analysis Dialog Boxes: Specifying Your Input Data

•

Outputting Analysis Results

•

Recalculation of Analysis Results

•

Generating Analysis Report Sheets

•

Performing Math Operations on Datasets

•

Linear/Polynomial Regression

•

Nonlinear Curve Fitting

•

Peak Analysis using Origin

•

Signal Processing

•

Image Processing and Analysis

329

16 Statistics
16.1.1Apps for Statistics
Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related
graphing and analysis Apps have been added to OriginLab's File Exchange and more tools are being released
all the time.
A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no
extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to
show only statistics-related Apps. Browse available Apps and click the Download and Install button
install an App.

to

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive "wizard" interface to
help you choose appropriate statistical tests and to tell you where to find them in your Origin software, or -- if
the test is available from another add-on App -- where to find it on the OriginLab File Exchange.
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16.2 Basic Statistics

Many of Origin's advanced statistical tests are available only in OriginPro. Users of
standard Origin will see these Pro-only tests marked as (Pro) in the main menu. If you
own the standard version of Origin but find that you need features of OriginPro, you can
upgrade by contacting your Origin representative.
If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):

16.2.1Basic Statistics on Worksheet
Descriptive Statistics

•

Statistics on Columns

•

Statistics on Rows

Menu entry with worksheet active

Statistics:Descriptive Statistics

No menu access. To open the dialog box:

•

Statistics on Y by X Bin

1.

Click Window: Script Window.

2.

At the cursor, type statsxy -d and press
Enter.

•

Cross Tabulation and Chi-Square

Statistics:Descriptive Statistics

332

Statistics

Frequencies/Counts

•

Discrete Frequency

•

Frequency Counts

•

2D Frequency Counts/Binning

Menu entry with worksheet active

Statistics:Descriptive Statistics

Distribution

•

Distribution Fit

•

Normality Test

Statistics:Descriptive Statistics

Relationship

•

Correlation Coefficient

•

Partial Correlation Coefficient

Statistics:Descriptive Statistics

Detecting Outliers

•

Grubbs Test

•

Dixon's Q-test

Statistics:Descriptive Statistics

You can apply Conditional Formatting to a worksheet by applying mathematical
expressions or statistics to cell values. For more information, see Conditional
Formatting.
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16.2.2Descriptive Statistics on Graph
Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

Descriptive Statistics

•

Menu entry with graph active

Cluster Gadget

Gadgets:Cluster...

Gadgets:Statistics...

•

Statistics Gadget
With Origin 2022b the Statistics Gadget
supports custom labeling of the ROI Box.

16.2.3Descriptive Statistics on Matrix
Descriptive Statistics

•

Menu entry with matrix active

Output descriptive statistics (mean, sd,
min, max, etc.) on the matrix stack
(series of matrix objects), for each pair

Analysis: Descriptive Statistics

of XY coordinates.

16.2.4Statistics on Selected Range
Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s)
in a graph.
16.2.4.1 Status Bar
Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and
you can use the CTRL key to select non-contiguous groups of cells.
Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar.
Right click on the status bar to customize what quantities to display.
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16.2.4.2 Command or Script Window
Statistics, Report to Script/Command Window
1.

Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in
a graph.

2.

Open the Command Window or the Script Window from the Windows menu, and type one of these
commands, then press ENTER:

stats

moments

quantiles
With the Command Window, the results are typed out below the command line. With the Script Window, you
will need to issue an additional command to return your results:

stats;
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stats.=;

Note: For more information, please refer to the:
Help: X-Function > X-Function Reference > Statistics

16.3 Statistical Graphs
Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

Graph Type
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Plot Menu
Category

Box Charts: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half
Box, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box
Charts.

Statistical

Box Charts, Violin Plots, etc., Grouped: Grouped Scatter - Indexed Data,
Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped
Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data,
Grouped Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped
Half Violin - Indexed Data, Grouped Half Box - Indexed Data.

Categorical

Violin Plots: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile,
Violin with Stick, Split Violin, Half Violin.

Statistical

Histograms: Histogram, Histogram + Rug, Histogram + Probabilities, MultiPanel Histogram, Distribution, Distribution + Rug, Histogram with Labels,
Stacked Histograms, Marginal Histograms.

Statistical

Population Pyramid

Statistical

2D Kernel Density

Contour

Heatmap: Heatmap, Heatmap with Labels, Split Heatmap

Contour

Contour - Categorical Z

Contour

Cluster Plots

Categorical

Probability: Probability Plot, Q-Q Plot.

Statistical

Statistics

Graph Type

Plot Menu
Category

Pareto and QC Chart: Pareto Chart - Binned Data, Pareto Chart - Raw Data,
QC (X-bar R) Chart.

Statistical

Bland-Altman Plot (Tukey mean-difference)

Statistical

Scatter Matrix

Statistical

Trellis Plot: Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot

Categorical

Parallel Plot: Parallel Plot, Parallel Sets, Parallel Index.

Categorical

The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.

Graph Type

•

Means Plot

•

Means Comparison
Plot

•

Survival Curve

•

One Minus Survival

Menu Entry

Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA
Statistics: ANOVA: One-Way Repeated Measure ANOVA

Curve

•

Hazard Curve

•

Log Survival Curve

•

Scree Plot

•

Component Plot

•

Dendrogram

Statistics: Survival Analysis: Kaplan-Meier Estimator

Statistics: Multivariate Analysis: Principal Component Analysis

Statistics: Multivariate Analysis: Hierarchical Cluster Analysis
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Graph Type

•

Menu Entry

Classification
Summary Plot

•

Classification Fit
Plot

•

Statistics: Multivariate Analysis: Discriminant Analysis

Canonical Score
Plot

•

ROC Curve

Statistics: ROC Curve

16.4 Comparing One, Two or More Groups
Origin provides parametric and non-parametric tests to compare one, two, three or more groups.

16.4.1Parametric Hypothesis Tests
Feature

•

One-Sample t-Test

•

Two-Sample t-Test

•

Pair-Sample t-Test

•

One-Sample Test for
Variance

•

Menu Entry

Statistics: Hypothesis Testing

Two-Sample Test for
Variance

•

One-Sample Proportion
Test

•

Two-Sample Proportion

Statistics: Hypothesis Testing

Test

•

Two-Sample t-Test on
Rows

•

Pair-Sample t-Test on
Rows
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Statistics: Hypothesis Testing

Statistics

16.4.2ANOVA

Feature

•

One-Way ANOVA

•

Two-Way ANOVA

•

Three-Way ANOVA

•

One-Way Repeated-Measures ANOVA

•

Two-Way Repeated-Measures ANOVA

Menu Entry

Statistics: ANOVA

(Supports both Balanced and Unbalanced data)

16.4.3Non-parametric Tests

Feature

•

One-Sample Wilcoxon Signed Rank Test

•

Paired-Sample Wilcoxon Signed Rank Test

•

Paired-Sample Sign Test

•

Mann-Whitney Test

•

Two-Sample Kolmogorov-Smirnov Test

•

Kruskal-Wallis ANOVA

•

Moods Median Test

•

Friedman ANOVA

Menu Entry

Statistics:Nonparametric Tests

Notes:
Multiple nonparametric tests can be run simultaneously. (Accessible from the
Statistics:Nonparametric Tests menu ) Available options are:

•

(NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test

•

(NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test

•

(NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov
Test
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16.5 Advanced Statistics
Several additional tools are available in OriginPro.

16.5.1Multivariate Analysis
Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from
your data.

Feature

•

Principal Component Analysis

•

K-Means Cluster

•

Hierarchical Cluster

•

Discriminant Analysis

•

Canonical Discriminant Analysis

•

Partial Least Squares

Menu Entry

Statistics:Multivariate Analysis

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the
Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System)
menu.

16.5.2Survival Analysis
OriginPro includes widely used survival tests to quantify survivorship in a population.

Feature

•

Kaplan-Meier Product-limit Estimator

•

Comparing Survival Curves

•

Cox Proportional Hazards Model

•

Weibull Fit Model

Menu Entry

Statistics:Survival Analysis

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator
feature.

16.5.3Power and Sample Size
Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in
designing experiments. Origin can compute the power of the experiment for a given sample size and can also
compute the required sample size for given power values.
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Statistics

Feature

•

One-Proportion Test

•

Two-Proportion Test

•

One-Sample t-Test

•

Two-Sample t-Test

•

Paired-Sample t-Test

•

One-Variance Test

•

Two-Variance Test

•

One-Way ANOVA

Menu Entry

Statistics: Power and Sample Size

16.5.4ROC Curve

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two
methods that are used to discriminate between diseased and healthy cases.

Feature

•

ROC Curve

Menu Entry

Statistics: ROC Curve

16.6 Topics for Further Reading
•

Statistics on Worksheet Columns

•

Statistics on Worksheet Rows

•

Descriptive Statistics

•

Statistics Charts, General

•

Appendix 2 - Origin Graph Types

•

Appendix: Statistical Graph Types by Template

•

Normality Testing

•

Distribution Fit

•

Parametric Hypothesis Testing

•

ANOVA

•

Nonparametric Tests

•

Multivariate Analysis

•

Survival Analysis

•

ROC Curves

•

Power and Sample Size Tests

•

LabTalk Supported X-Functions: Statistics
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17.1 Analysis Report Sheets

Analysis operations, such as those performed with the tools listed in the Analysis chapter or in the Statistics
chapter, create detailed Analysis Report Sheets.

•

Analysis Report Sheets contain tables that are organized in a tree structure.

•

Expand or collapse each branch to show or hide table contents.

•

Tables are not static reports. They are constructed using placeholders linked to particular analysis results
and thus, results can be recalculated with changes to input or analysis parameters.

•

You can add comments to the sheet or copy tables and paste or paste-link them to other windows in your
project.

•

Analysis Report Sheets often contain embedded graphs such as fit curves or residual plots. To customize
these plots, double-click on them. This opens the embedded graph in a separate window where -- as with
any Origin graph -- you can customize it using Mini Toolbar buttons or Plot Details controls. When you are
done customizing, click the Close

button and re-insert the customized graph back into the report

sheet.
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For more information on Analysis Report Sheets, see the Origin Help File.

17.2 Recalculation
All Analysis and most data processing dialog boxes in Origin include a Recalculate control. This control
allows you to tie output operations to the source data. When Recalculate is set to Auto or Manual, changes to
the source data will trigger an update of the output (pending, in the case of Manual). This allows you to
analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature
is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.

The Recalculate control has three modes:

None

•

No lock is displayed in the output.

•

Changes to the input data will not result in an update of the output.

•

An auto green lock

displays on the output columns and graphs of the output data.

The main operation lock displays on the left-most column as

, while any related

operations columns to right of the main operation display the "+" icon

Auto

•

The output will be automatically updated when input data is changed.

•

You can also click on a lock icon and open the dialog to make changes to the analysis
settings, including changing the Recalculate mode.
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•

A manual green lock

is displayed in up-to-date output columns, and graphs that

contain plots of the output data. Any related operations columns to right of the main
operation display the "+" icon

•

A yellow lock

.

indicates that input data have changed and recalculation operations

are pending. You can trigger updates individually by clicking on a yellow lock and

Manual

selecting Recalculate from the shortcut menu; or you can update all pending
operations by clicking the yellow Recalculate button

•

on the Standard toolbar.

You can also click on a lock icon and open the dialog to make changes to the analysis
settings, including changing the Recalculate mode.

Tips for Managing Recalculation Operations

•

A left-click on the lock displays a menu that provides multiple options including changing analysis
parameters, opening source data sheet, switching to result sheets, and controlling the status of the
operation such as switching from manual update to auto update.

•

The Standard toolbar displays a Recalculate button that shows green
are up-to-date and yellow

when all project operations

when there are recalculation operations pending. If you have opened a

project and you see that the Recalculate button is yellow, understand that calculations are pending and
that the data and data plots you see in the project may not be up-to-date.

•

If a lock icon appears dark gray in color

, this indicates that the associated operation was performed in

OriginPro and the window or project has been opened in standard Origin. The operation is not supported
by standard Origin and to modify or re-run the analysis, you will need to locate a computer with an
OriginPro license.

•

If a lock icon appears red

something has occurred which makes recalculation operations impossible.

Such conditions are rare but would occur if, for instance, you passed a project file that included a userdefined curve fitting operation to a colleague but failed to pass along your user-defined fitting function.

•

Having many recalculation operations in your project file can slow down your work. You can block
recalculation -- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block
Recalculation from the popup menu. Placing a block on pending recalculations places a yellow "block"
icon

on each associated operation in the chain. Placing a block on up-to-date calculations places a

green "block" icon

on each operation in the chain. To remove the block, click on the "block" icon and

clear the check mark (Note that clicking the yellow Recalculate button

on the Standard toolbar does

not update blocked operations).

•

To suspend all recalculation, press Ctrl+0, choose Analysis: Pause Auto Recalculate (worksheet only)
or click the Pause Auto Recalculate button

•

on the Standard toolbar.

You can hide the lock icons on your graph window by clicking on the graph and, from the main menu,
choosing View: Show and clearing the check mark beside Lock Icons. This does not remove associated
operations from the graph window. To re-display the icons, repeat the procedure.
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Pause Auto Recalculate using hotkey Ctrl+0. Menu command also added to the
Analysis menu when a worksheet is active.

17.3 Dialog Themes
Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file.
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different
settings.
Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme
that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box.
The same Themes are also available from the main menu item associated with the analysis dialog box.

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.
Tutorial: Saving and Re-using a Dialog Theme
1.

Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder.

2.

Highlight column B and select Analysis: Fitting: Linear Fit...

3.

In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit
Options) and set the Fix Intercept at edit box to 0.

4.
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the Theme Name box, enter Zero Intercept and press OK. Press OK again to
close the Linear Fit dialog box and perform the analysis. FitLinear1 and
FitLinearCurve1 result sheets are added to the workbook.
5.

Return to the source data and highlight column C. Select Analysis: Fitting:
Linear Fit from the menu. You will see a fly-out menu with multiple Theme options
including the Zero Intercept Theme you saved in the previous step.

6.

Select your saved Theme. The analysis is automatically performed on Column C
using the settings saved in the Theme. Note that the dialog box does not open.

Tips for Working with Themes:

•

Hold the SHIFT key while clicking on your Theme in the main menu and the
associated dialog box will open with settings from the selected Theme loaded into
the dialog box.

•

The default Theme Origin shipped for an analysis is called System Default. Click
the fly-out menu in the analysis dialog and choose System Default to load it.

•

Click the fly-out menu in the analysis dialog and choose Delete to delete Themes
you have created, including any customized <default> Theme.

•

The customized <default> Themes for all analysis dialogs are saved in
Defaults.xml in the User Files Folder. Deleting this file restores system default
settings of all analysis dialogs.

17.4 Workbook and Project Templates
There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here
are a few typical scenarios.

•

You might import data files that always have a fixed number of columns with a repeating pattern of
column designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing
these files (File: Save Template As).

•

You regularly import data files of similar structure and you perform some routine graphing and analysis
operations on the data, then generate a report using a worksheet or a workbook embedded Notes window.
This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template).

•

You perform some operations similar to those described in the previous example but you can't save your
workbook as an Analysis Template because all data are cleared from the workbook on saving and that
would destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to
clear only the imported data and save your workbook as a window file (File: Save Window As). This
preserves the sheet of reference data and like the Analysis Template, saves analysis and graphing
operations with the workbook.

•

You routinely import data, do some analysis and generate a report and would like to make use of the
Analysis Template concept (as in the second bullet point), but you have multiple windows in your project,
including Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis
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Template won't do the job. In this case, you could save the project without data by "cloning" it (File:
Clone current Project).

17.4.1The Workbook as Template
The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices
and notes, plus scripts, variables and other supporting data.
You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your
needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU)
or as an Analysis Template (OGWU):

•

Workbook (OGWU): Choosing File: Save Window As saves all workbook content.

•

Analysis Template (OGWU): Choosing File: Save Workbook as Analysis Template clears all data
columns that are used in analysis operations in the workbook before saving. Operations are preserved as
are data that are not associated with analysis operations.

•

Template (OTWU): Choosing File: Save Template As saves the structure of the workbook, plus any
analysis operations that exist in the workbook, but all data including data that are not associated with
these analysis operations, are cleared.

The New Book dialog is a template library for managing workbook, matrixbook and
Analysis Templates. See Workbooks for an overview of dialog box features.

Tutorial: Creating an Analysis Template
1.

Start with a new workbook and import the file Samples\Curve
Fitting\Sensor01.dat.

2.

Select column B and use the Analysis: Fitting: Linear Fit and open the Linear
Fit dialog.

3.

Change the Recalculate drop-down to Auto.

4.

Click the Fit Control tab, check the Fix Intercept check box and enter 0 in the
Fix Intercept at edit box.

5.

Click OK to close the dialog and perform the linear regression.

6.

Answer "Yes" to the prompt and switch to the FitLinear1 report sheet to view
results including plots of the best-fit line and residuals.

7.

Now switch back to the original data sheet and import the file Samples\Curve
Fitting\Sensor02.dat. The analysis results will be automatically updated with this
new data. Note that you could continue to use this workbook for importing other
data; or you could right-click the workbook window title and choose Duplicate
without Data to create a new workbook with the linear fitting operation saved
into it. This allows you to import new data into the new workbook and thus save a
project with multiple such workbooks, if desired.

8.

With the workbook active, select the menu File: Save Workbook as Analysis
Template..., and in the dialog that opens, give a name such as Linear Fit of
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Sensor Data and click Save.
9.

Choose File: Recent Books and select the template that was saved in the
previous step. The workbook will open and the data sheet will be empty.

10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet
(1st sheet). The analysis results will be automatically generated upon data import.

Analysis Templates can include summary sheets and custom report sheets (worksheet-based or HTML),
making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine
analyses. When used in combination with the the Batch Processing tool, you can repeat a set of analyses
and graphing operations for any number of data files and create a PDF summary report for each one, as it is
processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the
workbook as a template for handling repetitive tasks.
Notes windows now support HTML. Notes windows can be added to the workbook
(right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML
reports into your Analysis Templates. For more information, see HTML Reports
From Notes Windows.

17.4.2The Project as Template
The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks
-- particularly when your analyses and graphing tasks can't be resolved within a single workbook.
The basis steps of creating a "project template" are as follows:
1.

Create the desired graphs and/or analysis results from data in your workbook(s) and save the project.

2.

After saving the project, choose File: Clone current Project. A small dialog opens for configuring
your cloned project:

o

Add Data Connectors: Check this box to add Data Connectors from the cloned project to your
saved project. Each cloned worksheet will have a connection to the original worksheet in the
saved project. If you plan to import data from other similar files in your cloned project, you
should CLEAR this box.

o
o

Clear All: Clear imported data only. Analysis operations are preserved in the cloned project.
Clear Imported Data and Delete Calculations: Clears imported data and analysis operations.
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3.

Click OK to create your cloned project. Selected data are cleared and the cloned project named UNTITLED
is added to the workspace.

4.

Name and save the cloned project and when you are ready to process more data files, you can open it and
import new data:

o

If your analysis and graphing operations are linked to a particular set of data files that are
periodically updated, you don't necessarily need to use Connectors. You can simply re-import the
files (Data: Re-import... or Re-import Directly).

o

If your operations are linked using Data Connectors, click the Connector icon

and from the

popup menu choose Import (this Connector only) or Import All (all Connectors in the book).

o

One possible scenario is that you store all of your data in a single Origin project file. If you have
added Data Connectors from your cloned project, to your original project then you can selectively
import just the data that you need to perform your graphing and analysis operations. When you
have finished, you can save the file to a new name, preserving your cloned project for re-use.

17.5 Batch Plotting
Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two
sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data
files. In addition to these two procedures, batch plotting can also be performed programmatically using
LabTalk script or Origin C.

A new Match X by Offset check box is added to the Set Column Offset dialog, for
handling batch plotting of graphs that use multiple X columns (e.g. Sunburst plot).

17.5.1Duplicating Graphs with Data from Other Books/Sheets/Columns
If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new
data. There are two cases:

•

If you have plotted a graph with a single dataset and customized it, and want to clone the graph with
other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New
Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.

•

If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you
want to clone the graph with other worksheets or workbooks with a similar data structure: Choose
Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books.
Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook
you want to plot from. Each worksheet or workbook will be plotted as a new graph.

Tutorial: Duplicating a graph with data from other books/sheets

1.
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2.

Press the Import Wizard

button on the same toolbar. This opens the Import

Wizard dialog box.
3.

Click the browse button

to the right of the File box. Browse to the Import

and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and
S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog
box, press Finish. The files are imported into three separate workbooks.
4.

Drag and select all three Y columns in one of the workbooks, then select the menu
item Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one
shared X axis. Make any desired customizations to the graph.

5.

Right-click on the title bar of the graph window then select Duplicate (Batch
Plotting) shortcut menu.

6.

In the dialog box that opens, press Ctrl and select the other two
workbooks/worksheets then press OK. Two more graphs are created with data
from the other two workbooks/worksheets.

17.5.2The Workbook as a Template for Processing Multiple Files
If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting,
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your
workbook and save the workbook as a template. Using this template you can process multiple files, creating a
workbook for each file and its corresponding graph.
Tutorial: Creating graphs from multiple data files
1.

With a new workbook active, choose Data: Import From File: Single ASCII and
import the file Sensor01.dat from the Samples\Curve Fitting subfolder of the
Origin installation folder.

2.

Highlight column B and create a line+symbol graph of the data.

3.

Double click on the X axis to open the Axis dialog. Make sure Scale tab is active.
Select both Horizontal and Vertical on the left panel and set Rescale to be Auto
and click OK. This will ensure that the graph scale will update automatically on
data change.

4.

In the workbook, right-click on the worksheet tab and select Add Graph as
Sheet, then select the graph created above and click Done. This will add a new
workbook sheet containing an embedded graph.

5.

Switch to the data sheet, double-click on the tab rename the sheet as Data.

6.

Select the Worksheet: Clear Worksheet menu item to clear the data in this
sheet. Note that this step is optional. Clearing the data will reduce the size of the
template saved in the next step.

7.

Select the File: Save Window As... menu item, assign a name such as Sensor
Data and Graph and press Save.

8.

Now we can use this template to process multiple files. Select the File: Batch
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Processing... menu item.
9.

In the dialog box that opens set the Batch Processing Mode to Load Analysis
Template, then set the Analysis Template control to point to your saved
template.

10. Set Data Source to Import from Files and select the three files Sensor01.dat,
Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder.
11. Set the Data Sheet(s) to Data and set Result Sheet to <none>.
12. Press OK to close the dialog box. You should get three workbooks with the data
imported into the first sheet and the graphs updated in the 2nd sheet. To further
edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, those settings will be
saved to the data sheet by default. Settings thus saved to the sheet will be used for
import when batch processing of multiple files using the workbook as a template.

17.6 Batch Analysis
Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

17.6.1Analyzing Multiple Datasets in Dialogs
Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets.
Report sheets created by these dialog boxes include a summary table listing the parameter values for each
dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an
external sheet for further processing.
Tutorial: Fitting Multiple Datasets
1.

Open a new workbook and import the file Samples\Curve Fitting\Multiple
Gaussians.dat from the Origin installation folder.

2.

Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4.

3.

Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit...
menu item to open the NLFit dialog box.

4.

Select Gauss from the Function drop-down list, then press the Fit button to perform
fitting and close the dialog box.

5.

Switch to the FitNL1 report sheet. You will see a table named Summary which lists
the fit parameters and fit statistics for each dataset.
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In the NLFit report sheet, click on the downward-pointing arrow button
next to the
table named Summary and select Create Copy as New Sheet. This will create a copy
of the table in which all cells are linked to the report. Any updates/changes to the fit
will automatically update the values in this copied sheet. This sheet can then be used to
plot or to perform secondary analysis on the fit parameters.

When enumerating something like a column Long Name, as you did in step 2 above,
enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lowerright corner. When the cursor becomes a "+", drag across the other cells and the
contents of the first cell will be extended to those cells.

17.6.2Using Gadgets for Analyzing Multiple Curves
Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a
data range of interest, switching from one dataset to another, and setting various preferences specific to the
analysis being carried out.
Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings,
and generating a table of results across all datasets.

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves

1.

Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".

2.

With the graph window active, choose Gadgets: Integrate from the main menu.

3.

In the dialog that opens, click the Baseline tab and set the Mode drop-down to
Straight Line.

4.

Click the Output tab, expand the Output Quantities to node, and check Append to
Worksheet. Press OK to close the dialog box.

5.

A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI
and resize this object to cover the entire data range plotted in the graph. The integrated
area will be displayed as a shaded region.

6.

Click the arrow button

at the top right of the ROI object, then choose Change Data

from the context menu and switch to another plot in the layer. Check that the current
baseline setting works for other curves in the layer.
7.

Click the arrow button

, select New Output for All Curves (N) or simply press the

"N" key. Integration is performed on all curves.
8.

Click the arrow button

again and select Go to Report Worksheet. Expand the
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report worksheet to view the integration results from all curves.

17.6.3Batch Analysis Using an Analysis Template
The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template.
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook,
and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template
to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and
additionally, to create a summary table with select analysis parameters and other metadata that you have preconfigured in your analysis template.
These Batch Processing improvements are added for Origin 2022b:

•

When setting Batch Processing Mode = Repeatedly Import into
Active Analysis Template Window, there is a new Result Sheet =
<none> option.

•

If the Analysis Template is set up to import multiple files into the same
sheet, Batch Processing will now import all selected files to new columns
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when Use Import Settings in Workbook is checked.

Tutorial: Batch Analysis of Multiple Files using an Analysis Template
1.

From the main menu, choose File: Batch Processing.... This opens the Batch
Processing dialog box.

2.

Set Batch Processing Mode to Load Analysis Template.

3.

Press the browse button

to the right of the Analysis Template box and

browse to and select the file <Origin Program Folder>\Samples\Batch
Processing\Sensor Analysis.OGW. This Analysis Template contains multiple
sheets set up for linear regression analysis, reporting, and summary tables.
4.

Set Data Source = Import From Files, then click the browse button

to the

right of the File List and from the Samples\Curve Fitting folder, select files
Sensor01.dat, Sensor02.dat and Sensor03.dat .
5.

Set Dataset Identifier to File Name, Data Sheet(s) to Data, and Result Sheet
to Result. Note that these are the names of existing sheets in the Analysis
Template.

6.

Uncheck Delete Intermediate Workbook.

7.

Click OK to close the dialog box and process the three files (you can answer "No"
to the prompt). You will obtain three books with the data, analysis results, and
report for each file, and a fourth book containing the summary table of analysis
results from all files.
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Saving the initial workbook as an Analysis Template is optional. You can simply save
the Origin project (.opj) and next time replace the data in your workbook to update all
results and graphs. The Batch Processing tool also has an option to repeatedly import
files into the active window, allowing you to simply re-use an existing book within a
project (which contains all desired analysis and graphs) as an on-the-fly template for
the batch analysis.

You can batch generate analysis reports using a custom MS Word template, with the
option of outputting a PDF and/or an MS Word file for each report. Additionally, you
can opt to combine reports into a single file. For information on Batch Processing
with a Word Template for Reporting, see this tutorial.

17.7 Repeating Analysis on Other Datasets or Data Plots
For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the
lock associated with the operation.

•

In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y
columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.

•

In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will
repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of
only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can
be repeated on all other datasets.
Tutorial: Smoothing Multiple Columns in a Worksheet
1.

Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty
workbook.

2.

Select column B and click Analysis: Signal Processing: Smooth to open the
smooth dialog box.

3.

Accept the defaults and press OK to perform smoothing. A new column will be
added with the smoothed data.

4.

Click on the lock

in the output column and select Repeat this for All Y

columns. Three more columns of smoothed data with same settings will be
generated from the data in columns C thru E.

17.8 Duplicate this Operation
Output produced by the Origin's analysis operations is linked to its source data by a particular analysis and a
particular set of analysis parameters. This linkage is signified by the placement of an "operations lock" on
analysis output and -- unless the user turns off recalculation for a particular operation -- such results are
generally "locked" to editing. You can find out more by reading about Analysis Report Sheets and Recalculation,
in the introductory sections of this chapter.
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The lock icon placed on analysis output can be clicked on to open a menu, giving you post-analysis access to
operation parameters and other information. This includes the dialog box and parameter-set used to produce
the analysis output, opened by clicking Change Parameters.
Towards the bottom of this menu, you will see a Duplicate this Operation entry.

One possible use of the feature goes like this:
1.

The user performs an analysis operation on a data plot, say, a fitting operation using the nonlinear curve
fitter (NLFit).

2.

The user is not sure which fitting function best models her data so she tries a fit using one potential
function.

3.

The user clicks the resulting operations lock and chooses Duplicate this Operation.

4.

A duplicate analysis is run and a second operations lock is added to the graph window.

5.

The user clicks the second operations lock, chooses Change Parameters and when the NLFit dialog
opens, chooses her alternate fitting function and performs a new fit operation. The new fit operation
results in new output which can now be compared to the output generated by a fit of the first fitting
function.
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17.9 Repeating Analysis Using Data Filters
Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce
multiple graphs from the same source data using different filtering conditions. The filtered data can also be
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.
Selected columns from the source data sheet can be copied to create child sheets where the filter condition
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is
updated, all child sheets, associated graphs and analysis results will automatically update using their
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to
the parent sheet at any time.
The image below displays the source workbook with data for several makes of automobiles. Two books were
created with a subset of columns and a data filter to restrict the data to a particular make of automobile.
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the
two filters.
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Tutorial: Locking a Filter Condition on Copied Columns
1.
2.

Import the file Samples\Statistics\Automobile.dat
Click on the Make column, then click the Add/Remove Data Filter button

on

the Worksheet Data toolbar.
3.

Click on the filter icon

that was added to the column, and uncheck all makes

but Honda (Hint: Clear the check mark beside Select All, then check Honda and
click OK).
4.

Hold down the CTRL key and click and select the Make, Power and Engine
Displacement columns. Next, right-click and select Copy Columns to... from the
shortcut menu.

5.

In the dialog that opens, expand Copy Labels and place a check mark beside
Long Name and Units, then click OK. A new worksheet will be added to the
workbook and it will contain only the Honda data, for Power and Engine
Displacement.

6.

Click and hold the tab of the new worksheet and drag it to an empty spot in the
Origin workspace to create a separate workbook.

7.

Click on any of the locks in the columns of this copied sheet, and select
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Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you
change the filter condition in the original data sheet, this copied sheet will not be
affected.
8.

You can now return to the original automobile book, click the filter icon and
change the filter condition to Toyota, then use Copy Columns to to create another
worksheet.

9.

Highlight column B in your Honda workbook,then right-click and choose Set As: X.
Do the same for the Toyota book.

10. Highlight column C in your Honda workbook and click the Scatter button

on

the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots
of Power vs Engine Displacement, one for Honda, one for Toyota.
11. Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the
dialog defaults and click OK. Do the same for the Toyota graph. A linear fit is
performed for both datasets and an Analysis Report Sheet is generated for each.
12. Compare the fitting results for the two automobile makes.

By default, when there is a data filter on a column that is input for an analysis
operation, filtered data (hidden rows) are ignored in the analysis. To include hidden
rows, click on an analysis lock icon and set Ignore Hidden Rows = No.
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17.10 Automating Tasks Using Programming
In addition to the above mentioned methods for automating tasks using the interface, graphing and analysis
features can also be accessed programmatically from the LabTalk scripting language, from Origin C or from
Python (internal or external). Access to Graph Themes and templates, and Analysis Templates can be
programmed. You can set up some of the procedures manually by first creating templates (graph templates,
Analysis Templates™, etc.) using the graphical user interface, and then write your code to call the templates
as needed.
You can get a broad look at what programming options are available in Origin by browsing the Programming
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.

17.11 Topics for Further Reading
•

Recalculation of Analysis Results on Data or Parameter Change

•

Saving Analysis Dialog Settings as a Theme

•

The Theme Organizer, Dialog Themes

•

Analysis Templates

•

Batch Processing and Analysis Templates

•

Copy and Paste Operations

•

Using Data Filters to Obtain Different Views of Your Data

•

Analysis Report Sheets and Columns

•

Tutorials: Batch Processing

•

Video: Batch Processing

•

Tutorial: Combine Quick Peaks Gadget with Peak Analyzer

361

18 Publishing and Export

363

UserGuide_2022b

18.1 The Master Page
The Master Page feature is used to add one or more common objects to exported or printed graphs. Use
the master page to add a set of properties and objects -- a custom background, a company logo, text labels,
images, etc. -- to selected graph windows in your project.

To make use of this feature, you must first create your Master Page. The Master Page should contain only the
properties and objects that you want to display on your selected graph windows:
1.

From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting
this menu item, you will be asked to switch to the project root folder.

2.

Customize the Master Template. Note that the comments that show beneath the Save Master Template

3.

Click the Save Master Template button. When you save, the Master Template will be saved to the

button are "hidden" and will not be applied to your graph windows.
User Files Folder as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User
Files\Master.otpu").

Things to know about the Master Page:

•

Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension
to All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio.

•

If you create a graph and modify page size, then choose File: New: Master Page and load a Master
Template into the workspace, the Master Template will be loaded with the page dimensions of your
modified graph page.

•

The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape
and portrait).

•

When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of
the same aspect ratio, or to all graphs of the same orientation (portrait or landscape).
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•

Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation
and vice versa.

•

When NOT using Master Items, Edit: Copy Page (CTRL + J) will place an OLE-editable Origin graph
object on the Clipboard. When using Master Items, Edit: Copy Page will place an image on the Clipboard;
the Copy Graph as Image dialog will open asking you to accept or adjust image settings before clicking
Copy.

•

If a graph uses Master Items, Send Graphs to PowerPoint does not support Insert Graphs as
Embedded Object. Instead, use Insert Graphs as Picture which does support Master Items.

•

There is a mechanism for selectively excluding Master Items in your exported or printed page. Any object
that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open
an arrow object's Properties dialog and on the Programming tab, rename "Arrow" to
"NoExport_Arrow").

•

When you customize and save your Master Page to the User Files Folder, the next time you choose File:
New: Master Page, you load your customized template.

•

If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove
the check mark. The exported graph will still contain the Master Items (they just won't show in the
workspace).

•

If you want to remove Master Items from a graph in both the workspace and exported images, click
Format: Page..., Display tab and clear the Use Master Items check box.

You could use the Text tool to add project and system information to your Master
Template as static text objects, but since the idea is to build a template for re-use,
consider "soft-coding" information in your text labels. To learn more, see these topics:

•

Substituting Variable Values in Text Labels]

•

LabTalk String Registers

18.2 The Export Margin Offsets Dialog Box
By default, the margins of your copied or exported graph are determined by the Margin Control in Copy
Page Settings group of Preferences: Options (Copy actions) or the Export Settings branch of Export
Graphs (Export actions). You can interactively modify the default margins using the Export Margin Offsets
Dialog Box.
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1.

Click on the graph window (to activate) and choose Edit: Set Export Margins. This opens the Export
Margin Offsets dialog.

2.

Drag the blue selection handles that appear at the page margins; or enter values into the dialog edit
boxes and click Apply.

18.3 Fit Page to Layer and Layer to Page
There are two small dialog boxes that are also helpful for removing white space or placing a margin around
your graph before exporting:

•

Fit Page to Layers: Choose Graph: Fit Page to Layers to open the pfit2l dialog box.

•

Fit Layers to Page: Choose Graph: Fit Layers to Page to open the gfitp dialog box.
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Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph
aspect ratio. You can view the documentation for both to decide which might work best for you but basically it
boils down to whether you need to keep a particular page size. If so, you'll likely want Fit Layers to Page; if
not, either one may work for you.

18.4 Copying and Pasting Graphs to Other Applications
There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word .docx
files):

•

As an image

•

As an editable OLE graph object

When you paste as an image, you are pasting a static object. In MS Word, for instance, you may be able to
modify the image using Word's picture-editing tools, but you cannot make edits to the graph in Origin and
have it update the graph in Word (short of deleting the existing image and replacing it with a new one).
By contrast, when you paste an editable OLE graph object you can later double-click on the object in the host
application to launch a new instance of Origin. The graph and any associated data sheets will be available for
editing. After editing, use Origin's File: Exit and Return to... menu item to update the embedded object,
close Origin and return to the host application.

18.4.1Copy Graph as Image
1.

Click on your Origin graph to activate it, then ...

2.

Choose Edit: Copy Graph as Image (CTRL+ALT+J). Alternately, click on the graph window near the
page margin and click the Copy Graph as Image button on the Mini Toolbar.
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3.

In your host application choose Paste or press CTRL+V.

When copying the graph as an image (CTRL+ALT+J), you have a choice of image formats (PNG, EMF, DIB,
HTML, JPG). Additionally, you can make quick size adjustments and specify background transparency (PNG).
The Copy Graph as Image (copyimg) dialog includes a Dialog Theme control which allows repeating <Last
used> settings, saving current settings as default Save as <default> or saving settings to a named Theme
(Save As...).

There is a Copy control on the Preferences: Options: Page tab that lets you assign
the CTRL+C hotkey combination to either Copy Graph as Image <last used> or
Copy Page (CTRL+J) (i.e. "editable OLE graph object"). This allows you to bypass the
Copy Graph as Image dialog and speed up placing a standardized image on the
Clipboard using CTRL+C.

18.4.2Copy Graph as Editable OLE Graph Object
1.

Choose Edit: Copy Page (CTRL+J).

2.

In your host application choose Paste or press CTRL+V.
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Note: For more information, please refer to the:
Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs
in Other Applications

18.5 Organizing Your Graphs for Presentation or Export
If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder
and arranging them there:

•

Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph
window, to a new Favorites subfolder (visible in Project Explorer).

•

When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the
corresponding dialog box or (2) set slide order following this procedure.

If you are preparing a manuscript for publication, you may want to see FAQ-441 How
do I export graphs with exact size and resolution as specified by publishers?

18.6 The Layout Page
Origin 2022b supports export of layout pages to .SVG files. When adding graphs to
the layout, choose Add Graph from the layout shortcut menu and elements of your
SVG file (e.g. text) will be editable in applications such as Inkscape or Adobe
Illustrator.
A layout page, as the name implies, is a window useful for laying out different elements for publication or
export. Use it to assemble graphs, result tables, text objects, etc. onto a single panel.
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Typically, you start by creating a blank panel:
1.

Click the New Layout button on the Standard toolbar.

2.

Right-click on the blank layout to paste Clipboard content, add text, insert images from files, add graphs,
tables, etc.

3.

When inserting an image from file, right-click in the area where you want to insert. When adding graphs
or worksheets, pick a window in the Browser and drag out an area on the layout with your mouse. Note
that added objects can be moved or resized by dragging with your mouse.

o

You can make edits to inserted images, by double-clicking on the image. This opens the image in
the Image Window.

o

You can make edits to the graph by double-clicking on the inserted graph object. This opens the
source graph for editing. Edits to the source graph will update the graph on the layout page.

o

Inserted tables can be edited by double-clicking on the table object. Style adjustments can be
made by selecting a table object and using available Mini Toolbar buttons.

4.

Note that selected elements on the layout page can be aligned using Object Edit toolbar buttons.

For more on the layout page, see Using the Layout Page Window in the Origin Help file.
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18.6.1Merge Graphs to Layout
As an alternative to manually creating layouts, Origin offers a tool that will merge select graphs into a single
layout page of equal spacing. In this case, merged graphs are images and, therefore, not editable using the
procedure described in step #3 of the previous section. However, if further graph edits are not needed, you
can use this method to quickly produce a nice-looking layout.

To merge graph images into a single layout:
1.
2.

With a graph window active, click Graph: Merge Graph to Layout: Open Dialog.
Use the Selection drop-down to specify how to select graphs. To choose individual graphs, choose
Specified and use the browse button beside Graphs to open the Graph Browser and pick graphs.

Origin 2022b adds a Fit Page to Objects menu command (Format: Fit Page to
Objects), allowing you to apply a uniform margin to the active Layout page. This works
the same as the aforementioned Fit Page to Layers does for graph windows.

18.7 Exporting Graphs and Layout Pages to an Image File
Origin 2021b added a simplified graph export routine to complement the existing graph export routine:

•

File: Export Graph: If you simply want to export one or two graphs to one of several common image
format (PNG, BMP, JPEG, TIFF, EMF) and need only minimal control of image size, this routine is quick and
easy.

•

File: Export Graphs (Advanced): If you want to batch export graphs (e.g. All in Active Folder, All in
Project, etc.), or export to vector types such as PDF or EPS, use this routine. The dialog supports
outputting to a specified path, auto naming, application of Speed Mode settings to exported graphs, plus
margin control, image size and other filetype-specific settings.
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Origin 2022b supports export of graphs and layout pages to .SVG files. Before
exporting, confirm that @SVGTC = 1 and text objects (e.g. axis titles and tick labels)
will be more-easily editable in applications such as Inkscape or Adobe Illustrator.

18.7.1File: Export Graph
File: Export Graph (X-Function = expG2img) is a simplified routine for exporting the active graph page to
one of the following formats: PNG, BMP, JPEG, TIFF, or EMF. It does not offer the level of control or flexibility
as File: Export Graphs (Advanced) (next section) but it works well for simple export of individual graph
pages.
To export using expG2img:
1.

When a graph window is active, choose File: Export Graph.

2.

For EMF images, set a size factor relative to the Image Size reported at the bottom of the dialog. For
raster formats, choose an output DPI setting. Alternately, clear the Auto check box and specify a Width
in Pixels.

18.7.2File: Export Graphs (Advanced)
File: Export Graphs (Advanced) (X-Function = expGraph) is Origin's primary tool for exporting graphs and
layout pages. It supports raster or vector output, flexible multi-page export (e.g. All in Active Folder), DPI
and Speed Mode control and more.
To export a graph or a layout page as an image file:
1.
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The expGraph routine exports graphs to one of 15 file formats:

Raster Formats

BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;

Vector Formats

CGM, DXF, EPS, EMF, PDF, SVG, WMF

18.7.2.1 Saving Export Settings to a Theme
As is the case with many other Origin dialog boxes, you can save your graph export settings as a Dialog
Theme for repeat use.

Once you have determined your export settings:

•

Click the flyout button to the right of Dialog Theme and choose one of the Theme save options.

•

Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme
then becomes available for loading your last used settings and you can access it from the expG2img or
''expGraph dialog boxes or from the File: Recent Exports menu.
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Since Origin 2021, expGraph dialog box settings are saved to the graph automatically on export.

•

To save current settings withtout exporting, choose Save to <Graph>.

•

To restore saved settings after you've modified them in the export dialog, choose <Graph>

Note: For more information, please refer to the:
Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or
Layout Page to an Image File
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You can export multiple graphs, such as all graphs in a folder or all graphs in a project file,
to a single, multi-page PDF file. Choose File: Export Graphs and open the Export Graphs
dialog box. Set Image Type to Portable Document Format (*.pdf) and Select
Graph(s) to one of the following options and you will see a checkbox for Export as multipage PDF file.

18.8 Exporting Images to a Raster File
Image window content can be exported to several raster formats: BMP, GIF, JPG, PNG, TIF.
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For Origin 2022b, you can set a DPI for your exported image.

18.9 Send Graphs to PowerPoint
You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations
of embedded objects and Master Items, explained above). Graphs inserted as embedded objects can be
further edited in your Origin software. Double-click on the graph in PowerPoint to open the graph in an OLE
instance of Origin.
To Send Graphs to PowerPoint:

1.

Click the Send Graphs to PowerPoint button

on the Standard toolbar.

Click the Send Graphs to PowerPoint icon

in the Apps Gallery, docked to the right-side or your

or...

1.

Origin workspace (if you do not see the Apps Gallery, click View: Apps or press ALT + 9).
or...
1.

Right-click in the lower-pane of Project Explorer and choose Send Graphs to PowerPoint.

Tutorial: Send Graphs to PowerPoint
1.

Run Origin and open the sample file <Origin EXE
Folder>\Samples\Graphing\Column and Bar.opju.

2.

Click the Send Graphs to PowerPoint button

3.

Click the Select Graphs button and choose Specified.

4.

Select all except Graph5B in the left panel and move them to the right panel by
clicking the

on the Standard toolbar.

in the middle of the dialog box. Click OK. A scrollable list of

graphs is added to the left panel in the App.
5.

Set Insert Graph as = Picture.

6.

Set the Slide Margin top dimension as 8% and leave the others as 0.

7.

Set Title Line = Top of Slide, and Title = Window Long Name.

8.

Set Starting Slide Index = 3 and Slide Mode = Start New.

9.

Use the browse button beside Load File/Template (optional) to load the file
<Origin EXE Folder>\Samples\Import and
Export\Column_Plots_in_Sample_OPJ.pptx.
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10. Specify a Save File as (optional) output path for the resulting PPTX file.

There is also a Send Graphs to Word App that is pre-installed with your Origin
software. This App is particularly useful for batch export of graphs to a book-marked
MS Word document.

18.10 Slide Show of Graphs
Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide
show can be started in two ways:

•

Right-click on any folder in Project Explorer and select Slide Show of Graphs...

•

Click the Slide Show of Graphs button

or

on the Standard toolbar.

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders,
etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window
of the currently displayed slide).
Tutorial: Slide Show of Graphs
1.

Use the File: Open Sample Projects: 2D and Contour Graphs menu to open
the sample project.

2.

Click on the Slide Show of Graphs button in the Standard Toolbar.

3.

Accept default settings in the dialog that opens, and press OK to start the slide
show.

4.

You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

18.11 Creating Movies
Origin provides a Video Builder tool, accessible from the Open Video Builder button
on the
Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame
at a time to a video (.AVI) file.
Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data
and then writing out the graph as a frame in the video, at each step during the computation.
Note: For more information, please refer to the:
Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation
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For specific examples of programmatically created movies, including Origin Projects and
code, please visit www.originlab.com/animation.

18.12 Notes Windows for Reporting

For Origin 2022b, the Notes window gets Rich Text support.

Over time, Origin's Notes window has morphed from a plain-text window for jotting down your research notes,
into a flexible medium for collating a variety of research-related materials.
Because the Notes window can contain linked objects -- graphs, images, worksheet cell values, etc. -- it can
be useful to add a Notes window to an Analysis Template™ for purposes of summarizing analysis results.
Alternately, you can save your Notes window as a PDF by clicking File: Print and choosing a PDF driver.

18.12.1

Notes Window Syntax

Origin's Notes window supports four syntaxes: Text, Origin Rich Text (default), HTML, and Markdown.
1.

To switch syntaxes, choose Notes: Syntax: Text.

2.

Once you have selected Text, you can freely choose other syntaxes from the Notes menu.

18.12.2

Rich Text

With Rich Text, the Notes window has two modes -- raw text mode and Render mode. Toggle between these
modes using Notes: Render Mode or shortcut key combination CTRL + M.
To add text to the Notes window, you need to be in raw text mode. To style added text, use the Format
toolbar and/or apply pre-defined paragraph styles.
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18.12.2.1 Adding Content to Your Notes

Objects that you can Insert by right-clicking in the Notes window:

Object

Comments

Graph/Image

Opens the Graph/Image Browser where you can pick project graphs and images.
Note that you can Show Embedded Graph (see the first row of this table for a
definition of "embedded graph") and Project Explorer "Favorites" folder shortcuts
(Include Shortcut Page).

Worksheet Cell...

Opens the interactive range selector. Use this to pick a cell value in a worksheet or
report sheet. Click Done to insert a linked cell value.

Info Variable...

Opens the Insert Variables dialog for inserting project variables stored on data
import.

New Table

Opens the New Table dialog for configuring a basic table. Clicking OK closes the
dialog and opens a basic workbook containing a single worksheet. Customize the
worksheet, add data, etc., then use Notes window Render Mode to view the resulting
table.
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Object

Symbol Map

Comments
Opens a simplified Symbol Map with characters sorted by tab. Click Advanced to
go to the full Symbol Map.

Opens the LaTeX Equation Editor App (if you've not already installed this free App,
LaTeX Equation

you are prompted to do so). You can click the Equation button
to open a list of
Origin's fitting functions (incl. your user-defined functions). Pick a function (or enter a
function into the top box) and click Preview to see your equation rendered.

Link

Opens a dialog box for entering Text to display and a Link. The link can be a URL
or it can be a link to such things as a worksheet data range (e.g.
range://[book1]sheet1!col(1)[100]). Additionally, you can run simple LabTalk
commands using a "labtalk://" tag (e.g. labtalk://newsheet).

Image from File

Opens a dialog to browse for image files. Note that the inserted image is linked to an
external file and is not saved with the project.

Image form Web

Opens a dialog to specify a Image Link for a web image (hint: In your browser,
right-click on an image and Copy Image Address, Copy Image Link, etc).

1.

Add your content using raw text mode.

2.

When you are ready to view your content, turn on (place a check mark beside) Notes: Render Mode or
press CTRL + M. Note that you can use the Zoom combo box
zoom in or out on the page (CTRL + mouse wheel also works).
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18.12.2.2 Text Styles Manager

In addition to styling text with the Format toolbar, you can apply a simple set of
paragraph styles on a line-by-line basis. Manage styles with the Text Styles Manager
dialog box.

1.

With a worksheet active, choose Tools: Text Styles Manager.

2.

Select a Style to Modify and Apply or Close.
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Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style
and Delete.
To apply a paragraph style to Notes window text:
1.

Open the cell note in a Notes window.

2.

With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph
Styles and choose a style from the popup menu.

3.

To check results, press CTRL + M (Render Mode).

To see a list of built-in paragraph styles, open a fresh Notes window, then from the
menu choose Notes: Load Samples: Built-in Styles.txt.
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18.12.2.3 Adding Rich Text Content to Layout or Graph

Insert Rich Text content of a Notes window to a text object on a Layout or graph page.

To add the content of an existing Note (Layout or Graph):

1.

Select the Text tool

, then click on the Layout/Graph and enter "@@@NotesN" (i.e. the Notes

window Short Name).
2.

Click off the text object to insert Notes content.

To add content by creating a new Note (Layout only):
1.

Right-click on the Layout and choose Insert Notes Text.

2.

See Adding Content to Your Notes.
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18.12.2.4 Print or Export to PDF
You can output Rich Text content to a physical printer; or print to PDF using a third-party driver such as
Microsoft Print to PDF.
To create nice-looking output, you'll need to pay attention to these settings:

•

Paper Size: This is set in File: Page Setup or in the Advanced options for your printer driver.

•

Margins: These are set in File: Page Setup.

•

Notes Display Margin: By default, the Notes display margin = 5 (units = points). Thus, you will note
that in Render Mode (CTRL + M), there is a slight margin to the left side of the Notes page. This display
margin is controlled by setting system variable @NDM.

•

Notes Window Page Width: Page width is controlled by the property note.width (units = in/cm, etc).
Default = 0, which corresponds to an uncontrolled width. For best printing results, you will need to set

notes.width.

Paper Size - Margins - Notes Display Margin = Width of the printed area (paper or PDF).
So, for example, an 8.5 inch wide page with 1 inch margins to the left and right; and a display margin of 0
points, should "print out" as 6.5 inches wide. Therefore, for best results, set page.width = 6.5 before
printing.

18.12.3

HTML and Markdown

You can also use Notes windows to create HTML or Markdown reports. Similar to Rich Text, you can build your
HTML report using placeholders that link to report sheet elements such as metadata, statistical results or
graphs. The resulting HTML report can be printed or exported; or it can be incorporated into your Analysis
Template. If Markdown syntax is used, optional HTML syntax can be also included for advanced customization.
To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most
things, the more proficient the user is, the easier it will be to create professional-looking output. However, the
skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance.

18.12.3.1 Adding Content to Your HTML Report
The basic steps of creating reports using an Origin Notes window, are as follows:
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1.

Create your project to include graphing and analysis results.

2.

Click the New Notes button

3.

From the menu, choose Notes: Syntax, then choose HTML or Markdown (Hint: You can toggle

to add a Notes window.

between text/view and markup modes by pressing CTRL+M and you can choose the default syntax by
setting LabTalk System Variable @NPS).
4.

You can write your code in the Notes window's markup mode or you can use a text editor such as
Notepad++, then copy and paste it to your Notes window. If you have no experience with HTML or
Markdown, you may want to load samples by activating your Notes window and clicking Notes: Load
Samples (HTML = ".html", Markdown = ".md").

5.

You will likely want to incorporate graphing and analysis results from the current project, into your report.
The simplest way to do this is to insert "placeholders" for each Origin object that you intend to include in
your report, into your code. These placeholders can be named using any string that makes sense to you
and they should be enclosed in double-curly braces (e.g. {{MyR-SquareValue}}).

6.

Right-click on the Notes window title bar and choose Edit Placeholders. Placeholders that you have
incorporated into your code will be picked up and added to a Placeholders worksheet in the workbook.
The sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B -is blank and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing
results, etc.) that you want to include in your report.

7.

For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if it is
a numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click
and choose Copy, or press CTRL+C on your keyboard).

8.

Return to the Placeholders sheet, right-click in column B, beside the associated placeholder and choose
Paste-Link. This associates your placeholder with the intended Origin object.

9.

If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab
in your Analysis Template and choose Add Notes as Sheet. This inserts your Notes window into
workbook and you can now choose File: Save Workbook as Analysis Template.

When a Notes window is active, you can click the Notes menu and load a sample HTML
file into the Notes window.
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18.12.3.2 Using Your HTML Report
As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once
completed, you can do various things with your HTML report, including:

•

Print to hard-copy or to PDF (File: Print).

•

Export the window as a webpage (Notes: Export to Webpage).

•

Click the embed button in the upper-right corner of the Notes window to embed the content into your
workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis
Template).

18.13 Exporting Worksheets and Matrices
18.13.1

Exporting Worksheets

With a worksheet active, the File: Export menu item provides the following options:

•

ASCII, NI TDM (TDM, TDMS), and Sound (WAV)

This option is available only for sheets containing data columns, and is not available when report sheets
such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data
from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored.

•

Excel

Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM).
Note that analysis report sheets with their hierarchical tables, and things such as embedded graphs and
images, are not exported to the Excel file. Analysis results that are output to regular Origin worksheets
are exported.

For information on copying analysis report sheets and pasting to MS Office applications,
see FAQ-815 How do I copy report sheet tables and paste them into Word, Excel or
PowerPoint?

•

SQLite

This option exports the active worksheet(s) as an SQLite file. Specify a file extension of .sqlite, .sqlite3
or .db (note that file structure is identical). Options to skip hidden columns or rows. Limited to export of
data in worksheet columns.

•

As Multipage PDF File

This option is available only on sheets with data columns, and not for report sheets. Use the View:
Page Break Preview Lines menu item to view the vertical and horizontal page break lines that
determine which columns and rows will be included in each page of the export. Floating or embedded
graphs placed in the worksheet will be included in the exported image.
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•

As Image File

This option is available on both data and report sheets. In the dialog that opens, you can select whether
to export the entire sheet, visible area, or selection. Image file formats including PDF are supported.
Floating or embedded graphs placed in the worksheet will be included in the exported image.

•

As PDF File†

This option is available for both data and report sheets. In the dialog that opens, you can opt for
exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in
the exported PDF.

When creating a custom report from a worksheet that combines data, numeric results
and graphs, the best option is to export the entire sheet as a PDF file, or export the
sheet as a multi-page PDF file.

18.13.2

Exporting a Matrix

Origin matrix data can be exported in these two formats:

•

ASCII

This will create an ASCII file of the data contained in the active matrix object.

•

Image

This option will export the image view of the active matrix object, as a raster file.

Note: For more information, please refer to the:
Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and
Matrices

18.14 Topics for Further Reading
•

The Preferences: Options Page Settings

•

Pasting or Embedding Graphs in Other Applications

•

Exporting Your Graph or Layout Page to an Image File

•

Which Image Format Should I Choose?

•

The Export Graph Dialog Box

•

Send Graphs to PowerPoint

•

Send Graphs to PowerPoint Dialog Box Settings

•

View Graphs as a Slide Show

•

The Slide Show of Graphs Dialog Box Settings
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•

Creating Graph Animations

•

Printing Graphs, Layout Pages and Analytical Results

•

The Print Dialog Box

•

The Print Options Dialog Box

•

Copying and Pasting Graphs inside Origin

•

Inserting Graphs and Images into Worksheet Cells

•

Tutorial: Creating a Custom Report Sheet

•

Using the Layout Page Window

•

Creating a Master Page Layout for Graphs
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19 Apps for Origin
Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's alreadypowerful graphing and analysis capabilities.
Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition,
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as
a means to create and distribute tools for your company or user-community.
At present, all Apps can be downloaded for free. Note that some Apps require OriginPro; these are denoted in
the App description by the

symbol.

19.1 Where Do I Find Apps?
Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using
your web browser, it easier to obtain and manage your Apps using the App Center.
The App Center provides "one stop" App installation and maintenance: Browse and download new and
popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab
website.
Search for Apps and install them directly from the Start menu.
To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.

What to look for in the App Center:

•

Installed Apps with an Up-to-date Version icon

•

Apps with a clickable Download and Install icon

beside them are up-to-date.
beside them are not installed. Click

this icon to install.

•

Apps with an Update icon

beside them have an available update that you can install.

Click this icon to update.

•

Click the New and Popular tab for a quick look at what's available. Download and update
Apps.

•

Click the Search tab to find Apps by Category and Minimum Version. Download and
update Apps.
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•

The Updates tab will display a red circle icon when there is an update to one or more
installed Apps. Improvements and bug fixes are listed for each.

New Apps and App updates are continually made available to Origin and OriginPro
users. Be sure to open your App Center occasionally (press F10) and if it displays the
red Download Now button, click to get the latest list of available Apps.

19.1.1Finding Apps from Analysis and Statistics Menus
You can find Apps for these specific applications by clicking Find Apps... from Origin's main menu:

•

Analysis: Fitting

•

Analysis: Peaks and Baseline

•

Statistics

These menu commands open the App Center Search tab to show only relevant Apps that are currently
available from OriginLab's File Exchange. Click the Download and Install button
install the App.
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19.2 How Do I Install Apps?
If you install your Apps using the Download and Install button
in the App Center dialog, you don't
need to do anything else. The App is automatically downloaded and installed. When App updates become
available, you can use the Update button

to update an installed App.

If your workstation does not have internet access:
If your workstation does not have internet access, you will need to find a computer that does (does not need
to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it
back to your workstation.
1.

On the internet-connected computer, open a browser window and browse to
originlab.com/fileExchange.

2.

Browse the list of Apps, go to the App's description and download page, then click the Download File
button and copy the file to your thumb-drive.

3.

Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer,
browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App
file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or
drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps
Gallery, docked to the right side of your Origin workspace.

If you have questions, click the How to Install link below the Download File button on the File Exchange
App description and download page.

19.3 How Do I Run an App?
•

Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin
workspace.

•

App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be
operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps
Gallery).

•

If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by
double-clicking on it in the Apps Gallery.

•

If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View:
Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the
OriginLab workspace or to an existing toolbar. Close the dialog box.

•

Specific usage information is available on the description and download page for each App.

391

UserGuide_2022b

19.4 Managing Your Apps
You can use the App Center in combination with the Apps Gallery, to manage your Apps:

•

Use the App Center (discussed above) to add and update Apps, search for Apps, request an App or
submit a review of an App.

. To launch the App Center, click the Add Apps button in the Apps Gallery.

•

Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and
choose New Tab, then double-click on the default tab name and give the tab a meaningful name.
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•

Additional higher-level actions available from the shortcut menu:

Adjust icon spacing using an Apps Icon Spacing slider control. LabTalk
system variable support for @APPS (horizontal) and @APPV (vertical)
spacing.

•

Apps Icon Spacing ...

•

Uninstall All ...

•

Refresh

•

New Tab

•

Show Connector Apps

•

Show Apps from Other Tabs

•

Sort Apps (Alphabetically, Newest Install, Recently Used).
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•

A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery
and choosing from the shortcut menu.

•

Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App
installation folder.

•

Uninstall: Uninstalls the selected App.

•

Open the File Exchange Page: Opens the App's description and download page on the
OriginLab File Exchange.

•

Send Feedback...: Opens a Rate App dialog box to provide feedback.

•

Show All (user-added tabs only): Shows Apps from all Gallery tabs on the active tab.

•

Refresh: Refreshes the tab view.

•

Tab Views: Place or remove the check mark beside the App to determine on which Gallery
tab(s) the App shows.
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19.4.1Docking the Gallery
By default, the Gallery is docked to the right side of the workspace.

Beginning with Origin 2022b, you can dock the Gallery to the top of the workspace, just
below the toolbars.

1.

To dock the Gallery at the top of the workspace, drag the title bar toward the top of the workspace. Guide

2.

Once docked, drag the bottom edge of the Gallery to adjust width, as needed.

it to and drop it on he workspace docking button that appears (shown outlined in magenta).
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19.5 Will I be Notified When Updates are Available?
Several things will indicate when an App update is available:

•

A red dot appears in the upper-right corner of the Add Apps icon in your Apps Gallery (docked to
the right side of your workspace). Additionally, the red dot shows on individual Apps when an update
is available.

•

In the App Center, the App will appear with a clickable "update" icon beside it.

•

The App Center Updates tab will show a red dot with a number indicating how many App updates are
available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.

To update an App:

•

Click the Update icon that appears next to the App in the App Center.

•

Right-click on the App in the Apps Gallery and choose Download and Install Update

•

Click the Update All Compatible button that appears on the Updates tab in the App Center; or click the
"update" icon beside each App.

•
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Right-click on the Add Apps icon in the Apps Gallery and choose Update All.
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You can verify the version of an installed App by hovering on the App in your Apps
Gallery.

19.6 How Do I Uninstall an App?
Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the
shortcut menu.

19.7 How Do I Give Feedback on an App?
OriginLab relies heavily on customer input to improve our software products. We encourage you to give
feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It
takes just a few seconds!
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19.8 Can I Request an App?
As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if
you do not program but you find that you need some particular functionality that is not currently a part of the
Origin product, you can request an App through the OriginLab website. OriginLab is continually building and
posting new Apps to the File Exchange.
1.

To request an App, open the App Center and click the Request App button in the lower-left corner of the
dialog box. This opens a web page on www.originlab.com.

2.

Verify that the Your Reason for Contacting Us drop down is set to Request an App.

3.

Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form.
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20 Programming in Origin

As you gain experience with Origin, you may want to access Origin features programmatically, add your own
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic
programming options available in Origin. For more detailed information, see the following Origin programmingrelated resources:

•

Programming documentation including guides, language references, and examples are available from the
Help menu in the product.

•

Online programming documentation is available at www.originlab.com/doc.

•

You can typically locate online programming pages by performing a web search from your browser using
phrases such as: labtalk importing , originc interpolate, or labview origin send data.

•

An Origin Programming Forum can be found at www.originlab.com/forum.

•

Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your
Origin software.
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20.1 LabTalk
LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots.
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.
There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections
in a file, and those individual sections can be executed from the user-interface at the command prompt in the
Script Window or Command Window; from buttons added to worksheets and graphs; from included or
custom-made toolbar buttons; or from custom menu commands.
Origin 2022b improvements to LabTalk:

•

Support for "substituting" cell Notes in graph legend and text objects using @WN
(e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source worksheet).

•

Control display of sparklines with new LabTalk System Variable @SPK (0 =
(default) no change, 1 = display only existing, 2 = can add, but load with none, 3
= no add, load with none).

•

Improve text editing in Notes window: support moving cursor to matching
brace/parenthesis using CTRL+K, CTRL+B.

•

Layer object support for changing XY mapping of the matrix object.

The following "mini-tutorial" will demonstrate adding a button object to a worksheet,
associating a short LabTalk script with the button, then using the button to execute the
script and perform a basic statistical calculation while writing the results to the
worksheet.

1.

Run Origin and start a new project by clicking the New Project button

on the

Standard toolbar.
2.

Click Data: Import from File: Single ASCII and browse to the file
\Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is
imported into the active worksheet window.

3.

With the worksheet window active, click Format: Worksheet. In the Worksheet
Properties dialog, click the Size tab and set Gap from Top to 25, then click OK.
A gap is added to worksheet window.

4.

Click the Text Tool on the Tools toolbar. Click inside the gap that you just added
and type "Add Mean Label Row" into the text object. Click outside the text object
to exit edit mode.

5.

Right-click on the text label and select Properties.... Choose Programming
Control tab, set Script Run After to Button Up. Copy and paste the following
script into the text box:
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wks.userParam1 = 1;

wks.userParam1$ = "Mean";

for (int ii = 2; ii <= wks.ncols; ii++)

{

range rr = $(ii);

Col($(ii))[D1]$ = $(mean(rr),.2*);

}

6.

Click OK to apply settings and close the Text Object dialog box. Note that your
text object now looks like a button.

7.

Click the button. Note that a new header row labelled "Mean" is added to the
worksheet and the mean value of each column of data is written to the Mean row
cell above the corresponding column.

Note: For more information on LabTalk, Origin's built-in scripting language, please consult your
product documentation at Help: Programming: LabTalk.
Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.

20.2 Python
Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports
command line execution of Python code from the Python Console or Origin's Code Builder IDE. As of
September 2021, the embedded Python version is version 3.8.3.
Python support improvements in Origin 2022b:

•

Added a function evaluate_FDF(strFFname, indepvars, parameters) to
call a fitting function from Python.

•

Added package version checking to pip -chk and pip -chk1 (e.g. pip -chk

emd==0.4.0; // install emd version 0.4.0 only).
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Note: For more information on integrated usage of Origin and Python, see these topics in the Python
documentation:

•

Introduction to Python in Origin

•

Embedded Python

•

Sample Projects with attached Python Code.

There is an API for calling Origin from Python. See note under Automation Server,
below.

20.3 R
Origin supports running R commands in the Origin environment. You can issue R commands in the Script
Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through
version 3.6.
From Origin, you can connect with R in two ways:

•

R. Installed on your local computer.

•

Rserve. Installed on a remote PC.

Note: For more information on integrating Origin and R, refer to the Origin Help file (R Console and
Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve
Objects).
Sample files can be found in the \Samples\R folder of your Origin software.

20.4 MATLAB
The MATLAB Console allows Origin users to issue MATLAB commands from Origin, and to transfer data
between the two applications either using a graphical interface or using a command line.

•

The Console requires both Origin and MATLAB be installed on the same computer.

•

Origin also supports importing MATLAB (MAT) files from disk. There are two import routines, the older
Data: Import from File and the new Connector-based Data : Connect to File: MATLAB. Importing
MAT files does not require that MATLAB be installed.

Note: For more information on the MATLAB Console, refer to the Origin Help file (MATLAB Console.
The <Origin Program Folder>\Samples\COM Server and Client\MATLAB subfolder contains an example
(CreatePlotInOrigin.m, CreatePlotInOrigin.OPJ) that illustrates how to connect to an Origin COM server
from a MATLAB client (requires MATLAB).
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20.5 Origin C
Origin C is a full-featured high-level programming language based on the ANSI C programming language
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.
Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and
manageability for developing and debugging code of greater scope and complexity.
Origin C also provides access to the NAG Numerical Library functions included in your Origin installation.
NAG functions provide you with a large selection of algorithms for performing computations ranging from
simple statistics and Fourier transforms to linear algebra and multivariate analysis. Origin currently supports
NAG Library Version Mark 26.1.
Origin C improvements for 2022b:

•

Add function to matrixbase class for importing ASCII strings; with support for
LF/CRLF, specify token separator and missing value.

•

Add global function to get data range from name.

•

Add function Worksheet class to get list of cells with Notes.

•

Support for getting Notes embedded in worksheet.

Note: For more information on Origin C, please refer to the Origin C documentation:
Help: Programming: Origin C
There you will find usage information, a language reference, developer notes, examples, etc.
Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.

20.6 X-Function
An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function.
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions.
Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script
execution, such as the script window, toolbar buttons, or custom menu items.
Note: For more information on X-Functions, please refer to your product documentation that is
installed with your software:
Help: Programming: X-Functions
There, you will find information on creating and using X-Functions, a language reference, and tutorials.

20.7 Automation Server
Origin can be used as an Automation Server. Client applications such as National Instruments™
LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and
can also send commands to be executed within Origin.
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Note: For more information on Origin's Automation Server functionality, refer to the product
documentation installed with your Origin software:
Help: Programming: Automation Server.
There you will find examples and language reference information. Sample files can be found in the
\Samples\COM Server and Client folder of your Origin software.

20.8 LabVIEW
National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of postacquisition analysis and presentation.
Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs
in their main LabVIEW application to communicate seamlessly with Origin.

For Origin 2022b, the "Close References" application control is added to all
Samples\COM Server and Client\LabVIEW .vi files. Copy these samples to LabVIEW
using the Origin menu Tools: Copy Origin Sub-VI LabVIEW vi.lib\addons.

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed
with your Origin software:
Help: LabVIEW VI
Examples and tutorials are provided.

20.9 Orglab
Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other
Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to
use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their
frontend software to output data as Origin files.
The Orglab module is available for 64-bit systems. To find out more about Orglab and to download the
Orglab module, go to the Products > Orglab page of www.originlab.com.
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21.1 Customizing Default Settings
21.1.1Setting Preferences with the Options Dialog Box
The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display,
file and system paths, text fonts, Origin program opening and closing behaviors, etc.
To open the Options dialog box:

•

Choose Preferences: Options (any Origin window is active)

•

If you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active)

Controls For

•

Max number of ticks for numeric and date/time scales

•

Distances from the tick labels to tick marks, axis titles

•

Display of zeros and scientific notation in tick labels, units display in axis title

Two zero control check boxes were added and turned on by
default for Origin 2020b:

Axis Tab

•

Zero is '0'

•

No Trailing Zero

Beginning with Origin 2021, these options are turned OFF
by default.

Excel Tab

File Locations
Tab

•

Use of default plot assignments

•

Scan datasets for legend text

•

Prompt before opening Excel files by drag-and-drop or saving Excel workbooks

•

Set file paths to track last opened, last saved, last exported file

•

Set default path and file extension for importing different file types

•

Define applicable file types for ASCII import dialogs
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Controls For

•

Dash lines definitions, line to symbol gap, user-defined symbols, etc.

•

2D graph anti-aliasing

•

Enable in-place editing of linked and embedded graphs in another application

•

Speed mode reminder watermark

Origin 2022 improves support for user-defined symbols,
removing some long-time restrictions and making it easier
to apply custom symbols to your graph:

Graph Tab

•

Support for Clipboard, .bmp or .svg formats.

•

Support B&W or color symbols.

•

Add symbols via the Options dialog or via Plot Details
Add from Clipboard button (Symbol tab > Custom
Construction check box > User Defined Symbols
radio button).

Miscellaneous
Tab

•

Proxy server configuration

•

Default templates for ASCII import

•

Custom date/time formats

•

Enable collapsible menus

•

Use of dataset names in the Origin workspace

Origin's Python Packages dialog for managing installation
of Python packages used with Origin, now supports package
installation via proxy server. Open Preferences: Options,
go to the Miscellaneous tab, choose Use HTTP Proxy
Server and enter the proxy address.
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Controls For

Numeric
Format Tab

Open/Close
Tab

•

Thresholds for displaying numbers in scientific notation

•

Defaults for displayed digits in data and report sheets

•

Radians, degrees or gradians

•

Separators for decimal places

•

Default window closing behaviors

•

Project startup, backup and autosave options

•

Options dialog save options

•

Default percent of page size of OLE graphs copied to Clipboard, graph margin
and CTRL+C hotkey controls.

Page Tab
Until 2021b, the Size Factor (%) (formerly, Ratio) was
set to 40. The default is now 100.

•

Default fonts for text objects

•

WYSIWYG and in-place editing mode behaviors

•

Size and positioning of superscripts/subscripts

•

Footnote size, analysis report sheets

Text Fonts
Tab
For information on controlling fonts used in the Origin
interface, see LabTalk's system.font(object).

•
System Path
Tab

View/Change the location of the User Files, Autosave, Backup, Unsaved and
Group folders

•

View locations of system folders (Program, License and Application Data)

21.1.2System Variables Dialog
System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors.
Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set
system variable values. In the dialog, there is a link named System Variables List which opens a web page
with a list of all system variables, the default value, and description.
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To customize a particular system variable:
1.

Type the system variable name in the first column of Set System Variables, without the @ symbol. For
example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type:
DAM

2.

Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set
Recalculate to Auto, type the value: 1.

3.

Add optional comments in the third column and click OK to close dialog.

This modified value will be remembered and applied in every Origin session.
You can quickly read or set the value of a writable system variable in the Script Window (Window: Script
Window) by typing @systemVariable= as, for example ...

@DAM=
... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the
Script Window sets the variable value for the current session only.

21.1.33D OpenGL Settings Dialog
Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced
performance including fast drawing, fast rotation and zoom, transparency, and lighting support.
For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's
support for OpenGL, run Origin and choose Preferences: 3D Open GL Settings.... Look under OpenGL Info
for information on graphics hardware and the supported version of OpenGL.
If your graphics hardware is older, you may experience compatibility issues with things such as transparency
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as
disabling transparency. The dialog box also provides information on disabling OpenGL.
For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this
chapter.

21.2 Customizing Menus
21.2.1Collapsible Menus
Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a
partial list of menu commands when opening longer menus. If you want to show all commands upon opening,
click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check box.
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21.2.2Custom Menu Organizer
If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom
Menu Organizer you can...

•

Create up to 3 main menus and corresponding sub-menus

•

Assign LabTalk scripts and X-Functions to a menu item

•

Restrict menu item access to specific window types

•

Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu.
Then press F1 or click the button

in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from
the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch
from one configuration to another. A Default configuration is also available in the fly-out, to revert to default
menu settings. Configuration files can be shared among colleagues so that you use a common set of menu
commands.

21.2.3Displaying Bitmaps in Menus
You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap
indicates that there is an equivalent toolbar button.
On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening
menus. To turn off the display of menu command bitmaps:
1.

Select Preferences: Options to open the Options dialog box.

2.

Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.

21.3 Customizing Toolbars and Buttons
In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.

21.3.1Displaying, Hiding or Moving Toolbar buttons
•

Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context
menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also
available.

•

Press ALT key and drag a button to any new toolbar location.

•

Press ALT key and drag a button to blank Origin workspace to create a new toolbar.

•

Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.
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21.3.2Customizing Toolbar Button Appearance
Use controls on the Options tab (View:Toolbars) to:

•

Show toolbar screen tips and shortcut keys on hover

•

Increase toolbar and toolbar button size

•

Toggle between "flat" or 3D toolbar buttons

21.3.3Displaying or Hiding a Toolbar
•

Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to
dock.

•

In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to
edge of the Origin workspace to dock.

•

In docked mode, drag the left/top end of a toolbar to reposition.

•

To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check
boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag
buttons from the Button Groups tab to add buttons on the new toolbar.

•

Use the Reset, Reset All buttons to reset toolbars.

21.3.4Creating New Toolbars with New Bitmap Images
Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run
when click it. Choose View: Toolbars... and create new button group on Button Group tab.

•

Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.

•

Click any button and click Settings... button to link .ogs (Script) file section with the button.

•

Drag the button to Origin workspace to create toolbar button.

•

If you are feeling really creative, Origin allows you to define a new button group that uses your own 16
color, 16 x 16 pixel bitmaps.

•

Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag
and drop the OPX file onto Origin workspace to install the toolbar.

Note: To learn more about creating and exporting user-defined toolbars, see:
Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars

21.3.5Add a Custom Button to the Window Title Bar
Origin supports adding a system button to the left of the minimize button on the window title bar. A custom
LabTalk script can then be associated with this button.
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Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:
Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical
Listing of Commands > Page

21.4 Customizing the Status Bar
Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other
useful information depending upon current action, selection, window, etc.

•

Right-click on Status Bar to customize the display.

•

Press ALT and drag items along the Status Bar to reorder.

21.5 Customizing the Origin Workspace
Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages
Log windows.

•

Right click on the window title bar to specify dock, hide, auto hide, and other settings.

•

When auto-hide is unchecked, double click to float the window.

•

Drag the window title to move or dock to a new location.

•

Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.

•

Choose View: Toolbars... from main menu. On the Toolbar tab:

o
o

The Reinitialize button resets menu, toolbar and dockable windows to default settings.
The Export button exports the current menu, toolbar and dockable window settings to an .OPX
file. Drag and drop the OPX file onto another Origin installation to configure the workspace to
match your customized settings.

Occasionally, an Origin workspace component goes "missing" -- The Data Display
window, one of the panels in Project Explorer, etc. When this happens, you can reset
your workspace by choosing View: Toolbars: Reinitialize. The downside has been
that this also resets workspace customizations and toolbar configurations. Beginning
with Origin 2018, clicking the Reinitialize button produces an attention message
asking if you want to restore the workspace settings from your previous version or use
the 2018 system defaults.

21.6 Templates and Themes
The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to
the creation of custom settings for repeat use. You can save your custom settings either as templates or
themes, described briefly in the following sections.

411

UserGuide_2022b

Note: For detailed information please refer to Origin Help file, see:
Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)

21.6.1Templates
The Origin template concept applies to graphs, workbooks, matrixbooks, and Analysis Templates™. Templates
allow you to choose a set of properties or operations and save those for repeat use.
21.6.1.1 Template Center
Both the New Book (File: New: Workbook/Matrix: Browse...) and Template Library (Plot: Template
Library) dialogs include an Open Template Center button
downloading additional templates.

that opens a dialog for browsing and

To open the Template Center directly, choose Tools: Template Center and set the Type drop-down to Graph
or Book.
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Beginning with Origin 2022b, you can search for additional templates and install them
directly from the Start menu.

21.6.1.2 Workbook Templates and Analysis Templates
You can save workbook or matrixbook settings, such as the number of columns and sheets, column plot
designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or
dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files.
When the workbook or matrix window is active and you choose File: Save Template As, you save any
window customizations, minus any data that might exist in the window at the time of saving, to a template file.
The template file can then be used to create new windows, as needed, for storing and analyzing your data.
You can use the New Book dialog box for managing your workbook, matrixbook and Analysis templates. The
New Book dialog is re-designed for Origin 2021b and is covered in the Workbooks chapter of this User Guide.
Use the same New Book dialog to manage your Analysis Templates™. An Analysis Template starts from a
workbook but differs in that when you save it as an Analysis Template (File: Save Workbook as Analysis
Template), it is saved with whatever analysis operations and dependent graphing operations, exist in the
workbook at the time of saving. Analysis Templates are discussed briefly in the Batch Analysis section of
How to Handle Repetitive Tasks chapter of this guide.
For a more in-depth discussion of Analysis Templates, see these topics:

•

Analysis Templates.

•

Creating and Using Analysis Templates (tutorial).

•

Batch Processing with Word Template for Reporting (tutorial).

21.6.1.3 Graph Templates
As mentioned in the Customizing Graphs chapter, Origin ships with about 240 built-in graph templates that are
used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you
can create your own graph, adding more layers, setting scale or dimensional relationships between layers,
modifying data plot properties, etc., and then save your customizations as a user-defined graph template
(.OTP) file by clicking File: Save Template as.... See the "Templates and Themes" section of the Customizing
Graphs chapter for a general discussion of graph templates.
One important subset of graph templates are what are called “cloneable” templates. A cloneable template
requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once
created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or
panels in your graph, then you shouldn't need to recreate this arrangement every time you want to recreate
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such a graph. Cloneable templates are identifiable in the Template Library by the presence of a “sheep” icon
next to the template name or thumbnail image.

For more information, see the section on cloneable templates in Graph Template Basics in your Origin Help
file.

21.6.2Themes
An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis
dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that
there are tabs for Graph, Worksheet, Dialog, Function and System Increment Lists.
Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take
the object properties of one graph and apply them to all the other graphs in the same project.
Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose
Copy Format context menu to copy format. Depending where you right click, the corresponding selection's
format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste
Format... to paste the Format to multiple target graphs.
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The Theme Organizer dialog box is opened from the Preferences menu. Use this dialog to organize your
graph, worksheet, and dialog themes.
With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme,
allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means
that it will be applied to new graphs automatically, if the graph template allows a System Theme to override
template settings (see the Allow System Theme & System Increment Lists to Override check box).

The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk
as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the
dialog, as needed, using the dialog box's Dialog Theme drop-down list. Saving multiple Themes for a dialog
box allows you to customize your analysis routines from different experiments, when each requires using a
specific (and unique) group of settings.

415

UserGuide_2022b

Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.

21.7 Topics for Further Reading
•

The 3D openGL Settings Dialog Box

•

Creating Custom Menus

•

The Custom Menu Organizer

•

Analysis Themes

•

How to Manage Multiple Menu Configuration (.OMC) Files

•

Managing Collapsible Menus

•

The User Files Folder
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22 Sharing Origin Files

You may want to customize some aspect of your Origin installation and then share your customizations with
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard filters,
LabTalk script files (.ogs), and X-Functions.

22.1 Drag and Drop Sharing
A quick and easy way to share a file with another user is simply to send it as an email attachment. The
recipient can then drag and drop the file into the Origin workspace.
Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a
dialog opens asking how you want to categorize the new fitting function.
Beginning with Origin 2022b, you can use a small dialog to remove formulas and links
from the current selection, the active sheet, the active book or the entire project. This
converts formulas and links to raw numbers. Removing formulas and links can make it
easier to share project data with colleagues without having to share such things as
externally-linked (DDE) Excel files; or to significantly reduce project size before
archiving data.
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22.2 Sharing Files with Multiple Machines for Single Users
If you are a single user and have installed Origin on multiple machines, you can share your custom settings
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive,
or even a USB flash drive, and use the same UFF path with each installation.
Note: For information on changing the UFF path, see:
Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The
User Files Folder

22.3 Sharing Files with Other Users in a Network
You can set up and use a group folder to share files among users. Multiple groups are allowed, and each
group can have some power user(s) set as the group leader. The group leader can use the Group Folder
Manager tool to publish custom files for sharing with other group members. When a group member launches
Origin, the published files will be copied to their Origin automatically and made ready for use.
Origin supports setting multiple group folders, making it possible to share different files
between groups. A leader machine can set up multiple groups and publish different files
to different groups. A member machine can belong to multiple groups and thus receive
all files published by group leaders.

Note: For information on group folders, see:
Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with
Multiple Clients > Setting a Group Folder Location

22.4 Packaging Files
Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file.
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk
scripts before and after installation.
To access the Package Manager, click Tools, and then click Package Manager...
To install the contents of an .opx file, simply drag and drop into the Origin workspace.
Note: For information on packaging files, see:
Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files
as OPX

22.5 The Origin Viewer
The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do
not have Origin installed.

418

Sharing Origin Files

•

The Origin Viewer is distributed as a single EXE file - no installation needed.

•

Available as a 64-bit Windows application, or as a native Mac application (Mac version not compatible with
11.0.1, Big Sur).

•

Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view
option.

•

Open a graph in a pop-up window for better viewing.

•

Supports viewing and rotating Origin's OpenGL 3D graphs.

Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer
versions 9.6.5 or later allow anyone to save the Unicode-compliant OPJU project files
to the pre-2018 OPJ format for sharing of projects with users of older versions of
Origin.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin,
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more
and download the free EXE.

22.6 Topics for Further Reading
•

The User Files Folder

•

Attaching Files to the Origin Project

•

Package Manager

•

Setting Up a Group Folder

•

Exporting Custom Button Groups

•

Exporting Toolbar Settings

•

Apps for Origin
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23 Origin Toolbars
This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default configurations.
You will note that some buttons are missing from default toolbar configurations. This may be because a button
has been deprecated, because it is duplicated on another toolbar, or simply because it is a lesser-used button.
To add or remove buttons from a toolbar:
1.

Click View: Toolbars to open the Customize dialog box.

2.

Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the
workspace.

3.

To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the
upper right-corner of the toolbar (removes entire toolbar from the workspace).

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool
displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.
Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance,
the 3D-Rotation Toolbar is only available when a 3D graph is active.

In addition to these dockable toolbars, Origin has context-sensitive Mini Toolbars for
variety of common editing tasks. These toolbars are discussed in The Origin Interface
chapter of this Guide. For a complete list of those toolbars, see the Origin Help File.

23.1 Standard

Button

Description

Hotkey

Button

Description

New Project

New Folder

New Workbook

New Graph

New Matrix

New 2D (Function) Plot

New 2D Parametric Plot

New 3D (Function) Plot

Hotkey
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Button

Description

Hotkey

Description

Hotkey

New 3D Parametric Plot

New Layout

New Notes

Digitize Image

New Image

Open

Ctrl +
O

Open From Cloud

Save Project

Ctrl +
S

Save Template

Recalculate Auto/Up-todate vs Manual/Pending

Pause Auto
Update/Recalculation

Zoom In and Out by
Percentage

Print

Ctrl +
P

Send Graphs to
PowerPoint

Refresh

Slide Show of Graphs

Open Video Builder

F5

Custom Routine

Duplicate

Project Explorer

Alt +
1

Object Manager

Alt +
8

Results Log

Alt +
2

Command Window

Alt +
3

Code Builder

Alt +
4

Add New Columns
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23.2 Import

Button

Description

Hotkey

Button

Description

Import Wizard

Import Single ASCII

Import Multiple ASCII

Import Excel

Re-import no Dialog

Ctrl +
4

Hotkey

Re-import with Dialog

Clone Import

Batch Processing

Connect to Data from
Web

Connect Multiple Files

Import All Connected
Data

23.3 Edit

Button

Description

Hotkey

Button

Description

Hotkey

Cut

Ctrl+X

Copy

Ctrl+C

Paste

Ctrl+V

Undo

Ctrl+Z
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23.4 Graph

Button

Description

Button

Description

Enable/Disable AntiAliasing

Rescale

Rescale X

Rescale Y

Rescale XY

Rescale Z

Exchange the X and
Y axes

Enable/Disable Speed Mode

Extract to Layers

Extract to Graphs

Merge

Duplicate with New
Columns/Sheets/Books

Add Bottom-X Left-Y
Layer

Add Top-X Layer

Add Right-Y Layer

Add Top-X Right-Y Layer

Add Inset Graph

Add Inset Graph With Data

Zoom In

Zoom Out

Whole Page
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Hotkey

Hotkey

Ctrl+R

Origin Toolbars

23.5 2D Graphs

Note that only common plot types have a toolbar button. Complete access to Origin plot
types is found on the Plot menu.

Button

Description

Button

Description

Line

Horizontal Step

Vertical Step

Spline Connected

Scatter

Grouped Scatter - Indexed Data

Scatter Central

Column Scatter

Y Error

X Y Error

Vertical Drop Line

Bubble

Color Mapped

Bubble + Color Mapped

Line + Symbol

Line Series

2 Point Segment

3 Point Segment

Row-wise

Column

Column + Label

Grouped Column-Indexed Data

425

UserGuide_2022b

Button

426

Description

Button

Description

Bar

Stacked Column

Stacked Bar

100% Stacked Column

100% Stacked Bar

Floating Column

Floating Bar

3D Color Pie Chart

2D B&W Pie Chart

Double Y Axis

3Ys Y-YY

3Ys Y-Y-Y

4Ys Y-YYY

4Ys YY-YY

Multiple Y Axes

Stacked Lines By Y Offsets

Colormapped Line Series

Waterfall

Waterfall Y: Color Mapping

Waterfall Z: Color Mapping

3D Waterfall

3D Waterfall Y: Color Mapping

3D Waterfall Z: Color Mapping

Vertical 2 Panel

Horizontal 2 Panel

4 Panel

9 Panel

Stack

Origin Toolbars

Button

Description

Button

Description

Multiple Panels by Label

Trellis Plot

Cluster Plot

Box Chart

Violin with Box

Grouped Box Charts-Indexed
Data

Grouped Box Charts-Raw Data

Interval Plot

Histogram

Histogram + Probabilities

Multi-Panel Histogram

Marginal Histograms

Marginal Boxes

Distribution + Rug

2D Kernel Density

QC(X-bar R) Chart

Pareto Chart-Binned Data

Pareto Chart-Raw Data

Scatter Matrix

Probability Plot

Q-Q Plot

Parallel Plot

Area

Stacked Area

Fill Area

Zoom

Polar theta(X) r(Y)

Polar r(X) theta(Y)
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Button

Description

Button

Description

Wind Rose-Binned Data

Wind Rose-Raw Data

Ternary

Piper

Smith Chart

Radar

Vector XYAM

Vector XYXY

High-Low-Close

Japanese Candlestick

OHLC Bar Chart

OHLC-Volume

Line (Stock)

Bridge Chart

Template Library

23.6 Add Object to Graph

Button
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Description

Hotkey

Button

Description

Add Color Scale

Reconstruct Legend

Add Asterisk Bracket

Add XY Scale

Date & Time

Project Path

New Link Table

Add Bubble Scale

Hotkey

Ctrl+L

Origin Toolbars

23.7 3D and Contour Graph

Button

Description

Button

Description

3D Scatter Plot

3D Trajectory

3D Scatter + Error Bar

3D Vector XYZ XYZ

3D Vector XYZ dXdYdZ

3D Tetrahedral

3D Bars

3D Stacked Bars

3D 100% Stacked Bars

XYY 3D Bars

XYY 3D Stacked Bars

XYY 3D 100% Stacked Bars

3D Ribbons

3D Walls

3D Waterfall

3D Waterfall Y: Color Mapping

3D Waterfall Z: Color Mapping

3D Color Fill Surface

Multiple Color Fill Surfaces

3D X Constant with Base

3D Y Constant with Base

3D Colormap Surface

Multiple Colormap Surfaces

3D Color Fill Surface with Error
Bar

3D Colormap Surface with Error
Bar

3D Wire Frame
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Button

Description

Button

Description

3D Wire Surface

3D Colormap Surface with
Projection

3D Ternary Colormap Surface

Contour - Color fill

Contour - B/W Lines + Labels

Gray Scale Map

Contour Profiles

Polar Contour theta(X) r(Y)

Polar Contour r(X) theta(Y)

Ternary Contour

Image Plot

Image Profiles

Heatmap

Heatmap with Labels

23.8 3D Rotation

Button
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Description

Button

Description

Rotate counterclockwise

Rotate clockwise

Tilt left

Tilt right

Tilt down

Tilt up

Increase perspective

Decrease perspective

Fit frame to layer

Reset Rotation

Origin Toolbars

Button

Description

Button

Reset

Description

Rotate on any direction

Rotation Angle

23.9 Worksheet Data

Button

Description

Hotkey

Button

Description

Statistics on Column(s)

Statistics on Row(s)

Sort

Set Column Values

Set All Column Values

Ctrl+F5

Hotkey

Ctrl+Q

Row number

Uniform random
numbers

Normal random
numbers

Add/Remove Data
Filter

Enable/Disable Data
Filter

Reapply Data Filter

23.10 Column

Button

Description

Set as X

Button

Description

Set as Y
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Button

Description

Button

Description

Set as Z

Set as Y Error Bars

Set as Labels

Set as Disregard

Set as Grouping

Set as Subject

Move to First

Move Left

Move Right

Move to Last

Swap Columns

Add Sparkline

23.11 Layout

Button

Description

Button

Add Graph

Description

Add Worksheet

23.12 Mask

Button
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Description

Button

Description

Mask Range

Unmask Range

Change mask color

Hide/Show masked points

Origin Toolbars

Button

Description

Button

Description

Swap mask

Disable/Enable masking

23.13 Tools

Button

Description

Hotkey

Button

Description

Pointer

Scale In

Scale Out

Screen Reader

Data Highlighter

Data Reader

Data Cursor

Data Selector

Selection on Active
Plot

Selection on All
Plots

Mask Points on
Active Plot

Mask Points on All
Plots

Unmask Points on
Active Plot

Unmask Points on
All Plots

Draw Data

Text Tool

Annotation

Arrow Tool

Curved Arrow Tool

Distance Annotation

Hotkey
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Button

Description

Hotkey

Button

Description

Hotkey

Line Tool

Polyline Tool

Curve Tool

Freehand Draw
Tool

Rectangle Tool

Circle Tool

Polygon Tool

Region Tool

Zoom-Panning Tool

Hold
"A"

Insert Equation

Insert Word Object

Insert Excel Object

Insert Object

Insert Graph

Insert Worksheet

Rescale Tool

Hold "Z": Zoom;
Hold "X": Pan

Hold
"R"

Rotate Tool

23.14 Object Edit

Button
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Description

Button

Description

Left

Right

Top

Bottom

Origin Toolbars

Button

Description

Button

Description

Vertical

Horizontal

Uniform Width

Uniform Height

Group

Ungroup

Distribute Selected Layers/Graphic
Objects
Evenly in Vertical Dimension

Distribute Selected Layers/Graphic
Objects
Evenly in Horizontal Dimension

Front

Back

Forward

Backward

Front(data)

Back(data)

23.15 Arrow

Button

Description

Button

Description

Horizontal Alignment

Vertical Alignment

Widen Head

Narrow Head

Lengthen Head

Shorten Head
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23.16 Style

Button
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Description

Hotkey

Button

Description

Fill Color

Line/Border Color

Lighting Control Dialog

Palette

Line/Border Style

Line/Border Width

Fill Pattern

Fill Pattern Width

Pattern Color

Clear Borders

Left Border

Top Border

Right Border

Bottom Border

Frame Borders

Inside Horizontal
Borders

Inside Vertical Borders

Inside Horiz and Vert
Borders

All Horizontal Borders

All Vertical Borders

All Borders

Merge cells

Hotkey

Ctrl+R

Origin Toolbars

23.17 Format

Button

Descriptio
n

Hotkey

Font

Button

Description

Hotkey

Font size

Bold

Ctrl+"B"

Italic

Ctrl+"I"

Underlin
e

Ctrl+"U"

Superscript

Ctrl+"+"

Subscrip
t

Ctrl+"="

SuperSubscri
pt

Ctrl+"-"

Ctrl+">"
Increase
Font

Greek

Ctrl+Shift+
"."

Ctrl+"G"

Ctrl+"<"
Decrease
Font

Ctrl+Shift+
","

Left

Center
Horizont
al

Right

Top

Center
Vertical

Bottom

Font Color
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23.18 Auto Update

Button

Description

Pause Auto Update/Recalculations

23.19 Database Access

Button

Description

Button

Description

Open SQL Editor

Open Query Builder

Load ODQ File

Preview Import

Import data

Remove SQL

23.20 Markers & Locks

Button

Description

Add Data Markers

Marker Size

Lock Positions
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Hotkey

Ctrl+Alt+M

Button

Description

Clear Data Markers

Marker Hide Show

Hotkey

Ctrl+Alt+N

Origin Toolbars
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2
2D Integration .............................................. 295
3

Code Builder .................................................. 49
Collapsible Menus ............................................ 27
Column Label Rows, Worksheet ......................... 97

32- and 64-bit .................................................. 3

Column Plot Designations ............................... 171

3D Graphing, Hardware Compatibility ............... 408

Column Values, Setting .................................. 106

3D Surface Fitting ........................................... 14

Columns, Naming ............................................ 83

A

Command Window .......................................... 45

AB? .............................................................. 70

Concurrent Network ........................................... 5

ABF .............................................................. 70

Consulting ....................................................... 9

Active Dataset .............................................. 304

Convolution .................................................. 327

Analysis Markers ........................................... 311

Coordinate Values, Reading/Annotating ............. 295

Analysis Reports ........................................... 354

Coordinates, Reading/Labeling......................... 287

Analysis Templates ................................. 125, 354

Copy/Paste Graphs ........................................ 367

Animating Graphs ......................................... 377

Curve Fit, Linear and Polynomial ...................... 322

ANOVA ........................................................ 339

Curve Fit, Nonlinear ....................................... 322

Apps Gallery................................................... 37

Curve Fitting ................................................ 295

ASCII Data..................................................... 68

Custom Menu Organizer ................................. 409

ASCII Data, Import to Graph ........................... 174

Customizing Origin, Global Settings .................. 405

Auto Recalculate ........................................... 344

Customizing Toolbars and Buttons .................... 409

Automating Origin .................................. 343, 361
Axis Dialog Box ...................................... 212, 225
B

D
DAT .............................................................. 70
Data Cursor Tool ........................................... 281

B2D .............................................................. 70

Data Display................................................. 280

Batch Peak Analysis ....................................... 324

Data Info Window ......................................... 285

Batch Plotting ............................................... 350

Data Markers......................................... 309, 311

Batch Processing ........................................... 343

Data Reader ................................................. 280

BDF .............................................................. 70

Data Reduction, Graphs.................................. 178

Binary 2D Array, Import ................................... 70

Data Reduction, Worksheets ........................... 123

Binary Data .................................................... 71

Datasets, Creating......................................... 104

BRUKER OPUS ................................................ 70

DCF .............................................................. 70

Buttons, Adding Programmable to Origin Windows410

Deactivate License............................................. 7

C

Derivatives, Plot............................................ 295

CDF .............................................................. 70

Descriptive Statistics ..................................... 295

CGM ............................................................. 70

Dialog Box Themes ........................................ 346

Clipboard Data, Importing ................................ 72

Differentiation .............................................. 295
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Digitizing Scatter Plots ..................................... 76

Graphs, Add Data by Insert Plot to Layer ........... 172

Drag and Drop Plotting ................................... 172

Graphs, Adding or Removing Plots.................... 172

Drag-and-Drop Origin File Sharing ................... 418

Graphs, Adding Text & Drawing Objects ............ 241

Drag-and-Drop, Importing by ............................ 71

Graphs, Animating......................................... 377

DX ................................................................ 70

Graphs, Cloning with New Data........................ 350

DX1 .............................................................. 70

Graphs, Copy/Paste Format ..................... 264, 414

E

Graphs, Copy/Paste or Embedding ................... 367

EarthProbe ..................................................... 70

Graphs, Customizing Axes ................ 212, 225, 234

EDF .............................................................. 70

Graphs, Customizing Data Points ..................... 222

Embed Graphs, 3rd Party Applications............... 367

Graphs, Customizing Grouped Plots .................. 219

Embed Graphs, Origin Templates ..................... 348

Graphs, Distance Between Two Points ............... 281

EPA .............................................................. 70

Graphs, Embed in Worksheets ......................... 125

ETAS INCA ..................................................... 70

Graphs, Extract to Graphs .............................. 255

Excel.......................................... 42, 66, 403, 405

Graphs, Extract to Layers ............................... 255

Exporting a Matrix ......................................... 387

Graphs, Function ........................................... 164

Exporting Graphs/Layout Pages ....................... 371

Graphs, Insert Equation ................................. 244

F

Graphs, Inset .......................................... 261–58

Famos ........................................................... 70

Graphs, Labeling a Data Point.......................... 243

FFT ...................................................... 295, 326

Graphs, Layer Contents Dialog Box................... 173

File Types, Origin ............................................ 53

Graphs, Layer Customizations ......................... 213

Filtering, Signal Processing ............................. 326

Graphs, Legend Customization ........................ 234

FLEXnet ........................................................... 5

Graphs, Linking Axis Scales............................. 257

Full Menus ..................................................... 27

Graphs, Listed by Type182, 188, 191, 193, 197, 201, 205, 206

Function Plots, 2D and 3D............................... 164

Graphs, Magnifying........................................ 269

G

Graphs, Merge .............................................. 213

Gadgets.................................... 15, 287, 295, 353

Graphs, Panning ........................................... 269

Graph Gallery ................................................. 12

Graphs, Plot Details ................................ 211, 216

Graph Layer ................................................. 166

Graphs, Reading Coordinate Values .................. 275

Graph Layer Frame ........................................ 166

Graphs, Reorder Layers .................................. 257

Graph Page .................................................. 166

Graphs, Rescaling ......................................... 269

Graph Types................................................. 180

Graphs, Save Format as Theme ....................... 214

Graphical Exploration Tools, Annotation ............ 285

Graphs, Saving Custom Templates ................... 213

Graphical Exploration Tools, Data Cursor ........... 285

Graphs, Send to PowerPoint ............................ 376

Graphical Exploration Tools, Data Info Window ... 285

Graphs, Slide Show ....................................... 377

Graphical Exploration Tools, Data Reader .......... 285

Graphs, Speed Mode ...................................... 178

Graphing Matrix Data ..................................... 162

Graphs, Template Library ............................... 213

Graphing, Functions....................................... 164

Graphs, Templates ........................................ 262
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Index

Graphs, Theme Organizer ............................... 265
Graphs, Themes............................................ 264
Graphs, Zooming .......................................... 269

K
KaleidaGraph.................................................. 70
L

Group Folder Manager .................................... 418

LabTalk ....................................................... 400

Grouping Plots .............................................. 177

LabVIEW™ ................................................... 404

H

Layer Contents Dialog Box ....................... 173, 177

H5 ................................................................ 70

Layer Icon, Graph ......................................... 166

HDF5 ............................................................ 70

Layers, Graph ............................................... 166

HE ................................................................ 70

Layout Pages, Exporting ................................. 371

HEKA ............................................................ 70

Legend, Box Charts ....................................... 236

Help Files, Updating ......................................... 10

Legend, Bubble Scales ................................... 237

Hiding Worksheet Columns ............................. 121

Legend, Categorical Data ................................ 236

HPF .............................................................. 70

Legend, Color Scales...................................... 236

HYP .............................................................. 70

Legend, Customizing............................... 212, 234

I

Legend, Update vs. Reconstruct ....................... 235

IBW .............................................................. 70

License Management ......................................... 3

IgorPro .......................................................... 70

License, Dongle ................................................ 5

Image Processing ..................................... 16, 328

License, Maintenance ......................................... 6

Image Profile................................................ 295

License, Node-locked ......................................... 5

Image, Import ................................................ 70

License, System Transfers .................................. 7

Images, Matrix ............................................. 131

Limitations, Matrix......................................... 129

IMG .............................................................. 70

Limitations, Workbook...................................... 82

Import Wizard ................................................ 71

Limitations, Workbooks .................................... 81

Importing, Filter Files (OIF)............................... 53

Lock, Recalculate .......................................... 344

imzML ........................................................... 70

M

Inset Graph ............................................. 261–58

Magnifying Graphs......................................... 269

Installing Origin ................................................ 3

Manual Recalculate ........................................ 344

Integration................................................... 295

Masking Data, Graphs .................................... 314

Interpolation ................................................ 295

Masking Data, Remove or Disable Mask............. 314

ISF ............................................................... 70

Masking Data, Worksheets .............................. 314

J

Mat ............................................................... 70

JCAMP ........................................................... 70

Math Tools, Area/Volume ................................ 320

JCAMP-DX ...................................................... 70

Math Tools, Interpolation ................................ 319

JCM .............................................................. 70

MATLAB ......................................................... 70

JDX .............................................................. 70

Matrix Objects .............................................. 133

JNB .............................................................. 70

Matrix Objects, Naming .................................. 130
Matrix, Converting to Worksheet ...................... 153
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Matrix, Converting Worksheet Data .................. 156

Networks, Sharing Files .................................. 418

Matrix, Data Mode vs. Image Mode .................. 131

New Features ................................................. 19

Matrix, Exporting .......................................... 387

NI DIAdem ..................................................... 70

Matrix, Manipulating Data ............................... 151

Non-parametric Statistics ............................... 339

Matrix, Profiling ............................................ 149

O

Matrix, Set Values ......................................... 149

Object Linking and Embedding (OLE) ................ 367

Matrix, Virtual............................................... 157

Object Manager ................................ 39, 167, 175

Matrixbooks, Naming ..................................... 130

OGG Files ...................................................... 53

Matrixsheets, Naming .................................... 130

OIF Files ........................................................ 53

MDF .............................................................. 70

OpenGL ................................................ 408, 419

Menus, Organizer ............................................ 27

Options Dialog Box ........................................ 405

Messages Log ................................................. 49

Orglab......................................................... 404

Minitab .......................................................... 70

Origin C ....................................................... 403

Modifying Toolbars ........................................ 409

Origin C, IDE .................................................. 49

Movies, Animating Graphs .............................. 377

Origin Viewer ............................................... 418

MPJ .............................................................. 70

Origin, Display Language .................................... 7

MTW ............................................................. 70

Origin, License Deactivation ................................ 7

Multivariate Analysis ........................................ 14

Origin, Licensing ............................................... 3

Multivariate Statistics..................................... 340

Origin, New Features ....................................... 19

mzData ......................................................... 70

Origin, Registering ............................................ 5

mzML ............................................................ 70

Origin, Service Releases ..................................... 6

mzXML .......................................................... 70

Origin, Sharing Files ............................... 417, 418

N

Origin, System Transfers .................................... 7

NAG Numerical Library ................................... 403

Origin, Uninstalling ............................................ 8

Naming Columns ............................................. 83

Origin, Upgrading .............................................. 3

Naming Matrix Objects ................................... 130

OriginPro, Features.......................................... 13

Naming Matrixbooks ...................................... 130

Orthogonal Regression ..................................... 13

Naming Matrixsheets ..................................... 130

OTM Files....................................................... 53

Naming Workbooks ......................................... 83

P

Naming Worksheets......................................... 83

Package Manager .......................................... 418

National Instruments ....................................... 70

Page, Graph ................................................. 166

National Instruments™ LabVIEW™ ................... 404

Panning Graphs ............................................ 269

NC ................................................................ 70

parametric function plots ................................ 164

NetCDF ......................................................... 70

Parametric Function Plots, 2D and 3D ............... 164

Networks, Concurrent ........................................ 5

pClamp ......................................................... 70

Networks, Installation ................................. 5, 418

pCLAMP ......................................................... 70

Networks, Multi-seat Node-locked ........................ 3

Peak Analysis ................................... 14, 295, 324
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Pivot Tables ................................................. 121

Rise Time .................................................... 295

Plot Designation ............................................ 161

ROC Curve ................................................... 341

Plot Details Dialog Box ............................ 167, 211

S

Plot Setup Dialog Box ...................... 167, 173, 177

Sample Projects .............................................. 10

Plots, Exchanging .......................................... 171

SAS .............................................................. 70

Plotting Virtual Matrix Data ............................. 162

sas7bdat ....................................................... 70

Plotting Worksheet Data ................................. 161

SAV .............................................................. 70

PowerPoint, Exporting to ................................ 376

Screen Reader .............................................. 279

Preferences

Scripting...................................................... 400

Options..................................................... 405

Selecting Data, Graph ............................. 304, 307

Princeton Instruments ...................................... 70

Selecting Data, Worksheet .............................. 301

Prism ............................................................ 70

Set Column Values, Worksheet ........................ 106

Profiling Images ............................................ 149

Set Matrix Values .......................................... 149

Profiling Matrix Data ...................................... 149

Sharing Files with Multiple Users ...................... 418

Programming Origin................................ 361, 399

Sharing Origin Files ................................ 417, 418

Programming Origin, LabTalk .......................... 400

SIE ............................................................... 70

Programming Origin, Python ........................... 401

SigmaPlot ...................................................... 70

Programming Origin, X-Functions ..................... 403

Sigmoidal Fit ................................................ 295

Project Explorer .............................................. 32

Signal Processing ............................................ 15

PXP .............................................................. 70

Signal Processing, Coherence .......................... 328

Python ........................................................ 401

Signal Processing, Correlation ......................... 327

PZFX ............................................................. 70

Signal Processing, Decimation ......................... 328

Q
QDA.............................................................. 70

Signal Processing, Envelope Curves .................. 328
Signal Processing, Filtering ............................. 326

R

Signal Processing, Rise Time ........................... 328

R 402

Signal Processing, Smoothing .......................... 327

RAW ............................................................. 70

Slide Show of Graphs ..................................... 377

REC .............................................................. 70

Smoothing ................................................... 327

Recalculate .................................................. 344

Somat ........................................................... 70

Recalculation of Results .................................. 344

Sorting Worksheet Data ................................. 121

Region of Interest ......................................... 131

Sparklines.................................................... 100

Region of Interest (ROI)287, 288, 295, 318, 319, 320, 323, 325,
SPC353
.............................................................. 70
Regional Data Selector ................................... 307

SPE .............................................................. 70

Re-Importing.................................................. 78

SPSS ............................................................ 70

Reports, Analysis .......................................... 354

Statistics ......................................... 14, 287, 295

Rescaling Graphs .......................................... 269

Statistics, Basic ............................................ 332

Results Log .................................................... 49

Statistics, Charts........................................... 336

445

UserGuide_2022b

Statistics, Data Selection ................................ 334

U

Statistics, Descriptive..................................... 332

Update Legend ............................................. 212

Statistics, Multivariate...................................... 14

Upgrading Origin ............................................... 3

Statistics, Report to Script/Command Window .... 335

User Files Folder (UFF) ................................ 4, 418

Statistics, Report to Status Bar ........................ 334

User Files, Transferring ...................................... 3

Status Bar ..................................................... 47

User Forum ...................................................... 9

Surface Fit ................................................... 322

V

Surface Fitting, 3D .......................................... 14

Video Builder ................................................ 377

Survival Analysis ........................................... 340

Virtual Matrix ............................................... 157

System Transfer ............................................... 7

Visual Basic/Visual C/C# ................................ 403

System Variables .......................................... 407
T

W
WAV ............................................................. 70

Technical Support.............................................. 9

Wavelet Analysis ........................................... 328

Tektronix ....................................................... 70

Windows, Dock/Float/Auto-Hide ......................... 49

Templates.................................................... 411

Workbook Organizer ...................................... 101

Templates, Analysis ......................... 125, 348, 354

Workbooks, Naming......................................... 83

Templates, Project ........................................ 347

Worksheet Column Label Rows .......................... 97

Templates, Workbook .................................... 347

Worksheet Column Properties............................ 92

Theme Organizer ............................ 214, 265, 415

Worksheet Plot Designations ........................... 165

Themes ....................................................... 411

Worksheets, Converting from Matrix ................. 153

Themes, Dialog Box ....................................... 346

Worksheets, Converting to Matrix ............... 156–55

Themes, File Types .......................................... 53

Worksheets, Naming ........................................ 83

Thermo ......................................................... 70

Worksheets, Processing Data........................... 121

Toolbar Bitmaps, in Menus .............................. 409

Worksheets, Set Column Values....................... 106

Toolbar Buttons, Custom ................................ 410

Worksheets, Sorting Data ............................... 121

Toolbars and Buttons, Customzing ................... 409

Worksheets, Transposing Data......................... 121

Toolbars, Customizing ...................................... 27
Training........................................................... 9
Transfer User Files ............................................ 5
Tutorials, Help File........................................... 10
Tutorials, Video............................................... 11
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Z
Zooming Graphs ........................................... 269

